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Introducing FortiEDR

This chapter describes the FortiEDR system components, FortiEDR technology and the workflow for
protecting your organization using FortiEDR.

Introduction

FortiEDR provides multi-layered, post- and pre-infection protection that stops advanced malware in real
time. FortiEDR recognizes that external threat actors cannot be prevented from infiltrating networks, and
instead focuses on preventing the exfiltration and ransoming of critical data in the event of a cyber-attack.
FortiEDR's unique virtual patching technique, which only blocks malicious outbound communications,
enables employees to continue working as usual even when their devices are infected.

Execution prevention

FortiEDR stops both known and unknown malware types using machine-learning-based Next-Generation
Anti-Virus (NGAYV), a signature-less approach that detects and mitigates zero-day attacks by filtering out
known malware variations. This blocks the execution of files that are identified as malicious or suspected to
be malicious. For this policy, each file is analyzed to find evidence for malicious activity.

In addition to machine-learning-based NGAV protection, Execution Prevention policy is augmented by other
techniques such as signature-based detection, sandboxing, and more.

Data exfiltration

Data exfiltration is the unauthorized transfer of sensitive information from a target’s network to a location
that a threat actor controls.

FortiEDR is a realtime targeted-attack exfiltration prevention platform.
Threat actors only benefit when they actually succeed in stealing your data.

FortiEDR ensures that your data is not exfiltrated by threat actors, regardless of the methods that they
use.

FortiEDR can prevent malicious exfiltration attempts of any kind of data, from any application, from any
process, using any protocol or port.

FortiEDR becomes your last line of defense in case of a data exfiltration attempt. All malicious
connections are blocked and precise details of the infected devices and their associated components are
available for your review.

FortiEDR is a software-only solution that can be installed with your current standard equipment.

FortiEDR 7.2.0 Administration Guide 10
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Introducing FortiEDR

FortiEDR protects your data from exfiltration both On-Premises and Off-Premises.

Ransomware

Ransomware is malware used by attackers to infect a device, hijack files on that device and then lock them,
via encryption, so that they cannot be accessed until the attacker decrypts and releases them. A successful
ransomware attack represents the exploit of a greater security vulnerability in your environment. Paying the
attacker is only a short-term solution that does not address the root of the problem, as it may likely lead to
another attack that is even more malicious and more expensive than the previous one.

FortiEDR prevents, in real time, an attacker’s attempt to encrypt or modify data. FortiEDR then generates an
alert that contains the information needed to initiate an investigation, so the root breach can be uncovered
and fully remediated. Moreover, the end user can continue to work as usual even on an infected device.

Threat hunting

FortiEDR’s threat-hunting capabilities features a set of software tools and information sources focused on
detecting, investigating, containing and mitigating suspicious activities on end-user devices.

FortiEDR provides post- and pre-infection endpoint protection management, while delivering high detection
rates with realtime blocking and response capabilities when compared to traditional Endpoint Detection and
Response (EDR) tools.

FortiEDR provides malware classification, displays Indicators of Compromise (I0OCs) and delivers full attack-
chain views - all while simultaneously enabling users to conduct further threat hunting, if and when needed.

FortiEDR 7.2.0 Administration Guide
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FortiEDR technology

PREVENT
REAL-TIME PROTECTION

DETECTI&

DISCOVERY DEFUSE
& PREDICT NO ALERT FATIGUE
PROACTIVE RISK NO DWELL TIME

MANAGEMENT

RESPOND & REMEDIATE
CUSTOMIZED DISINFECTION

CLOUD, ON-PREMISES OR [@) LIGHTWEIGHT
HYBRID MANAGEMENT H>7 AGENT

When looking at how external threat actors operate, we recognize two important aspects. The first is that
the threat actors use the network in order to exfiltrate data from an organization. Second, they try to remain
as stealthy as possible in order to avoid existing security measures. This means that threat actors must

establish outbound communications in a non-standard manner.
FortiEDR’s technology prevents data exfiltration by identifying, in real time, malicious outgoing
communications that were generated by external threat actors. Identification of malicious outgoing
communications is the result of our research conducted on both operating system internals and malware
operation methods.

Our research revealed that all legitimate outgoing communications must pass through the operating
system. Thus, by monitoring the operating system internals it is possible to verify that a connection was
established in a valid manner. FortiEDR gathers OS stack data, thread and process related data and
conducts executable file analysis to determine the nature of the connection. Additionally, any type of threat

FortiEDR 7.2.0 Administration Guide
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Introducing FortiEDR

attempting to bypass the FortiEDR driver is detected as the connection will not have the corresponding data
from FortiEDR.

FortiEDR'’s technology prevents data exfiltration by identifying, in real time, malicious outgoing
communications that were generated by external threat actors. Identification of malicious outgoing
communications is the result of our research conducted on both operating system internals and malware
operation methods.

FortiEDR components

Overview

The FortiEDR platform is a distributed architecture that collects the connection establishment flow of your
organization’s communicating devices directly from each device’s operating system internals. FortiEDR
analyzes the flow of events that preceded the connection establishment and determines whether the
connection establishment request was malicious. The system can enforce your organization’s policy by
blocking the connection establishment request in order to prevent exfiltration.

The FortiEDR platform is comprised of the following components:

Threat Hunting

[Goal

o

FortiEDR Cloud Services (FCS)

FortiEDR 7.2.0 Administration Guide
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Introducing FortiEDR

FortiEDR Collector

The FortiEDR Collector is an agent that resides on every communicating device in your enterprise, including
desktops, laptops and servers.

By default, the Collector runs in autonomous mode. Upon every attempt made by the communicating device
to establish a network connection or change a file, the Collector collects all required metadata and analyzes
it to determine whether the process performing the action is legitimate. You can configure the Collector to
use a Core for the metadata analysis, in which case the Collector holds the establishment of the connection
until authorization is received from the Core.

« Pass: Legitimate requests are allowed with extremely negligible latency.
« Block: Malicious exfiltration and file changing attempts are blocked.

If third-party software attempts to stop the FortiEDR Collector service, the system

V) prompts for the registration password. This is the same password used when
‘?' installing the Collector. If an incorrect password is supplied at the prompt, the
|| message Access Denied displays on the Collector device. In this case, the FortiEDR

Collector service is not stopped. For more details about the required password to
supply in this situation, you may refer to Component Authentication on page 316.

A FortiEDR Collector should be installed on each communicating device in your organization. The same
FortiEDR Collector can be installed on all Windows, macOS, and Linux systems. The following are the
connections established between the FortiEDR Collector and other FortiEDR components:

» To the FortiEDR Aggregator: The FortiEDR Collector initially sends registration information to the
FortiEDR Aggregator via SSL and then it sends ongoing health, status information, and security events.

* From the FortiEDR Aggregator: The FortiEDR Collector receives its configuration from the FortiEDR
Aggregator.

» To the FortiEDR Core: The FortiEDR Collector sends the following information:
« Compressed activity events that are later used for Threat Hunting
« Communication-related data to be used for the Communication Control

e (Non-autonomous mode only) Metadata for determining whether a specific action should be
blocked or passed

When a Core is used for the metadata analysis, which means the Collector is
not running in autonomous mode, if all Cores are unreachable due to
) ! /. connection issues or errors, the Collector switches to autonomous mode
? automatically after one minute where it continues to run and protect the
- device by analyzing the metadata locally. The Collector then keeps trying to
establish a connection with the Core every few seconds to few minutes,
depending on the number of errors in previous attempts.

* From the FortiEDR Core: The FortiEDR Collector receives connection establishment authorization or
denial (blocking) from the FortiEDR Core.

FortiEDR 7.2.0 Administration Guide
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Introducing FortiEDR

Negligible footprint

The FortiEDR Collector retains only a limited amount of metadata on the device in order to keep CPU usage
to virtually zero and the storage requirements to a minimum. FortiEDR’s traffic consumption requirements
are low because the FortiEDR Collector sends to the Core its activity events, the size of which depends on
the amount of activity, and sends to the Aggregator security events which are small in size. Additionally,
FortiEDR uses message compression in order to further reduce the traffic sent to the network. You may
refer to Collector System Requirements for the exact specifications of the system requirements.

Quick and easy installation

The FortiEDR Collector comes as a standard installer package that is easily installed via standard remote
unattended deployment tools, such as Microsoft SCCM. No local configuration or reboot is required;
however, a reboot of the system ensures that any malicious connections that were previously established
before the installation are thwarted and tracked via FortiEDR after the reboot is complete. Upgrades can be

performed remotely and are rarely needed, because all the brains of the FortiEDR system are in the FortiEDR
Core.

Incidents view

The Windows Incidents view records whenever a FortiEDR Collector blocks communication from a device,
as described in Incidents on page 85.

FortiEDR Core

The FortiEDR Core is the security policy enforcer and decision-maker. It determines whether a connection
establishment request is legitimate or represents a malicious exfiltration attempt that must therefore be
blocked.

FortiEDR collects OS stack data, thread and process-related data and conducts executable file analysis to
determine the nature of every connection request, as follows.

* When working in prevention mode, all the connection establishment requests in your organization must
be authorized by a FortiEDR Core, thus enabling it to block each outgoing connection establishment
request that is malicious.

« When the FortiEDR Core receives a connection establishment request, it comes enriched with metadata
collected by the FortiEDR Collector that describes the operating system activities that preceded it.

» The FortiEDR Core analyzes the flow of events that preceded the connection request and determines
whether the connection request was malicious. The system then enforces your organization’s policy by
blocking (or only logging) the connection request in order to prevent/log exfiltration.

* The collection of the flow of events that preceded the connection request enables FortiEDR to
determine where the foul occurred.

One or more FortiEDR Cores are required, according to the size of your network based on deployment size
(up to 50 FortiEDR Cores). Refer to Appendix C — ON PREMISE DEPLOYMENTS on page 459 for the exact

FortiEDR 7.2.0 Administration Guide
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specifications of the system requirements.) The following are the connections established between the
FortiEDR Core and other FortiEDR components:

» To the FortiEDR Aggregator: The FortiEDR Core sends registration information the first time it
connects to the FortiEDR Aggregator and then sends events and ongoing health and status information.

« From the FortiEDR Aggregator: The FortiEDR Core receives its configuration from the FortiEDR
Aggregator.

The FortiEDR Core is located on exit points from your organization. It only reviews FortiEDR Collector
metadata; it does not see the outgoing traffic. It is a central Linux-based software-only entity that can run
on any workstation or VM that is assigned with a static IP address.

FortiEDR Aggregator

The FortiEDR Aggregator is a software-only entity that acts as a proxy for the FortiEDR Central Manager and
provides processing load handling services. All FortiEDR Collectors and FortiEDR Cores interact with the
Aggregator for registration, configuration and monitoring purposes. The FortiEDR Aggregator aggregates
this information for the FortiEDR Central Manager and distributes the configurations defined in the FortiEDR
Central Manager (such as exceptions, policies, and rules) to the FortiEDR Collectors and FortiEDR Cores.
The configuration update latency is usually around 60-120 seconds but can take up to 20 minutes in edge
cases.

Most deployments only require a single FortiEDR Aggregator. Additional FortiEDR Aggregators may be
required for larger deployments of over 10,000 FortiEDR Collectors.

FortiEDR Central Manager

The FortiEDR Central Manager is a software-only central web user interface and backend server for viewing
and analyzing events and configuring the system. Chapters from Security Settings on page 196 to Threat
Hunting on page 125 describe the user interface of the FortiEDR Central Manager. The FortiEDR Central
Manager is the only component that has a user interface. It enables you to:

e Control and configure FortiEDR system behavior

¢ Monitor and handle FortiEDR events

» Perform deep forensic analysis of security issues

¢ Monitor system status and health

FortiEDR Cloud Service

The FortiEDR Cloud Service (FCS) enriches and enhances system security by performing deep, thorough
analysis and investigation about the classification of a security event. The FCS is a cloud-based, GDPR-
compliant, software-only service that determines the exact classification of security events and acts
accordingly based on that classification — all with a high degree of accuracy.

The FCS security event classification process is done via data enrichment and enhanced deep, thorough
analysis and investigation, enabled by automated and manual processes. The enhanced processes may

FortiEDR 7.2.0 Administration Guide 16
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include (partial list) intelligence services, file analysis (static and dynamic), sandboxing, flow analysis via
machine learning, commonalities analysis, crowdsourced data deduction and more.

Along with potential classification reassurance or reclassification, once connected, FCS can also enable
several followed actions, which can be divided into two main activities:

* Tuning: Automated security event exception (allowlisting). After a triggered security event is
reclassified as Safe, an automated cross-environment exception can be pushed downstream and expire
the event, preventing it from triggering again. For more details, see Exception Manager on page 207

» Playbook Actions: All Playbook policy remediation actions are based on the final determination of the
FCS. For more details see Remediation on page 251.

How does FortiEDR work?

1. The FortiEDR Collector collects OS metadata: A FortiEDR Collector runs on each communicating device
in the organization and transparently collects OS metadata on the computing device.

2. Communicating device makes a connection establishment request: When any connection
establishment request is made on a device, the FortiEDR Collector sends a snapshot of the OS
connection establishment to the FortiEDR Core, enriched with the collected OS metadata. Meanwhile,
FortiEDR does not allow the connection request to be established.

3. The FortiEDR Core identifies malicious requests: Using FortiEDR’s patented technology, the FortiEDR
Core analyzes the collected OS metadata and enforces the policies.

4. Pass or block: Only legitimate connections are allowed outbound communication. Malicious outbound
connection attempts are blocked.

5. Event Generation: Each FortiEDR policy violation generates a realtime security event (alert) that is
packaged with an abundance of device metadata describing the internals of the operating system
leading up to the malicious connection establishment request. This security event is triggered by the
FortiEDR Core and is viewable in the FortiEDR Central Manager console. FortiEDR can also send email
alerts and/or be integrated with any standard Security Information and Event Management (SIEM)
solution via Syslog.

6. Forensic analysis: The Forensic Analysis add-on enables the security team to use the various options
provided by the FortiEDR Central Manager console to delve deeply into the actual security event and
the internal stack data that led up toit.

Using FortiEDR - workflow

The following is a general guideline for the general workflow of using FortiEDR and specifies which steps
are optional.

Setup workflow overview
The following describes the workflow for getting FortiEDR up and running in your organization:

FortiEDR 7.2.0 Administration Guide
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Installing

Modifying the FortiEDR Policies

[Opticnal]

Defining Collector Groups
[Opticnal]

Administration
[Cptional]

1. Installing: Install all FortiEDR components, as described in Installing FortiEDR Collectors on page 23 and
Appendix C - ON PREMISE DEPLOYMENTS on page 459.

2. Reviewing the Inventory: Review the health status and details of all the FortiEDR components in the
Dashboard on page 75 and Assets on page 256. FortiEDR Collectors are automatically assigned
FortiEDR’s default policies.

3. [Optional] Modifying the FortiEDR Policies: By default, the FortiEDR policies are ready to log out-of-

the-box. If needed, use the Security Settings on page 196 to modify the default policies for blocking
and/or to create additional policies.

4. [Optional] Defining Collector Groups: By default, the FortiEDR default policies are assigned to a default
Collector Group that contains all FortiEDR Collectors. Policies in FortiEDR are assigned per Collector
Group. You can define additional Collector Groups in . You can then assign the required policy to each
Collector Group (see Assigning a security policy to a Collector Group on page 205)

5. [Optional] Administration: The FortiEDR system installs with a single administrator user. This user can:
» Create additional users of the FortiEDR Central Manager.
» Define the recipients to receive email notifications of FortiEDR events.
» Configure a SIEM to receive notifications of FortiEDR events via Syslog.

FortiEDR 7.2.0 Administration Guide 18
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Introducing FortiEDR

Ongoing workflow overview

The following is the workflow for monitoring and handling FortiEDR security events on an ongoing basis:

Monitoring and Analyzing

Creating Event Exceptions
[Optional]

Investigating Events
[Cpticnal]

Handling Events
[Cptional]

< Monitoring: Monitor and analyze the events triggered by FortiEDR in the following locations:
° Dashboard on page 75
° Incidents on page 85
° Syslog on page 310
« [Optional] Creating Event Exceptions: FortiEDR precisely pinpoints interesting system events.

However, if needed, you can create exceptions in order to stop certain events from being triggered for
certain IP addresses, applications, protocols and so on. See Playbook policies on page 244.

» [Optional] Investigating Events: Deep investigation into a security event, including meta data. With a
Threat Hunting on page 125 license add-on, you can also audit all operating system activities.

» [Optional] Handling Events: Mark security events that you have handled and optionally describe how
they were handled. See Marking a security event as handled/unhandled on page 115.
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Deploying FortiEDR Cloud

This topic explains how to deploy FortiEDR Cloud. This topic assumes that you already purchased the
desired subscription licenses for your deployment from a Fortinet partner or reseller and received your
license activation codes.

Ay
S L4
? You can create only one FortiEDR Cloud instance per FortiCloud account.

To deploy FortiEDR Cloud:

1. Register the FortiEDR Cloud subscription contract to your FortiCloud account:
a. Onthe Customer Service & Support site, go to Asset Management > Register Now.

b. In the Registration Code field, enter your license activation code and select Next to continue
registering the product.

c. Enter your details in the other fields and complete the registration.

Ay
‘Q' You may need to wait a few minutes for the cloud instance to initialize before

you can proceed.

2. Provision your FortiEDR Cloud environment:
a. InFortiCloud, go to Services > Cloud Services and click FortiEDR.

(=) FortiCloud % senvices © support + Q 4 -
ASSET M2 ASSETS & ACCOUNTS CLOUD MANAGEMENT CLOUD SERVICES
Asset Management FortiClient EMS Cloud FortiSASE FortiMail FortiMonitor rith
Dashboa
1AM FortiGate Cloud S0Caa$ FortiRecon FortiWeb Cloud
@ Products  Organizations FortiAnalyzer Cloud FartiAppSec Cloud FortiCanverter FortizTP
FortiManager Cloud FortiSandbox Cloud FortiCASB Managed FortiGate
& Marketpl
FortiEdge Cloud FortiToken Cloud FortiCNP FortiPhish
e Asset Trz ) i iVoi i
e FortiSOAR Cloud FortiGSLB FortiVoice FortiTrustiD
FortiSIEM Cloud Overlay as a Service FortiGate CNF FortiDAST
FortiDevSec FortiPresence FortiCamera Cloud
FortiCare Elite (Beta) FortiDemao Fortilnsight
Security Awareness (Beta) FortiDeceptor Daa$ Cloud FortiABP
FortiDevice FGaa$ FortiClient Services
CTAP (Beta) Lacework FortiCNAPP FortiDLP (Beta) o5 an 1AM
| FortiEDR s for new
e granular
Show Less ~
® No Coverage 0
L]
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b. Click PROVISION.
¢ FortiCloud S Services ~ @) Support +

Provisioning

Serial Number Expiration Date License Type XDR MDR Capacity Provision

FEDR 1 10:00:00 AM Predict-and-Protect 500

c. Select the time zone and cloud region to provision your FortiEDR Cloud instance.

Provisioning

Please provide your product region preferences.

— Tirme zane

America/Los_Angeles X -
~ Cloud regicn

Los Angeles, California, North America X -

CANCEL PROVISION

d. Click PROVISION to start the provisioning process, which takes about 5 minutes for a new
organization in a shared environment and 40 minutes for a dedicated environment.

Provisioning in progress
This might take a few minutes
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3. After the provisioning process is complete and the environment is ready, click Agree to access the
FortiEDR Central Manager console.

(& FortiCloud 2 Senvices @) Support ~ -

DASBOARD  EENTVEWSR  THREATHUNTNG  COMMUNCATIONCONTROL v WENTORY v AOMNISTRATON C® smustion v ) englsn

SECURITY EVENTS Product License Agreement / EULA and Warranty Terms FeioRs

Product License Agreement | o
The parties o this agreement are you (the end-customer) and Fortinel, Inc. (*Fortinet").
CAREFULLY READ THE FOLLOWING LEGAL AGREEMENT (THE OR THIS "AGREEMENT" OR
“EULA"). USE OR INSTALLATION OF FORTINET PRODUCT(S) AND ANY UPDATES THERETO,
INCLUDING HARDWARE APPLIANCE PRODUCTS, SOFTWARE AND FIRMWARE INCLUDED
THEREIN BY FORTINET, AND STAND-ALONE SOFTWARE PRODUCTS SOLD BY FORTINET
(TOGETHER, THE "PRODUCTS") CONSTITUTES ACCEPTANCE BY YOU OF THE TERMS IN
THIS AGREEMENT, AS AMENDED OR UPDATED FROM TIME TO TIME IN FORTINET'S
DISCRETION BY FORTINET PUBLISHING AN AMENDED OR UPDATED VERSION. FORTINET
SHALL NOT BE BOUND BY ANY ADDITIONAL AND/OR CONFLICTING PROVISIONS IN ANY
ORDER, RELEASE, ACCEPTANCE OR OTHER WRITTEN CORRESPONDENCE OR OTHER
WRITTEN OR VERBAL COMMUNICATION UNLESS EXPRESSLY AGREED TO IN A WRITING
SIGNED BY THE GENERAL COUNSEL OF FORTINET. IF YOU DO NOT AGREE TO ALL OF
THE TERMS OF THIS AGREEMENT, DO NOT START THE INSTALLATION PROCESS OR USE
THE PRODUGTS.IF YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, YOU
SHOULD IMMEDIATELY, AND IN NO EVENT LATER THAN FIVE (5) CALENDAR DAYS
AFTER YOUR RECEIPT OF THE PRODUCT, IMMEDIATELY NOTIFY FORTINET
MOST TARGETEL taliei e incen Wy sare LEGALLEGAL@FORTINET.COMOF REQUESTED EULA CHANGES.
2 ) 1. License Grant.
This is a license agreement between you and Fortinet, not a sales agreement. The term
"Software", as used throughout this Agreement, includes all Fortinet and third party firmware and
software provided to you with, or incorporated into, Fortinet appliances and any stand-alone
software provided to you by Fortinet, with the exception of any open source software contained in
Fortinet's Products which is discussed in detail in section 15 below, and the term “Software™

ud ion, any updates and of the software or
firmware provided to you by Fortinet, at its option.Fortinet grants to you a non-transferable (except
as provided in section 5 ("Transfer") and section 15 ("Open Source Software”) below), non-

* By cheking “Agres™ and agreed o cur EULA and Warranty Torms

(" Downioad
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Deploying FortiEDR Collectors

This chapter describes how to deploy FortiEDR Collectors, which is the only component you need to install
for FortiEDR cloud deployment. All backend components, including FortiEDR Central Manager, Aggregator,
Threat Hunting Repository, and Core, are installed and managed in the cloud by Fortinet.

¢ Installing FortiEDR Collectors on page 23
» Uninstalling FortiEDR Collectors on page 70
e Upgrading the Collector on page 73

If you want to deploy any of the backend components on your organization’s premises (on-premises), see
Appendix C - ON PREMISE DEPLOYMENTS on page 459.

Installing FortiEDR Collectors

You can install the FortiEDR Collector on any communicating device that meets the requirements in
Collector System Requirements. Your license determines the number of FortiEDR Collectors allowed to
register with the FortiEDR Central Manager. When you reach the maximum number of Collectors, you must
uninstall a FortiEDR Collector from a device and delete it from the FortiEDR INVENTORY before you can add
another FortiEDR Collector.

NP You can get a Collector that is customized to your environment’s settings, as
‘Q' described in Requesting and obtaining a Collector installer on page 409. If a custom
- Collector is used during the installation, all input fields such as Aggregator address

and registration password are auto-filled.

 Installing a FortiEDR Collector on Windows on page 23

* Installing a FortiEDR Collector on macOS on page 28

¢ Installing a FortiEDR Collector on Linux on page 53

» Automated FortiEDR Collector deployment on page 55

* Installing FortiEDR on MacOS devices using Jamf PRO on page 58
» Working with FortiEDR on VDI environments on page 69

For more details about installing a Collector in a multi-organization environment, see Collector registration
on page 416.

Installing a FortiEDR Collector on Windows

1. Itis recommended to get a pre-populated customized Collector installer for Windows, as described in
Requesting and obtaining a Collector installer on page 409.
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2. Run the FortiEDR Collector installation file. Use the FortiEDRCollectorInstaller32.msi file if you are

using a 32-bit operating system; or use the FortiEDRCollectorInstaller64.msi file if you are using a
64-bit operating system.

3. ﬁ Fortinet Endpoint Detection and Response Platform S X
Welcome to the Fortinet Endpoint Detection and [P
Response Platform Setup Wizard o

The installer will guide you through the steps required to install Fortinet Endpoint
Detection and Response Platform on your computer.

WARNIMNG: This computer program is protected by copyright law and international
treaties. Unauthorized duplication or distribution of this program, or any portion of it,
may result in severe civil and criminal penalties, and will be prosecuted to the
maximum extent possible under the law.

Cancel < Back Mext =

Click Next.
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4. ﬂ Fortinet Endpoint Detection and Response Platform - X

Select Installation Folder l

The installer willinstall Fortinet Endpoint Detection and Response Platform to the
following folder.

To install in this folder, click "Mext”. To install to a different folder, enter it below or click...

Folder:
|C:1F'n:|gram Files\FortinetFortiEDRA Browse...
Disk Cost..
Cancel < Back Mext =

Leave the default FortiEDR Collector installation folder or change it as necessary. Click Next.
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10.

1.

12.

ﬁ Fortinet Endpeint Detection and Response Platform — >
Collector Configuration el
|
Aggregator Address: .console.ensilo.com Port: |3081

Fegistration Password: | T

Organization: |

Advanced:
[ ] VDI {Vitual Desktop Infrastructure) installation [ Citrix PVS Inetallation

[] Use System Proxy Settings

If a non-customized installer is used, in the Aggregator Address field, specify the FortiEDR Aggregator
domain name or IP address.

If a non-customized installer is used, in the Port field, specify the FortiEDR Aggregator port (8081).

vy
‘?' When upgrading a FortiEDR Collector, the Aggregator address field can be left

empty —in order to retain the previously defined Aggregator address.

If a non-customized installer is used, in the Registration Password field, enter the device registration
password that you defined, as described in Configuring the FortiEDR Central Manager server and
console on page 474.

For a multi-organization FortiEDR system, enter the name of the organization in the Organization field.
For more details, see the Collector registration on page 416.

If you are installing the Collector on a VDI environment, check the VDI checkbox. For more details, see
Working with FortiEDR on VDI environments on page 69.

If you use a web proxy to filter requests in this device’s network, then check the Use System Proxy
Settings checkbox. Note that Windows must be configured to use a proxy and tunneling must be
allowed from the Collector to the Aggregator on port 8081 and from the Collector to the Core on port
555. (Run as Administrator: netsh winhttp set proxy <proxy IP >).

If you are installing the Collector on a Citrix PVS golden image, check the Citrix PVS installation
checkbox.

Click Next twice to start the installation. Windows may possibly display a message requesting that you
confirm the installation. Please do so.
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13. After the installation of the FortiEDR Collector has been successfully completed, the following window

displays:
ﬁ Fortinet Endpoint Detection and Response Platform = X
Installation Complete [P

Fortinet Endpoint Detection and Response Platform has been successfully installed.

Click "Close” to exit.

Please use Windows Update to check for any critical updates to the NET Framework.

Cancel =< Back Close

Check Windows Services to verify that the FortiEDR Collector Service is running, as shown below:
- X

‘4% Services

File Action View Help
o | mECc HE »anw

=, Services (Local)

Name Description Status Startup Type Log On As

'-';-.: FortiEDR Collector Service  Host component of the Fortinet Endpoint Detection and Response Platform Running
.‘;‘ Function Discovery Provid... The FDPHOST service hosts the Function Discovery (FD) network discovery p... Manual

14. Verify that the FortiEDR Collector details are listed in the INVENTORY tab of the FortiEDR Central
Manager console (see Assets on page 256. Select the New filter to display a list of newly registered
FortiEDR Collectors, as shown below:

COLLECTORS (2/47)

St Croate Group 82 MovetsGroup i Delete v (W EnableDisable v [@lisolate v [4 Export ¥ X, Uninstal

DEVICE NAME LAST LOGGED os [

Automatic Local System

Local Service

A\ 184 Unmanaged devices were found

COLLECTOR GROUP NAME MAC ADDRESS VERSION STATE LAST SEEN

emulation

an
¢ ce-2-Test1 \emu1  windows 10 10.51.121.18 ( -AD 41.024 ® Disconnected Yesterday

liort
119

15. If another AV product is also installed on the machine, exclude AV exceptions by following the
instructions in Exclusion paths.
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Installing a FortiEDR Collector on macOS

The process described below includes a description of how to allow the following upon first FortiEDR
Collector installation:

» System Extensions

¢ Network Extensions

e Full Disk Access

IMPORTANT: Failure to add these permissions will result in incomplete protection.

Deployment can also be managed using an MDM, such as Jamf.

To install a FortiEDR Collector on macOS that is running with Big Sur (version 11) or
later:

To start the installation:

1. Itis recommended to get a pre-populated customized Collector installer for macOS, as described in
Requesting and obtaining a Collector installer on page 409.

2. Double-click the *.dmg file named FortiEDRCollectorInstallerOSX_<version>.dmg.

3. Click Continue.

] « Install FortiEDR Endpoint Detection and Response 8

Welcome to the FortiEDR Endpoint Detection and Response Installer

You will be guided through the steps necessary to install this

® Introduction
software.

Continue J
[
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4. Click Install.

[ ] « Install FortiEDR Endpoint Detection and Response 8

Standard Install on "Macintosh HD"

Introduction This will take 19.3 MB of space on your computer.

Destination Select Click Install to perform a standard installation of this software
on the disk “Macintosh HD"

#® |Installation Type

Go Back Install |

5. Enter the Mac password at the prompt and click Install Software.
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w# Install FortiEDR Endpoint Detection and Response &
|
- Installer is trying to install new software.
Introduc I ' a Enter your password to allow this.
3
Destinat - ftware
Llser Name:
® |Installa
llat Password: |
nar
Cancel Install Software
. .

Go Back Install J

6. If anon-customized installer is used, in the Collector Conifguration page, specify the Aggregator's
address and FortiEDR registration password. Optionally, you can select a destination Organization and
Collector Group and/or installation using a system proxy.
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b

@ O @ Fortinet Endpoint Detection and Response Collector Config

. Collector Configuration u
Dest

Aggregator Address: (example: 192.168.0.1)
Insta

o 3 | | Port: 8081

1l . .
I Registration Password:

Organization:

Group:

Advanced:

Use System Proxy Settings

Cancel

7. Click Apply to start the installation process.
8. Continue the installation:

¢ macOS 15 or later

e macOS13o0r14

e macOS 11 or12
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To continue the installation on macOS 15 or later:
1. In the popup window, click OK to allow the installer to access files:

Lo

Installing FortiEDR Endpoint Detection and Response

Introduction
Destination Select
Installation Type

® Installation Valid

“Installer” would like to access
files in your Desktop folder.

Don't Allow OK

L
2. Enable Network and System Extensions:
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- " === - - = v . Y
w1 ) Esponse & |\
tes
Response
ecents
pplications Introduction
o System Extension Blocked
esktop Destination Select A
R The program "FortiEDRControl” tried to
ocuments Installation Type load new system extension(s). If you
# Installation want to enable these extensions, open
ownloads Security & Privacy System Preferences.
_—
ons
pared.
etwork | | Open Security Preferences
FortiEDRControl .

Installing Network Extension

-ﬁ.lll

2 Installing EndPoint Extension

Getting File System permissions
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a. Open General > Login Items & Extensions and scroll down to Extensions.
" NON ] > General

Q Search Manage your overall setup and preferences for Mac, such as software

updates, device language, AirDrop, and more.
Sign in
9 with your
Apple Account

& wi-Fi

About

€3 sivetooth (£ software Update
Network B storage

| ¥ Energy Saver

" foristare sty

Accessibility
@ Appearance
) Control Center
Desktop & Dock

@ Displays

=) Screen Saver

B siri |

o)

AirDrop & Handoff

AutoFill & Passwords

(Q

Date & Time

@8

Language & Region

(.1 Wallpaper E Login Items & Extensions
a Notifications Li4 Sharing

Sound

Focus

Screen Time

Startup Disk

Time Machine

® [

g Lock Screen

&

Device Management
m Privacy & Security
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ec e

Q, Search

Sign in
9 with your
Apple Account
Wi-Fi
Bluetooth
Network

|/ Energy Saver

{#¥ General
Accessibility
@ Appearance
a Control Center
Desktop & Dock
u Displays

|| Screen Saver
@ siri

(i) Wallpaper

B Notifications

Sound
Focus

Screen Time

n Lock Screen

m Privacy & Security

< > Login Items & Extensions

JAMF Software [ @)

& This setting has been configured by a profile.

Parallels International GmbH [ @)

2 items: 1 item affects all users

o) Steam )
® 1item
Extensions

Extensions add extra functionality to your Mac and apps. Some extensions may run
in the background.

@ Actions @
Markup

Endpoint Security Extensions
FortiEDREndpointSecurity

Finder
Rotate Left, Markup, Trim, Create PDF, Convert Image, Remove BacK\,..

@ 0O

Network Extensions
FortiEDRNetworkFilter

O

Photos Editing
Markup

(@)

Quick Look
TipsQuicklook, ProvisoningProfileQuicklookExtension

® 6 6 6 6

Sharing
Add to Photos, Add to Reading List, AirDrop, Copy Link, Freeform, M...

e

b. Click Endpoint Security Extension and toggle on FortiEDRControl.
The Mac password is required for this change.
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Endpoint Security Extensions

B Endpoint security extensions can help detect malicious activity.
These extensions run in the background and can monitor system
events on your Mac.

FortiEDRControl
FortiEDREndpointSecurity D ©

c. Click Done.
d. Click Network Extension and toggle on FortiEDRControl.
The Mac password is required for this change.
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Network Extensions

Network extensions extend core networking features on your Mac.
These extensions run in the background and can monitor the
network traffic on your Mac.

FortiEDRControl
FortiEDRMNetworkFilter D @

e. Click Done.
3. Enable Full Disk Access:
a. Open Full Disk Access on Privacy & Security.

b. Toggle on the two FortiEDR-related options to authorize full disk access for FortiEDR, as shown
below:
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en e < Full Disk Access

Q, Search Allow the applications below to access data like Mail, Messages, Safari,
Home, Time Machine backups, and certain administrative settings for all

a Spotlight users on this Mac.

(i Wallpaper

com.microsoft.autoupdate

I3 Notifications )
m Sound
Focus

FortiEDR

FortiEDREndpointSecurity

Screen Time

¢ O

n Lock Screen

W Privacy & Security

it Touch ID & Password
E Users & Groups

(&) internet Accounts
% Game Center

& iCloud

© wallet & Apple Pay

+

(&) Keyboard
) Trackpad
G Printers & Scanners

4. See To finish the installation.
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To continue the installation on macOS 13 or 14:
1. In the popup window, click OK to allow the installer to access files:

Lo

Installing FortiEDR Endpoint Detection and Response

Introduction
Destination Select
Installation Type

® Installation Valid

“Installer” would like to access
files in your Desktop folder.

Don't Allow OK

L
2. Enable Network and System Extensions:
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- " === - - = v . Y
w1 ) Esponse & |\
tes
Response
ecents
pplications Introduction
o System Extension Blocked
esktop Destination Select A
R The program "FortiEDRControl” tried to
ocuments Installation Type load new system extension(s). If you
# Installation want to enable these extensions, open
ownloads Security & Privacy System Preferences.
_—
ons
pared.
etwork | | Open Security Preferences
FortiEDRControl .

Installing Network Extension

-ﬁ.lll

2 Installing EndPoint Extension

Getting File System permissions
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a. Open Privacy & Security and scroll down to the Security section:

_—

o0 e Privacy & Security
Q, Search
g Analytics & Improvements
Sign in
with your Apple ID m Apple Advertising

Software Update Avail... €)

Wi-Fi

Security

Allow apps downloaded from

£ Bluetooth
App Store
(i) Network © App Store and identified developers

g Notifications

) sound

Some system software requires your attention before it can be used.

Details...
Focus
i E Screen Time
FileVault Turn On...
FileVault secures the data on your disk by encrypting its
@ General content automatically.

@ Appearance
WARNING: You will nead your login password or a recovery key to access your

g Mcessibility data. A recovery key is automatically generated as part of this setup. If you
— forget both your password and recovery key, the data will be lost.

I a Control Center FileVault is turned off for the disk "Macintosh HD",
B siri & spotiight

@ Privacy & Security m Lockdown MOC_'B _ _ Turn On...
Lockdown Mode is an extreme, optional protection that

should only be used if you believe you may be personally

a Desktop & Dock targeted by a highly sophisticated cyberattack. Most
eople are never targeted by attacks of this nature.

b. Under Some system software requires your attention before it can be used, Click Details.
c. Enter the Mac password at the prompt.

d. Toggle on both toggles in order to allow FortiEDR to use Network and System Extensions and click
OK.
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System software from the following developers was updated and
the system needs to be restarted before it can be used.

' FortiEDRControl

' FortiEDRControl

cancel (TR

3. Enable Full Disk Access:
a. Open Full Disk Access on Security Preferences.

b. Toggle on the two FortiEDR-related options to authorize full disk access for FortiEDR, as shown
below:
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* Collector earlier than 6.0:

-

o0 e
Q, Search

Sign in
with your Apple ID

Software Update Avail... €)

Wi-Fi
Bluetooth

%) Network

a Notifications

€D sound
Focus

B Screen Time

@ General

@ Appearance
Accessibility

a Control Center
B siri & Spotiight
() privacy & security

a Desktop & Dock

< Full Disk Access

Allow the apps below to access data like Mail, Messages, Safari, Home,
Time Machine backups, and certain administrative settings for all users
on this Mac.

FortiEDR_EndPoint

B FortiEDRCollector

818 6

- sshd-keygen-wrapper

. Terminal

+

* Collector 6.0 or later:
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Full Disk Access

Allow the applications below to access data like Mail, Messages, Safari,
Home, Time Machine backups, and certain administrative settings for all
Sign in users on this Mac.
with your Apple ID
Q¢ FortiEDR
Wi-Fi

. FortiEDREndpointSecurity

Bluetooth

Network =] sshd-keygen-wrapper

Notifications > Terminal
Sound +
Focus

® screen Time

General

©® Appearance
—Ck)_ Accessibility
Control Center
#* Siri & Spotlight

W Privacy & Security

= Desktop & Dock

4. See To finish the installation.

To continue the installation on macOS 11 or 12:

1. In the popup window, click Later:

———

“Installer” will not have full disk

access until it is quit.

You can choose to quit "Installer” now,

or do it on your own later.

Later Quit & Reopen
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2. Enable Network and System Extensions:

ecents

pplications

esktop

ocuments

ownloads

hared...

etwork

Ale

i

Introduction
Destination Select

Installation Type

# Installation

-

w 1

System Extension Blocked

The program "FortiEDRControl” tried to
load new system extension(s). If you
want to enable these extensions, open
Security & Privacy System Preferences.

Open Security Preferences

Response

Installing MNetwork Extension

Installing EndPoint Extension

Getting File System permissions

2 0 T o

Open Security Preferences.

Click the lock at the bottom of the window in order to make changes.
In the General tab, click Details.

Mark both checkboxes to allow FortiEDR to use Network and System Extensions. Click OK.
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System software from the following developers was updated and the
system needs to be restarted before it can be used.

+~ FortiEDRControl

FortiEDRControl

Cancel

A |
3. Enable Full Disk Access:

a. Open Security Preferences.

b. Click the lock at the bottom of the window in order to make changes.

c. Inthe Privacy tab, select Full Disk Access from the left pane.

d. Select the checkboxes of both the FortiEDRCollector and the FortiEDR_EndPoint applications:

. < it Security & Privacy q

General  Fllevault  Frewal | Privecy

B —

Ful Dk Access

4. See To finish the installation.
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To finish the installation:

1. Click Allow.
r

A login password hi rd

“FortiEDRControl” Would Like to -

v Require past Filter Network Content 'en saver begins

Show a mes All netwaork activity on this Mac may be
filtered or monitored.

Allow Don't Allow

Me
+ Disable aute

Allow apps downloaded from:

App Store
® App Store and identified developers

[ 2
E * Click the lock to prevent further changes. Advanced...
k
2. Click OK.
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0@ < i Q _
@ @ @ @ | Esponse & l
ites F |
Response
‘ecents b
pplications Introduction Full Disk Access for FortiEDR
lesktop Destination Select e e
locuments T T Please enable Full Disk Access for
#® |Installation FortiEDR EndPoint extension and
townloads _ FortiEDR Application
Summary
e Failure to add relevant permissions will -
result in incomplete protection.
hared...
Open Settings -> Security & Privacy ->
letwork Privacy -> Full Disk Access.
FortiEDRControl Manually add [Applications/FortiEDR
D | and check FortiEDR_EndPoint.
Please consult installation guidelines if

@ Installing Metwork Extens

@ Installing EndPoint Extens

@ Getting File System permissions
L [

3. Click Close to complete the process.
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: & O % Install FortiEDR Endpoint Detection and Response &
The installation was completed successfully.

Introduction

Destination Select

Installation Type

Installation

® Summa H H
B The installation was successful.
The software was installed.

[ A

4. When prompted to allow FORTIEDRTRAY notifications, click Allow.

Q & Wed16Feb 17:51

"FORTIEDRTRAY" NOTIFICATIONS

Notifications may include alerts, sounds -
badges.

Allow
Don't Allow

—

5. Reboot the device.
6. Run the following command to check the status of the Collector:
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¢ Collector 6.0 or later:

/Applications/FortiEDR.app/Contents/Library/LaunchServices/fortiedr_collector.sh status

» Collector earlier than 6.0:

/Applications/FortiEDR.app/fortiedr_collector.sh status

7. If another AV product is also installed on the machine, exclude AV exceptions by following the
instructions in Setting up exclusions with other AV products on page 69.

To install a FortiEDR Collector on macOS with versions prior to Big Sur (11), such as
Catalina or Mojave:

1. Itis recommended to get a pre-populated customized Collector installer for macOS, as described in
Requesting and obtaining a Collector installer on page 409.

2. Double-click the *.dmg file named FortiEDRCollectorInstallerOSX_1.3.0.xxx.dmg.
3. Double-click the *.pkg file named FortiEDRCollectorInstaller0OSX_1.3.0.xxx.pkg.

«

FortiEDRInstallerOSX_3.1.5.2
4.pkg

4. Click Continue.

FortiEDR 7.2.0 Administration Guide
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Y Install FortiEDR Endpoint Detection and Res

Welcome to the FortiEDR Endpoint Detection and Response Installer

You will be guided through the steps necessary to install this

Introduction
software.

Continue

5. Select the destination disk and click Continue.
6. Specify the installation location and click Install.

Y& Install FortiEDR Endpoint Detection and Response

Standard Install on “Mac"

T This will take 21.8 MB of space on your computer.
Destination Select Click Install to perform a standard installation of this software

Installation Type on the disk SMac.

Go Back Install

7. If anon-customized installer is used, in the Aggregator Address field, enter the IP address of the
Aggregator in the first box and the port of the Aggregator in the adjacent (Port) box.

FortiEDR 7.2.0 Administration Guide
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10.

1.
12.

[ [ ] @ Fortinet Endpoint Detection and Response Collector Config
Collector Configuration
¢
Aggregator Address: (example: 192.168.0.1)
\ Port: 8081
Registration Password:
Organization:
Group:
Advanced:
Use System Proxy Settings
cancel | (EETI

If a non-customized installer is used, in the Registration Password field, enter the registration password
as described in Configuring the FortiEDR Central Manager server and console on page 474.

Leave the Organization field empty or for a multi-tenant setup, insert the organization to which this
Collector belongs (as it appears under the ADMINISTRATION > ORGANIZATIONS tab of the FortiEDR
Central Manager).

If you use a web proxy to filter requests in this device’s network, then check the Use System Proxy
Settings checkbox. Note that the MacOS must be configured to use a proxy and that the proxy must
support HTTPS before installing the Collector (System Preferences > Network > Advanced > Proxies).
Click Apply.

Click Close.

(e Install FortiEDR Endpoint Detection and Response

The installation was completed successfully.

Introduction
Destination Select
Installation Type
Installation

Summary

The installation was successful.

The software was installed.
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13. If another AV product is also installed on the machine, exclude AV exceptions by following the
instructions in Setting up exclusions with other AV products on page 69.

Installing a FortiEDR Collector on Linux

vy
‘?' The FortiEDR Collector installation requires some dependencies. Ensure the Linux

endpoint has network connection to the respective upstream package managers.

To install a customized FortiEDR Collector on Linux:

1. Itis recommended to get a pre-populated customized Collector installer for Linux, as described in
Requesting and obtaining a Collector installer on page 409.

2. Copy the custom Linux Collector installer zip file, FortiEDRSilentInstall 5.1.0.195 envname_
Tenant.zip to the device. This file was downloaded from the provided link as described in Requesting
and obtaining a Collector installer on page 4009.

3. Unzip using the following command:

sudo unzip ./FortiEDRSilentInstall_5.1.0.195_envname_Tenant.zip

If you don’t have zip software on the device, install it using:

yum install zip

4. Extract the installer using the following command:

sudo gunzip ./FortiEDRSilentInstall _5.1.0.195_envname_Tenant.sh.gz

5. Change the installation script permission with the following command:

chmod 755 FortiEDRSilentInstall_5.1.0.195_envname_Tenant.sh

6. Run the following to execute the installation script:

sudo ./FortiEDRSilentInstall_5.1.0.195_envname_Tenant.sh

7. If another AV product is also installed on the machine, exclude AV exceptions by following the
instructions in Exclusion paths.

FortiEDR 7.2.0 Administration Guide
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To install a non-customized FortiEDR Collector on Linux:

1. Run the FortiEDR Collector installation file for 64-bit servers using the following command:

» CentOS/RHEL/Oracle/AMI:
sudo yum install ./FortiEDRCollectorInstaller_%Linux_distribution%-%version_
number%.x86_64.rpm

For example, sudo yum install ./FortiEDRCollectorInstaller_Cent0S6-3.1.0-74.x86_64.rpm.
* Ubuntu:

sudo apt-get install ./FortiEDRCollectorInstaller_Ubuntu-%version_number?%.deb

For example, sudo apt-get install ./FortiEDRCollectorInstaller_Ubuntu-3.1.0-74.deb.
e SUSE Linux:

rpm --import RPM-GPG-KEY.key

The FortiEDR PGP key is included in the download link of the pre-populated installer, see the
Requesting and obtaining a Collector installer on page 409.

zypper install FortiEDRCollectorInstaller_%distribution% -%version_number?%.rpm
For example: zypper install FortiEDRCollectorInstaller_openSUSE15-4.5.0-88.x86_64.rpm
2. After the installation is completed, run the following:

sudo /opt/FortiEDRCollector/scripts/fortiedrconfig.sh

3. Specify the domain name/IP address and port (8081) of the Aggregator that the Collector registers
with.

Collector with the same Aggregator that the Collector runs on. Register the

s‘é’, If you are installing the Linux Collector on an Aggregator, you cannot register the
- Collector with another Aggregator instead.

4. For a multi-tenant setup, enter the organization. Otherwise, leave the organization empty.
Enter Collector Group information or leave empty to be registered to the default Collector Group.

6. Enter the device registration password, described in Configuring the FortiEDR Central Manager server
and console on page 474.

a

7. Atthe Do you want to connect via proxy (Y/N)? prompt, type Y if your setup includes a web proxy.

8. If you are installing the Linux Collector build 5.1.5.1062 or later on a machine with secure boot enabled,
at the One or more modules are not signed. Would you like to sign them now? prompt, type Y to sign the
unsigned kernel modules or N to leave them unsigned.

9. If your software distribution system does not allow the addition of specific parameters to the command,
you can use the custom FortiEDR Collector installer, which can be accessed via the Central Manager
Console using the required DNS or IP address and password that is already embedded inside. For more
details, see Requesting and obtaining a Collector installer on page 409.

10. If another AV product is also installed on the machine, exclude AV exceptions by following the
instructions in Exclusion paths.

FortiEDR 7.2.0 Administration Guide
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Automated FortiEDR Collector deployment

Automated FortiEDR Collector deployment on Windows
FortiEDR can be installed automatically via any software installation and distribution system.

To deploy a custom FortiEDR Windows Collector via a command line:

1. Get apre-populated customized Collector installer for Windows, as described in Requesting and
obtaining a Collector installer on page 4009.

2. Use the following command syntax:

msiexec /i FortiEDRCollectorInstaller64.msi

3. If another AV product is also installed on the machine, exclude AV exceptions by following the
instructions in Setting up exclusions with other AV products on page 69.

To deploy a non-customized FortiEDR Windows Collector via a command line:

1. Use the following command syntax:

msiexec /i FortiEDRCollectorInstaller64.msi /qn AGG=10.0.0.1:8081 PWD=1234

For example, to install a FortiEDR Collector on a 64-bit machine, connect it to a FortiEDR Aggregator on
IP address 10.0.0.1 and use the device registration password 1234, enter the following command:

msiexec /i FortiEDRCollectorInstaller64.msi /qn AGG=10.0.0.1:8081 PWD=1234

You can specify which organization or Collector group to assign this Collector to by adding the ORG or
DEFGROUP parameter. These parameters are optional. Values with spaces must be wrapped in double
quotation marks.

For example, to install a FortiEDR Collector with the same configurations as above and assign it to the
default organization and default Collector group, enter the following command:

msiexec /i FortiEDRCollectorInstaller64.msi /qn ORG="Default Organization" AGG=10.0.0.1:8081
PWD=1234 DEFGROUP="Default Collector Group"

Ay
S L4
q The name of the Collector MSI file may be different.
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For Collectors version 3.0.0 and above, you can set a designated group and/or organization. To do so,
enter the following command:

./CustomerBootstrapGenerator --aggregator [IP] --password '[PASSWORD]' --organization
[ORGANIZATION]' --group '[GROUP]' > CustomerBootstrap.js

2. Using web proxy can be configured for Collectors version 3.0.0 and above. To do so, append the
parameter PROXY =1 to the command syntax shown above.

3. Ingeneral, a FortiEDR Collector does not require the device on which it is installed to reboot after its
installation. However, in some cases, you may want to couple the installation of the FortiEDR Collector
with a reboot of the device. To do so, append the parameter NEEDREBOOT=1 to the command syntax
shown above.

Collectors that are installed with this flag appear in the FortiEDR Central Manager as Pending Reboot
(page 87) and will not start operating until the after the device is rebooted.

NP In general, rebooting the device after installing a FortiEDR Collector is good
S L4 . . .
q practice, but is not mandatory. Rebooting may prevent a threat actor from
- attempting to exfiltrate data on a previously existing connection that was

established before installation of the FortiEDR Collector.

4. When installing on a Citrix PVS golden image, append the parameter CITRIXPVS=1 to the command
syntax shown above.

5. If your software distribution system does not allow the addition of specific parameters to the command,
you can use the custom FortiEDR Collector installer, which can be accessed via the Central Manager
Console using the required DNS or IP address and password that is already embedded inside. For more
details see Requesting and obtaining a Collector installer on page 409.

6. If another AV product is also installed on the machine, exclude AV exceptions by following the
instructions in Setting up exclusions with other AV products on page 69.

Automated FortiEDR Collector deployment on Mac

To deploy a custom FortiEDR macOS Collector via a command line:

1. Get a pre-populated customized Collector installer for macOS as described in Requesting and obtaining
a Collector installer on page 409.

2. Run the following command in order to install using the specified settings:

sudo installer -pkg <package path> -target /

For example, if the package file is FortiEDRInstallerOSX_2.5.2.38.pkg, use the following command:

sudo installer -pkg ./FortiEDRInstallerOSX_2.5.2.38.pkg -target /
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To deploy a nhon-customized FortiEDR macOS Collector via a command line:

Run the following command line to generate the settings file:

./CustomBootstrapGenerator --aggregator [IP] --password [PASSWORD] > CustomerBootstrap.jsn

If the Aggregator port is different than 8081 (which is set by default), you can add the following:

./CustomBootstrapGenerator --aggregator [IP] --password [PASSWORD] --port 8083 >
CustomerBootstrap.jsn

The following are optional parameters that can be used with the custom installer generator:

« If the Collector should be part of a designated Collector Group, use --group ‘[GROUP]".
e For a multi-tenant setup, the organization to which this device belongs to can be added using

--organization ‘[ORGANIZATION]’

« If a web proxy is being used to filter requests in this device’s network, use

--useProxy '1°'

The following is an example that includes all optional parameters:

./CustomBootstrapGenerator --aggregator [IP] --password [PASSWORD] --useProxy 'l' --organization
‘[ORGANIZATION]’ --group ‘[GROUP]’ > CustomerBootstrap.jsn

If another AV product is also installed on the machine, exclude AV exceptions by following the instructions
in Setting up exclusions with other AV products on page 69.

Automated FortiEDR macOS Collector deployment on Big Sur operating system
devices with MDM

When distributed with MDM solutions such as Jamf, FortiEDR can be allowlisted with the following Team ID
and Bundle ID identifiers:

e A97R6J3L29 com.ensilo.ftnt
» A97R6J3L29 com.ensilo.ftnt.sysext

FortiEDR 7.2.0 Administration Guide
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Installing FortiEDR on MacOS devices using Jamf PRO

To install FortiEDR using Jamf PRO:

1. In Jamf PRO, navigate to Computers > Configuration Profiles > New.
2. Create a configuration profile as shown in the following screenshots:
e Collector version 6.0 and later:
i. Go to Computer > Configuration Profiles.
ii. In the General tab, click Edit.

4 Pro
2 Computers :  Configuration Profiles
L 2 Computers . :
< FortiEDR - Fortinet, Inc
a
b ventory ons
g Searchinventory Q
General
Search Volume Content
@ @ General Name
Licensed Software Display name of the profile
FortiEDR - Fortinet, Inc
Content Management ®
e Description
Brie explanation of the content or purpose of the profile

Configuration Profiles.

Software Updates

Restricted Software

Mac Apps o
Patch Management

eBooks

.3

Groups

Smart Computer
Groups

[

Static Computer Groups

®

Classes

e
e

ACME Certificate
ot configured This i the official FortiEDR MDM profile for FortEDR versions 6.01 and above
AD Certificate
Not configured

Category
AitPlay Category to add the profe to
Not configured

None

App-To-Per-App VPN

Level
Mapping t which to apy .
Not configured Level at which 1o apply the profile

Computer Level
Application & Custom
Settings v
Not configured

Install Automatically -

Approved Kernel
Extensions
Not configured

Associated Domains.

iii. Configure the relevant settings, then click Save.

iv. In the Content Filter tab, click Edit, and configure the relevant settings.

Specify the values for the following fields:

Filter Name
Identifier

Organization

FortiEDRNetworkFilter
com.fortinet.fortiedr.macos.SysExt

Fortinet Inc.
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!‘ Pro

# g Computers

a
] Inventory
oo Search Inventory
&
Search Volume Content
@

Licensed Software

Content Management
Policies

Configuration Profiles.
Software Updates
Restricted Software
Mac Apps

Patch Management

eBooks
Groups

Smart Computer
Groups

Static Computer Groups

Classes

Enroliment

!‘ Pro

& 2 Computers

p=}

[} Inventory

" Search Inventory
&

Search Volume Content

Licensed Software

Content Management
Policies

Configuration Profiles
Software Updates
Restricted Software
Mac Apps

Patch Management

eBooks

Groups

Smart Computer
Groups

Static Computer Groups

Classes

Enroliment

e

Computers :  Configuration Profiles

< FortiEDR - Fortinet, Inc

Computers :  Configuration Profiles

Content Filter

Settings configured: 6
Setting

Filter Name
Display name of the filter in the app and on the device

FortiEDRNetworkFiler
Required

Identifier

Identifier for the filter plug-in
comfortinet fortiedr.macos. SySExt

Required

Service Address
Hostname or IP address or URL for the service

Organization
Organization for the filter plug-in

Fortinet, Inc

< FortiEDR - Fortinet, Inc

9 oveomigres
G s
& e tnues
Y-

Identification

User Name
User name for authenticating to the service

ehacohen

Password
Password for authenticating to the service

®

Certificate
Certificate for authenticating to the service

None v

Filter Order
Specify the order in which traffic is filtered. Filters with a grade of firewall see network traffic before filters with a grade of inspector.

Firewall v

Socket Filter
Specify filtering of socket traffic

Specify the values for the following fields:

Socket Filter Bundle

Identifier

Socket Filter Designated

Requirement

FortiEDR 7.2.0 Administration Guide
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com.fortinet.fortiedr.macos.SysExt.nefilter

anchor apple generic and identifier

Cancel

Exclude all

Include

"com.fortinet.fortiedr.macos.SysExt.nefilter" and (certificate
leaf[field.1.2.840.113635.100.6.1.9] /* exists */ or certificate 1
[field.1.2.840.113635.100.6.2.6] /* exists */ and certificate leaf
[field.1.2.840.113635.100.6.1.13] /* exists */ and certificate leaf

[subject.OU] = AHAXFXJ7DK)

0o
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Pro o &

Computers :  Configuration Profiles

% 2 computers 2 2
P < FortiEDR - Fortinet, Inc
Q
P Options Scope
& Search Inventory Q Socket Filter Bundle Identifier

Bundie identifier of the socket filter provider system extension
Search Volume Content

Content Filter
Settings configured: 6

@
<

com fortinet fortiedr macos. SysExtnefilter
Licensed Software

Socket Filter Designated Requirement

Directs

Content Management B Roreontiored Designated requirement of the socket flter provider system extension

Policies anchor ap and identier “com. Extnefiter” and ( fleld.1.2.840.113635.100.6.1.9) /* exists * or certficate 1(field.1.2.840.113635.100.6.2.6] * exists */ a
& ONSProxy

Configuration Profiles Not configured

Software Updates Network Filter

& DNS Settings @

e Specify filtering of network packets

Not configured

Restricted Software
Enabie)

Mac Apps

o Dock
Not configured Browser Filter
Rl g Specify filtering of WebKit traffic
Energy Saver .
eBooks. 9D ot configured Ignore | Enable |
Groups. ¢ Extensions Custom Data D)
Not configured Custom configuration data for the filter plug-in T
Smart Computer
C2s Add values to the configuration.
Y Finder
Static Computer Groups Not configured
Classes + Add
o Fom
Enroliment e a
R
v. Click Save.
vi. In the Notifications tab, click Edit, and configure the relevant settings.
o &
" Computers :  Configuration Profies
2 Computers g 2
< FortiEDR - Fortinet, Inc
Q
[} ervenory| Options  Scope
= Search Inventory Q¥ ahacoben Notifi X
otifications
Search Volume Content Remove all + Add
@ o Notifications 1 payload configured —
Licensed Software 1paytoad configured
FOrtiEDRTray  sundie I0: com.fortinet fortiedrmacos FortIEDRTray « =N
™ Parental Controls Settings configured: 7
Content Management parntalCon
Policies App Name Bundle ID
2 Passcode — —
Configuration Profiles Not configured FortiEDRTray com.fortinet fortiedr.macos. FOriEDRTt
Software Updates printng equired
© ot configured Settings Include
Restricted Software
Mac Apps Privacy Preferances Polcy Critical Alerts o)
@  control Critical Alerts can ignore Do Not Disturb and ringer settings for this app
Patch Management 1 payload configured ,w
‘eBooks s
B ot configured Notifications )
Groups Allow notifications to be displayed for this app
(Disable
o Restritons o [ETD)
Groups
Banner alert type o
Static Computer Groups s Banner alerts appear in the upper-right corner. Temporary banners clear automatically and persistent banners require the end user to take action before clearing.
Classes Temporary Vv
o Secuyandprivaey
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!‘ Pro

Computers :

< FortiEDR - Fortinet, Inc

8
% o Computers

p=}

[x} Inventory pt

2
&

@

Critical Alerts
Critical Alerts can ignore Do Not Disturb and ringer settings for this app

CIETY crovl )

Notifications
Allow notifications to be displayed for this app

Banner alert type

Banner alerts appear in the upper-right corner. Temporary banners clear automatically and persistent banners require the end user to take action before cleari

Temporary v

Smart Computer
Groups

Static Computer Groups

Classes

Enroliment

vii. Click Save.

Badge app icon

I Disolay

Play sound for notifications

viii. In the Privacy Preferences Policy Control tab, click Edit, and configure three apps using the
following values.

Identifi
er

Identifi
er Type

Code
Require
ment

Access

App 1

com.fortinet.fortied
r.macos

identifier
"com.fortinet.fortie
dr.macos" and
anchor apple
generic and
certificate 1
[field.1.2.840.11363
5.100.6.2.6] /*
exists */ and
certificate leaf
[field.1.2.840.11363
5.100.6.1.13] /*
exists */ and
certificate leaf
[subject.OU] =
AH4XFXJ7DK

Allow

FortiEDR 7.2.0 Administration Guide

Fortinet Inc.

App 2

com.fortinet.fortiedr.macos
.SysExt.esclient

Bundle ID

anchor apple generic and
identifier
"com.fortinet.fortiedr.maco
s.SysExt.esclient" and
(certificate leaf
[field.1.2.840.113635.100.6
.1.9] /* exists */ or
certificate 1
[field.1.2.840.113635.100.6
.2.6] /* exists */ and
certificate leaf
[field.1.2.840.113635.100.6
.1.13] /* exists */ and
certificate leaf[subject.OU]
= AH4XFXJ7DK)

App 3

com.fortinet.fortiedr.macos.F
ortiEDRCollector

identifier
"com.fortinet.fortiedr.macos.
FortiEDRCollector" and
anchor apple generic and
certificate 1
[field.1.2.840.113635.100.6.2
.6] /* exists */ and certificate
leaf
[field.1.2.840.113635.100.6.1
.13] /* exists */ and
certificate leaf[subject.OU] =
AH4XFXJ7DK
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% Pro

® o Computers

@ | wwentory
oo Searchinventory
&

Search Volume Content

Computers :

< FortiEDR - Fortinet, Inc

Options  Scope

Privacy Preferences Policy

Configuration Profiles

Privacy Preferences Policy Control

Licensed Software @ control () AppAccess
payioad configured
Content Management proes Identifier
L
Policies Not configured (‘comfortinet ortiedrmacos
Configuration Profiles © Restictions Identifier Type
Not configured .
Software Updates Bundie D~ J
scep
Restricted Software B Notoues Code Requirement
Mac Apps identifier “com fortinet fortiedr.macos" and anchor apple generic and certificate 1field1.2.840.113635.100.6.2.6] /* exists */ and certificate leaf(field1.2.840.113635.100.6113] /* exists */ and
@ SecurityandPrivacy certificate leaf(subject.0U] = AHAXFXJ7DK
Patch Management Not configured
eBooks )
& Single Sign-On Extensions (7] validate the Static Code Requirement
Not configured
(Orutee APP OR SERVICE ACCESS.
Smart Card
Smart Computer B e
Static Computer Groups 5 Software Update
~ Not configured [+ _Add
Classes
@ System Extensions
R Tpayload configured
Cancel  Save
Q&
= Computers :  Configuration Profiles
2 Computers A :
< FortiEDR - Fortinet, Inc
p=}
@ | evenory Options  Scope
oo Search Inventon .
& U Q .
Search Volume Content () App Access ®®
Privacy Preferences Policy
Licensed Software @ control
Tpayload configured Identifier
e — [ com.fortinet fortiedr.macos.SysExt esclient
g Provies
Not configured
Policies " confis Identifier Type
Configuration Profiles o Restictions Bundie ID
Not configured
Software Updates Code Requirement
scep
Destctsue B Notcontigurea anchor apple generic and identifier “com.fortinet. Ext.escl 61.9] /* exists */ or certificate 1(field1.2.840113635100.6.2.6] /* exists
Ve A */ and certificate leaflfield1.2.840113635100.6113] /* exists */ and certificate leaf[subject.OU] = AHAXFXJ7DK)
< Apps
@ Securtyandprivacy
Patch Management Not configured .
(] validate the Static Code Requirement
eBooks Single SiamOn £
o Snde Son-OnExarsons xeponseavice access
Groups ——
SystemPolicyAlF - : ("oelete
Smart Card
Z’”a" Conpliag D ot contigured
roups
+ add )
Static Computer Groups 5 Software Update
Z Notconfigured
Classes . .
~ e
System Extensions App Access *
R 1 paylosd configured ®
Concel  Save
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!‘Pro [
w0 Computers :  Configuration Profiles
% @ Computers : .
P < FortiEDR - Fortinet, Inc

a
b nventory Options  Secope
r Search Inventory a

Search Volume Content ~) App Access X (7

Privacy Preferences Poli

Licensed Software

Content Management

ontrol
1 payload configured

Identifier

com.fortinet.fortiedr.macos. FortiEDRCollector

B s
Policies Identifier Type
Configuration Profiles © Restrictions BundlelD ~
Sclwarelpdaiss Code Requirement
Restricted Software 8 identifier "com.fortinet.fortiedr.macos.FortiEDRCollector" and anchor apple generic and certificate 1(field.1.2.840.113635.100.6.2.6] /* exists */ and certificate leaf[field.1.2.840.113635100.6113] /*
Mac Apps exists */ and certificate leaf[subject.OU) = AHAXFXJ7DK
Patch Management Not configured
(0] validate the Static Code Requirement
eBooks ¢ Single Sign-On Extensions
e Edit Delete |
Smart Computer Smart Card
Static Computer Groups o
Classes
Enroliment s c © R a .
. 4
. .
ix. Click Save.
Xx. Inthe System Extensions tab, click Edit, and configure the relevant settings.
Display Name FortiEDR System Extensions
System Extensions Types Allowed System Extensions
Team Identifier AHAXFXJ7DK
Allowed System e com.fortinet.fortiedr.macos.SysExt.esclient
Extensions » com.fortinet.fortiedr.macos.SysExt.nefilter
g Pro o &
o Computers :  Configuration Profiles
B | o comput i .
CLIREE < FortiEDR - Fortinet, Inc
p=}
o Search Inventory Q
e — Not configured System Extensions x
® Search Volume Content .
Lcensed Software PR Allow users to approve system extensions
ot configured ) Allowed System Extensions and Teams IDs > G
FortiEDR System Extensions
Configuration Profiles
m Smerncard System Extension Types
Software Updates configure
Restricted Software ~ Software Update
' Not configured POTENTIAL CONFLICT BETWEEN NON-REMOVABLE AND REMOVABLE SYSTEM EXTENSIONS
Rec RS @ A System Extension payload containing both “N: ble system " and * system extension” types will be rejected by the computers in
Patch Management a ?:Jc:u[:mq ;s scope. You can use the same system extension when choosing "N ble system from UI" and system g
eBooks Team Identifier
& AHAXFXJ70K
o
€D ot configured com.fortinet fortiedr.macos.SysExt.esclient Edit Delete
SHBEIIERD a VPN com.fortinet.fortiedr.macos.SysExt.nefilter Edit Delete
., Xsan
Enroliment - Not configured

L

Cancel

Click Add and configure another system extension with the following values:

Display Name
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System Extensions Types Removeable System Extensions
Team Identifier AHAXFXJ7DK

Allowed System » com.fortinet.fortiedr.macos.SysExt.esclient
Extensions e com.fortinet.fortiedr.macos.SysExt.nefilter

4 Pro o 3
2 Computers :  Configuration Profiles
L 2 Computers . .
< FortiEDR - Fortinet, Inc
a
b ventory Option
g Searchinventory Q
- ot configured v i +
Search Volume Content N qured Allowed System Extensions and Teams IDs ()]
@
Licensed Software @ Secuiyandpivacy Display Name,
Not configured Removable FortiEDR System Extensions
Content Management
& Single Sign-On Extensions System Extension Types
Policies 7 Not configured
Removable System Extensions v
Configuration Profiles
" POTENTIAL CONFLICT BETWEEN NON-REMOVABLE AND REMOVABLE SYSTEM EXTENSIONS
Software Updates
ware Up @ A System Extension payload containing both “N: system “and * system extension” types will be rejected by the computers in
scope. You can use the same system extension when choosing "N system from UI" and tem
Restricted Software ~ Software Update
* Not configured
D Team Identifier
e —— AHAXFXJ7DK
Patch Management @ SystemExtensions
payload configured
eBooks REMOVABLE SYSTEM EXTENSIONS
@ System Migration
Not configured com.fortinet.fortiedr.macos.SysExt.esclient Edit Delete
Groups
m.fortinet.fortie t.nefil Edit Delete
e © TimeMachine com fortinet fortiedr.macos.SysExt.nefilter elete
Groups Not configured
(+ g
Static Computer Groups R
Not configured
Classes
Xsan
Enroliment Not configured c;ie
. 4

xi. Click Save.
» Collector versions earlier than 6.0:

Computers : Configuration Profiles

& FortiEDR
Options  Scope
@, General General

Name Display name of the profile

Jp Passcode

Not configure

FortiEDR

Description  Brief explanation of the content or purpose of the prafile

7 Network This is the official FortiEDR MDM profile for FortEDRCollector versions 41019 or later

Not configured

A VPN
= [ Category Categery io add the profile
None
DNS Settings
@ ot contgured Level Lvet at which to applythe profie
Computer Level  ~
3 DNSProy
B Not configured Distribution Method  Methos (0 use for disiribuling the profie
Install Automatically -
[y Centent Caching
> Not configured
=) Certificate
B8 ot contourea
Certificate Transparency
@ N
ot configured
g sceP
Not configured
[ Drectory
Not configured
Software Update el ove
) P Cancel Save
Not configured

FortiEDR 7.2.0 Administration Guide
Fortinet Inc.



Deploying FortiEDR Collectors

App 1 App 2

Identifier [Applications/FortiEDR.app/FortiEDRCollecto com.ensilo.ftnt.sysext
r

Identifier Path Bundle ID

Type

Code identifier "com.fortiedr.collectord" and anchor apple generic and

Requirement  anchor apple generic and certificate 1 identifier
[field.1.2.840.113635.100.6.2.6] /* exists */ "com.ensilo.ftnt.sysext" and
and certificate leaf (certificate leaf
[field.1.2.840.113635.100.6.1.13] /* exists */  [field.1.2.840.113635.100.6.1.9]
and certificate leaf[subject.OU] = /* exists */ or certificate 1
A97R6J3L29 [field.1.2.840.113635.100.6.2.6]

/* exists */ and certificate leaf
[field.1.2.840.113635.100.6.1.13]
/* exists */ and certificate leaf
[subject.OU] = A97R6J3L29)

Access Allow

Computers : Configuration Profiles

« FortiEDR

Privacy Preferences Policy Control

. App Access x4+

IApplicationsiFortiEDR.app/FortiEDRCallectar

\dentifier Type

Path

~ GCode Requirement

identifier "com fortiedr.ollectord” and anchor apple generic and certificate Tfield.1.2 8401136351006 2.6] /* exists  and certificate leaflfield 1.2, 84013635 100,6113] 1 exists */ and <ertificate
leaf{subject OU] = AG7REJ3L29

[ validate the Static Code Requirement

APP OR SERVICE AccEsS
Allow Edt Delete
Find
B
+ Add
@ A bility
n.
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jamf

Q Computers : Configuration Profi
< FortiEDR

Computers
Options  Scope

Privacy Preferences Policy
& centrol

1 payload configured

] ApCertiicate

Not configured
o Energy Saver
M ot contgurea
Application & Custom
4 settings v

Not configured

Identification

Not configured

@y Time Machine

Not configure
Finder
B ot contigure

@ Accessibiliy

Not configured

g Proves

Not configures

App-To-Per-App VPN

Display Name
System Extensions Types
Team Identifier

Allowed System
Extensions

jamf

= Computers : Configuration Profi
¢« FortiEDR

Computers D

Options  Scope

g Prowes

Nt configured

App-To-Per-App VPN
1 Mapping

Not configure

o Xsan

Not configured

Smart Card

Not configured

o) i‘/slem Migration

Approved Kernel
Extensions

Not configured

@ Associated Domains
Not configured

- Fxtensions

Filter Name

Identifier

Organization

FortiEDR 7.2.0 Administration Guide
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n 4
L 4
TR e
APP OR SERVICE access
AlFil Allow et Detete
+ add
. App Access <) (£

Identifier

com.ensilo fint sysext

Identifier Type

Bundie D ¥

Code Requirement

anchor apple generic and Identifier "com.ensilo.fint sysext” and (certificate leaflfield1.2.840.113635100.61.9] /* exists */ or certificate 1[fielc12.840113635.100.6.2.6] * exists */ and certificate
leaflfield12. 840113635 100.6113] /* exists */ and certificate leafisubject OU] = A97R6J3129)

[ ] validate the Static Code Requirement

APP OR SERVICE access

FortiEDR System Extensions
Allowed System Extensions
A97R6J3L29

e com.ensilo.ftnt

¢ com.ensilo.ftnt.sysext

System Extensions x

Allow Users 1o approve system extensions

~  Allowed Team IDs and System Extensions +

Display Name.

FGrtiEDR System Extensions

System Extension Types

Allowed System Extensions -

Team ldentifier

A97R613L29

ALLOWED SYSTEM EXTENSIONS
com.ensilo ftnt Edit Delete

com.ensilo ftntsysext Edit Delete

+ Adg

FortiEDR
com.ensilo.ftnt

Fortinet Inc.
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jamf

jm Computers

. q
Computers D FortiEDR
Options  Scope
o Proxies
= Not configured

App-To-Per-App VPN

Feles 1 Mapping
@, Configuration Profiles (PG ST
Restricte
& Xon

Not configurad

Smart Card

Not configured

System Migration
Not configured

Approved Kernel
B Extensions
Not configured

@ Associoted Domains
Not configure

r,  Extensions
Not configurea

@ STEDETENEITED
ot configured

System E

1payload canf

jamf

jm Computers

. q

Computers D FortiEDR
Options  Scope
= Prm‘ues

App-To-Per-App VPN
1 Mapping

Not configured

o Xsan
Not configurad

Smart Card

Not configured

System Migration
Not configured

Approved Kernel
B Extensions
Not configured

@ Associoted Domains
Not configure

r,  Extensions
Not configurea

@ STEDETENEITED
ot configured

System

1payload canf

Socket Filter

Socket Filter Designated
Requirement
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Configuration Profiles

Configuration Profiles

Content Filter

Settings configured: 5
Includ

Filter Name

Display name of the fiter in the app and on the device

FortiEDR ‘

Required

Identifier
Identifier for the filter plug-in

com.ensilo.fint ‘

Service Addres
Hostname or IP a

Organization

Orgarization for the fiter plugein
Fortinet Inc. ‘
User Name ® )
User nam for authenticating to the servies
Concel
N 4
&L 9
User Name (@
User nam for authenticating to the servie
Password . )
P for authentic,
| 2
Certificate @

Certificate for authenticating to the service

None ~

Filter Order [ o]
Speily the arder In which taifc s fitered. Fit arade offrewal

(e 2

Socket Fillter @
Sacket Filter Bundle Identifier Eundie identer of e socket fitar provider system extension

‘ com.ensilo.fint ‘
Socket Filter Bundle identifier

Socket Filter Designated Requirement Desicnated requirement of tae socket filer provider system extension

anchor apple generic and identifier "com.ensilo.ftnt’ and (certificate leaflfield1.2.840.13635100.619)  exists */ or certfificate 1[field1.2.840113635100.6.2.6] / exists */ and certificate |

Required
Network Filter

®

Cancel

com.ensilo,ftnt

anchor apple generic and identifier
"com.fortinet.fortiedr.macos.SysExt.nefilter" and (certificate leaf
[field.1.2.840.113635.100.6.1.9] /* exists */ or certificate 1
[field.1.2.840.113635.100.6.2.6] /* exists */ and certificate leaf

Exclude all

o

[

Save

[

Save
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[field.1.2.840.113635.100.6.1.13] /* exists */ and certificate leaf
[subject.OU] = A97R6J3L29)

jamf a

) Computers : Configuration Profiles
< FortiEDR

Computers D

Options  Scope

= Prodes )
B Socket Filter [ o]

configured
Sockat Filter Bundle Identifier Bundie identifier of the socket filter provider system sxtension

com.ensilofint. ‘

App-To-Per-App VPN
& Mapping

Not configured Feaured
Socket Filter Designated Requirement Desinaled requirement of the socket fiter provider systemn exiension
& [ 510061.9] * exists */ or certificate field]2.840.13635100.6.2.6] / exists */ and certificate leaflfield 1.2.840.1136 35100,6113] /* exists */ and certificate |eafsubject.OU] = AS7R6J3L29) ]
Not configured
Required
Smart Cardl

Not configured Network Filter )

Network Filter Bundle Identifier Buncle (dentifier of (e newor fiter provider system extension

[y System Migraton ‘ ‘

anfigurea
Requred

A e Natusork Fitter Dasignated Requiramant Designated raqiremant of the network il pravider systers extansion
B o ]

bt F— Natwork Filir Designatad Recuramant
@ Associated Damains

Not configuredt Custom Data D

Custom configurtion dsta for the fiker plug-in
-, Extensions
2" Not configured Key Value
Add values to the configuration.

£ Single Sign-On Extensions

Not confgurea

~+ Add

System Ext
B
Tpaylosd con
7 Content Fier ® &

Setiings confiqured: 5 carcel  Save

jamf Q 4
| Computers : Configuration Profiles
Computers & FortiEDR
Options  Scope
Q e
he Notifications Removeall - Add
Toayloed configured
& s, .
onfig FortiEDRTray  Bundie ID. com.ensilo. ftnt Fort EDRTray X A
Settings configurec: 7

4 Parental Controls

e App Namo Bundio 1D

FortiEDRTray comensio fint FortiEDRTray

Security and Privacy i

B o comtgurec
Sattings Include

Privacy Preferences Policy

@ control Critical Alerts [EEZH «oo |

I~ Notiications =3 -

. Encrgy Saver Banner alert type
a Bannar alerts apn

e T i1 the UppEr-ight cormer Temporary bannars clear utomatically and parsistent Banmers require the end user to take action befare clearing.

Application & Custom

@ i*‘“‘:?:‘ . v Notifications on Lock screen [+oe [N
Notifications in Notification Center (e R

Identificati
o ot Badge app ion 2 o+ ]
o Time Hochine Play sound for notifications = - |

Not configured

[ Finder ®

Not configure

0

Cancel Save

A sample Jamf profile for upload can be provided upon request.
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3. If another AV product is also installed on the machine, exclude AV exceptions by following the
instructions in Exclusion paths.

Setting up exclusions with other AV products

If another AV product (such as FortiClient) is also installed on the machine, you must exclude AV
exceptions in both FortiEDR and the other AV product to avoid collision which might cause the endpoint to
run slowly or hang:

1. In FortiEDR, add exclusion paths for the other AV product according to the directions in the other AV
product. Note that FortiEDR supports exclusions on Windows only.

2. Inthe other AV product, add the following exclusion paths for FortiEDR:

Windows

%ProgramData%\FortiEDR\
%ProgramFiles%\Fortinet\FortiEDR
%ProgramFiles%\Fortinet\FortiEDR\Fort
iEDRCollector.exe
%ProgramFiles%\Fortinet\FortiEDR\Fort
iEDRCollectorService.exe
%ProgramFiles%\Fortinet\FortiEDR\Fort
iEDRAvScanner.exe
%ProgramFiles%\Fortinet\FortiEDR\Fort
iEDRInventoryScanner.exe
%ProgramFiles%\Fortinet\FortiEDR\Fort
iEDRIotDiscovery.exe
%windir%\System32\drivers\FortiEDRAvVD
river_*.sys
%windir%\System32\drivers\FortiEDRBas
eDriver_*.sys
%windir%\System32\drivers\FortiEDREla
mDriver_*.sys
%windir%\System32\drivers\FortiEDRIot
Driver_*.sys
%windir%\System32\drivers\FortiEDRWin
Driver_*.sys

macOS

/Library/FortiEDR
/Applications/FortiEDR.
app
/Library/FortiEDR/Forti
EDRCollector
/Library/FortiEDR/Forti
EDRCollectorTray
/Library/FortiEDR/Forti
EDRConfig
/Library/FortiEDR/Forti
EDRDrive

/Library/Extensions/For
tiEDRDriver. kext

Working with FortiEDR on VDI environments

Linux

e /opt/FortiED
RCollector

The FortiEDR Collector must only be installed on the master image (not on a clone) of the VMware Horizon
or Citrix XenDesktop in order to ensure that the virtual environment is protected. On Citrix, it is also
recommended to install the Collector on the Windows servers that run the entire Citrix platform.

When installing the Collector, set the VDI-designated installation flag. To do so, append the parameter
VDI=1 to the command syntax shown above or check the VDI checkbox in the installation wizard, as shown
in Installing FortiEDR Collectors on page 23.
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When installing on a Citrix PVS golden image, append an additional parameter CITRIXPVS=1 to the
command syntax shown above.

After the Collector is successfully installed and running on the golden image and before the image is being
cloned, the FortiEDR Collector configuration must be erased such so that cloned images will not show up as
the same Collector on the Central Manager console. To do that so, run the following command as an
administrator:

FortiEDRCollectorService.exe --stop --clean

In VDI installations where VDI pools are used, there is no need to generate Collector groups in the user
interface. Any newly generated virtual desktop is automatically assigned to the default VDI Collectors
group. Upon first user login to the virtual desktop, FortiEDR automatically generates a Collector group that
corresponds with the respective pool name, as specified in VMware Horizon. Any Collector that is installed
on a virtual desktop that is part of this pool is automatically assigned from the default VDI Collectors group
to the corresponding Collector group, regardless of whether the pool definition in VMware is dedicated or
floating. In effect, Collector groups in the FortiEDR user interface are a copy of the virtual machines’ pool on
VMware Horizon or Citrix.

Any newly created Collector group is automatically assigned to an out-of-the-box predefined policy. This
mechanism ensures that any newly created virtual machine is automatically and immediately protected by a
unique instance of the FortiEDR Collector.

W When using FortiEDR automatic updates to Collectors via the Central Manager,
‘Q' make sure to update the master image too. Otherwise, every time that a new
- environment is created from the master image, an automatic update is performed,

which can overload network traffic.

Uninstalling FortiEDR Collectors

You can uninstall a FortiEDR Collector using the following methods:

e From the Central Manager INVENTORY > Collectors page

NP This method is recommended for Windows, Linux, and macOS 10.11 to 10.15.

S L4
9 For macOS 11 or later, due to a macOS design limitation, this method does not
— remove the FortiEDR Collector system extension, which can only be uninstalled
using an MDM solution.

e Through the operating system'’s application management (for example, Add or Remove Programs on
Windows)

« Using dedicated FortiEDR scripts

The following section describes how to uninstall a FortiEDR Collector with Fortinet scripts.
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Windows

Uninstall the Collector by running either of the following commands as administrator. Replace REGPWD with
the registration password used for the installation, which is available in Component Authentication on page
316.

e msiexec.exe /x GUID /qn UPWD=REGPWD RMCONFIG=1 /l*vx log.txt

Replace GUID with the FortiEDR uninstallation product key, which can be found by following the steps
below:

a. Select Start >> Run.

b. Type regedit to open the Registry Editor window.

c. Navigate to HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Uninstall\.
d

. Expand the Uninstall subkeys in the left-hand pane and search for "FortiEDR" to locate the subkey
for FortiEDR.

e. Open the FortiEDR subkey and copy the UninstallString value in the right pane, for example,
{O1C88AE6-6782-4798-81C6-954E0D14FCF5}.

f. Close the Registry Editor window.
e msiexec /x FortiEDRCollectorInstaller_X.msi /qn UPWD=REGPWD RMCONFIG=1

You must run this command from same directory as the msi installer. Or you can replace the msi
filename with the full path to the msi file, such as
C:\Users\Allen\Desktop\FortiEDRCollectorInstaller64_4.1.0.491.msi, which allows you to run the
command anywhere.

macOS

To uninstall the Collector on macOS with versions prior to Big Sur (11), such as Catalina or Mojave:

sudo /Library/FortiEDR/fortiedr_uninstaller.sh 'REGISTRATION PASSWORD'

It is good practice to use REGISTRATION PASSWORD wrapped with single quotes so
NV that it is interpreted correctly by the shell. For example,

sudo /Library/FortiEDR/fortiedr_uninstaller.sh '!EPdzv3@break’

To uninstall the Collector on macOS with Big Sur (version 11) or above:

« Collector versions earlier than 6.0:

/Applications/FortiEDR.app/fortiedr_uninstaller.sh 'REGISTRATION PASSWORD'

+ Collector version 6.0:
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/Applications/FortiEDR.app/Contents/Library/LaunchServices/fortiedr_uninstaller.sh
'REGISTRATION_PASSWORD'

Linux

Uninstalling a Linux Collector removes all configuration files. You must reconfigure
Ny all settings after installing a new Linux Collector.

‘?' If you are uninstalling a non-customized Linux Collector installer and would like to
|| retain the configuration for later use, Fortinet recommends that you upgrade the
= Linux Collector instead of uninstalling the current Collector and re-installing a new

one. However, you cannot perform an upgrade on a custom Linux Collector.

To uninstall a Collector on Linux:

1.

Check the status of the Collector using the following command:

/opt/FortiEDRCollector/control.sh --status

The Collector should be stopped before running the uninstall command.
If the status is not stopped, stop the Collector using the following command:

/opt/FortiEDRCollector/control.sh --stop <registration password>

For example:

/ opt/FortiEDRCollector/control.sh --stop 12345678

Uninstall the Collector using the following command:
* CentOS, RHEL, Oracle, AMI, SLES:

yum remove <package name>

OR

rpm -qa | grep -i fortiedr | xargs rpm -e
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e Ubuntu:

sudo dpkg --purge fortiedrcollectorinstaller

Upgrading the Collector

After a Collector has been installed in the system, you can upgrade it using one of the following methods:

¢ Updating the Collector version on page 405
» As described in the procedure below.

To upgrade the Collector manually (not via the user interface):

Windows

1. Copy the FortiEDRCollectorInstallaler32_x.x.x.xxx.msi or FortiEDRCollectorInstallaler64_
x.x.x.xxx.msi file (as appropriate) to the Collector machine. For example,
FortiEDRCollectorInstallaler32_2.0.0.330.msi or FortiEDRCollectorInstallaler64_2.0.0.330.msi.

2. Double-click the FortiEDRCollectorInstallaler32_x.x.X.xxx.msi or
FortiEDRCollectorInstallaler64 x.x.x.xxx.msi file and follow the displayed instructions.

Linux
N ! ’, You can only manually upgrade non-customized Linux Collectors. For custom Linux
9 Collectors, you must first uninstall the current Collector and then install a new one,
- which requires reconfiguration.

To upgrade a non-customized Collector on Linux:

1. Check the status of the Collector using the following command:

/opt/FortiEDRCollector/control.sh --status

The Collector should be stopped before running the upgrade command.
2. If the status is not stopped, stop the Collector using the following command:

/opt/FortiEDRCollector/control.sh --stop <registration password>

For example:
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/ opt/FortiEDRCollector/control.sh --stop 12345678

3. Copy the installer file to the Collector machine (either FortiEDRCollectorInstaller_Linux_
distribution-version_number.x86_64.rpmor FortiEDRCollectorInstaller_Ubuntuversion_
number.deb).

4. Upgrade the Collector using the following command:

e CentOS/RHEL/Oracle/AMI:

sudo yum install FortiEDRCollectorInstaller_Linux_distribution-version_number.x86_64.rpm

* Ubuntu:

Ubuntu: Run sudo apt install FortiEDRCollectorInstaller_Ubuntu-version_number.deb

» SLES:

zypper install FortiEDRCollectorInstaller_distribution-version_number.rpm

5. Enter y when asked if you want to upgrade.
6. After the upgrade is complete, start the Collector using the following command:

/opt/FortiEDRCollector/control.sh --start

If your FortiEDR Threat Hunting Repository, Central Manager, Aggregator or Core are deployed on your
organization’s premises (on-premises), see Upgrading FortiEDR components on page 524 for instructions of
upgrading these components.
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Dashboard

This chapter describes the FortiEDR DASHBOARD for monitoring security events.

Introduction

The FortiEDR Dashboard provides a visual overview of the FortiEDR protection of your organization. It
provides an at-a-glance view of the current security events and system health. The first time you log in, the
FortiEDR Getting Startedwindow launches where you can watch a series of getting started videos for
orientation within the FortiEDR environment. Use the videos to learn more about how to deploy and use
FortiEDR.

FORTIEDR GETTING STARTED

Welcome to the FortiEDR Best Practice Setup
aun
< Deployment Perquisites F:-:HT'nET a
» Resource for IT Guidelines a

~ support for Mac, Windows, Linux QS
~ Legacy End of Life Operating Systems
~ 5CCM Whitelisting
AV Whitelisting
> Create Users and Notifications
> Deploy FortiEDR Collectors

> Post-Deployment

7 & Ga % Cd I

NP You can change the window location over the screen, resize or minimize the window
‘Q' using the provided buttons at the bottom right. Progress of the current video is not
- kept after you switch to another one. You have to start over with the current video
- after switching back.

The following videos are currently available but the list is subject to change without notice:
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Section Videos

Deployment Perquisites Resource for IT Guidelines
Support for Mac, Windows, Linux OS
Legacy End of Life Operating Systems
SCCM Whitelisting
AV Whitelisting
Create Users and Central Manager: Create Secondary Admin
Notifications Enable 2FA
Create Email Distribution List
Deploy FortiEDR Collectors Request FortiEDR Collector
Create Server Collector Group
Install Collector Win64
Win Collector Command Line Install
Linux Collector Command Line Install
Win Collector Troubleshooting
Post-Deployment BPS Lite Checklist

Collector Troubleshooting

The Dashboard is automatically displayed after you exit the getting started window or when you click the
DASHBOARD tab.

=_= FortiEDR | PESLLEG Incidents Threat Hunting Communication Control Security Settings v Inventory v Administration v

Last 30 days v 0%

Collectors By Version m =] e Collectors By 0S m B Collectors By State B

Windows N Windows N Windows

No data to display

Windows

@ Running Degraded @ Disconnected Pending Reboot Disabled @ Ruming Degraded @ Disconnected Pending Reboot Disabled

Detection Activity =]

Last 30 days v All classifications
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NP The system time is displayed in all pages at the bottom right of the status bar. It
‘Q' represents the local FortiEDR server time. For example, if the FortiEDR server is
- located in London, and you log in from Los Angeles, USA, then the time shown is the

current time in London, and not the current time in Los Angeles.

System Time (UTC +03:00) 10:17:49

The Dashboard enables you to display two different slices or views of the data collected by FortiEDR in each
widget. Click the applicable view button at the top left of the window to display that view in the
DASHBOARD tab:

e Graph View (): This view presents information in a graph or pie chart.
» Table View (): This view presents information in a table.
The information presented in the Dashboard represents an aggregation of events. For more details, you

may refer to the Event Aggregation on page 85. FortiEDR aggregates security events in both the Device
view and the Process view in the Dashboard.

The top right corner includes the notification center where you can access notifications, the Help button to
access the FortiEDR documentation portal where you can access all FortiEDR documents, such as the
FortiEDR Administration Guide and Release Notes, and the Logged-in User dropdown list with the following
options:

» English: Expand to switch the Ul language from English to a supported language, such as Japanese. The

default is English.
 Privacy Policy: Downloads the FortiEDR privacy policy.
e Logout: Exits the FortiEDR application.

@ Prevention

~ | & English
English
RS
H=3E
Frangais

1) Privacy Policy

Logout
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Collectors chart

The COLLECTORS chart provides an overview of FortiEDR Collectors. You can view Collectors by OS, policy,
state, or version.

Collectors By Version

m= Collectors By 0S me
Wwindows v Windows -
2 8
6
g‘ I I I I ;
£ H
Z I
o o I
5.27.0051 52.7.0046 5.2.7.0030 5.2.6.0065 MAC Windows Linux
@ Running Degraded @ Disconnected Pending Reboot Disabled @ Running Degraded @ Disconnected Pending Reboot Disabled
Collectors By Policy me Collectors By State B
Windows -
15
10
3
= 4
5 Collectors
0
Exfiltration Prevention Default Communication Execution Prevention Default Playbook Ransomware Prevention
Control Policy
@ Prevention Simulation Unassigned @ Running @ Besrades @ Disconnected Pending Reboot Disabled

S ! ’, Disconnected status may indicate that the device on which the FortiEDR Collector is
9 installed is simply powered down or disconnected from the network. It does not

necessarily mean that there is a problem with that FortiEDR Collector or that device.
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Event Handling widgets

Event Classification Distribution [ORZ]

My Events me
Last 30 days Last 30 days
10
’ .
e 6
13 g
Events 4
2
0 |
Handled Unhandled
@ Malicious Suspicious PUP Inconclusive Likely Safe @ Safe @ Malicious Suspicious PUP Inconclusive Likely Safe @ Safe
Team Workload Overview Bes Top Affected Devices o= Top Response Actions o=
Last 30 days v | InProgress

Last 30 days N

Last 30 days N
15

Amount

® Malicious Suspicious PUP Inconclusive LikelySafe @ Safe

The Event Handling widgets show the number and classification of the FortiEDR security events. The charts
and graphs are color-coded according to security event classification:

* Red: Critical
* Yellow: High
e Grey: Medium
» Green: Safe

Each security event that is detected by the FortiEDR system is initially marked as unread and unhandled.

Multiple users may be using the FortiEDR Central Manager in parallel. The Unread and Unhandled statuses
enable users to keep track of whether anyone has read and handled the message.
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Top Affected Devices chart

Top Affected Devices m =
Last 20 dayd v
15
e 10 -
5]
E
< 5
p NN || - L —_ . . | . -
o o c_}'% \,':?' '_L{__‘Q I_LQ;QK oD & gi{b ES
& g & & & > o 3 N & 0’
PG R e A e e S
4 : 5 )
R S S S &
R R
@ Malicious Suspicious PUP Inconclusive @ Likely Safe @ Safe

The Top Affected Devices chart displays the history of the most-infected and targeted processes,
applications and devices. This chart is color-coded according to the classification of the attacks. The
information is displayed per last day, last week or last month, according to your selection.

Detection trends and analysis widgets

Variants Detection Activity B

New Events Detections =]

Top Detection Rule By Occurrence ms
Last 30 days - All classifications - Last 30 days - All classifications: -

Last 30 days

Dec? Decl0 Dec14 Dec16 Dec17 Dec18 Dec21 Dec22 Dec23 Dec24 Jand

PUP
Linix <+ Mac - Windows

Dec7 Decl0 Decl7 Deci8 DecZl Dec2? Dec23 Dec2d  Jand Ll ive @ LikelySefe @ Safe

Suspicious
Detected Configuration Application

The Detection trends and analysis widgets show the trends and analysis of the FortiEDR security events.

The graphs in the Top Detection Rule By Occurrence widget are color-coded according to security event
classification:
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Red: Critical
Yellow: High
Grey: Medium
Green: Safe

Communication Control Policies graph

The Communication Control Policies graph displays a breakdown of the applications that are allowed or
denied in your organization.

Communication Control Policies m =

Prevention V

2

Amount

Default Communication Control Policy Isolation Palicy

@ Deny @ Allow
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System Components

System Components m =]

Amount
(2]

0 I I I

Cores Aggregators Repository FCS

@ Running Degraded @ Disabled

The System Components graph shows the status of the Cores, Aggregators, Threat Hunting Repository, and
FCS.

Licensing widgets

License Gapacity = =] License Status

Li

icense
Predict-Protect-and-Response
Workstations

Expiration Date: 14-May-2028
Remaining 40 months

Estimated Threat Hunting Data Retention
Servers 182 Days(0.22% of the storage is utilized)

® inuse Remaining

The Licensing widgets provide an overview of the FortiEDR license status, including licensing type and
status, capacity and usage information, and threat hunting data retention usage.
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Generating reports

oo
On the dashboard, click the Configuration icon () on the top-right of the dashboard and click Generate
report to download a PDF report with a summary of the security events and system health within the
specified time range.
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configuration

» Collectors

> Event Handling

> Detection trends and analysis

> Policy

> System Components

> Licensing

[ 4 Generate report

{* Reset to default
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Incidents

This chapter describes the FortiEDR Incidents view for monitoring and handling security events.

Introducing the Incidents view

Upon connection establishment attempt, each FortiEDR Collector sends relevant metadata to the FortiEDR
Core, which sends it on to the FortiEDR Aggregator so that it can be displayed in the FortiEDR Central
Manager Incidents view. The Incidents tab enables you to view, investigate, and acknowledge handling of
each such security event. A row is displayed for each event.

The Incidents tab enables you to display two different views of the event data collected by FortiEDR:

» AllIncidents (): This view shows all the security events detected on all devices within the specified time
range (up to 30 days).

« Mobile Incidents (): This view shows security events detected on mobile devices within the specified
time range (up to 30 days).

vy
‘?' Security events that were triggered by Saved Queries appear slightly different in the

Incidents tab.

Event Aggregation

For convenience and easier navigation, FortiEDR aggregates security events in the Incidents tab.

» Each primary-level row represents an incident entity with its own state independent from the
associated child events.

both the top-level incidents and their child events. An incident may appear on its

s";’, You can filter incidents with a time rang of up to 30 days. Filters are applied to
- own if it matches the filter criteria even if none of its child events do.

« You can drill down on a device/process to display the security events for that device/process. Each

security event row is marked with a flag indicator.

In the Process view, the Destinations column indicates the number of destinations to which the process
attempted to connect. If only one destination was accessed, its IP address is shown. If more than one
destination was accessed, the number of destination IPs is shown in the Destinations column.

In the Process view, the Device column indicates the number of devices the malware attempted to
attack. If only one device was attacked, its device name is shown. If more than one device was
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attacked, the number of devices is shown in the Device column.
e You can drill down further in a security event row to view the raw data items for that event by clicking

on the [* icon. Raw data items display the relevant information collected by FortiEDR from the device.
For example, if a specific process was connecting to 500 destinations, then 500 raw data item rows
display for that security event. For example, in the figure below, the security event comprises 2 raw

data items, coming from different devices and going to different destinations. You can click the
icon to return to the aggregated security event view.
The following actions can be performed in the Incidents view:

» Marking a security event as handled/unhandled on page 115

« Manually changing the classification of a security event on page 116

» Viewing Application Control security events on page 123

¢ Viewing Device Control security events on page 123

» Other options in the Incidents viewer on page 124

When a new security event is generated by FortiEDR, an indicator number displays or is incremented.
Hovering over this number indicates the number of new unread security events.

In some cases, Updated displays next to the number of new unread security events indicator. Updated
means that FortiEDR originally classified one of the unread events, but that classification was later changed
by the user. After more data for this security event was received, FortiEDR overrode the manual
classification of the event by the user and changed the classification for the event again, based on the
newly received data.

Incidents pane

Clicking a security event expands it to show more details and enables the buttons at the top of the window.
The following information is provided for each security event:

Desktop incidents:
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Exception Manager >

Incidents
All statuses - Security Events - Last 30 days N % C Q
Mobile Incidents
9 results
Classifi.  Incident Num. of Ev..  Status ) Assigned to Device First Seen LastSeen = 000
(] 1 Unhandled =
3 Unhandled -
| #* 1 Handled L ]
o pendener = VO :
Excepti. Status Classifi Event Certificate Variants Device Action D First Seen Last Seen
| [=] Handled #* Ca\Users e 1 (]
{J explorerexe @ Y .
The Extended Detection policy provides detection features (meaning that events are
S ! ’, logged and displayed in the Incidents tab). No protection (blocking) features are
q provided. The exceptions options are not available in the Incidents tab for security
- events triggered by the Extended Detection policy, because these events were not

collected by a FortiEDR Collector.

Mobile incidents:

Al
‘Q' The Mobile incidents tab is available only if mobile is enabled in the organization
setting. See Step 2 - Defining or importing an organization on page 419.

Incidents
Al statuses v Last 30 days v <] Q
Allincidents
1 results

Classifi..  Incident Num.of Ev..  Status D Assigned to Device First Seen LastSeen = 000

| #* 6 Unhandled iPhone 13
| B Unhandled 6 iPhone 13 %)

The mobile incidents view displays incidents specific to mobile devices. The details for each mobile incident
are similar to those in the desktop incidents view except that the Investigate button is unavailable for mobile

incidents.
Information Field Description
View Indicator Indicates the view context for the security event aggregation. &2 displays
for a device and 1 displays for a process.
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Information Field Description

Handled/Not Handled p

Specifies whether any FortiEDR Central Manager user handled this

security event, as described on Marking a security event as

handled/unhandled on page 115

ID Specifies an automatically assigned unique identifier for each security
event generated by FortiEDR. This identifier is particularly useful for
security event tracking purposes when monitoring security events using

an external system, such as a SIEM.
Device

Process

Specifies the device name on which the security event has occurred.

Specifies the process that is infected. This is not necessarily the process

that made the connection establishment request (such as Firefox, which
might be being controlled by the infected application). If the security
event was triggered by a script, then the script name is specified.

Classification

Specifies how malicious the security event is, if at all. Classifications are

initially determined by the Core but can be changed either automatically
as the result of additional post-processing, deep, thorough analysis and
investigation by the FortiEDR Cloud Service (FCS) or manually. See
Overview on page 90 for more detailed information about the
classification of the event, such as the classification history.

Classifications are as follows:

Icon Classification Definition

Events with the
following
characteristics:

» Verified to have
malicious
capability

e Intended to harm
the infected
device

e Have no
commercially
viable use

Malicious

E 3

Events that behave in
ways that strongly
indicate malware, but
are not verified
malware.

Suspicious

. Inconclusive Further investigation

needed to determine
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Action

Remediate

Review and
remediate

Administrator
review
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Information Field Description

Icon Classification Definition Recommended

Action

if the event is
malicious.

PUP (Potentially  Events triggered by Administrator to
Unwanted programs that are review whether
Program) bundled with the program
legitimate software or should be
commercial software  removed
that may be used for (recommended)
malicious purposes, or allowed
for example, torrents.

9 Likely Safe Events that probably ~ Administrator
carry norisk, and are  review
most likely legitimate.

=7 Safe (Confirmed Events triggered by No action
Safe Software) legitimate software necessary
that was intended for
use by the customer,
for example, security
software.

Received Specifies the first time that this security event was triggered. For
aggregations, the earliest received time is displayed.

Last Updated Specifies the last time that the security event was triggered. For
aggregations, the most-recent time is displayed.

Action Specifies the action that was enforced:

 Block @: The exfiltration attempt was blocked and this blocking
event was generated.

» Simulated Block -: The policy that protected this device was set to
Simulation mode. Therefore, the exfiltration attempt was NOT
blocked and this blocking event was generated. FortiEDR would have
blocked this exfiltration security event if the policy had been set to
Prevention mode.

+ Log[%: The security event was only logged and was not blocked.

For raw data items, the following information is available:

Information Description

Device Specifies the device name on which the security event has occurred.
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Information Description

First Seen The Incidents tab aggregates the occurrences of the same security
events into a single row when it represents the same attack on the same
device. This timestamp specifies the first time this security event
occurred. The row of this security event pops to the top of the list in the
Incidents tab each time it occurs again.

W, If a change is made to the FortiEDR policy used by a
‘?' specific FortiEDR Collector, then the security events
|| before and after that change are not aggregated

together.

Last Seen Specifies the most recent time this same security event occurred. See
FIRST SEEN described above.

Process Owner Specifies the user who ran the process that triggered the security event.

Process Type Specifies whether the infected process is 32-bit or 64-bit.

Use Specifies the domain of the computer/user of the device.

Process Path Specifies the path of the infected process.

Count Specifies the number of occurrences of the same raw event on the same
device.

Overview

After you select an incident in the Incidents pane on page 86 and click Investigate, the Overview pane
displays detailed information about the audit history, violated policies, and rules assigned to the FortiEDR
Collector that triggered this security event.

The audit history shows the chronology for classifying the security event, and the actions performed by
FortiEDR for that event. This area also displays relevant details when the FortiEDR Cloud Service (FCS)
reclassifies a security event after its initial classification by the Core. For example, the following example
shows that the security event was reclassified by the FCS and given a notification status of PUP at
23:03:51.
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Unhandled

Incidents >
[} Status
PUP
Overview  Event Analysis

[P Handle Incident

Activity Audit
Add Incident comment

28-May-2024 p3:03:51

Incident ID;

ssiratonchnge

FortinetCloudServices

28-May-2024, 23:03:51

Incident ID;
Classification change: PUP

Fortinet

28-May-2024, 23.03:51

Event D

Glassiication change: # PUP

FortinetCloudServices

FortinetCloudServices

FortinetCloudservices

Organization Assigned to FirstSeen Last Seen
N/A
Devices involved (1)
=
=
>
Response
Violated Policies
A .
BT () Execution Prevention
Malicious File Detected
Response

ATT&CK

o3 Full Screen [ New Tab

Processes involved (1)

exe ©

The ATT&CK section lists techniques that were used in this incident based on the MITRE ATT&CK common
techniques scheme. Clicking the technique opens the MITRE web page, providing additional details, as

shown below.

MITRE AtT&CK

Matrices  Tactics ~  Techniques ~  Mitigations ~

Register to stream ATT&CKcon 2.0 October 29-30

Home >

ENTERPRISE ~

TECHNIQUES

All

Initial Access

Execution

Persistence

Privilege Escalation

Defense Evasion
Access Token Manipulation
Application Access Token
Binary Padding
BITS Jobs
Bypass User Account Control
Clear Command History
CMSTP
Code Signing

Compile After Delivery

ques > Enterprise > Process Doppelganging

Windows Transactional NTFS (TxF) was introduced in Vista as a method to perform safe file operations. 1170 ensure data integrity, TXF
enables only one transacted handle to write to a file at a given time. Until the write handle transaction is terminated, all other handles are
isolated from the writer and may only read the committed version of the file that existed at the time the handle was opened. 2 To avoid

corruption, TxF performs an automatic rollback if the system or application fails during a write transaction. £
Although deprecated, the TxF application programming interface (API) is still enabled as of Windows 10. )

Adversaries may leverage TxF to a perform a file-less variation of Process Injection called Process Doppelganging. Similar to Process
Hollowing, Process Doppelganging involves replacing the memory of a legitimate process, enabling the veiled execution of malicious code
that may evade defenses and detection. Process Doppelgénging's use of TxF also avoids the use of highly-monitored API functions such as
NtUnmapViewOfSection, VirtualProtectEx, and SetThreadContext. 2]

Process Doppelganging is implemented in 4 steps )

« Transact - Create a TxF t ion using a then overwrite the file with malicious code. These changes will be

isolated and only visible within the context of the transaction

Load - Create a shared section of memory and load the malicious executable.

Rollback = Undo changes to original executable, effectively removing malicious code from the file system.

Animate — Create a process from the tainted section of memory and initiate execution.

Groups  Software

—

ID:T1186

Tactic: Defense Evasion

Platform: Windows

Permissions Required: Administrator, SYSTEM, User
Data Sources: APl monitoring, Process monitoring

Defense Bypassed: Process whitelisting, Anti-virus,
Whitelisting by file name or path, Signature-based detection

Version: 1.0

In the Violated Policies pane, only policies that were violated are displayed. The rule’s configured action is
displayed for each rule, as defined in POLICIES. The Action that was actually executed is displayed in the
action column of the Incidents pane of this window. The action taken is determined by the rule with the

highest priority.
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Investigation View

The Investigation View is accessible in the Event Analysis tab using the Investigation button (

) when you select an incident in the Incidents tab. It helps understand the flow of
activity events during Threat Hunting with a dynamic and interactive graphical view of the activity events
details: source, action and target.

The graphical view provides the ability to add more activity events to the graph and show the relationship
and timeline of the occurrence of those activities, such as the following:

» All actions performed by a given process

« All files the process has created or updated

« AllIPs the process has initiated communication with

It also allows you to interactively view a chain of activity events in the following ways:

* Browse between the various processes involved in the chain
e See all activity events related to one node in the Security Event graph
« Filter activity events table to include or exclude a specific value
e Switch and see the graph chain on the other involved endpoints while analyzing security event on one
device
You can also perform certain actions, such as:

» Retrieve or remediate files

e Connect to a device or isolate a device

« Move a device to high security group

e See the graph chain on the other involved endpoints while analyzing security event on one device

» The Investigation View is not available to IT users (see Users on page 277).
Ny Read-Only user can only view and manipulate graphs but cannot remediate or
‘q‘ perform other actions.
- e The view adds visualization and interaction of existing data that is already
= available in other non-graphical and non-interactive forms without creating or
generating any additional data.

The following figure illustrates the various components of an Investigation View window launched from the
Incidents view.
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incidents > MicrosoftEdgeUpdate.exe 3 Full Screen [ New Tab

D Status Organizatior Assigned to First Seen Last Seen
4§ Inconclusive )
~7 384846 Unhandled liorlamb N/A 24-May-2024, 13:38:15 24-May-2024, 13:38:32
Overview Event Analysis
=] v Unhandled * C:\Program Files Temp\EU27AB.tmp\Micr 8 2 8 WINT0-64BIT +1 (] 384844 24-May-2024, 13:38:15 24-May-2024, 13:38:32

+ Add Exception [ MicrosoftEdgeUpdate.exe Classification # Inconclusive Destination 13.107.42.16 Received 24-May-2024, 13:38:32 Last Seen 24-May-2024,13:38:32  1Incidentresponse ‘
v Automated |

[% Export : =) WIN10-64BIT : B Running Up Time 19d, 20h, 49min, 32sec nternal IP N/A External IP 82.81.92.138 = collector Version 5.2.4.0014

o
o ¥ Rules(1) v M MITRE & Behavior (2) v + [ sshd | PiD-7080 TID-7080 o bic

Parent D 1
Name

0 systeme

Creation Time 05-Sep-54957, 10:50:20

@
)
E Creation Time 06-5ep54957, 15:42:30

Product Information Name openssh-server

Version 7.4p1

Company name  Amazon Linux

root

0

64bit

7080

Bk\'* @ > @ | 10151121174
Command Line )
Connect
File Version Information  Name openssh-server
me Y

Version 7.4p1
Company Name  Amazon Linux
File Version 7.4p1

Command Line D

Raw data Items 1/3

All Activity (60) ~ Process(9)  File(0) ~ Network(51)  Registry(0)  Log(0) e Activities related to Process sshd < V| search B|

Compared with the investigation view window launched from the Details Pane under
NP Threat Hunting, this view includes the following additional functionality:
‘9' » Advanced threat hunting and investigation capabilities, such as exporting the
| graph as JSON, raw data items navigation graph, and Stacks view on page 99.

» General event details in the first row, such as classification and incident

response.
Component Description
1 General details about the event, such as event ID, process name, classification, IP

address, and incident responses.

Use the Export button ( r—' EXport ) to save files for sharing or record reasons:
e JSON—Export the event data as a JSON file.

» SVG—Export the investigation view graph as an SVG file. This is the only option
to save a graph that includes dynamic changes based on the default graph
view, such as adding processes.

B Export E [m]

» Use the following buttons, accessible by clicking the eclipses on the right of the
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Component Description

device name, to connect to a device, isolate a device, or move the device to high
security group.

Sratus B Running

Connect to device
Isolate device

Move device to high security group

3 Graphical flow diagram with a process tree that you can build according to your
investigation needs, from left to right and top to bottom. The tree is also interactive,
which means you can click on a specific component to drill down for more details or
contextual actions.

A Node—Source of an activity or event, which can be a process, an endpoint, a
thread or service, or another security product. Nodes are represented by
boxes with icons for the activity type, some with descriptions under the
boxes.

64
it
e Click on a node to display the Details pane on page 145 on the right and
the Activity events tables on page 141 on the bottom with contextual
information about that specific node.

® Click the Collapse (") or Expand (') icon in the right of a node icon to
show or hide all the downstream nodes, edges, and leaves.

» Right-click a node to perform actions allowed on the node, including any
custom actions you defined. These action buttons also appear in the
Details Pane, which is available on the right after you click the node.

The list of available options varies by node type. The following is an
example list of actions for a process node.
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Component Description

Remediate

Retrieve

Add Process Exclusion
Add to Blocklist

View activity events

Edge—Activity event type or action represented by a curved line with an
arrow. An edge can be one activity event/action or an aggregation of several.
The numbered arrows indicate the sequence of actions and specify the action
that was performed, such as Process Creation, Socket Close, Block and so on.
Multiple operations performed between two processes are represented by
multiple arrows between them. Edges that triggered the event are indicated in
red.

— 0

Click on an edge to display the Details pane on page 145 on the right and the
Stacks view on page 99 on the bottom with contextual information about that
specific edge.

Edges may also have icons below them indicating classification or violation of
certain rules and MITRE & Behavior models. Click on an icon for more detailed
information.
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Component Description

C Leaf—Target of activity event of type File, Registry Key, Registry Value,
Network components (IP/DNS/URL). A leaf can also be a group of artifacts. For
example, all the files created or modified by a process. Leaves have a round

@

shape ( ).

¢ Click on a leaf to display the Details pane on page 145 on the right and the
Activity events tables on page 141 on the bottom with contextual
information about that specific leaf.

» Right-click a leaf to perform actions allowed on the leaf, including any
custom actions you defined. These action buttons are also available in the
Details Pane, which appear on the right after you click the leaf.

The list of available options varies by leaf type. The following is an
example list of actions for a network leaf:

Show the number of distinct processes that communicated with this IP
Show the number of devices that communicated with this IP
Block address on firewall

D Hint—Categorized groups of activities related to a node that are not part of
the main chain of activity events and thus not represented in the graphical
diagram. Click a node to show the number of relevant activities. The hints no
longer display after you move the selection to another node or edge.

* Click the Expand ( [':) or Collapse ([': ) icon near a leaf hint to show or
hide the node or leaf list of that type.

¢ Right-click the type name of a hint and select Add to graph to add the
relevant leaves to the graph or select View activity event to pull out the
Activity events tables on page 141 for this specific file type. The Add to
graph option is unavailable when the number of hints exceeds 500, in
which case you can only choose to view the activity event.

Add to graph

View activity event
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Component Description

E Use the Rules or MITRE & Behavior legends to highlight the corresponding
icons below relevant edges in the diagram.

¥ Rules (1) w M MITRE & Behavior (2) v

F W

+
Use the Zoom In ( ), Zoom Out ( ), and Zoom To Fit ( - )
buttons to adjust the graph window size.

Use the Reset ( ) button to restore the graph to the default view.
Usethe Undo () button to cancel an operation.
G Navigate between the graphs of the various raw data items for a security

event using the right and left arrows.

Raw data ltems 1/ 3

> 2l

B
LS

4 Details pane on page 145 for the selected node, edge, or leaf where you can view details
of the activity, action, or target, and perform common actions on a node or leaf, such as
retrieving a file, remediating devices upon malware detection, or adding an application
to the Application Control policy blocklist. The actions can also be performed by right-
clicking a node or leaf and selecting the option from the menu.
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Component Description

32
,[U taskhost.exe | PID- TID- it 8

+ =
{gn, Add to blocklist Remediate: % Fetrieve

Path i

Parent ID 528
Barme R —.
Creation Time IZgm 235, 202 2EC

Creation Time L,

Product Information Mame Microseft® WindowsE Operating System
Version
Company name Microsoft Corporation
Executing User

Executing User ID

For specific leaf types, this pane also includes an Insights tab which allows you to run
queries to retrieve analytics data, such as the number of communicating processes or
devices of a certain IP. The Insights options are also available from the right-click menu
of those leaf types.

@D 54.67.13.75:443

Details Insights

How many distinct processes have communicated this IP? Run
. I/-—"\‘
How many devices have communicated this IP? { Run |
e A
5 « When a node or leaf is selected, the contextual Activity events tables on page 141

appears at the bottom, which is organized by tabs of activity types. Drag the top
edge of the table up for a fuller view of the table. Activities with a number at the
front of the row are already in the graph and the number matches the one in the

graph.
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Component Description

MaxW10x64-M3 Value Read

MaxWi0x64-M3

» To add activities to the graph, select the corresponding rows and click Add to
a5+

| =, Add to graph

).

e To customize the columns to display in the table, click Customize (
["]l] Customize )

» To search for a specific activity or event, enter keywords in the search bar on

5 i Search B
the top right corner ( ).

» To filter the results in the Activity Events table to include or exclude a specific

value, use the green plus () and red minus (=) icons that appear when you
hover over the value. Multiple filters are supported. To delete a filter, click the
cancel icon that appear when you hover over the filter on the top-left of the
table.

« When an edge is selected, the Stacks view on page 99 appears at the bottom
instead.

Stacks view

The stacks view displays the stacks that were collected during the action performed between two process
nodes in the Investigation View on page 92 when an edge is selected. The stack entries include the
executables and DLLs involved in the process stack. The stack entries due to which the event was triggered
are highlighted with a red background. The main stack entry, which means the first one, is marked with a

separator.
- v | senen B
() Remedize (2 Res ) customize
> v 0x67000
> £ S 0x80000
> & 0xc70000
> v 0x1600000
> 2 0xac2000

For each executable, you can see the following information:
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» Executable File Name: Specifies the filename of the executable.

» Signature: Specifies whether or not the file was signed. Possible values: Signed, Unsigned, Self-signed,
Invalid timestamp, Signed (no timestamp).

» Size: Specifies the size of the file.

< Base Address of this entry in memory.

» End Address of this entry in memory.

e Hash: Specifies the file hash. No hash is available for memory items.
» Owner: Specifies the owner of the file.

Writable memory is indicated by the :E'} icon at the front of the stack.

You can also expand a stack to view more details, such as the last modified time (not available for writable
memory entries), whether or not the stack entry is of OS executable or console application for executables
and DLLs.

You can perform the following actions in the stacks view table:

» Remediate a file or retrieve memory using the Remediate or Retrieve buttons (

Remediate Al Retrieve
lﬁ R = ) at the top-left of the table.

* Customize the columns to display in the table using the Customize button (l]l]l] ustormize )

« Search for a specific stack entry using the search bar on the top right corner (

5 A Search B
).

Retrieving memory

The Retrieve Memory function enables you to retrieve the stack-memory of a specific Collector to perform
deeper analysis by analyzing the actual memory from the device. Memory is fetched by the Collector in
binary (*.bin) format, compressed, encrypted and then sent to the user’s local machine. The returned file is
password-protected with the password enCrypted. If the file cannot be sent, it is saved locally on the host
by the Collector.

This function is accessible from the Investigation View on page 92 (detailed in the procedure below) or by
connecting to the device directly using the FortiEDR Connect on page 109 functionality.
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To retrieve memory for a Collector from the investigation view:

1. Right-click the node of the relevant activity event and select Retrieve.

:J m task” - -
U

Remediate

Add Process Exclusion
Add to Blocklist

View activity events

Alternatively, select the node of the relevant activity event and click the Retrieve button in the Details
Pane that appears on the right.

32
II_T taskhost.exe | PID- TID- bt 7
+ -
{gn Add to blocklist Rernediate: % Retrieve
Path CA
Parent ID 528
Name e ——
Creation Time CIgmic 0Dy DInIIiIC
Creation Time Py, a—
Product Information Mame MicrosoftE WindowsE Operating System
Wersion
Company name Microsoft Corporation
Executing User
Executing User ID
\‘ ! 'l
q The Retrieve button is also available from the Stacks view on page 99, which is
|| available when an edge is selected.
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2. The following window displays:

Retrieve Memory

explorer.exe

®) Retrieve memory of selected stack entries - 1 entry(s) selected

! Memaory Disk
Retrieve memaory region from address:  Hex value (0x.) to address: Hex value (0x..)

Retrieve the entire process memory

Estimated Memory Retrieval file size: Unknown

3. Select one of the following options:

a. Retrieve memory of selected stack entries: Select this radio button to retrieve memory for one or
more specific stack entries. Then, select the stack entries you want to analyze by checking their
checkboxes.

You must also specify whether to retrieve the memory from memory, disk, or both by selecting the
respective checkbox. The Memory option is the default. You can select either option or both
options. It is important to remember that the retrievable data may be different in the memory and
on disk. In addition, the stack entry may no longer reside in memory, for example, if the system was
rebooted. After you make your selection, the window indicates how many stack entries were
selected.

b. Retrieve memory region from address: Select this option to retrieve memory from a specific memory
region. Specify the To and From addresses for the region in the adjacent fields.

c. Retrieve the entire process memory: Select this option to retrieve memory for an entire process. This
option retrieves all the stack entries comprising the process.

4. Click Retrieve.

Isolating a device

An isolated device is one that is blocked from communicating with the outside world (for both sending and
receiving). A device can be isolated manually from the Inventory > Collectors page or the Investigation View
on page 92 (detailed below).
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Isolation mode takes effect upon any attempt to establish a network session after

N ! /., isolation mode has been initiated. Connections that were established before device
q isolation was initiated remain intact. The same applies for Communication Control
- denial configuration changes. Note that both Isolation mode and Communication

Control denial do not apply on incoming RDP connections and ICMP connections.

For more details about device isolation, see Investigation on page 249.

To isolate a device from the investigation view:

1. Inthe Investigation View on page 92 of an event with an associated device that you want to isolate,
click the eclipses on the right of the device name and select Isolate device, as shown below:

— | ]
I .
[ ] . Status # Running

Connect to device

Isolate device

Move device to high security group

2. Inthe window that appears, click Isolate.

Isolate collector? x

You are about o isolate collector.

To remove isolation from a device in the investigation view:

1. Inthelnvestigation View on page 92 of the same event, click the eclipses on the right of the device
name and select Remove isolation, as shown below:

.
R .
. Status B Running

Connect to device

| Remove isolation |

Maowe device to high security group
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2. Inthe window that appears, click Remove.

Remove Isolation

You, are about to remove Collector isolation-

Remove [ Cance

Remediating a device upon malware detection

After malware is detected on a device, you can remediate the device from the Investigation View on page
92 (detailed in the procedure below) or by connecting to the device directly using the FortiEDR Connect on
page 109 functionality.

The following options are available when you remediate the situation in the FortiEDR system:

Method Description

Terminate the Process This method does not guarantee that the affected process will not
attempt to execute again.

Delete the Affected File from  This method ensures that the file does not attempt to exfiltrate data

the Computer again, as the file is permanently removed from the device. When using
this method, be careful not to delete files that are important to the
system, in order to protect system stability.

Remove or Modify the This method removes a registry key or updates a registry key’s value.
Registry Key This method changes malicious registry key modifications by removing
newly created keys or returning key values to their original form.

) Some malware have persistency capabilities, which
‘9' makes the infection appear again. In addition, in some
- rare cases, malware can cause the system to crash if
= you try to remove them.

Both of these methods can be performed using the Forensics add-on.
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To remediate a device from the Investigation View on page 92:

1. Right-click the node of the relevant activity event and select Remediate.

."‘}.-- |
: m task” -

Retrieve

Add Process Exclusion
Add to Blocklist

View activity events

Alternatively, select the node of the relevant activity event and click the Remediate button in the Details
Pane that appears on the right.

32
,[U taskhost.exe | PID- TID- bt 0
+ -
{gn Add to blocklist Remediate % Retrieve
Path CA
Parent ID 328
Name s ——
Creation Time CIgmo 0Dy DInIIiIC
Creation Time R ————
Product Information Mame Microsoft®E WindowsE Operating System
Version
Company name Microsoft Corporation
Executing User
Executing User ID
\‘ ! 'l
q The Remediate button is also available from the Stacks view on page 99, which is
| available when an edge is selected.
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2. The following window displays:

REMEDIATE DEVICE WIN-MQHOCMRUD?2)

services.exe
EVENT 171303
PROCESS ID 452

Terminate process services.exe )

Remove 1 selected executable file

Delete file at path  |c:\temp\abcd exe

Handle persistent data (registry)

lodify registry value  [(Default)

F=

I-I'I-- -HI
| Cancel )
. S

3. Do one of the following:
a. Check the Terminate process checkbox to terminate the selected process. A warning message

displays.
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WARNING

SEMVICES exe
Do you want to I'EI'I'IDtE|}" rccess

services.exe ?

If an open program is associated with this process on the remote device,
closing it will result in losing any unsaved data.
If you end a system process, the remote device may become unstable.

Are you sure you want to continue?

Ty
Terminate process '.\ Cancel /.'

Click Terminate process to terminate the selected process.

b. Check the Remove selected executable file checkbox to delete the specified file from the device. A
warning message displays.

WARNING

Do you want to remotely delete executable file
\Device\HarddiskVolume1\Windows\System32\services.exe ?

Deleting an executable file will prevent its future execution on the target
device

Are you sure you want to continue? |

S
Delete file I.\ Cancel ,z"

Click Delete file to remove the selected file.

c. Check the Delete file at path checkbox. In the adjacent field, enter the file path on the device that
contains the file to be removed.
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v Delete file at path  |c-\templ\abcd exe

A warning message displays.
WARNING

You are about to delete file
c:temp

Are you sure you want to continue?

DGR | Cancel )

Click Delete file to remove the file from the specified path.

d. Check the Handle persistent data (registry) checkbox to clean the registry keys in Windows. In the
adjacent field, enter the value of the registry key to be removed or modified.

Handle persistent data (registry)

Value data should be provided in the required format, based on the value type selected in the
dropdown list, as follows:

» String for types REG_SZ(1), REG_LEXPAND_SZ(2), REG_LDWORD(4) and REG_QWORD(11).

e Base64 for types REG_BINARY(3), REG_LDWORD_BIG_ENDIAN(5), REG_LINK(6), REG_MULTI_SZ
(7), REG_RESOURCE_LIST(8), REG_FULL_RESOURCE_DESCRIPTOR(9) and REG_RESOURCE_
REQUIREMENTS_LIST(10).

Select the Remove key radio button to remove the registry key value.

Select the Modify registry value radio button to change the current registry key value. When
selecting this option, you must also specify the new value for the registry key in the gray box and
the key’s value type in the adjacent dropdown menu (for example, string, binary and so on).

4. Click Remediate.
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FortiEDR Connect

The FortiEDR Connect feature opens a console that provides direct access to a FortiEDR-protected device
running a v5.2 Windows Collector through a remote Shell connection. This enables you to respond to
incidents immediately and to perform in-depth investigation by running commands and scripts on the
device, collecting and downloading forensic data from the device, remediating threats, and so on.

A FortiEDR Connect console can be accessed from various FortiEDR pages that list devices, such as such as
the Inventory tab, the Threat Hunting on page 125 tab, and the Investigation View on page 92.

« A Connect to Device button appears at the top of these pages, which enables you to connect to the
device that is selected in the list.

* You can only connect to a single device in each FortiEDR Connect session. See Connecting to a
FortiEDR-protected device on page 109.

» A device can only be connected to a single session at a time.

e Each FortiEDR user can have up to ten FortiEDR Connect sessions open and connected at the same time
- each to a different device.

e Multiple users in your organization can open up FortiEDR Connect sessions (on the FortiEDR Manager),
but no more than 30 sessions can be opened at the same time.

To allow a user access to the FortiEDR Connect functionality, configure the following options. Otherwise,
the Connect to Device button is deactivated for the user.

* In Administration > Settings, ensure that the Allow FortiEDR Connect — remote shell connection checkbox
is selected, which enables the FortiEDR Connect functionality for the organization. See FortiEDR
Connect on page 334.

Allow FortiEDR connect - remote shell connection

» Select the FortiEDR Connect option in the user role capability to grant the user access to the FortiEDR
Connect functionality. See Users on page 277.

Ay
S L4
q This checkbox is available for Admin, Analyst, and Senior Analyst users only.

Connecting to a FortiEDR-protected device

The following describes how to open a FortiEDR Connect console session that connects you directly to a
FortiEDR-protected device.
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To directly access a FortiEDR-protected device:

1. A FortiEDR Connect console can be accessed from various FortiEDR pages that list devices, such as the
Assets on page 256 tab, the Threat Hunting on page 125 tab, and the Investigation View on page 92. The
operation of the FortiEDR Connect console is the same regardless of where it was accessed from.

2. Select the relevant device from the list.

You can only connect to a single device at a time, and therefore, if you select more than one device, the
Connect to Device button is deactivated.

You can only connect to accessible devices. For example, the Connect to Device button is deactivated,
when you select a disconnected device.

L}
‘?' If the list only displays a single device, then the Connect to Device button
|| automatically applies to that device without you needing to select it.

3. Click the Connect to Device button at the top of the list. For example, as shown below -
Connect to Device

A Shell window opens in a new browser tab. You may be requested to wait while the connection is
established.

The following displays after the connection has been established:

£2% FortiEDR Connect | lena-wind2019X64

The name of the device is displayed in the top left corner of the page.
The connection status and a timer is displayed in the top right corner of the page.

4. The main part of this page shows a terminal screen (black) with a prompt (>>>) at the top left where
you can type commands.
Clicking the Help button at the top right of the terminal screen displays a list of the commands (and
their parameters) that you can run. To run a command, simply type it (for example, %dir) with its
parameters and press Enter. Note that when the parameter should be Path, full path should be
provided. For example: c:\MyDirectory or c:\MyDirectory\MyPath.
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Commands help

Command

U

Mipconfig

Mipconfig_all

sodownload_file

Yupload_file

Yupload_and_run

wlogged_in_users

Volume in drive C

Volume Serial Number

Directory of C:\

T
= =

A
A
A
M
A
A
1
n
A
A
A

= = =

Parameters
P s pradn
Files path

Path to which to upload the
file, File in the "File Library"

Path to which to upload the
file, File in the "File Library"

Program

Description

AL I T QiU O S nie e 1ainaesn .
Returns IP information.

Returns extended IP information.

Downloads the file to your browser.

Uploads the file to the specified path.
Uploads the file to the specified path and runs it.

Returns a list of the logged in users.

Most of these are FortiEDR-specific commands. For example, typing %dir \ displays the following:

Files

Pythonid

In addition, you can use the %cmd command to open a command prompt view, as shown below.
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semd

C:\Windows\TEMP\_MEIZA4B02>

This view enables you to enter standard Microsoft terminal (cmd) commands, such as dir. For example,
the following displays:

C:\Windows\TEMP\_MEIZ4B@2Z> dir

Volume in drive C has
Volume Serial Mumber is

Directory of C:\Windows\

11:88 P

11: ..

11: p i-ms-win console-11-1-8.d11
11: - | i-ms-win e-gatetime-11-1-8.d11

11: P 1-ms-win ‘2-debug-11-1-8.d11
11: P : i in re-errorhandling-11-1-68.d11
11: 08¢ 12,792 apl-ms core-file-11-1-8.d11

In addition, you can run Python command at the prompt. The supported Python version is 3.x.

L}
‘?' The FortiEDR Audit Trail on page 314 feature records the connection of a

FortiEDR Connect session and every action that was performed in the session.

File Library pane

The File Library pane on the right enables you to upload, download and reuse files during FortiEDR Connect
sessions from/to FortiEDR-protected device. No other users can see these files or upload/download from/to
your FortiEDR Connect session. These files are deleted everywhere when you close the FortiEDR Connect

Console, as described in Disconnecting FortiEDR Connect session on page 114. A FortiEDR Connect session

enables you to:

» Upload a file to the FortiEDR File Library on the FortiEDR Manager.

e Upload a file from the FortiEDR File Library to a FortiEDR-protected device by running the %upload_file
or %upload_and_run command. For example, to upload a forensics script to the device.

» Download a file from the FortiEDR-protected device. For example, to download an executable from the
device for further inspection in a sandbox.

Uploading a file to the FortiEDR file library

The File Library page lists the files that you have uploaded to the FortiEDR file library on the FortiEDR
Manager during the current FortiEDR Connect sessions, and that are available to be uploaded on the
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devices.

To upload a file to the FortiEDR file library:

1. Open a FortiEDR Connect session with a FortiEDR-protected device, as described on Updating the
Collector version on page 405.

2. Click the Upload File button in the File Library pane. A standard file selection window is displayed.
3. Select a file and click the Open button.

You can hover over the question mark icon () at the top right of the File Library pane to display a
tooltip showing the file size limitation.

A progress bar is displayed while the file is uploading, as shown below. After the file has been uploaded

(100%), it appears in the list at the bottom of the pane.

File Library

1 Upload file

file_Name.yp

file_Name.yp

Name 1.yp

Name 2.yp

Name 3.yp

Name 4.yp

Name 5.yp

100KB

100KB

100KB

100KB

100KB

45%

A\,

* To stop an upload that is in progress, click the Delete button (m) next toits
progress bar.

» To delete afile that has already been uploaded into the file library, click the
il

Delete button (m) next to its name.

Uploading a file from the FortiEDR file library to a
FortiEDR-protected device

The following describes how to upload a file from the FortiEDR file library to a FortiEDR-protected device.

To upload a file to a FortiEDR-protected device:

1. Open a FortiEDR Connect session with a FortiEDR-protected device, as Connecting to a FortiEDR-
protected device on page 109.
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2. In case the file doesn’t appear at the file library, upload a file to the FortiEDR file library on the FortiEDR
Manager, as described on File Library pane on page 112. The File Library page lists the files that you
have uploaded to the FortiEDR file library.

3. At the promptin the FortiEDR console, enter the %upload_file or %upload_and_run command and
specify the path to which it should be uploaded, including the name it should have at the uploaded
location, and file name to be uploaded. For example:

>>> %upload_file C:\Windows\TEMP\_MEI37122\StatScript.bat StatScript.bat

Upload file StatScript.bat success.

Download a file from a FortiEDR-protected device

The following describes how to download a file from a FortiEDR-protected device.

To download a file from a FortiEDR-protected device:

Open a FortiEDR Connect session with a FortiEDR-protected device, as described on Connecting to a
FortiEDR-protected device on page 109. At the prompt in the FortiEDR console, enter the %download_file
command and specify the full path and file name to be downloaded. For example, %download _file
c:\SuspiciousDir\abcfilename

Files are downloaded directly to the Downloads folder on the device in which the FortiEDR Connect session
is running in a browser.

File Library

Name 1.yp  momnner 100KB

Name2yp  rommner 100KB

Disconnecting FortiEDR Connect session

Disconnect a FortiEDR Connect session in one of the following ways:

Clicking the Disconnect button at the bottom right of the File Library pane.

Closing the browser tab by clicking the Close button.

» Logging out of the FortiEDR Console.

Rebooting/shutting down the FortiEDR-protected device. For example, using reboot/sh.
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« Timing out. If you are not working with the FortiEDR console session, then at some point the session will
timeout and disconnect it.

After you disconnect, the message Device is not connected is displayed in the FortiEDR console session.

A connected button is then displayed which you can click to reconnect to the same session, as shown
below:

£2% FortiEDR Connect | lena-wind2019X64

Marking a security event as handled/unhandled

The following describes how to specify that you have handled a security event. When any FortiEDR Central
Manager user marks a security event as Handled, all users see it as having been handled.

1. Select the rule’s checkbox and then click the Handle Incident button or just click the flag icon of the
security event row. The Incident handling window displays.

[2 Incident handiing

Malicious

Unhandled

Activity audit

Fortinet Unhandled
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Ay
‘Q' If an exception was already defined for this security event, then the words event

includes exceptions are displayed at the top of the Incident handling window.

2. In the Classification dropdown list, change the classification for the security event, if needed. For more
details, see Manually changing the classification of a security event on page 116.

3. Inthe comments box, use free text to describe how you handled the security event.
4. Click the Save button.

Manually changing the classification of a security
event

You can manually change the classification of a security event, if needed.

1. Select the rule’s checkbox and then click the Handle Incident button or just click the flag icon of the
security event row. The Incident handling window displays.

FortiEDR 7.2.0 Administration Guide
Fortinet Inc.

116



Incidents

2. In the Classification dropdown list, change the classification for the security event, as needed.

3 Incident handling

530359 - powershell exe

Classificatio

Malicious X -

N P
Malicious

Suspicious
Inconclusive
PUP

Likely Safe

ACTIVITY QuUait

Fortinet Handle

3. Click Save.

After changing the classification of a security event, the Overview on page 90 pane displays the history of
any actions (Playbook policy-related actions and others) that were made automatically by FortiEDR. For
Playbook policy actions, the timestamp shows when the action was performed, as defined in the Playbook
policy. For more details about Playbook policy actions, see Playbook policies on page 244,

| * powershell.exe 3 Unhandled

N Audit
[ Handle Incident () o2 evicel

Excepti.. Status Classifi..  Event Certificate  Variants Device Action [} First Seen Last Seen

No results found

When the Fortinet logo appears next to an entry in the Overview on page 90 pane, it indicates that the
security event was automatically classified by FortiEDR. Security events that are manually classified do not
display the Fortinet logo.

Ay
S L4
q Notifications for security events are not shown in the Overview pane.
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Defining security event exceptions

The following describes how to create a new exception and how to edit an existing one.

Exceptions enable you to limit the enforcement of a rule, meaning to create a white list for a specific flow of
security events that was used to establish a connection request or perform a specific operation.

FortiEDR exception management is highly flexible and provides various options that enable you to define
pinpointed, granular exceptions.

Details describing how to edit an existing exception are described in Editing security event exceptions on
page 121. You can access the Exception Manager by clicking the Exception Manager button at the top of the
Incidents pane or by selecting SECURITY SETTINGS > Exception Manager. Additional options for managing
exceptions are provided in the SECURITY SETTINGS tab, as described in Exception Manager on page 207.

An exception that applies to a security event can result in the creation of several exception pairs.

An exception pair specifies the rule that was violated and the process on which the violation occurred,
including or excluding its entire location path. For more details, see Playbook policies on page 244

After an exception is defined for a security event, new identical events are not

triggered.
Ay m~
S s Security events that occurred in the past appear with an ™M icon to indicate that
q an exception has been defined for them, even though at the time they were
- P

triggered, the exception did not exist. This ™™ jcon on past security events serves
as an indication to you that there is no need to create an exception for it, since one
was already created (but after the event occurred).

In cases where an exception was defined for the security event but it does not fully cover all the existing
occurrences or raw data items of this event, a slightly different icon is displayed, as described and shown
below.

vy
‘?' When defining an exception for Listen on Port Attempt events, listening on 0.0.0.0

means listening on all interfaces. In such cases, you should use All Destinations.

Defining the scope of an exception

When defining an exception, it is important not to make it too broad or too narrow in scope, so that it
properly identifies and catches the data items that you want.

OF
If an exception does not cover all the raw data items for a security event, the M® jcon displays for that
exception. This can happen, for example if the exception was defined only on part of the collector groups
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and the security event occurred on devices that are not part of the collector groups on which the exception
was set.

In addition, the raw data items comprising a security event distinguish between data items that are covered

( : ) and not covered ( : ) by the exception, based on the exception’s current definition.

For example, if you see that the current exception is too narrow and excludes a raw data item that you want
to include in the exception, you can click the : icon and then modify and broaden the exception

sufficiently so that it will also include that raw data item. When you click the @ icon, the Event Exceptions
window automatically opens and displays the existing exception which can be broadened. Alternatively,
you can click the + icon to create another exception that will include the non-covered raw data item.
Clicking the + icon after the exception is opened using the covered icon next to the raw data item opens a
new exception from the perspective of that raw data item, meaning that it includes all the data that is
relevant for that raw data item, as shown below:
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EVENT EXCEPTIONS

Exceptions for event 49858
Last updated at 06-0ct-2020, 07:33 By lior

Exception 1 Exception2 <+

Created from Raw Data Iterm 12970979 of event 45858

Collector groups

e All groups All organizations

Destinations

1L

o All destinations

Users

Triggered Rules:

B Malicious File Detected

Type comments

i
Remowve Exception

<> 1/3Raw Data Items in the event are not coverad Cancal

In addition, when saving an exception, if the exception does not cover all raw data items for a security
event, a message such as the following displays.
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PARTIALLY COVERING EXCEPTION

Exception was saved successfully

Q} Flease note that 1 out of 3 Raw Data ltems in the event are
not covered with the exception

Non-covered items

Back to Exception JRSSES(ES

You can click the Non-covered items link in this message to open the Incidents tab in a new window, and
display only not-covered raw data items.

Device Control exceptions

Exceptions on device control security events are similar to other exceptions, with several additional
capabilities that enable you to set the exception on a device name, description, serial number or a
combination, as follows:

» The USB device's description is specified under the Process Name field.

e The device’s serial number is listed in order to exclude a specific USB device with the designated serial
number.

» The device’'s name is specified under the second Process name.

Editing security event exceptions

[ I
1. Click the Edit Exception WM button in the security event row for the exception you want to modify. The
following window displays:

FortiEDR 7.2.0 Administration Guide 121
Fortinet Inc.



Incidents

EVENT EXCEPTIONS

Exceptions for event 30558956
Last updated at 23-Mar-2020, 09:47 By Tzaf

Exception 1 +

Created from Raw Data lterm 558547576 of event 30558956

’]

Collector groups

® Allgroups All organizations

Destinations

@) All destinations

Users

Triggered Rules:

> Suspicious 5cript Execution

Type comments

Remove Exception

( cancel )

2. Modify the Collector Groups, Destinations and Users to which the exception applies and the pairs of
rules and processes that operate together to define an exception in the Triggered Rules area, as
needed.

For a multi-organization FortiEDR system, an Administrator can also specify whether the exception
applies to all organizations. The All organizations option applies the exception to all organizations,
regardless of whether or not the security event already occurred.
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3. Click Save Changes.

Viewing Application Control security events

Security events in the Incidents tab can be filtered to show only Application Control security events.
Application control security events are events that were triggered on rules that are part of the Application
Control policy. Such events do not necessarily mean that there was malicious activity but indicate an
attempt to execute an application that is listed in the user-defined blocklist. These security events are
displayed separately from other security events. Defining an exception for them can be done in a similar
manner as for other security events. The exception specifies which applications are blocked by its hash.

Incidents
Status Type
All - [A:uplil:ation Control -
All
Security Events
All Incidents Mobile Ing )

Application Control Events

Device Control Events

ThreatHunting Detection

Last Seen

Last 30 days -

Viewing Device Control security events

A\,

‘Q' Device Control capabilities are license-dependent. You may contact Fortinet
Support for more information.

Security events in the Incidents view can be filtered to show device control security events. Device control
security events are events that were triggered on rules that are part of the Device Control policy. Such
events do not necessarily mean that there was malicious activity but indicate USB peripheral access. These
security events are displayed separately from other security events. Defining an exception for them can be
done in a similar manner as for other security events. The exception can be set on the device name, vendor,

serial number or a combination.
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Incidents
Status Type Last Seen
All v { Device Control Eve - Last 30 days v
All
Security Events
All Incidents Mobile Ing y

Application Control Events

Device Control Events

ThreatHunting Detection

Other options in the Incidents viewer

Option Description

Sorting incidentss Click any column name to sort security events. For example, you may
want to sort by process and collector in order to see the history of
everything that happened to that process on that device.

Free text search Enter text in the search field to search by process, device, or ID.

Time Filter Click the down arrow in the Time Filter to display a list of time period
options. The default is Last 30 days.

Deleting incidents ﬁ
Select an event and click the Delete button (= ) to completely delete a

security event from the FortiEDR system.

Unless you are having storage capacity issues, we highly

s";’, A deleted incident cannot be restored or retrieved.
- recommend just hiding incidents and not deleting them.

Exception Manager Click the Exception Manager button (Exception Manager —») at the top
right corner to access the Exception Manager on page 207.

Investigating incidents Click the ( . ) button for a graphical and
Investigate -
Investigate

interactive view to further drill down the chain of activities involved in the
event. See Investigation View on page 92.

Fortinet Inc.
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Threat Hunting

FortiEDR’s Threat Hunting functionality enables you to search for many types of Indicators of Compromise
(I0Cs) and malware across your entire environment in order to enable enhanced detection. Searching can

be based on various attributes of files, registry keys and values, network, processes, event log and activity
event types. Search operations apply to both Windows and Linux operating system activity.

Threat Hunting is ideal in situations where you have identified malware on one endpoint and want to search
throughout your organization to determine whether this same malware exists on another endpoint, even
though it may not be currently running (stealth mode) or in situations where you would like to hunt for the
existence of a specific loC within your organization.

Ay
‘9' Threat Hunting is a license-dependent add-on and supports only Collectors that run

FortiEDR 5.0 or later. You may contact Fortinet Support for more information.

Threat Hunting utilizes activity events, which specify an action taken by an entity. Each type of entity may
be involved in a variety of types of actions. An activity event consists of a source (usually a process), an
action (the activity event type) and a target (Process, file, Registry key/value, network item(, where the
source performs the designated action on the target.

For example, when a process runs, it can perform various actions on files, such as File Open, File Read, File
Delete and so on. In this case, the process is the source, and it performs an action such as File Open on a

target File.
Activity events are not the same as the security events identified in the Incidents
NP tab. Unlike Incidents tab security events, which are only reported in the Incidents tab
S L4 .. .
q as they occur and are detected, activity events are continuously collected based on
- a wealth of data, activity and actions occurring in your system and the chosen

Threat Hunting Profile. You may refer to Threat Hunting on page 233 for more
information.

FortiEDR categorizes the various actions that can be performed into the following categories:

Action Description

Registry Key Actions All targets are either registry keys or registry values and all actions are
registry-related, such as Key Created, Key Deleted, Value Set and so on.

File Actions All targets identify the target file on which the action was performed and
all actions are file-related, such as File Create, File Delete, File Rename
and so on.

Process Actions The target is another process and all actions are process related, such as

Process Termination, Process Creation, Executable Loaded and so on.

Network Actions The target is a network item (such as connection or URL) and all actions
are Network related, such as Socket Connect, Socket Close and Socket
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Action Description

Bind.

Event Log Actions The only action is Log Entry Created and relates to the logs of the
operating system - Windows and Linux.

The Threat Hunting page contains the following areas:

THREAT HUNTING
catesory vewce & e
Y i categores v CollectME-0-T... v Last 30 days v !
v

AllActivity (18K)  Process (6)  File (78)  Network (477)  Registry (13K)  Log (0)

000 coose cotumns

CATEGORY  TIME = os DEVICE NAME TYRE BEHAVIOR PROCESS AND ATTRIBUTES TARGET EVENT ATTRIBUTES

(3] 29-Jan-2024 18:10:45 ANDREYTXP Socket Close SYSTEM > B 105110315:59.. 5 R 00000 051 305 15 56603
29.Jan-2024 18:10:45 ANDREYTXP Socket Accept SYSTEM 5 o= 10511031559, G0 000000000 1057105 1555603

= 29-Jan-2024 18:14:39 ANDREYTXP File Rename wmiprvse.exe S 2 FrameWorklog e Winbowsisysiem
2] 29-Jan-2024 18:16:02 ANDREYTXP Socket Close SYSTEM 9 B 10511081889, 500 booo0 a0 1a 0612
) 29-Jan 2024 18:16:02 ANDREYTXP Socket Accept SYSTEM 5 2 10511031559, 50 RERP 000000600 1051105 1558612
(3] 29-Jan-2024 18:24:10 ANDREYTXP Socket Close SYSTEM > B 10511031599, 5 REPP boome 0 051 05 15 50621
3] 29-Jan-2024 18:24-10 ANDREYTXP Socket Accept SYSTEM o= 10511034559 Joonesre [L[? 900000 SOI o 05150515 56621
s 29-Jan-2024 15:25:09 ANDREYTXP Value Read svehost exe > & e FKLMSOF TWARE\Ciasses\CLSIDS0ACE

e Filters on page 126

¢ Facets on page 138

e Activity events tables on page 141

» Details pane on page 145

* Investigation View on page 155

» Exporting threat hunting logs on page 166

Filters

The Filters area enables you to define a query that filters the activity events to display in the result tables. It
comprises the following filters:

cateory pevie & e
All Categories ~ All Devices v Last hour v !

Ay
‘9' This area also enables you to save queries and to redisplay saved queries, as
| described in Saving queries and saved queries on page 131.
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Filter Description

Category The Category filter enables you to filter the activity events by their
category.
CATEGORY
All Categories W

« All Categories

Frocess
hawi

File
a2
iviley  Registry

fptl  Network

eral
Lﬂg
CORE ,:““l
Device The Device filter enables you to filter by a specific device[s].
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Filter Description

DEVICE

ACWIn10A v

ACWin10A

Q lﬁesrcl"
(85 f
ZEWINDOWSVICTIM
ABCDEFGHIJKLMNO

v ACWIN10A

ACWIN10B
ACWIn10C

ACWINZ01 2A

Free-text Query This filter enables you to specify a free-text Lucene-syntax query to filter
the results. You can also convert STIX JSON and STIX XML syntax
queries into Lucene syntax using the Convert Query button.

=]

For Lucene-syntax queries, to simplify definition, the free-text query
filter has an auto-complete helper dropdown list that contains all the
available activity event fields, as well as available syntax operators.
Simply start typing to see a dropdown menu of options. The automatic-
complete helper guides you through the process of creating a query by
displaying appropriate options in the dropdown menus, such as fields
and operators when appropriate.
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Filter Description
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name|
Device.Mame
_ o Target Process... (280.1K)
Device.OrganizationName
g Eit.exe 58.5K
1 Source.Process.OperationSource.RemoteEndpoint. MachineName = T 462K
2 Source.Process.OperationSource.RemoteEndpoint.Username chrome.exe 22K
Source.Process.File.Mame rearns.exs T
proxyhost.exe 10.5K
Source.Process.File.Threathame
¥ More(13)

Source.Process.File.CompanyName

For JSON and XML syntax queries, use the Convert Query button to
convert the query into Lucene syntax.

Convert Query
2]

You can then select the file type and paste the query or upload a JSON or
XML file in the CONVERT QUERY window. The following indicators are
supported and will be translated into Lucene syntax: hashes, file names,
files size, paths, IPs, usernames, registry keys, URLs and domain names.
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Filter Description

CONVERT QUERY

Type TAXII 2 (JSON) v

Convert Query ® Paste query Upload query

r/- \i
[ cancel )

Time The Time filter enables you to filter for a specific time period. The default
is the last hour.

TIME

Last 24 hours
N
Last hour
Last 12 hours
" Last 24 hours
Last 7 days
Last 30 cays

Time range...
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Filter Description

NP When you run a Threat Hunting query with a Time filter,
S L4 . . q
q the response time can vary depending on the period and

the amount of collected data. When the time is set to
Last 30 days, the query can run for a few minutes.

To clear the contents of all the filters in the Filters area, at the far right of the page, click the eclipsis icon ( f)
and select Clear all.

Saving queries and saved queries

After filtering the activity events displayed in the result tables, you can save the query to be redisplayed
when needed. Saving a query in this manner also enables you to define it as a scheduled query in order to
automate the process of threat detection.

Out-of-the-box queries, provided by Fortinet, are marked with the logo

NP FiIATINET | you can change the scheduling of a query defined by Fortinet and/or
‘Q' disable the execution of a query. However, the query itself and its name cannot be
- edited. If you need to edit one of the Fortinet-defined queries, copy the query itself

and paste it in a newly created query. In this case, it is recommended to disable the
original Fortinet-defined query.

To save a query:

1. Use the filters to display the desired filtered events in the result tables.

2. Inthe Filters area, at the far right of the page, click the ¥ button and select Save Query. The following
displays populated with the current filter definitions. The Category, Device, and Time dropdown menus
show the filter selections and the box underneath it shows the actual query string. For example, as
shown below:
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Save Query

Query Name | oC for Bad Wolf

Description

Tags +

Qrganization ® ensilofordev All Organizations

Full Query

Category Device Time

Network v v Last hour v

BadWolf.exe|

Community query

Scheduled guery

3. Fillin or modify the definitions of this saved query, as follows:
* Query Name: Enter any free text name describing this query.
» Description: Enter any free text description of this query.

» Tags: Enables you to assign one or more metadata tags to this query. You can assign a previously
defined tag to this query or define a new tag. These tags can then be used for general information
purposes and for searching through queries in the Incidents tab.

Ay
S L4
q These tags only relate to saved queries.

Tags +

Click the Add button to assign tag(s) to this query. The following displays:
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Tags

Q b

Credentials

+ new ta '5- /

All previously defined tags (for any query in your organization) are listed for your selection.
If this tag is assigned to this query, a checkmark appears on its left; ¥ Credentials

To assign a tag to this query, simply click on it. It will then show the checkmark to its left. Each tag
that you assign appears as anicon, as follows:

Tags BadWolf Credentials
Q pea
v Badwolf
@Creden[ials _}/ ‘i'

(" JAdd new

To unassigned a tag from a query, click on it in the list so that its checkmark is removed or hover
over it to display a Cancel button (X) and then click the Cancel button (X) to delete it, as shown
below:

Tags ‘Ij +

To create a new tag, click the + Add new tag button.

To modify the name of the tag or to delete it from the list (and from all queries to which it was
assigned previously in the organization(s) of the logged in user), hover over it and click the Edit or

Credentials L d 'ﬂ'

E

Delete icon, as needed.
Click the Apply button to assign all the selected tags (with checkmarks) to this query.

» Organization: Specifies the name of the organization in a multi-organization FortiEDR environment
when the logged in user has a Hoster role. In a single-organization FortiEDR system, this field does
not appear.

e The Category, Device and Time dropdown menus show the filter selections and enable you to
modify the selection.

» Query String Box: Displays the actual query string according to the selections made above and
enables you to modify it.

« Community Query: Select this option to specify that it is shared with the entire FortiEDR community
including other organizations.

V) After you have defined a Community Query and saved it, you can edit it.
‘9' Unchecking the Community Query option means that this query is no longer
|| available to the FortiEDR community. If however, a community member

already copied this query, they will still have it, even after you unshare it here.
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» Scheduled Query: Mark this option to automate the process of detecting threats so that this query
is run automatically according to the schedule that you define. A security event is automatically
created in the Incidents tab upon detecting threats (query matches). Notifications are sent
according to the security event’s definition, such as via email, Syslog and so on. You can also
configure playbook actions for the triggered security events from the scheduled query.

Enabling this checkbox shows the following options:

+ ScheduledQuery

Classification Suspicious ~
Repeat every 1 v |Weeks v
on Sun | Mon | Tue | Wed | Thu | Fri | Sat | at 12:00 AM v

The time range of the activity events that this query matches is determined by the frequency of the
schedule. For example, if you define that the query automatically runs once a week, then each time
it runs, it will match and create a security event for all the activity events in the most recent week;
the same goes for it being scheduled once a month —in this case, the query will match all the
activity events in the most recent month.

Define the scheduled query, as follows:

Field Definition

Classification Select the classification of the Security Event to be issued when
the scheduled query has run and found matches. The Classification
specifies how malicious the security event is, if at all.
Classifications are initially determined by FortiEDR automatically or
manually and are shown in the Incidents tab, as described in
Overview on page 90. They can be:

e Malicious

* Suspicious

¢ Inconclusive

» Likely Safe

e PUP (Potentially Unwanted Program)
e Safe

Repeat Every/On These options enable you to define the frequency and schedule
when this query will be run. For example, to repeat the query every
week on Sunday, make the selections shown in the screen above.

Trigger Playbook Actions Specifies whether to allow FortiEDR to trigger the corresponding
Playbook action of the triggered security event from the scheduled
query. Enabling this checkbox allows FortiEDR to automatically
apply the action of the Playbook that is assigned to the Collector
Group the triggering device belongs to.

Configure the following options:
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Field Definition

* Terminate Process—Specifies which process in the Activity
Event, which resulted from the execution of the saved query,
should be terminated:

e Source Process
e Source Process Parent
e Target Process

» Delete File—Specifies which file in the Activity Event, which
resulted from the execution of the saved query, should be
deleted:

» Source Process File
e Target File
e Target Process File

e Target Executable Image File

4. Click Save to save this query so that it is available to be redisplayed, as described below. The system
runs the query immediately in order to verify that it is functional.

Ay

If the system detects a large quantity of events about which to send
notifications, then a warning message is displayed suggesting that you refine the
query so that there are fewer matches. The reason being that extremely large

quantities of notifications may be more of a hindrance than a help.

To display a saved query:

1. In the Filters area, at the far right of the page, click the eclipsis icon () and select Saved Queries. The
following displays listing all the queries that were saved using the Save Query option.

SAVED QUERIES

‘ Search query

ElFFortinet

[ Delete
NAME

140 (yoselTAXII2 +) # 2

140 (yosefTAXII2 +)# 1

140 (yosefTAXII2 +) # 11

<]
R

140 (yosefTAXII2 +) # 01
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TAG

MATCHES

o

[}

0

[}

DEVICES »

0

0

0

2xCommunity | 3 Threat Intelligence Feed

LAST RESULT

01-Mar-2023 02:34.03

01-Mar-2023 02:34.02

14-Dec-2022 12:25:02

14-Dec-2022 12:25:01

(f)Scheduled | Unscheduled

REPEAT EVERY

01-Mar-2023, 02:34 by Fortinet

01-Mar-2023, 02:34 by Fortinet

14-Dec-2022, 12:25 by Fortinet

14-Dec-2022, 12:25 by Fortinet

STATE

( Close )
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For each saved query, this list shows the quantity of matches detected (MATCHES), the quantity of
devices on which these matches were detected and the last time the query was run (LAST RESULT).
These three columns are highlighted in gray, as shown above. Additional details about the queries
definition are also displayed in each row. Out-of-the-box queries, provided by Fortinet, are marked with
the Fortinet logo FRATINET

2. Click on the row of a saved query to display additional details about that query’s most recent run. For
example, as shown below:

There is a Behavior BadWolf 2K 15 04-Feb-2021, 05:35 04-Feb-2021, 05:35 by Galit

zory all Jevice All devices me Last hour

_exists_: Behavior

3. You can filter this list of saved queries by typing into the Search field and/or selecting one of the
following options:

a. FiZRTINET /user: To select FEfATINET defined queries. Selecting User filters by saved queries
that were created by a user.

b. Community/User: To specify that Community Queries are listed in this window, click the Community
option. A Community Query is one whose Community Query field was marked when it was

created/modified. & appears in the list next to Community Queries. User refers to queries that are
not Community Queries, meaning that each one is only available to the Organization for which it
was created.

c. Threat Intelligence Feed: To specify that Threat Intelligence queries are listed in this window, click
the Threat Intelligence Feed option. Upon each retrieval of Threat Intelligence Collection data, one
or multiple queries with the name Collection ID/Name (Connector Name) #x are created by the
Threat Intelligence Feed connector that you configure under Administration -> Connectors. As one
Threat Hunting query can include only 150 to 1000 conditions, depending on the indicator type,
FortiEDR may create multiple Threat Intelligence query entries for the same Collection.

d. Scheduled/Unscheduled: To specify that Scheduled Queries are listed in this window, click the
Scheduled option. A Scheduled Query is one with the Scheduled Query field marked when it was
created/modified.

4. You can modify a saved query by hovering over it. The following tools are displayed on the right of the

row:

|. 228 3 baren-2021, 0415 (DIdeyat 000 04 Fet-2021, 0418 by Gait @ Enabled % R |
Run Now A To run and detect activity events now according to this saved query.
Edit & To edit the Saved Query definition.
Delete & To delete the saved query. Multiple queries can be deleted at once by

marking the checkboxes on the left side of each row and then clicking

th = icon atthet f the window.
eDeIete con at the top of the do

5. Toenable/disable a saved query, mark the checkboxes on the left side of the relevant rows and select
the Enable/Disable option in the Set State dropdown menu.
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Set statew
Enable

Nicahla
Uisable

Scheduled queries

Scheduled queries enable you to automate the process of detecting threats so that it is activated
automatically according to the schedule that you define. This will enable timely and continuous detection
and notification of threats. A scheduled query runs automatically when you define a query as a scheduled
query, as described below. Each time it runs and detects a match, it generates a security event in the
Incidents tab, and sends a notification (via email, Syslog and so on) according to the security event’s
definition.

The security event that is generated by a scheduled query in the Incidents tab is similar to a standard
security event, except for the following:

The Create Exception (*" ) button is not available as you cannot define an exception for saved query
security events.

In the Process View m of the Incidents tab, a saved query security event shows the name of the
saved query instead of the process name.
The classification (in the CLASSIFICATION column) is determined by the definition of the saved query.

In the same manner as other security events it indicates the quantity of devices (in the DEVICE column)
on which this type of activity events were found. All other aspects of a saved query security event are
the same as other security events.

Clicking the Threat Hunting option on the right side of the saved query security event in the Incidents
tab displays the Threat Hunting tab and the saved query that was run, because that is what triggered
the security event.

The Incidents tab does not show any advanced data for a saved query security event.

Triggered Rules: When a saved query security event is selected in the Incidents tab, the Triggered Rules
pane on the bottom right of the page indicates that this security event was triggered by a Scheduled
Threat Hunting Query, as shown below:

The name of the saved query is listed below it. Click that saved query’s name (for example, Credential
Access (Edited)) to display additional details about this saved query, such as its description and the
tags that were defined when it was created/modified, as shown below:

Triggered Rules

= (@ Scheduled Threat

= Credential access [Edited]
Threat Hunting query that is scheduled to run has found matches.

BadWolf

Press on the Threat Hunting icon Gi to switch to the Tl%eat Hunting
tab populated with the query results for further analysis. In case the
gquery needs adjustments, edit the query at the Threat Hunting tab ->
Saved Queries
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* In the Device View E of the Incidents tab, a saved query security event appears under the devices
that were affected. It also shows the name of the saved query instead of the process name.
If this security event was triggered for more than 100 devices, then this row shows a notification
indicating that they are not all listed here and that you can use the Threat Hunting option on the right of
this event’'s row to investigate further.

Facets

As expected, the continuous, realtime collection of Threat Hunting data produces numerous activity events.
The sheer volume of activity data makes working directly with these activity events almost unmanageable.
Therefore, FortiEDR uses facets to summarize the data displayed in the results tables. Facets are
predefined in FortiEDR and represent the same data that is displayed in the results tables, but in an
aggregated form. As such, facets represent the aggregation of the values in the results tables.

Device Name (19) 1 Type (24) 1 Behavior (12) T Source Process... (293) %) Source Process Signed TargetFileMa... (1K+) =} TargetFile Path (1K+) 3| Target Process Signed
717K SocketClose 855K log deletion 918 sysiem 833K Signed 264.9K utilsdil.dll 435K program files\fortinet'f.. 4.9K Signed 16.6K

36.0K Socker Connect E0.TK later: 452K Ursigned 43K Unsigned a1

33T Library Loaded 333K 393K

333K Key Created 358K EEET

287K Socket Bind 314K execution 16 209K

¥ More(11)

Each individual facet pane summarizes the top five items for that facet. For example, in the Type (action)
facet below, the facet lists the top five actions, based on the filters applied in the query. The number at the
top in parentheses () indicates the total number of different values for this facet in the results table, in this
case 24. In this case, the top five actions are Socket Close, Socket Connect, Library Loaded, Key created, and
Socketind.

Facet can show the bottom five instead of the top five. In order to switch from the top five to the bottom

five for this specific facet, click on the arrow on the right side of the number

Type (24) i
Socket Close B5.5K
Socket Connect B0_TH
Library Loaded 383K
Key Creared 358K
Socket Bind 3 AK

The filters applied in the Filters area affect the results displayed in the Facets and Results Tables areas.
The displayed facets vary according to the filters used in the Filters area.

You can click the More link to display additional facets.
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81
48
28

A
Behavior (83) =L Type (22641) =) Device Name  (22641) =, Target Process Na... (329) =,
credentisl sccess 63 File Resd 10725 12878 givexe
privilege escalation ° File Write 2899 9763 ehrome.exe
scripting 4 File Create 2674 conhostexe
lateral movement 3 Executable Loaded 2367 svchostexe
reconnaissance 2 File Delese 1474

You can click the

backgroundsaskhost.exe

Filtering using facets

14
12

Registry Name

00030226
0003031F

00036604
00066659

001fésda

button to minimize the Facets area.

(1140) =T

1
1
1
1

Registry Key Path  (1140) =)
hkim\syscemiconirolset... 182
hkim\software\microsoft.. 88
hkim\software\microsoft.. 70

hkim\system\controlserd... 48

Registry Data

0
3

65538

(1120) =)

560

osoft.. 46

b

Registry Value Ty... (1140) =)

sz
dwe
bin
exsz

qw

411
200
258

50

57

Facets provide an easy-to-use mechanism to aggregate the results in the Activity Events tables. In addition,

you can also further narrow the results in the Activity Events table directly from the facets by including or

excluding specific values. For example, when you hover over an item in a facet pane, a green and red button

appear in its row. Click the green plus button to include that item as a filter or click the red minus =

button to exclude that item as a filter.

Type (22641) =]
Filz Read 10725
File Write 2899
File Create —|
Execurable Loaded 2367
File Delete 1474

Then, click the Apply button.

& Type

63 File Read 10725
s File Wrice 2899
scripting 2 File Create x

lateral movement 5 Executable Loaded b 2367

reconnaissance File Delete 1474

An item highlighted in green

~ Signed

yet been applied by clicking Apply.

Clicking the Apply button applies the additional filtering criteria to the threat hunting query. In addition, it
creates a chip (indicated by the arrow in the following picture), which represents that additional filter and

(22641) 3| Device Name

(22641) =)

Target Process Na... (329) %] Registry Name
12878 gitexe 81 00030226
conhestexe 22 00036502
svchost.exe 14 000b6659
¥ More(10)
File Create

2670
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(1140) =

1

1
1
1
1
1

Registry Key Path  (1140) =)

hidmts
Fiimte

klmtsofov

hiimsystem\:

controlsesd... 48

Registry Data

microsoft...

70 3
65538

(1120) =

Registry Value

Ty... (1140) |

indicates that it has been marked as an
inclusion filter, but has not yet been applied by clicking the Apply button. An item highlighted in red

indicates that it has been marked as an exclusion filter, but has not
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displays it at the top of the Facets area. In the example below, the query has been further filtered to only
show the File Create type of action. Each chip is also part of the threat hunting query.

r.y I' File Create -(—

Type (2674) =| Device Name (2674) = Source Process Fi... (2674) =)
| File Create 2674 1354 1410
1320 . 784

453

9

8

Source Process Signed Source Process Architecture Source Process P... (2674) =1

~) Signed 2670 % 6dbit 2521 adobe reader and acrobar... 1

=} Unsigned 4 32 32bic 153 dropbox update 2
forticlient aute-update 3g... 3
slack 3

microsoft edge &

Each chip has either a green or red border on its left side to indicate whether it was defined to include

(green) or exclude (red) that item in the filter.

Each Facet pane may have a green or red left border to indicate whether it has been applied in the query,

meaning that the displayed results are filtered by it.

.Y I’. oe: File Create l NOT Source Proces er: administrators, ensilolgalit
Type (1264) =) Device Name (1268) =} Source Process Fi... (1264) =|
I File Create 1264 (-] . 784
54 local system 483

| o

8

Source Process Signed Source Process Architecture Source Process P... (1264) =1

¥} Signed 1260 o 6dbit 1216 adobe reader and acrobar... 1
=) Unsigned 4 32 32 bie 48 forticlient auto-update ag... 3
slack 3
rnicrosoft edge 4

microsoft office 4

You can define an unlimited number of chip filters, with an AND relationship between multiple filters. Each
facet can create up to two chips, one for the inclusion of values and one for the exclusion of values.

If two values have been added to the query from the same Facet pane, the relationship between the values
in the chip is OR. The following example shows that the query includes activity events in which their Target
Process Name is either chrome.exe or teams.exe, which is shown below in both the chip and in the facet.

l Target Process Mame: chrome.exe, teams.exe
pe (2.5K) =l Device Name (2.5K)
ocess Termination 1.3K
ocess Creation 1.3K

=l Target Proces... (2.5K) =l

1.3K I chrome.exe 1.8K
535 I teams.exe 750
467
191

Hovering over a chip enables you to remove, disable or copy it, as follows:
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Tool Definition

Remove The chip is removed and the Facets and Result tables are updated
accordingly.

Disable A disabled chip no longer affects the results. The Facets and the Results
tabs are updated as if the chip was removed and the chip appears as
follows:

l Type:
Copy The chip content is copied to memory and can be pasted into the query

for further editing.

In order to enable a disabled chip and update the results according to its criteria, click the Enable v icon.

Activity events tables

The results presented in the tables in this area are activity events. The activity events table area contains
six tabs, each representing one category of activity events, as follows:

All Activity (14.94M) Process (806.4K) File (10.85M) Network (2.74M) Registry (538.1K) Event Log (15.6K)
CATEGORY TIME + 05 DEVICE NAME TYPE BEHAVIOR PROCESS AND ATTRIBUTES TARGET
E:!. 12-Jan-2021, 06:05:16 E File Read selfelectController.exe ¥, 55 downloadermulticast
= 124an-2021, 06:05:16 EU- 3 File Read TaskbarX.exe - 2 Accessibility.api
2 12-Jan-2021, 06:05:16 EU 3 File Read dilhost.exe von oleace.dll
= 124an-2021, 08:05:16 WPC File Read uihost.exe vo& Local State
Category Definition
All Activity This tab lists all activity events, based on the filters defined for the

Threat Hunting query. The number in parentheses () specifies the total
number of activity events, based on your query criteria. This total equals
the sum of the activity events in the other five tabs. Each Category of
activity events is represented by a different icon, as follows:

* m Process
¢ E‘File

an®
=a= Registry

* @ Network
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Category Definition
* D Log

You can hover over the icon in the Process and Attributes column to
temporarily display additional details about the source process, including
whether it is signed, its signature, issuer and so on.

Process And Attributes Target
msiexec.exe v :::"1, ldap-brute.nze
»
MSEEXECSE <) signed (valid)
Sitexe ;,;3: BOF DEII;I:E::‘;"B-:‘E;J.EEEEED."‘.E}EH EF6FEFAATS40
Mmsiexec.exe -~

Micrasaft Windows

Ay
‘9' There are several types of attribute icons, such as

Signed/Unsigned.

Process This tab shows all matching activity events of category Process.

File This tab shows all matching activity events of category File.

100 choose Cotumns

5580

Network This tab shows all matching activity events of type Network.
Registry This tab shows all matching activity events of type Registry.
Event Log This tab shows all matching activity events of type Event Log.

Each table contains a row for each matching activity event and each table includes different columns
according to the category.

You can select which columns should appear in any of the tables using the Choose Columns option at the far
right of the page. You can type in the Search box to help narrow the list of columns that display.
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I]I]I] Choose Columns

05

Device Name

Type

Behavior

source PID

Each activity event may also be a part of a behavior and/or a MITRE Technique. A behavior indicates that
this activity event is part of a specific behavior as determined by FortiEDR. A MITRE type (Technique or
Tactic) indicates that the activity event is part of specification of a technique and tactic as classified by
MITRE.

The activity events that have such behaviors and/or MITRE indications have values in the related columns in
the activity events tables, as shown below:

15 DEVICE NAME TYPE BEHAVIOR MITRE TACTIC MITRE TECHNIQUE PRt
C File Delete Log deletion Defense Evasion Indicator Remowal on Host: File Deletion sla
File Read Credential Access  Credential Access  Unsecured Credentials: Private Keys prc

When an activity event has a related MITRE indication, it is indicated in the Details pane on page 145 (see
below). You can hover over the associated icon to display more details.
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m Process Creation | Privilege escalation

Summary =3 SearchApp.exe += dllhost.exe

I:l Status W Running Internal IP 10.0.0.22
~PC Uptdme 2d, 48min, 28sec v
¥
I SearchApp.exe PID-16372 TID-18348 vy &
Path CAWindows\SystemApps\Microsoft. Windows.Search_cw5Sn1h2txyewy\Se...
Executing user
Product Microsoft® Windows® Operatng System
SHA1 BASECAADASE3I601255D4043CCARM EGEDT1B41C3D
Command line
ServerMame:Cortanalll.AppXBz9rjmS6hwdbsbneegwlkynoc2 Sowr St....
Process Creation
E File Read | Credential Access
x
Summary »3 proxyhost.ex 120, 04:23
m Mitre Techniques
echnigue
D Status
— Unsecured Credentials: Private Keys, T1552.004
PC Up time Tactic 5
A Credential Access, TADOOG
I proxyhost.exe e
Path C:\Program Files (xB&\LANDesk\Shared Files\proxyhostexe
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Filtering using activity events tables

The activity events tables area can be used to add filters to the query in a similar manner as facets.

When you hover over an item in the table, a green and red button appear to its right. Click the green plus

button ()to include that item as a filter or click the red minus button (=) to exclude that item as a filter.
For more details, see Filtering using facets on page 139.

BEEHAVIOR SOURCE PID PROCESS AND ATTRIBUTES

ation  Privilege escalati... 5056 kg ) OUTLOOK.EXE .

ation Privilege escalati... 19192 WhatsApp.exe v

Details pane

You can click anywhere in a row in any of the Activity Events tables to display more details about the
specific activity event in a Details pane on the right. The selected row is marked by a green border on its
left.

THREAT HUNTING

caTEGORY oevice name e
i
Y o Categories ~ v Last 24 hours ~

v
All Activity (14.94M)  Process(806.4K)  File (10.85M)  Network(2.74M)  Registry (538.1K)  Event Log (15.6K)
= R
100 choose columns (5 e fead
N
e Summary  +3ToskbarKexe  ¥sAccessibiliy.api 124802021, 06:05:16
CATEGORY TIME + 05 NAME TYPE PROCESS AND ATTRIBUTES TARGE EVENT ATTRIBUTES
e o e = Status B Running Internal IP 1
: S m SOURCE P ATH "~
[@  124an-2021, 0605116 EN.. FileRead selfElectController.exe 2 o les [El— r o COETE .
= y P SOURCE PID PATH st a .
2 124an-2021,06:05:16 EV. FileRead Taskbarx.exe o ) Program Files .. {0 TaskbarX.exe PID-22900 TID-14206 5 =
G - ) e . - ., SouRCERD PaT s Path c \Downloads\TaskbarX_1.6.2.0TaskbarX.exe
2 -jan-2021, 06:05:16 V. FileRea ostexe 8 Olew 17300 Windows\Syste..
Executing user

e SOURCE PID PATH HasH Parent D-2.. ( Actual

[@  124an-2021, 0605116 Ll FileRead uihostexe S Lon 7315
Product Taskbark

" SOURCE PID pATH HaSH SHAT SEQE7421875BAGC2E10078BC4E0BIDAZI004988F

[@  124an2021, 060516 U. FileRead uihostexe S Pre g1s i
ths=d 0:0;
asp=300 -prbo=0 5tbo=01-Ir=400 -obir =400 -5r=0 -frorc=1

“ SOURCE PID PATH HaSH
[@  124an2021, 060516 U. FileRead uihostexe S Sew g1s
[2  124an-2021, 0605116 u File Read uihost.exe SR Low  ppacere o e
= . - o v 7s12 - File Read

The Details pane for an activity event contains a Summary tab, one or two other tabs, and the Investigation

Investigate -

View ( ) button, as follows:
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.
Action
Behavior e E!- File Read | Credential Access [}
and MITRE
- Summary = MEIEKEC. B1e = ms-sql-empty-pa.. 2020-Oct-25 08:31:23
[e=] Status  Running Internal (P 10.212.134,130,192.168.0....
Uptdme 3d, 1h, 23min, 24sec o
Fa ia
I msiexec.exe PID-4424 o
Source
Path C:\Windows\System32\msiexec.exe
Executing user Local Systern
Froduct Windows Installer - Unicode
SHAT 5D6102F3A1F0EE2CTTISBFCZBICT ADADDA3SFIN
Comrmand line n
Action
(Event Type) File Read
[2 ms-sql-empty-password.nse
Target =
Path \Device\HarddiskVelume3\Pragram Files\Fortinat\FartiEDR\scriptsims-s...

* Summary tab: This tab specifies a summary of the activity event. At the top of the tab, it shows details
about the endpoint, including the endpoint and its IP, path, operating system, and so on. The area below
the endpoint section shows the source process and its detail. The area below the source graphically
shows the action again, which is the activity event type, as well as some additional data regarding the
action, if any. The area at the bottom of the pane shows the target and its details. You can click the
Expand (') or Collapse (#*) arrows in an area of this pane to show or hide additional relevant details,
respectively.

FortiEDR 7.2.0 Administration Guide 146
Fortinet Inc.



Threat Hunting

¢ Process tab: This tab shows additional details about the source process.

(2 FileRead  EETEIEIESss [

Summary % MSieXec.exe ¥+ ms-5q|-empty-pa... 2020-0¢01-25 08:31:23
Iy I msiexecexe  PiD-4424 & =
Integrity level "“ﬂ System
SHA1 SDe102F5ATTOEDBZCY T 35BRCZBECT1ADADDAISFDA
Command line N
File Version Mame Windows Installer - Unicode

Information = ; ;
Company name Microsoft Corporation

File Description Windows® installer

File Version 3.0.19041.1 (WinBuild.160101.0200)

5TD Our Console

5TD In Console

STD Err Console

Source Process File Bxtension Bxe

Source Process File Original YDrevice\HarddiskVolume3h
Drive

Source Process Volume Type Local

Source Hle Signature Time Valid v

e Target tab: This tab only displays if the target is of type Process or File, and details additional data
regarding such.
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E File Read  Credential Access m

Summary ~ s¥msiexecexe = ms-sqlempty-p.. 2020-Oct-25 08:31:23

[ ms-sql-empty-password.nse

Patch \Device'HarddizkVolume3\Program Files\Fortinet\Fortl EDR\scripts\ms-sgl-empuy-...
Executable File ms-5ql-empry-password.nse
Creation Time 2020-0ct-20 17:53:00

r-:.ndufuca:mf Time 2020-Oer-22 11:33:08

Cwiner Local System
Owner D 51-3-18
Status (00000000
Target File Extension ree
Target File Volume Type Local

You can click an icon in the Details pane to display additional details, as shown below:

s Columns - E- File Read

Summary = MSiBXEC axe 9+ |dap-brute.nse 2020-O¢r-25 08:31:23
Status @ Running Internal IP 10.212.134.130,192.168.0....
, 1h, 23rnin, 24sec v
-' L Signed (valid)
~4424 & "

Signature thumbprint
A4341B9FDS0FBO064283220A364 1 EFGFOFAATEAD Woystem3dimsievec.exe

Issued by n

Micrasoft Windows staller - Unicode

170E982CT735BFC2BIC1ADAODA3SFDN

Command line N
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. Investigate =
Investigation View ( ) button: This button opens a graphical Investigation View on

page 155 of the activity events details: source, action and target. The graphical view provides the
ability to add more activity events to the graph and show the relationship and timeline of the
occurrence of those activities for better understanding of the flow of activity events.

Event Log Details pane

The Details pane for an activity event of type Event Log Created appears somewhat differently, as shown
below. In this case, the action is always Log Entry Created and the target is always the event ID.
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Log Entry Created

Summary 2020-0cr-25 08:31:19
E Status @ Running Internal IP 10.212.134.130,192.168.0....
Uptme 3d, 1h 23min, 20sec v
[T security
Log Entry Created
| |
FaY
[ EventID 4672 .
Event Provider Microsoft-Windows-Securiny-Auditing
Level H
Message
Special privileges assigned o new logon.
Subject:
Security ID: 5-1-5-18
Arerminr Mame: SYRTEM
You can scroll down in the Target area to view the actual log entry.
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Log Entry Created

Summary 2020-Oe¢x-25 08:31:19

T_EUE-EI'ITI; LS = A
A
L WEvent ID 4672

Event Provider Microsoft-Windows-Security-duditing
Lewvel o
Message

Special grivileges assigned to new logon.

Subject:
Security 1D: 5-1-5-18
Account Mame: SYSTEM
Account Domain: NT AUTHORITY
Logen ID: Ox3E7

Frivileges: SebssignPrimaryTokenPrivilege
SeTebPrivile
SefecurityPrivilege
S5eTakaOwnershipPrivilege
SeloadDriverPrivilege
SeBackupPrivilege
SeRestorePrivilege

SeDebugPrivilege

—

Retrieving a file / Remediating devices upon malware detection

You can remediate any file that is a target of an activity event. You can also download a copy of any file
(Retrieve action) that is a target of an activity event.
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To retrieve a file or remediate the process:

1. Select the relevant activity event and open its Details Pane.
2. When hovering over the filename, you can select either of the following options:

e In the Summary pane, select the three dot dropdown menu and then select Retrieve of Remediate

the file, as shown below:

: [ WmiPerflnstdll -} 5 Retrieve :
Remediate
Path CA\Windows\System32webermWmiPerflnst.dll
Owner MNT Services\Trus... 1D - 5-1-5-80-056008885-3418522645-153103204..,
SHAT BC3B2C25CA37A34BBSACCADEFTABAD2EZF36DEAA
-OR-

» In the Details pane, click the Retrieve or Remediate button, as shown below:

WA D
5_“-\.-\.'-\.-\.8'--__ o= WmiPr

LA

E.exe ¥ WmiPerflnst.dll

[ WmiPerfinstdll =}

[ - = A
= Fetrieve Remediate

Path C\Windows\System32Wwberm\WmiPerflnst.dll

Adding an application to the Application Control policy blocklist

You can add any process that is either the source or the target of an activity event to the Application
Control Policy blocklist such that this process won't launch on the devices that are assigned to that
Application Control policy.

To add a process to an Application Control policy:

1. Select the relevant activity event and open its Details Pane.
®

@
2. Inthe Summary page, click the More (®) option next to the process name and select Add to Blocklist, as

shown below:
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E- File Create

Summary =3 Adobe CEF He... 3= ACC 2022-1-1... 14-]an-2022 03:54:17
D Status .Running Internal IP 10.100.102.6
ens Uptdme 3d, 1h, 27min, 43sec o
A

{I] Adobe CEF Helper.exe PID-12620 TID-13720 Add to Blacklist

Path C:\Program Files\Comman Files\Adobe\Adobe Desktop Comm...

Executing user EMNSILOWyi

Parent \Device\HarddiskVolume3\Program Files\Adobe\Adob... 1D- ...

Product Adobe CEF Helper, v35.6.0.788

SHAT DEDSC331AE6T71DCIAZCEABSEAS13B208B88B5F10

Command line --type=renderer --no-sandbox --autoplay-policy=no-user-

gesture-required --js-flags=--expose-gc --log-
file="C:\Users\yossimiAppDataiLocal\Tempt\CreativeCloudh...

OR
Go to either the Source or the Target tab of type process and click the Add to Blocklist button, as shown
below:
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E- File Create

summary »> Adobe Deskt... »» longpoll[9].json 24-]an-2022 16:38:02

{II Adobe Desktop Service.exe PID-13868 TID-10764 ) 2

bit
{gn Add to Blocklist

Path C:\Program Files (x86)\Common Files\Adobe‘\Adobe Desktop Comm...

Parent D 14292 Mame \Device\HarddiskVolume3\Program Files\Ado...
Creation Time 18-Jan-2022 02:30:45

Creation time 18-Jan-2022 02:30:50

Product Information Name Adobe Creative Cloud
Version 5.6.0.788
Company name Adobe Inc.

Executing user Bl Ov

Executing User ID 5-1-5-21-: 1952-3802803170-27590584230-2235

Remote Endpoint Address

GDPR and activity event data

The FortiEDR system fully complies with the General Data Protection Regulation (GDPR) standard, as
described in Personal Data Handling on page 325. When you use the Personal Data Handling feature to
delete data, it also deletes activity event data. However, the Personal Data Handling Search option does not
search for and display the activity data that it will delete. Just for your own knowledge, in order to see a list
of the activity data that will be deleted you can view it here before you delete it. To do so, simply enter a
query here that includes the chosen record from the Activity Report (that can be accessed by selecting
Administration > Settings > Personal Data Handling) in order to find the data to be removed. For example, if
you have provided the string 149 in Personal Data Handling for Search by Device name, then in the displayed
Activity Report, select the record containing the device name to be deleted. In this example, it is US-
Dev149. Then, in order to display all the activity events that are related to this device, enter the query
Device.Name: US-Dev149, as shown below in order to display the relevant records.
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Device.Mame: US-Dev1dd

To find all activity related to a user chosen from a Personal Data Handling Activity Report, enter the
following query, and select the required time range:

"Source.File.Owner:<username> OR Source.User:<username> OR Process.File.Owner:<username> OR
Process.User:<username> OR Target.File.Owner:<username>"

Similarly, to find all activity related to an IP chosen from a Personal Data Handling Activity Report, enter the
following query:

"Device.lPInternal:<IP> OR LocallP:< IP > OR RemotelP:< IP > OR
Target.Network.AdditionalData.Remotelp:</P>"

Investigation View

=
The Investigation View window is accessible from the Details Pane using the Investigation View button ( ® )
of an event under Threat Hunting. It helps understand the flow of activity events during Threat Hunting with
a dynamic and interactive graphical view of the activity events details: source, action and target.

The graphical view provides the ability to add more activity events to the graph and show the relationship
and timeline of the occurrence of those activities, such as the following:

» All actions performed by a given process
« Allfiles the process has created or updated
¢ All IPs the process has initiated communication with

It also allows you to interactively view a chain of activity events in the following ways:

* Browse between the various processes involved in the chain
» See all activity events related to one node and decide which nodes to add to the graph

» The Investigation View is not available to IT users (see Users on page 277).
NP Read-Only user can only view and manipulate graphs but cannot remediate or
‘q‘ perform other actions.
- » The view adds visualization and interaction of existing data that is already
= available in other non-graphical and non-interactive forms without creating or
generating any additional data.

The following figure illustrates the various components of an Investigation View window launched from the
Details Pane under Threat Hunting, which has the window title "Threat Hunting + activity name.
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Threat Hunting

= = Threat Hunting | IEG—_——

(54 Expa’:e = Status @ Running  UpTime 15h, 59min, 11sec  Incernal P Bxernal 1P
e ¥ Rules (0) v M MITRE & Behavior (1) v + QO sshd | pio- o by

All Activity Process..,  File(0)  Network Registry( 1 Log(0) o Activities related to Process sshd < V| Search B|

Compared with the Investigation View on page 92 window launched from the
Incidents view, this view has the following limitations:

O ! ’, e Some threat hunting and investigation capabilities are unavailable, such as
? exporting the graph as JSON, raw data items navigation graph, and Stacks view
= on page 99.

* Some general event details are missing in the first row, such as classification
and incident response.

Component Description

1 General details about the device that generated the event, such as Collector status,
process name, and IP address.

Export L . .
Use the Export button ( r—' e ) to export the Investigation View window as an SVG
file to share with others or for record reasons.

This is the only option to save a graph that includes dynamic changes based on the
default graph view, such as adding processes.

3 Graphical flow diagram with a process tree that you can build according to your
investigation needs, from left to right and top to bottom. The tree is also interactive,
which means you can click on a specific component to drill down for more details or
contextual actions.

A Node—Source of an activity or event, which can be a process, an endpoint, a
thread or service, or another security product. Nodes are represented by
boxes with icons for the activity type, some with descriptions under the
boxes.
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Component Description

64
kit
¢ Click on a node to display the Details pane on page 145 on the right and
the Activity events tables on page 141 on the bottom with contextual
information about that specific node.

* Click the Collapse () or Expand (') icon in the right of a node icon to
show or hide all the downstream nodes, edges, and leaves.

« Right-click a node to perform actions allowed on the node, including any
custom actions you defined. These action buttons also appear in the
Details Pane, which is available on the right after you click the node.

The list of available options varies by node type. The following is an
example list of actions for a process node.

Remediate

Retrieve

Add Process Exclusion
Add to Blocklist

View activity events

B Edge—Activity event type or action represented by a curved line with an
arrow. An edge can be one activity event/action or an aggregation of several.
The numbered arrows indicate the sequence of actions and specify the action
that was performed, such as Process Creation, Socket Close, Block and so on.
Multiple operations performed between two processes are represented by
multiple arrows between them. Edges that triggered the event are indicated in
red.
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Component Description

Click on an edge to display the Details pane on page 145 on the right with
contextual information about that specific edge.

Edges may also have icons below them indicating classification or MITRE &
Behavior models. Click on an icon for more detailed information.

C Leaf—Target of activity event of type File, Registry Key, Registry Value,
Network components (IP/DNS/URL). A leaf can also be a group of artifacts. For
example, all the files created or modified by a process. Leaves have a round

@

shape ( ).

¢ Click on a leaf to display the Details pane on page 145 on the right and the
Activity events tables on page 141 on the bottom with contextual
information about that specific leaf.

» Right-click a leaf to perform actions allowed on the leaf, including any
custom actions you defined. These action buttons are also available in the
Details Pane, which appear on the right after you click the leaf.

The list of available options varies by leaf type. The following is an
example list of actions for a network leaf:

Show the number of distinct processes that communicated with this IP
Show the number of devices that communicated with this IP
Block address on firewall

D Hint—Categorized groups of activities related to a node that are not part of
the main chain of activity events and thus not represented in the graphical
diagram. Click a node to show the number of relevant activities. The hints no
longer display after you move the selection to another node or edge.

* Click the Expand ( [':) or Collapse ([': ) icon near a leaf hint to show or
hide the node or leaf list of that type.

e Right-click the type name of a hint and select Add to graph to add the
relevant leaves to the graph or select View activity event to pull out the
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Component Description

Activity events tables on page 141 for this specific file type. The Add to
graph option is unavailable when the number of hints exceeds 500, in
which case you can only choose to view the activity event.

[-151 Metwork

[-19 Proy
Add to graph

View activity event

E Use the MITRE & Behavior legend to highlight the corresponding icons below
relevant edges in the diagram.

¥ Rules (0) v M MITRE & Behavior (1) v

F . - N
Use the Zoom In ( ), Zoom Out ( ), and Zoom To Fit ( - )
buttons to adjust the graph window size.
Use the Reset ( ) button to restore the graph to the default view.
Usethe Undo () button to cancel an operation.

4 Details pane on page 145 for the selected node, edge, or leaf where you can view details

of the activity, action, or target, and perform common actions on a node or leaf, such as
retrieving a file, remediating devices upon malware detection, or adding an application
to the Application Control policy blocklist. The actions can also be performed by right-
clicking a node or leaf and selecting the option from the menu. For specific leaf types,
this pane also includes an Insights tab which allows you to run queries to retrieve
analytics data, such as the number of communicating processes or devices of a certain
IP. The Insights options are also available from the right-click menu of those leaf types.

@ 54.67.13.75:443

Details Insights

How many distinct processes have communicated this IP? Run
How many devices have communicated this IP? | Run 1
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Component Description

5 Contextual Activity events tables on page 141 for the selected node or leaf organized by
tabs of activity types. Drag the top edge of the table up for a fuller view of the table.
Activities with a number at the front of the row are already in the graph and the number
matches the one in the graph.

2jan2024034529  SE@E] Maxwioxeem3 Value Read explorerexe & () HKLM\SOFTWARE\Classes
23Jan-2024 03:49:29 L MaxW10x64-M3 Value Read explorer.exe S @ HKLM\SOFTWARE\Classes.

234an-2024 03:49:29 = MaxW10x64-M3 value Read explorer.exe 5 HKLMISOFTWARE\Classes

* To add activities to the graph, select the corresponding rows and click Add to graph

E" Add to graph

( ).

To customize the columns to display in the table, click Customize (l][“] ustomize

).

« To search for a specific activity or event, enter keywords in the search bar on the

5 hd Search B
top right corner ( ).

e To filter the results in the Activity Events table to include or exclude a specific value,

use the green plus () and red minus (=) icons that appear when you hover over
the value. Multiple filters are supported. To delete a filter, click the cancel icon that
appear when you hover over the filter on the top-left of the table.

Remediating a device upon malware detection

After malware is detected on a device, you can remediate the device from the Investigation View on page
92 (detailed in the procedure below) or by connecting to the device directly using the FortiEDR Connect on
page 109 functionality.

The following options are available when you remediate the situation in the FortiEDR system:

Method Description

Terminate the Process This method does not guarantee that the affected process will not
attempt to execute again.

Delete the Affected File from  This method ensures that the file does not attempt to exfiltrate data

the Computer again, as the file is permanently removed from the device. When using
this method, be careful not to delete files that are important to the
system, in order to protect system stability.

Remove or Modify the This method removes a registry key or updates a registry key’s value.
Registry Key This method changes malicious registry key modifications by removing
newly created keys or returning key values to their original form.
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Method Description

) Some malware have persistency capabilities, which
S L4 . . . ono o
q makes the infection appear again. In addition, in some
- rare cases, malware can cause the system to crash if
= you try to remove them.

Both of these methods can be performed using the Forensics add-on.

To remediate a device from the Investigation View on page 92:

1. Right-click the node of the relevant activity event and select Remediate.

."‘}.-- |
: m task” B y

Retrieve

Add Process Exclusion
Add to Blocklist

View activity events

Alternatively, select the node of the relevant activity event and click the Remediate button in the Details
Pane that appears on the right.
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32
,[U taskhost.exe TID- Bit
+ -
{gn Add to blocklist Remediate % Retrieve
Path CA
Parent ID 328
Name s ——
Creation Time CIgmo 0Dy DInIIiIC
Creation Time (L,
Product Information Mame Microsoft®E WindowsE Operating System
Version
Company name Microsoft Corporation
Executing User
Executing User ID
\‘ ! "
9 The Remediate button is also available from the Stacks view on page 99, which is
|| available when an edge is selected.
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2. The following window displays:

REMEDIATE DEVICE WIN-MQHOCMRUD?2)

services.exe
EVENT 171303
PROCESS ID 452

Terminate process services.exe )

Remove 1 selected executable file

Delete file at path  |c:\temp\abcd exe

Handle persistent data (registry)

lodify registry value  [(Default)

F=

I-I'I-- -HI
| Cancel )
. S

3. Do one of the following:
a. Check the Terminate process checkbox to terminate the selected process. A warning message

displays.
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WARNING

SEMVICES exe
Do you want to I'EI'I'IDtE|}" rccess

services.exe ?

If an open program is associated with this process on the remote device,
closing it will result in losing any unsaved data.
If you end a system process, the remote device may become unstable.

Are you sure you want to continue?

Ty
Terminate process '.\ Cancel /.'

Click Terminate process to terminate the selected process.

b. Check the Remove selected executable file checkbox to delete the specified file from the device. A
warning message displays.

WARNING

Do you want to remotely delete executable file
\Device\HarddiskVolume1\Windows\System32\services.exe ?

Deleting an executable file will prevent its future execution on the target
device

Are you sure you want to continue? |

S
Delete file I.\ Cancel ,z"

Click Delete file to remove the selected file.

c. Check the Delete file at path checkbox. In the adjacent field, enter the file path on the device that
contains the file to be removed.
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v Delete file at path  |c-\templ\abcd exe

A warning message displays.
WARNING

You are about to delete file
c:temp

Are you sure you want to continue?

DGR | Cancel )

Click Delete file to remove the file from the specified path.

d. Check the Handle persistent data (registry) checkbox to clean the registry keys in Windows. In the
adjacent field, enter the value of the registry key to be removed or modified.

Handle persistent data (registry)

Value data should be provided in the required format, based on the value type selected in the
dropdown list, as follows:

» String for types REG_SZ(1), REG_LEXPAND_SZ(2), REG_LDWORD(4) and REG_QWORD(11).

e Base64 for types REG_BINARY(3), REG_LDWORD_BIG_ENDIAN(5), REG_LINK(6), REG_MULTI_SZ
(7), REG_RESOURCE_LIST(8), REG_FULL_RESOURCE_DESCRIPTOR(9) and REG_RESOURCE_
REQUIREMENTS_LIST(10).

Select the Remove key radio button to remove the registry key value.

Select the Modify registry value radio button to change the current registry key value. When
selecting this option, you must also specify the new value for the registry key in the gray box and
the key’s value type in the adjacent dropdown menu (for example, string, binary and so on).

4. Click Remediate.
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Exporting threat hunting logs

For on-premise deployments, when you submit a support ticket about issues with Threat Hunting
Repository installation, upgrade, or general functioning, you must include the threat hunting logs.

To collect threat hunting logs:

1. Run the following command:
sudo bash /opt/FortiEDR/deployments/latest/deployment/ci-tools/get_logs.sh

The script will create logs archive in the /tmp/ directory.

ftmp/tmp.207dGIvngx/rc-status. Log
[tmp/tmp.207dGIvngx/deployment-Apr-03-2024 04-46-21.log

jone. Logs collected in /tmp/edr2-onprem.2024-04-160614-23.tgz , logs directory: /tmp/tmp.2QjdGIvngx

2. Use the SCP client to download the .tgz file.
You can then attach the file to the support ticket.

NP To retrieve Collector, Core, and Aggegator logs, see the following:
‘q’ » Exporting logs for Collectors on page 273

» Exporting logs for Cores on page 274
» Exporting logs for Aggregators on page 275
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Communication control

This chapter describes the FortiEDR communication control mechanism for monitoring and handling non-
disguised security events.

Application communication control - how does it
work?

FortiEDR provides visibility into any communicating application in your organization, enabling you to control
which applications can communicate.

After FortiEDR installation, the system automatically maps all applications in your network that
communicate externally. After that, you then decide which of these applications to allow to communicate
externally when used by a legitimate user in your organization (allowlist). After the allowlist of
communicating applications is defined, only applications in the allowlist can communicate externally. If an
attacker abuses an application in the allowlist, FortiEDR’s patented technology (Exfiltration and
Ransomware prevention policies) blocks the communication and displays a security event in the Incidents
tab.

FortiEDR Communication Control uses a set of policies that contain recommendations about whether an
application should be approved or denied of communication. These policies can be configured as a next-
generation firewall in order to automatically block communications of potentially unwanted applications. For
example, applications with a known bad reputation or that are distributed by questionable vendors.

Moreover, FortiEDR Communication Control provides data and tools for efficient vulnerability assessment
and control. Virtual patching is made possible with Communication Control policies that can be configured
to automatically block connections from vulnerable applications.

You can also configure host firewall policies to control incoming and outgoing in network traffic to protect
endpoints against unwanted connections based on remote addresses, protocols, or applications in use to
reflect the organization’s network policies.

FortiEDR’'s Communication Control mechanism provides the following key advantages:

Mechanism Description
Realtime Proactive Risk Attack surface reduction using risk-based proactive policies that are
Mitigation based on application CVE and rating data.

Avoids Productivity Inhibitors  Non-authorized applications can still execute. Only their outgoing
communication is prevented.

Manageability Reduces the scope of the problem, which means that Security/IT needs
to handle only applications that communicate externally.
Frictionless Application Reduces users’ requests from Security/IT to approve applications.
Control
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Introducing communication control

The COMMUNICATION CONTROL tab identifies all the communicating applications detected in your
organization. To access this page, click the down arrow next to COMMUNICATION CONTROL and then

select Applications.

=as FortiEDR ‘ Dashboard  Incidents

APPLICATIONS
Policies
Allstatuses  ~ Y Advanced Fiter [ Export Host Firewal
APPLICATION VENDOR REPUTATION  NISTSEVERITY  ACISEVERITY
4 lior.exe Uns\gned enSilo Test Unknown Unknown Unknown
1.0.0.1 Unknown Unknown Unknown
b sedsvc Signed Microsoft Corporation —_ |l Unknown Unknown
3 Windows Modules Insta.. Signed Microsoft Gorporation —_ |l Unknown Unknown
> nc Signed 90000 Unknown Unknown Unknown
> IMRemoteURLConnectio . Signed  Apple Unknown Unknown Unknown
> @ Thunderbird Signed  Mozilla Corporation B o Ciitical o Criical
3 @ openssh-server Unsigned  Unknown Vendor - Unknown Unknown
b systemd Unsigned  Ubuntu i : Unknown Unknown
B BGAUpsall Signed Microsoft Corporation Unknown Unknown Unknown
D . oopen-vm-tools Unsigned  Unknown Vendor —_ |l Unknown Unknown
~ ADVANCED  appLicATION INFO APPLICATION USAGE
DATA Application Description. NiA No Collectors

First Connection Time:

Last Connection Time:

Process Names exe (

Threat Hunting Communication Control v Security Settings v

Applications

Search Application

FIRST SEEN

The COMMUNICATION CONTROL tab contains the following pages:

« Applications on page 168
* Policies on page 184

» Host Firewall Collector 6.1 or later on page 194

Applications

Q

LAST SEEN

Assets v

Administration v

@ Prevenion [\

APPLICATION DETAILS

Policies.

Policy

& Default Communication Control ... FeAmner

Servers Policy FezATinET

B Detautt communication Control Policy clone

Servers Policy clone
Servers Policy clone 1
Servers Policy clone 2

Isolation Policy F:RTINET

DESCRIPTIONS:

[

More.

CCONNECTION TIME

Action

According to

Alow (05
= Deny /p\;ﬁ;@m to
Allow /ggﬁuc‘rdwng to
-1 Deny ?Eﬁf,mm to
=1 Deny ?sﬁ;’:ﬂ\ng to
=] Deny Q;ﬁ;(dm to
=1 Deny S;ﬁ;mm to
LOCATION

= United States

The APPLICATIONS page lists all communicating applications detected in your organization that have ever

attempted to communicate. By default, applications are sorted according to their first-seen indicator,

placing new applications at the top. To access this page, click the down arrow next to COMMUNICATION

CONTROL and then select Applications.

FortiEDR 7.2.0 Administration Guide
Fortinet Inc.

168



Communication control

Dashboard

Incidents

Threat Hunting

Communication Control v

Security Settings v

Assets v Administration v

@ Prevention n

APPLICATIONS
Alstatuses  ~

APPLICATION VENDOR
4 lior.exe Uns\gnéd enSilo Test

1001

b sedsvc Signed Microsoft Corporation
P Windows Modules Insta.. Signed Microsoft Gorporation
> nc Signed 90000
> IMRemoteURLConnectio . Signed  Apple
> @ Thunderbirg Signed  Mozilla Corporation
[ @ openssh-server Unsigned  Unknown Vendor
b systemd Unsigned  Ubuntu
B BGAUpsall Signed Microsoft Corporation
> ® openym-tools Unsigned  Unknown Vendor
~ ADVANCED  appLicATION INFO

DATA

Appiication Description: NIA
First Connection Time:
Last Connection Time:

Process Names:

Y Advanced Filter

ACI SEVERITY

Policies

Host Firewall

Unknown

unknown

unknown

unknown

Unknown

Unknown

Critical

Unknown

Unknown

unknawn

unknown

APPLICATION USAGE

No Collectors

[3 Export~
REPUTATION NIST SEVERITY
Unknown Unknown
Unknown Unknown
_ _ Unknown
_ _ Unknown
Unknown Unknown
Unknown Unknown
_ _ ® Ciitical
_ _ Unknown
_ _ Unknown
Unknown Unknown
_ _ Unknown

exe (.

Search Application

FIRST SEEN

Q

LAST SEEN

APPLICATION DETAILS

Policies.

Policy

& Default Communication Control ... FeAmner
Servers Policy FezATinET

B Detautt communication Control Policy clone
Servers Policy clone

Servers Policy clone 1

Servers Policy clone 2

Isolation Policy F:RTINET

DESCRIPTIONS:

[ CONNECTION TIME

More.

Action

Allow

=1 Deny

Allow

-1 Deny

=1 Deny

-1 Deny

=1 Deny

According to
policy
According to
policy

According to
policy

According to
policy

According to
policy

According to
policy

According to
policy

LOCATION

= United States

Information is organized hierarchically in a two-level tree. The first (top) level specifies the name of the
application. The second level specifies the application version.

The following information displays for each application in the application list:

« Selection checkbox
¢ Resolving status icon

» Signed/Unsigned indication
» APPLICATION/VERSION: The name of the application/version.

* VENDOR: The application’s vendor and certificate details.
e REPUTATION: The reputation score of the application. For more details, Reputation score on page 169

* VULNERABILITY: The highest CVE vulnerability score for the application. For more details, see Severity
on page 170

» FIRST SEEN: The date and time when the application was first seen in the organization.

e LAST SEEN: The date and time of the last connection of this application.

The APPLICATION DETAILS area of the window on the right displays policy-related details for the entity
(application or version) selected in the application list. This area displays the policy action (Allow or Deny)

for each communication control policy.

The Advanced Data area at the bottom of the window presents statistics about the selected
application/version in the application list. For more details, see Advanced Data on page 178.

Reputation score

Each application in the APPLICATIONS page shows a REPUTATION indicator. Reputation scores are
determined by a third-party service, and are based on the hash (signature) of the file.
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APPLICATION VENDOR REPUTATION
b @ Thunderbird Signed Mozilla Corporation — j
b ® whatsApp Signed WhatsApp B
[ ® Firefox Signed Mozilla Corporation — j
> ® filebeat.exe Unsign... Unknown Vendor

Reputation scores use the following range to indicate the reputation for an application:

Reputation Score Reputation Description

1 Known as bad

2 Assumed as bad

3 Unclear, indication a contradiction or inability to determine the reputation
4 Assumed as good

5 Known as good

The REPUTATION indicator displays Unknown if the reputation score is unknown.

Severity

FortiEDR'’s severity scoring system provides a useful tool for vulnerability assessment and enables you to
review the weaknesses detected in your environment that could be exploited by attackers before they
actually occur. You can then use virtual patching to block applications with known critical vulnerabilities so
that they cannot connect until the system is patched for the CVEs listed.

It also provides comprehensive visibility into the organization's external attack surface so that analysts can
prioritize security alerts and incidents based on risk factors such as severity of vulnerabilities, relevance of
threat intelligence feeds, and severity of affected endpoints, ensuring that efforts are focused on
addressing the most significant risks to the organization.

Each application and version in the application list shows two severity ratings:

vy
‘?' The ratings are only available to users who have purchased the Discover and Protect

license or the Discover, Protect and Response license.

» NIST Severity—Rating provided by FortiEDR’s vulnerability scoring system leveraging the NIST
Cybersecurity Framework.
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» ACI Severity—Adversary Centric Intelligence (ACI) rating provided by FortiRecon leveraging FortiGuard
Threat Analysts to provide comprehensive coverage of dark web, open source, and technical threat
intelligence, including threat actor insights. This information enables administrators to proactively
assess risks, respond faster to incidents, better understand their attackers, and protect assets.

FortiEDR categories vulnerabilities into the following categories based on National Vulnerability Database
(NVD) severity ratings:

* Unknown
* Low
* Medium
¢ High
* Critical
APPLICATIONS Showing 1-10112 |» | b1 | [Search Application vQ VERSION DETAILS
Unresolved ~ fayMarkAs ~  [i Detete (= Modify Action W Advanced Fiter [ Exports
Policies
APPLICATION VENDOR REPUTATION NIST SEVERITY ACI SEVERITY FIRST SEEN LAST SEEN Policy Action
> ® Unsigned  Unknown Vendar _ | Unknown Medium [ Default Communication Control ... Fzmnner =1 Deny  Manualy
< - @ Firefox Signed  Mozilla Corporation _ . @ critical Medium Servers Policy FemTner -1 Deny ;;ﬁf‘:”-g
@ 970 _ ® Critical ® Critical
B TEsTC Control Policy =1 Deny  Manualy
@ 1000 _ H ® Critical ® Criical
According to
Isolation Policy FezATNET -1 Den O
® 7601 _ _ ® Critical ® Critical 4 ¥ policy
b [ ] Unsigned  Unknown Vendor _ _ Unknown Unknown
> [ ] Unsigned  Unknown Vendor Unknown Unknown Unknown
> [ ] Unsigned  Unknown Vendor _ _ Unknown Unknown
0 (] Unsigned  Unknown Vendor Unknown Unknown Low
Vulnerabilities
b (] Unsigned  Unknown Vendor Unknown ® critical
- - NIST ACI
b o Unsigned  Unknown Vendor — . Unknown Unknown ® Critical (CVSS 3.0: 9.8, CVSS 2.0: null) ® Critical
N ° Unsigned  Unknown Vendor _ - Unknown Medium ® Griical (CVSS 3.0: 9.8, CVSS 2.0: null) ® Critical
@ Critical (CVSS3.0: 9.8, CVSS 2.0: null) ® critical
b ® Unsigned  Unknown Vendor Unknown ® Critical
- — ® Critical (CVSS3.0:9.8, CVSS 2.0: null) ® Critical
@ Critical (CVSS 3.0 9.8, CVSS 2.0 null), ® Critical
® Critical (CVSS 3.0 9.8, GVSS 2.0: null) ® Critical
® Critical (CVSS3.0: 9.8, CVSS 2.0: null) ® criical
® Critical (CVSS3.0:9.8, CVSS 2.0: null) ® Critical
@ Critical (CVSS 3.0 9.8, CVSS 2.0 null) ® Critical

The Vulnerabilities area at the bottom right of the window lists the CVE-identified vulnerabilities for the
selected application and version. Each CVE row includes the CVE identifier, the NIST and ACI severity
category and the Common Vulnerability Scoring System (CVSS) vulnerability score .
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Vulnerabilities
MNIST ACI
CVE-2023-5731 @ Critical (CWSS 3.0: 9.8, CV55 2.0: null) @ Critical
CWE-2023-5730 @ Critical (CVSS 3.0: 9.8, CVS5 2.0: null) @ Critical
CVE-2023-5176 @ Critical (CVSS 3.0 9.8, CVSS 2.0 null) ® Critical
CWE-2023-5175 @ Critical (CVSS 3.0: 9.8, CV35 2.0: null) @ Critical
CWE-2023-5174 @ Critical (CVSS 3.00 9.8, CV35 2.0 null) @ Critical
CWE-2023-5172 @ Critical (CVSS 3.0: 9.8, CVS5 2.0: null) @ Critical
CVE-2023-5168 @ Critical (CVS3 3.0: 9.8, CV3S 2.0: null) @ Critical
CWE-2023-4058 @ Critical (CVSS 3.0: 9.8, CVS5 2.0: null) @ Critical
CWE-2023-4057 @ Critical (CVSS 3.0: 9.8, CVS5 2.0: null) @ Critical
M CVSS scoring utilizes two systems: CVSS 3.0, the most recent, and CVSS 2.0, its
9 predecessor. FortiEDR vulnerability information presents both CVSS 3.0 and CVSS
- 2.0 scores.s

You can click a CVE identifier link to view more details about that vulnerability in your browser, including
the type of vulnerability, the application(s) it affects, the version(s) it affects and so on.

CVE-2019-9820 Lo ional Vulnerability,

r r
'+ CVSS Severity Rating « Fix Information »

(NVD)

The entry._creation dal may reflect when the CVE 1D was allocated or reserved, and does not neces:

updated In CVE.

Phase (Legacy)
Assigned (20190314)
Votes (Legacy)
Comments (Legacy)

“This is an entry on the CVE List, which provides common identifers for

After a vulnerability is detected in your system, you can decide the type of the action needed to address it.
Typically, it is recommended to upgrade to a newer version of the application, meaning one that does not
have the identified vulnerability. Alternatively, virtual patching can be applied with vulnerability-based
policy that is configured to block communication of any application with known critical vulnerability. For
more details, see Policies on page 184. The information presented in the Advanced Data area of the window

ity_Database ( ).
Vulnerable Software Versions + SCAP Mappings » CPE Information

publicly known cybersecurity vulnerabilities.
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also provides useful information to help protect against vulnerabilities. For more details, see Advanced Data
on page 178.

Resolved vs. unresolved applications

By default, all new applications have an Unresolved status. Unresolved means that either FortiEDR or the
user have not examined the application to ensure that it is safe. Applications with the Unresolved status are
indicated by the @ icon in the application list.

FortiEDR automatically resolves an application as safe by checking the application’s characteristics. For
example, checking the application’s reputation and vulnerabilities to ensure that it does not have a bad
reputation or critical vulnerabilities. Applications that meet these criteria are automatically changed to the
Resolved status by FortiEDR. Applications with the Resolved status are indicated by the @ icon in the
application list. You can also change applications to the Resolved status manually.

Sorting the Application List

The application list can be sorted alphabetically by product, vendor, reputation score, vulnerability or arrival
time (first seen or last seen). By default, the list is sorted by arrival time, with the most recent
communication at the top.

Marking an Entry as Read/Unread

The following describes how to specify that you have viewed an entity in the application list. You can mark
applications or versions as read/unread.

The first time that an application/version is detected in the application list, it is shown in bold. Bold indicates
that the item is unread (see below).

APPLICATION VENDOR REPUTATION VULNERABILITY FIRST SEEN LAST SEEN
D @ Thunderbird Signed Mozilla Corporation — j ® Critical 18-Dec-2019 24-Dec-2019
[ @® whatsApp Signed WhatsApp — j ® Critical 18-Dec-2019 18-Dec-2019
o] ® Firefox Signed Mozilla Corporation — j @ Critical 18-Dec-2019 25-Dec-2019
b @ filebeat.exe Unsign... Unknown Vendor —E Unknown 19-Dec-2019 09-Feb-2020
[ ® Google Chrome signed Google — j @ Critical 19-Dec-2019 19-Dec-2019

To mark an entity as read:

Select the entity’s (application or version) checkbox and then click the down arrow on the

fad MarkAs.. ¥ bution and select Mark as read. The text no longer displays in bold.
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ﬂ Mark As... ¥
Mark as read

Mark as unread

Note - If you mark an application version as read, all lower levels in the version hierarchy for that application
are also marked as read.

Modifying a Policy Action

The following describes how to apply a different action to an application/version other than that specified in
the current policy for that application/version. In this case, the application/version is excluded from the
current action defined in the policy (Allow or Deny).

When modifying a policy action in this manner, the Application/Version Details area displays Manually to
indicate that the action was modified manually, and is excluded from the action defined in the policy.

APPLICATIONS showing 1-10/12 | » | »1 | | Search Application Q VERSION DETAILS
Unresolved ~ fad MarkAs ~ [ Detete (5 Modify Action V[ Advanced Fiter 3 Exports
Policies
APPLICATION VENDOR REPUTATION NIST SEVERITY ACI SEVERITY FIRST SEEN LAST SEEN Policy Action
E @ fiebeat exe Unsigned  Unknown Vendor I Unknown Medium 2024-05-09 06:33:02 2024-05-24 03:47°54 [ efault communication Conirol ... Fmrner | Deny  Mansaly
< - @ Firefox signed  Mozilla Corporation _ ® critical Medium 2024-05-09 06:43:42  2024-05-29 18:50:35 Servers Policy FrmmnEr 1 Deny ;gﬁsmrg o
® 570 - | ® Critical ® Critical 2024-05-23 18:08:28 2024-05-29 14:08:26
& TEST Communication Control Policy =1 Deny
® 1000 B ® Critical ® Critical 2024-0524 041238 2024-05-29 18:48:47
Isolation Palicy FEATINET: ~+lpeny Lccordnato
@ 76.0.1 _ ® Critical ® Critical 2024-05-24 06:55:00 2024-05-29 06:54:57 policy

To modify a policy action:

1. Select the application/version checkbox and then click the Gruearyacion button. The Modify Action window
displays.
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2.

MODIFY ACTION

2 applications were selected

E Default Communication Control P... ezzRrminer Deny v
Isolation Policy zzaminer According to policy (Deny) v
Servers Policy rezAminer According to policy (Deny) w

Type comment

(® will be applied to all current and future versions of the selected applications
Exclude All Current Versions

SavE and Besove ¥ (" save )( Cancel )

In the dropdown list on the right of the policy row whose action you want to change, click the down
arrow and then select the action to apply to the selected entity. You can change the action for one or

more policies.
[Optional] In the Comment field, enter a free-text comment describing the action change. By default,

the date and time when the policy action was changed automatically displays.

0K for server

admin, at 10-Sep-2019, 03:42°53] 1

[Optional] Check the Exclude All Current Versions checkbox if you want to exclude existing application
versions from the decision. In this case, the new communication control decision only applies to a
future version of the product. The application of the policy action change applies for current versions of
the application. When this checkbox is not selected, the change is applied to all versions of the

application.
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5. Click the arrow next to the button to save the new communication

Save and Resolve v
~ Save and Resolve

Save and Unresolve

control decision for the selected application(s).

When any FortiEDR Central Manager user marks an application/version as Resolved, all users see it as
having been resolved. You can also mark an application/version as resolved using the @ icon in its row in the
application list.

Searching the Application List

v
You can use theI Q field to perform an advanced search. Click the down
arrow to open the Search Applications window, in which you specify your search criteria.

SEARCH APPLICATIONS

Application First Connection From To
Last Connection  From To
Version
Status Unresolved Resolved
Vendor Action v | by in Policy
Policy ~ with Rule
Certificate Signed Unsigned Collector Group v
Reputation [ | 2 3 Callector
. . Unknown
Vulnerahility ® Critical High Medium Destination
o Low Unknown Process Name or hash

CVE identifier

[ scorcn JQERED)
You can filter the application list by the following criteria:

Filter Criteria

Application Filters by application name

Version Filters by version. This is a free-text field.

Vendor Filters by vendor name.

Certificate Filters by signed or unsigned certificate.

Reputation Filters by reputation score. Check the checkbox(es) for the reputation
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Filter Criteria

score(s) of interest.

Vulnerability Filters by vulnerability score.

CVE Identifier Filters by exact match of the vulnerability identifier, using the following
format - CVE-YYYY-nnnn.

First Connection / Last Filters by the specified date range when the first/last connection of the

Connection application was detected in the system.

Status Filters by status (Resolved, Unresolved,).

Action Filters by action.

In Policy Filters by policy. If you specify a specific action in the Action field, then
you can only select from policies with that specific action.

Policy Filters by a specific policy.

With Rule Filters by a specific policy predefined rule.

Collector Group Filters by the Collector Group used to communicate. This means that a
device(s) in the specified Collector Group was used to communicate.

Collector Filters by the Collector (device) used to communicate.

Destination Filters by the Collector destination (IP address).

Process (Name/Hash) Filters by the process name or hash value.

Other options in the Application pane

Option Function

wl v Click the down arrow in the All ¥ button and then select an
option in the dropdown list to filter the application list accordingly. You
can filter the list by:

All Lists all applications for the organization.

Unresolved Lists applications that have not been resolved by either the user or
FortiEDR. Applications with this status are indicated by the @ icon in the
application list. This is the default filter.

Resolved Lists applications that have been resolved by either the user or FortiEDR.
Applications with this status are indicated by the @ icon in the application
list.

Unknown Vendors Lists applications whose for which the vendor is not known in the
system.

Low Reputation Lists applications with a low reputation score.
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Option Function

Critical CVE Lists applications with a Critical CVE score.
Unread Lists applications that have not yet been viewed in the application list.
Click the down arrow on the Mark 4z w  button and then select
ﬁ Mark As... ¥ - .
Mark as read or Mark as unread. For more details, you may refer to the

Marking an Entry as Read/Unread on page 173.

i' Delete Click to delete the entity selected in the application list. Note that if the
deleted entity attempts external communication again, it will be added
back to the application list. In this case, any action defined in the policy
for this entity must be redefined.

(E» Modity acion Click the button to change the current policy action to be applied for the
selected entity, as described in Modifying a Policy Action on page 174

U Advanced fker Click the advanced filter to review applications by suspicious
characteristics, such as existing vulnerabilities or reputation score. This
filter can be used to set up policy rules. See Policy rules on page 188.

Select Filter. ~ | | select criteria. ~ | Setuprule

G Export Click the down arrow in the Export button (E Export - and select the

format for exporting data. You can select Excel or JSON.

I Use the Search Application field to perform an advanced search, as
described in Searching the Application List on page 176.

Advanced Data

The Advanced Data area presents statistics about the selected entity in the application list. The information
that displays varies, depending on the entity selected (application or version).

Application Advanced Data

When an application is selected in the application list, the ADVANCED DATA area displays the following
information for it:

¥ ADVANCED DATA

APPLICATION INFO APPLICATION USAGE DESTINATIONS

Application Description: Windows Defender SmarsScreen Total System: 9.6 comnections / day P CONNECTION TIME COUNTRY

First Connection Time: 17-Dec-2019, 15:42:01

emulation ] A 235018727 29Jan-2020, 03:18:24 = Netherlands

Last Cann 06-Feb-2020, 02:53:20

137.117.228.253 06-Feb-2020, 02:53:20 == Netherlands

rocess Names H (97862,
2 N (9786: 40.85.83182 06-Feb-2020, 02:35:11 Wl ireland

(9B0CS..

And 2 more... More.. More..

« Application information on page 179
« Application Usage on page 180
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e Destinations on page 181

Application information

The APPLICATION INFO area displays summary information about the selected application.

Y~ ADVANCED DATA

APPLICATION INFO

Application Description: Windows Defender SmartScreen

First Connection Time: 17-Dec-2019, 15:42:01

Last Connection Time: 06-Feb-2020, 02:53:20

Frocess Mames: f \Device'HarddiskVolume2\Windows\System 32\smartscreen.exe (97864,

f \Device\Harddizk\olume3WWindows\System32\smartscreen.exe (SB0CE...

And 2 mare...

In the Process Names field, a separate row appears for each application that shares the same vendor,
product and version properties. The Process Names field displays the full file path for each such application.

Y~ ADVANCED DATA

APPLICATION INFO

APPLICATION
Application Description: Windows Defender SmartScreen Total System:
First Connection Time: 17-Dec-2019, 15:42:01 emua-::un
Last Connection Time: 06-Feb-2020, 02:53:20

Process Nan \Device\HarddiskVolume3\Windows\System32\smartscreen.exe (9B0C636DF33EDE2 1F9862 7991 1EOFBO3CO6EE35Y)

§ \Device\HarddiskVolume3\Windows\System32\smartscreen.exe (3B0CE...
¥ (

And 2 more... More...

You can click the three dots next to the Process names field to navigate to the Threat Hunting window for
that process name or hash, or to explore the hash in VirusTotal, as shown below:
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Y~ ADVANCED DATA

APPLICATION INFO

Application Description: MAA

First Connection Time: 02-lan-2000 404057
VirusTotal

Last Connection Time: 23-

Threat Hunting by Hash
Process Names: i &0y eatlLogs\Filebeat\filebeat.exe (C6111...

Threat Hunting by File Name

Application Usage

The APPLICATION USAGE area displays details about usage of the selected application.
APPLICATION USAGE

Organization Total =3 Total System: 1 1 1 ; 0 connections / day

[ TH 1

i connections / aay

; connections / day

Collector Groups

Administration

s ol DmE)e  omE)e

; connections / day

Maore...

This area shows the number of connections (communication sessions) per day. The top line shows the total
number of devices within the organization on which the selected application is installed.

Each row below the underline represents a different Collector Group, and shows the number of devices in
the organization in that Collector Group.

» .
Each person 1 icon represents 10% of the total devices in the organization/Collector Group. Black 1 icons
represent devices that communicate externally using the selected application, and gray ! icons represent
devices that did not communicate externally using the application.

You can hover over the people icons to see the percentage of devices that communicate externally per day
using the selected application. For example, the figure below shows that only 3% of the devices in the
organization have the selected application installed.
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APPLICATION USAGE

Total System: - 16.2 connecticns / day
3%
emulation a MR
More

Click the More link to open the following window, in which you can view additional details about the
selected application.

Microsoft Corporation - App Uri Handlers Registration Verifier

Total System
Seen on & device(s) out of 246 (2%) device(s)

Average use frequency - 16.3 connections / day

emulation
Seen on & device out of 200 (3%) devices
Average use frequency - N/A

Export to Excel JENaEI

Click the Export to Excel button in this window to export application usage information to Excel.

Destinations

The Destinations area shows the destinations to which the selected application communicated (Allowed) or
attempted to communicate (Denied).

DESTINATIONS

IP COMMECTION TIME COUNTRY
65.55.252.190 16-Mar-2016, 07:23:42 == United States
233423527 16-Mar-2016, 01:08:13 == United States
157.56.194.72 15-Mar-2016, 21:19:07 == United States
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Each row shows the IP address, connection time and country of the destination.

By default, this area displays the five most-recent destinations. Click the More link to open the following
window, which displays the last 50 destinations.

ACCESSED IP ADDRESSES

WinZip (Signed)
WinZip

Total number of IP5- &

IP CONMNECTION TIME = COUNTRY
216.58.212.8 12-5ep-2016, 05:12:35 & United States
216.58.208.104 12-Sep-2016, 05:12:34 & United States
182.50.136.2359 11-5ep-2016, 05:48:36 SSingapore
157.55.160.240 11-5ep-2016, 05:48:30 & United States
54.210.8.37 11-5ep-2016, 05:48:30 & United States
216.58.212.40 11-Sep-2016, 05:48:30 & United States

e ™
Export to Excel \_Close )

Version Details

The Version Details area displays the action defined for the application in each policy, plus its vulnerability
details and affected destinations.
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VERSION DETAILS

Policies

Policy Action
E Default Communication Contro... FEERTINET Allow  According to policy
Servers Policy FEIRATINET - | Deny According to policy
E Home Test Allow According to policy
Servers Policy2 =] Deny  According to policy
B winzip Al Allow  According to policy

Vulnerabilities

Total 1484 CVEs
CVE-2020-6831 - ® Critical (CVsS 3.0:9.8, CVSS 2.0: 7.5) !
CVE-2020-6826 - ® Critical (CvsS 3.0:9.8, CVSS 2.0: 7.5)
CVE-2020-6825 - ® Critical (CvsS 3.0:9.8, CVSS 2.0: 7.5)
CVE-2020-6823 - ® Critical (CVsSs 3.0:9.8, CVSS 2.0: 7.5)
DESTINATIONS
Mo destinations
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Policies

The POLICY SETTINGS page displays the Communication Control policies that can be applied to an
application or version in the application list. Communication Control has its own policies. Each policy row
can be expanded to show the rules for that policy. To access this page, click the down arrow next to
COMMUNICATION CONTROL and then select the Policies.

272 ForiEDR |

Dashboard  Incidents

Threat Hunting

Communication Control -

Security Settings v

Assets v

Administration v

® Feenton Q0 ©)

POLICIES SETTINGS

All statuses ~

POLICY NAME

v [ pefautt Communication Gontrol Policy

[ Servers Policy

3 Isolation Policy

3 [ Defauit Communication Control Policy ..
[ Servers Policy clone

D Servers Policy clone 1

3 Servers Policy clone 2

FEATINET

FrzATInET

FERTINET

@

(@)

AN

RULE

Vulnerabilty is greater than or equal to Critical
Vendor is within 0 vendors

Default rule (if none of the rules apply)

Applications
177

4
4
4

Host Firewall
AFFECTED APPS.

Total 13 denied apps (by user) 1 Allow 1 Deny)

12 applications
0appications
675 applications

Total 444 denied apps (by user) 5 Alow 2 Deny

Total 666 denied apps (by user; 13 Alow 5 Der

Total 15 denied apps (by user; 1 Allow, 1 Deny)

Total 444 denied apps (by user) 5 Allow 2 Deny,

Total 444 denied apps (by user; 5 Aliow 2 Deny

Total 444 denied apps (by user 3 Aliow, 2 Deny

Search Application Policy

ACTION

-1 Deny
=1 Deny

Allow

STATE

® Enabled

"Q

ASSIGNED COLLECTOR GROUPS

High Security Collector Group (0 collectors included)
123 (0 collectors included)

aaa (0 collectors included)
agamous (0 collectors included)
AndreyF (0 collectors included)
andreyt (0 collectors included)
assdsad d as as dsa dsa dsadfs fds rgffd... (0 collectors included)
Brooks (0 collectors included)

Chris Test Group (2 collectors included)

Danny (0 colleetors included)

David (0 collectors included)

Default Collector Group (0 collectors included)

emulation (0 collectors included)

emulationVdi (0 collectors included)

GilB (0 collectors included)

GilBDriverhonitor (1 Collector included)

Johnnie (0 collectors included)

Lena 5.2 (1 Collector included)

lena osx (0 collectors included)

Linux-Golf-P4 (0 collectors included)

Linux-NU (0 eollectors included)

Linux5.1.1 {1 Collector included)

Communication Control policies define the actions to be taken for a given application or application version.
Each policy applies to a different Collector Group(s), and all the devices that belong to that Collector Group
(s). A Collector Group can only be assigned to one policy.

The following information is defined for each communication policy:

Information Field Description

The policy name appears in the leftmost column. The policy name is
defined when the policy is created.

Policy Name

Rule

Affected Apps

Action

State (Enabled/Disabled)

The rule as it applies to the policy. The default action for the policy is
displayed under the default rule of the policy. For more details, see the
Policy rules on page 188.

The number of applications affected by the policy.

Specifies the action that is enforced when this rule is violated (Allow or

Deny).

This option enables you to disable/enable this rule.

The Assigned Collector Groups area on the right lists the Collector Group(s) assigned to the policy.
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ASSIGNED COLLECTOR GROUPS

ﬂ Unassign Group

High Security Collector Group (0 collectors included)
Default Collector Group (0 collectors included)
emulation (200 collectors included)

group1 (0 collectors included)

group2 (0 collectors included)

Insiders (2 collectors included)

Linux (3 collectors included)

lior1 (9 collectors included)

lior8888 (0 collectors included)

os¥ (5 collectors included)

oti (0 collectors included)

Roy (1 collector included)

test (1 collector included)

Win10 (12 collectors included)

Win7 (2 collectors included)

WinXP (5 collectors included)
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Predefined policies

FortiEDR is provided out-of-the-box with several predefined policies, ready for you to get started. These
policies are marked with the FEZATIAET |ogo.

» The Default Communication Control policy is one such policy, and is always listed first in the list of
policies. The Default Communication Control policy is a blocklisting policy that is automatically applied
to any Collector Group that is not assigned to any of the other Communication Control policies.

« The Servers predefined policy is an allowlist policy that assigns a Deny action to all applications by
default, except for a list of known, recognized and legitimate applications, which are allowed. This
policy gives your organization a jump-start, as some of the leg work to identify legitimate applications
in your organization has already been done for you.

e The Isolation predefined policy isolates (blocks) communication to/from a device. This policy cannot be
deleted and only applies in Prevention mode. When this policy is in force and communication for a given
device has been blocked, you can manually permit communication to/from the device for a specific
application using the procedure below.

To permit communication to/from the device for a specific application:

1. Select the APPLICATIONS page.
2. Select the application/version to which you want to permit communication.
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3. Click the Modify Action button. The following displays:

MODIFY ACTION

Firefox

All Versions

E Default Communication Control P... r=zrminer According to policy (Allow) v
Isolation Policy FezRminer Allow v
Servers Policy Fe:Aminer According to policy (Deny) W

Type comment

@ Will be applied to all current and future versions of the selected applications
Exclude All Current Versions

ra T Y
Save and Resolve [ Save )( Cancel )
. A A

4. In the Isolation Policy row, select Allow in the dropdown menu.

Policy mode

The slider m for a policy indicates the current mode for the policy. A green slider indicates Prevention

mode and a gray slider @ indicates Simulation mode. You can change the mode using the Set mode (
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(P Set mode ")

to Protection or Simulation mode on page 198.

Policy rules

For each communication policy, FortiEDR provides four rules out of the box. These rules can be modified to
specify the connections to be blocked/unblocked according to several parameters. FortiEDR provides the

following communication policy rules:

button at the top of the Policies pane. For more details about these modes, you may refer

POLICIES SETTINGS Showing 1-3/3 Search Application Policy
Al v Clone Delete = ev Assign Collector Group
POLICY NAME RULE AFFECTED APPS ACTION STATE
< [B pefault Communication Control Policy  Fumnner (CHID Total 0 denied apps (b user 0 Allow, 0 Denyl
Vendor is within 0 vendors # | Oapplications =1 Deny
Default rule (if none of the rules apply) 310 applications Allow
> servers Palicy reamner (D Total 209 denied apps &y user: 1 Allow, 0 Dery,
> Isolation Policy FEATINET Total 309 denied apps (by user: 1 Allow, 0 Deny.

¥Q

Policy Rule Description

Default rule This rule applies when none of the other three rules apply.

Reputation is less than or This rule enables FortiEDR to block/unblock by reputation score.

equal to X

Vendor is within X vendors This rule enables FortiEDR to block/unblock by vendor. For this rule, you

specify the vendor(s) to include and to exclude.

Vulnerability is greater than This rule enables FortiEDR to block/unblock by vulnerability. In the rules,

or equal to X X represents a user-defined value.

In the rules, X represents a user-defined value.

For example, the figure below shows that the Servers Policy has the following rules defined for it:

POLICIES SETTINGS Showing 1-3/3 |Search Application Policy ¥ Q)
Al v Wl Cone T Delete (W Sethode ¥ Assign Collector Group
POLICY NAME RULE AFFECTED APPS ACTION STATE
[ E Default Communication Control Policy  Fzmrner (I Total 0 denied apps (by user: 0 Allow, 0 Deny)
- Servers Policy Feanner (D Total 209 denied apps (by user: 1 Allow, 0 Deny;
Vendor is within 12 vendors 7 K4 101 applications Allow
Default rule (if none of the rules apply) - 209 applications =| Deny
> Isolation Policy FiRMNET Total 309 denied apps (by user: 1 Allow, 0 Deny;

» Vendor is within 12 vendors. This rule is enabled for the policy. The action for this rule is Allow.
» Default rule (if none of the rules apply). This rule is always enabled.
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You can enable or disable a rule for a policy by clicking the Enabled/Disabled button in the State column of

the applicable rule. This button toggles between Enabled/Disabled.

STATE

@ Enabled

® Enabled

Editing a policy rule
The four rules for a policy can be modified, as needed.

To edit a rule:

1. Click the Edit (

) button for the rule of the policy that you want to modify. This switches the view to the

APPLICATIONS page, enabling you to review the applications affected by this rule before saving it. The

following displays:

Select Filter... ~

2. Inthe Select Filter dropdown list, select the parameter whose value you want to set in the rule. This

dropdown list lists the parameters available to configure for the rule.

Vulnerability severity is greater tha... v | | Select Criteria... ~ | Setuprule.
Vulnerability severity is less than or equal to

Vulnerability severity is greater than or equal to

VENDOR REPUTATION VULMNERABILITY
Reputation is less than or equal to : )
- od BitTorrent Inc. Unknown High
Reputation is greater than or equal to
Unknown High
Vendor is within

FIRST SEEN LAST SEEN
24-May-2016 13-Sep-2016
24-May-2016 08-Sep-2016

3. Intherightmost Select Criteria dropdown list, select the value for the parameter. This dropdown list lists

the values available to configure for the parameter specified in step 2.

Vulnerability severity is greater tha... » | | Select Criteria... ~ Setup rule.
Low
APPLICATION Medium R REPUTATION VULNERABILITY
High .
= pTorrent lent Inc. Unknown High
Critical
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When modifying the Vendor is within X vendors rule, you specify the vendor(s)
to include and those to exclude for the rule.

EXCLUDE VENDORS
All v | | Search Vendor Q Showing 1-15/61 | » | &l
VENDOR NAME (0) SIGNED (0) UNSIGNED (0)

Acronis International
Adobe Systems Inc.
‘q‘ Advanced Micro Devices Inc.
- AQ Kaspersky Lab

Apache Software Foundation

Apple Inc.
Atlassian
AVAST Software

AVG Technologies

( cancel )
4. Click the Setup rule link.
x
Vulnerability severity is greater tha... v | | High v Setupl'Jle‘.‘
5. Inthe Under dropdown list, select the policy to which this rule applies.
i i x
If | vulnerability severity is greater tha.. » | | High v Under | select Policy... v Then I: Cancel :w
6. Inthe Then field, specify whether to Allow or Deny the application based on this rule.
P x
If | Vulnerability severity is greater tha...~ | | High ~ Under | [ Home Test v Then =+l Deny \: Cancel :‘
The application list now shows the number of application(s) affected by the rule change.
P x
If | Vulnerability severity is greater tha... ~ | | High ~ Under |[E Home Test v Then =+l Deny \: Cancel :‘
7. Click the Save and Enable button to save and enable the changes to the rule. A confirmation window
displays, confirming the rule change.
FortiEDR 7.2.0 Administration Guide 190

Fortinet Inc.



Communication control

RULE SAVED

Rule has been saved and enabled.

8. Click OK.

Assigning a policy to a Collector Group

1. Check the policy that you want to change in the policy list and then click theAssign Collector Group

button. The following displays:

COLLECTOR GROUP ASSIGNMENT
Search Q

GROUP NAME « # OF COLLECTORS

High Security Collector Group
1@#$%"
1234 qwer
Default Collector Group
Group name that is so long that will have 3
hvghv
keren
kikbhj
knikin

1 Collector group selected

0

2 (=1 (=1 (=1 (=1 L~ (=1 (=]

m ( cancel )

Available
Available
Available
Available
Available

Available

Available

Availahle

2. Check the checkbox of the Collector Group you want to assign to the policy.
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3. Click Assign. A window displays, prompting you to confirm the reassignment.

CONFIRM

Group [A Victim] is already assigned to [Communication Control] policy - [Default Communication
Control Policy]. A Collector Group cannot be assigned to more than one [Communication Control]
policy and therefore will be removed from the previous one. Do you want to continue?

4. Click OK. The following displays:

ASSIGNMENT CONFIRMATION

Collector group

keren

was successfully assigned to application policy
Servers Policy

5. Click OK.

Creating a new Communication Control policy

A new Communication Control policy can be created by cloning an existing policy, as described below. New
policies are only needed if you are going to assign different policies to different Collector Groups.
Otherwise, you can simply modify one of the default policies that come out-of-the-box and apply it to all
FortiEDR Collector Groups by default. Modifications made on one policy do not affect any other policies.
1. In the policy list, check the policy that you want to clone. There are two types of Communication

Control policies: blocklisting policies ( =] ), such as the Default communication control policy, which

allows any connection by default, and allowlisting policies ( ), such as the Servers policy, which
denies any connection by default.
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2. Click the Clone button. The following window displays:

POLICY CLONING
ORIGINAL POLICY NAME CLOMED POLICY NAME
Default Communication Control Policy Default Communication Control Policy clong|

1 Application policy will be cloned

(O3 ( Cancel )

3. Inthe Cloned Policy Name field, specify a name for the cloned policy.
4. Click Clone.

Other options in the Policies pane

Option Description

wl M Click the down arrow in the = + button and then select an option in
the dropdown list to filter the policy list accordingly.

_!I Clone Click this button to clone a policy.

i‘ Delate Click this button to delete a policy. Before deletion, a confirmation
message displays, prompting you to confirm the deletion of the policy.

(P Setmode~ Click the down arrow in the (TJ) St mode = button and then select the
mode for the policy, as described in Policy mode on page 187
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Host Firewall (COLLECTOR 6.1 OR LATER)

Use the Communications Control > Host Firewall page to configure host firewall policies to control incoming

and outgoing network traffic to protect endpoints against unwanted connections based on remote
addresses, protocols, or applications in use to reflect the organization’s network policies. Host firewall
policies reduce the attack surface by protecting the host while working outside the enterprise network
(public Internet, home, or other networks).

Communication Control ~

Applications
Folicies
Host Firewa
Host Firewall
+ 0 Q
hpolicy1 «© N 2 b o
val «© et ¥ o b
h-policy3 o© . o OO
Folicy «© . 2 @O
New Policy o) N o2 0o
aaaaaaa _policy o N o DO o
hf_new_policy_5 = N <o OO
hf-osx_policy4 [ o] Default Collector Group ) ¢mba
osxepolicy «@© davdat-osx + 200
To configure a host firewall policy:
1. In the Communications Control > Host Firewall page, click the Add button at the top left corner.
2. Specify a name for the host firewall policy.
3. Select the Collector groups that the host firewall policy applies to.
4. Click Save to save the host firewall policy.
The host firewall policy appears in the list.
5. (Optional) Add or remove Collector groups for the host firewall policy in the Agent groups column.
6. Define rules to associate with the host firewall policy:
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a. Expand the row of the host firewall policy in the table.
10 results

name mode

mypolicy1 D

b. Click the Add button under the host firewall policy.

Enable the rule if you want to enforce the rule immediately after creation. You can also choose to
enable it later.

d. Specify a name for the rule.
e. Specify the application name or IP address and port combination that the rule applies to.

The IP address and port can be single or a range, including wildcard. For example, 192.168.0.1 or
192.168.0.1-192.168.0.100.

f. Select the protocol, which can be TCP, UDP, or any.

g. Inthe Process field, specify an application name to apply the rule to one specific application or use
the default Any, which means the rule applies to all applications.

h. Inthe Action dropdown, select whether to allow or deny matching connections.
The action applies to both incoming and outgoing traffic.

i. (Optional) Add a description for the rule.

jo Click Save to save therule.
The rule appears under the host firewall policy in the table.

k. Add more rules by repeating the steps above as needed.

. When more than one rule exists, drag and drop the rules in the order of priority. When the criteria of
multiple groups are met, the first matching rule will be used.

7. Enable or disable the host firewall policy or a specific rule using the mode button.

8. Tolog connections blocked by a Collector, check the Firewall Block action in the Collector's assigned
Threat Hunting Collection profiles on page 233.

Host firewall policies work side by side with existing Communication Control
policies. In case of contradictions, FortiEDR applies the more restrictive out of the
& ! /, two. For example, if a group is assigned to a host firewall policy that allows any
? connection to a specific remote address but the Communication Control policy
- assigned to the group restricts connections to low reputation applications,
connections to the remote address will be blocked if the connection goes to low
reputation applications.
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Security Settings

This chapter describes FortiEDR security policies and Playbook policies for defining, monitoring and
handling FortiEDR security.

Security events

FortiEDR security policies

The most powerful proprietary feature of the FortiEDR platform is its predefined and configurable security
policies.

To access the FortiEDR Security Policies page, click the down arrow next to SECURITY SETTINGS > Security
Events > Security Policies.

v Security Events
Security Policies
Exception Manager
Exclusion Manager

Application Control

»  Threat Hunting

Playbooks

Disk Encryption

Out-of-the-box policies

FortiEDR provides the following out-of-the-box policies. Each policy comes with multiple highly intelligent
rules that enforce it.
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Ay
b ] L4
q You will receive one or all policies, depending on your FortiEDR license.

» Application Control: This policy enables FortiEDR to block user-defined applications from running, so
that they do not launch. Blocklist management is done on the Application Control on page 223 page.

Ay
‘Q' Application Control security events are displayed under dedicated Application
|| Control filter in the Incidents page and are not listed as part of the All filter.

« Device Control: This policy enables FortiEDR to detect and block the usage of USB devices, such as USB
mass storage devices. In this policy, detection is based on the device type.

This feature is a license-dependent and requires the Vulnerability Management
) ! /. add-on (meaning License Type that is either Discover and Protect or Discover,
q Protect and Response). Device Control security events are displayed under
- dedicated Device Control filter in the Incidents page and are not listed as part of
the All filter.

» Execution Prevention: This policy blocks the execution of files that are identified as malicious or
suspected to be malicious. For this policy, each file is analyzed to find evidence for malicious activity.
One of the following rules is triggered, based on the analysis result:

° Most Likely a Malicious File: A Malicious File Execution rule is triggered with a critical severity. By
default, the file is blocked.
° Probably a Malicious File: A Suspicious File Execution rule is triggered with a high severity. By
default, the file is blocked.
° Show Evidence of Malicious File: An Unresolved file rule is triggered with a medium severity. By
default, the file is logged, but is not blocked.
« Exfiltration Prevention: This policy enables FortiEDR to distinguish which connection establishment
requests are malicious ones.
* Mobile Devices: This policy enables FortiEDR to detect and prevent access to malicious URL and IP
addresses from the mobile devices.

& ! /, The Mobile Devices policies are available only if mobile is enabled in the
? organization setting. See Step 2 — Defining or importing an organization on page
- 419.

e Ransomware Prevention: This policy enables FortiEDR to detect and block malware that prevents or
limits users from accessing their own system.

« eXtended Detection Policy: This policy provides visibility into data across multiple security systems and
identifies abnormal or malicious activity by applying analytics and correlating data from various
systems. Events are logged and displayed in the Incidents tab. No blocking options are provided. The
exceptions options are not available in the Incidents tab for security events triggered by this policy.
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S ! /, This policy requires that you configure an XDR source connector in the
q Administration > Connectors section. This feature is a license-dependent add-on.
- You may contact Fortinet Support for more information.
SECURITY POLICIES Search Q ASSIGNED COLLECTOR GROUPS

~ Al statu POLICY NAME RULE ACTION STATE High Security Collector Group (15 collectors included)
£ Appiication Control FoRTnET Default Collector Group (0 collectors included)
& Device Control Fonrner emulation (987 collectors included)

. - osx (2 collectors included
@ Execution Prevention e ] 4

Malicious File Detected @ Block Enabled

Privilege Escalation Exploit Detected - Amalicious escalation of privileges was detected @ Block Enabled

‘Sandbox Analysis - File was sentto the sandbox for analysis b Log Enabled

Stack Pivot - Stack Pointer is Out of Bounds @ Block Enabled

‘Suspicious Driver Load - Attempt to load a suspicious driver @ Block Enabled

‘Suspicious Seript Execution - A script was executed in a suspicious context @ Block Enabled

Wy Exiiltration Prevention  Fomrner
0 Mobile Devices Fonrner
ex

{F Ransomware Prevention  FuArnner

%] eXtended Detection rnmer

All security policies can run simultaneously. However, these security policies detect rule violations at
different places and points in time in the operating system. When multiple security policies are triggered,
FortiEDR uses the following guidelines to avoid generating duplicate security events:

For connection establishment attempts, the Exfiltration Prevention rule violation is detected.

For attempts to lock files or access their data (for example, by encrypting the data), the Ransomware
rule violation is detected.

When a malicious file is being executed by the user or by the operation system, the Execution
Prevention rule violation is detected.

For attempts to use a USB device, such as a mass storage device, the Device Control rule violation is
detected. It is supported on Windows devices only.

For execution attempts of an application that is included in the blocklist, the Application Control rule
violation is detected.

When malicious activity is identified across network, endpoints, and cloud, an Extended Detection rule
violation is detected.

Protection or Simulation mode

During an initial acquaintance period or at any time, you can decide that FortiEDR acts as either of the
following:

Protection: FortiEDR enforces its active exfiltration prevention policy that blocks all connections that
violate the relevant FortiEDR security policy rules.

Simulation (Notification Only): FortiEDR only issues an alert (described below) for all connections that
violate any rule in the FortiEDR security policy. In this mode, FortiEDR does not block exfiltration.
FortiEDR comes out-of-the-box set to this mode.
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NP If you have purchased a Content add-on license, policy rules and built-in
‘Q' exceptions are periodically automatically added or updated by Fortinet. When a
- new security policy is added, an indicator number displays on the SECURITY

SETTINGS tab.

Use the Protection/Simulation slider at the far right of the window to enable the applicable mode, as shown
below:

22 FortiEDR | Open Dashboard  Incidents  Threat Hunting ~ Communication Control v Security Settings v Inventory «  Administration v

SECURITY POLICIES Search Q ASSIGNED COLLECTOR GROUPS
~ Al statu. POLICY NAME RULE ACTION STATE High Security Collector Group (15 collectors included)
3 £ Application Control Fommner (D Default Collector Group (0 collectors included)
& Device Control J— emulation (987 collectors included)
@ Execution Prevention  Feznner 05X (2 collectors included)

Ry Exdilration Prevention

[ Mobile Devices

£x .
[F Rensomware Prevention

3 eXtended Detection Foanner

Security Policies page

The SECURITY POLICIES page displays a row for each security policy. Each policy row can be expanded to
show the rules that it contains, as shown below. To access this page, click the down arrow next to
SECURITY SETTINGS and then select Security Policies.

SECURITY POLICIES

Search Q ASSIGNED COLLECTOR GROUPS
~ Allstatu..  POLICY NAME RULE ACTION STATE High Security Collector Group (15 collectors included)
% Appiication Control FoRmnEr Default Collector Group (0 collectors included)
& Device Control el emulation (987 collectors included)
2 collectors included
< @ Exccvion Preventon  Forrner (I o (2 collectorsinchuded)
Maiicious File Detected @ Block © Enabled
Privilege Escalation Exploit Detected - Amalicious escalation of privileges was detected @ Biock ® Ensbled
Sandbox Analysis - File was sent to the sandbox for analysis b Log ® Enabled
Stack Pivot - Stack Pointer is Out of Bounds @ Block © Enabled
Suspicious Driver Load - Attempt o load a suspicious driver @ Block © Enabled
Suspicious Script Execution - A script was executed in a suspicious context @ Block @ Enabled
Ry Exdiltration Prevention FoRTner
0 Mobile Devices Fonrner

ex .
@ Ransomware Prevention  Fmmner

%] eXtended Detection rnmer

FortiEDR is provided out-of-the-box with several predefined security policies (depending on your license),
ready for you to get started. By default, all policies are set to Simulation mode (meaning that they only log
and do not block) and show the FE:RTINET |ogo. This page also enables you to define additional policies. See
Out-of-the-box policies on page 196 for more details.

Security Policy Icon

Application Control Policies ':ﬂT
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Security Policy Icon

Device Control Policies ﬁ“
Execution Prevention 9
Exfiltration Prevention Ry
Mobile Devices O

M/, This section is available only if mobile is enabled in the
organization setting. See Step 2 — Defining or importing

= an organization on page 419.
Ransomware Prevention X
Extended Detection b

The following information is defined per security policy:

Information Field Description

Policy Name The policy name appears in the left most column. The policy name is
defined when the policy is created. The name of the Default Policy cannot
be changed.

Rule Name FortiEDR’s proprietary rules come predefined and are the primary

component of FortiEDR’s proprietary security solution. This column
displays a short description for the purpose of this rule.

W, You can expand the ADVANCED POLICY & RULES DATA
‘Q' area at the bottom left of the window to display a more
- detailed description of what the rule does and how it

- works.

Action Specifies the action that is enforced when this rule is violated. You can
change this field, as follows:

« Block @ Elock: When this policy is set to Prevention mode (Setting a
security policy’s Prevention or Simulation mode on page 201), the
exfiltration attempt is blocked and a blocking event is generated.
When this policy is set to Simulation mode, the outgoing connection
attempt is NOT blocked and a simulated-blocking event is generated
(this indicates that FortiEDR would have blocked the exfiltration if
the policy had been set to Prevention mode).

« Log ™ 2 : The event is only logged regardless of whether the policy
is set to Prevention or Simulation mode. The outgoing connection
attempt is not blocked.

State (Enabled/Disabled) This option enables you to disable/enable this rule.
FortiEDR'’s rules have been created as a result of extensive expertise and
experience. Therefore, we do not recommend disabling any of them.
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To reset a FortiEDR security policy to its out-of-the-box settings, click the Reset
Policy button in the ADVANCED POLICY & RULE DATA section, as shown below:

< ADVANCED POLICY & RULE DATA

S~ Rule Details  Factory Settings
¢ =

Reset Policy

Setting a security policy’s Prevention or
Simulation mode

Each FortiEDR security policy can be set to operate in one of the following modes:

» Prevention: FortiEDR enforces its active prevention policy that blocks all activity that violates relevant
rules in the FortiEDR security policy.

< Simulation/Notification Only: FortiEDR logs and alerts only violations of FortiEDR security policy. The
events are shown in the FortiEDR Central Manager. In this mode, FortiEDR does not block malicious
activity. This is the default mode of all FortiEDR security policies out of the box. You can decide to use
this mode during an initial acquaintance period or at any time.

To set a security policy to Prevention or Simulation mode:

1. Select the checkbox of the security policy to be configured. Alternatively, you can select the top-left
checkbox to configure all security policies at once.
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SECURITY POLICIES

!| Clone Paolicy {:] Set Mode v Aszign Collector Group E Delete
v v All statu. . POLICY NAME

Dl v {4t Application Control F=Aminer (D
5l v & Device Control Formner D
e ' Execution Prevention F=pminer (0D
=N Ry Exiliration Prevention roanner (D
ol v [ Moabile Devices Fzpminer (0D
Bl v E Ransomware Prevention rommner (D
5| v ‘#. eXtended Detection FZ=ATINET.

2. You can now either:

a. (B Setmode. olick Set Mode and select either Prevention or Simulation, as shown above.

b. CI®: Move the slider to the left for Prevention or to the right for Simulation.

You can also set all FortiEDR policies to Simulation mode at once by moving the

slider at the top-left corner to Simulation, as shown below:

SECURITY POLICIES

!| Clone Paolicy {:] Set Mode b Aszign Collector Group
Prevention

« = All stat Simulation ME
) 0y . I 44t Application Control FiZRTINET
g L & Device Control FLIATIMET
BV ' Execution Prevention F:i=RTINET
b Mg Exfliration Prevention FLIATINET
bW [ Mobile Devices FE=RATINET
PV E Ransomware Prevention  FoAnner
D ¥ ‘s’ eXtended Detection FZ=ATINET

=}
=
i3
@
1]

CICRCRCRCN®
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Creating a new security policy

A new security policy can be created by cloning an existing policy, as described below. New security
policies are only needed if you are going to assign different policies to different Collector Groups.
Otherwise, you can simply modify one of the default policies that are provided out-of-the-box and apply it

to all FortiEDR Collectors by default. Modifications made on one security policy do not affect any other
policies.

To create a new security policy:

1. Inthe SECURITY POLICIES page, check the checkbox of the security policy to be cloned. The buttons at
the top of the window then become active.

SECURITY POLICIES

Search *Q ASSIGNED COLLECTOR GROUPS
[ cione e ©y (B SetMode  ~ [ Assign Colector Group i oeee |
~ Allstatu. POLICY NAME RULE ACTION STATE High Security Collector Group (15 collectors included)

4 Application Control Formner Default Collector Group (0 collectors included)
& Device Contral J— emulation (987 collectors included)
' Executior vention JR— osx (2 collectors included)

> Ry Exiitration Preventio
{ MobileDevices ~ pznmy ner
& Ransomware Prevention  Fummner
3! eXtended Detection Formner
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2. Select the Clone Policy = pbutton. The following window displays:

POLICY CLONING

ORIGINAL POLICY NAME CLONED POLICY NAME

Exfiltration Prevention Exfiltration Prevention cl

1 Policy will be cloned

I.-r-- — -\'ﬂl
Clone | Cancel |
L A’

3. Specify the name of the new security policy and click the Clone button.

4. If needed, assign the security policy to the required Collector Group so that it protects all the FortiEDR
Collectors in that group, as described in Assigning a security policy to a Collector Group on page 205.
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Assigning a security policy to a Collector Group

By default, a security policy protects the FortiEDR Collectors that belong to that Collector Group. A security
policy can be assigned to more than one Collector Group. Multiple security policies can be assigned to each

Collector Group.

) ! /. It is not recommended to assign multiple security policies that have the same or
? overlapping rules to a Collector Group, as this means that the same security events
- will be triggered in response to both policies, producing duplicated events.

Refer to Defining a new Collector Group on page 262 for a description of how to define a new Collector
Group in the INVENTORY tab.

1. Inthe SECURITY POLICIES page, select the name of the security policy to be assigned by clicking its
checkbox. The right side of the window displays the Collector Groups to which this policy is assigned.

SECURITY POLICIES Search -Q |ASSIGNED COLLECTOR GROUPS
) Clonc Policy () SetMode  ~ Assign Collector Group|  [i] Delete:
~ Al statu. POLICY NAME RULE ACTION STATE High Security Collector Group (0 collectors included)
p %t Application Control FoAnner CID Ayala (0 col ided)
& Defaut Gollector Group (3 collectors included)
v group_t (1 collectors included)
new (1 collectors included)
R
s¢ (4 collectors included)
g OTI (0 collectors included)
ex
-] Upgrade (2 collectors included)
-

2. Click the Assign Collector Group toolbar button, which displays the following window in which you can
select the Collector Groups to which to assign this policy.
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COLLECTOR GROUP ASSIGNMENT

Search

0 Collector groups selected

GROUP NAMEa
Default VDI Group
ensilo employees
ensSilo Servers
Home users

my citrix pool (VDI)
05X Users

Store

U5 Users

Q

# OF COLLECTORS

0 v Assigned

45 v Assigned

0 v Assigned

6

0 v Assigned

13

0

0 v Assigned
' Cancel '

A\,

The ASSIGNED COLLECTORS GROUPS area lists all the Collector Groups that have

been assigned a security policy to protect them. You can also simply drag-and-drop
a Collector Group from this list onto a policy in the left pane of this window to assign

the Collector Group to be protected by that policy.

Deleting a security policy

Select the policy’s checkbox and then click the Delete button.
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Control, eXtended Detection, and Execution Prevention FortiEDR security policies

\‘é’, The Exfiltration Prevention, Ransomware Prevention, Device Control, Application
] provided out-of-the-box (Fi:ZATIMET ) cannot be deleted.

Exception Manager

Exceptions enable you to limit the enforcement of a rule, meaning to create a white list for a specific flow of
events that was used to establish a connection request or perform a specific operation.

An exception can be made for a Collector Group (several specific ones or for all) and a destination IP (a
specific one, IP-set or all). The event is then no longer triggered for that specific Collector Group or
destination IP. This exception can be added on part or the entire set of rules and the process that triggered
this event.

When an exception is defined, it results in one or more exception pairs. An exception pair specifies the rule
that was violated, and the process on which the violation occurred, including its entire location path. For
example, the following shows several examples of exception pairs:

« Rule - File encryptor with Process — c:\users\root\Desktop\ransom\RnsmTOX. exe

¢ Rule - Process hollowing with Process — c:\users\root\AppData\Local\hipmiav.exe
An exception that applies to a security event can result in the creation of several exception pairs. Each
exception is associated with a specific process path. You determine whether the exception pair can run

from the event-specific path or whether to apply the exception for this process so that it can run from any
path.

If the exception pair includes more than one process, you can include the other processes too, as well as
determine whether they can run from the event-specific path or from any path.

Any exception that you define applies to all policies.

Exceptions are created in the Incidents tab, as described onDefining security event exceptions on page 118

Fortinet Cloud Services (FCS) may push an automated exception in cases where
& ! /, extended analysis and investigation of a security event leads to its reclassification
? as Safe. This prevents the security event from triggering again. In such cases, the
- security event is moved under handled events and the exception that was set is
added in the Exception Manager with FortiEDRCloudServices as the handling user.

To manage exceptions:

1. Select SECURITY SETTINGS > Security Events > Exception Manager. Alternatively, in the Incidents tab,
click the Exception Manager button. The following window displays, showing the list of previously
created exceptions:
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EXCEPTION MANAGER

Search Exception Advanced
Delete Showing 110201 | » |31
ENT PROCESS PROCESS PATH EXECUTED WITH PATH RULES COLLECTOR GROUPS DESTINATIONS USERS LAST UPDATED ~

663219 EXCEL.EXE Any path Suspicious Macro High Security Collector ... All Destinations. All Users 05-0ct-2020, 11:45 H4

by: Einat

30558956 netsh.exe \Windows\System32 PanGpHip.exe Any path Suspicious Script Execution All Collector Groups All Destinations All Users 23-Mar-2020, 09:47 H

by: Tzaf

665954 OfficeTimelineStartup.e... Any path Unconfirmed Executable All Collector Groups Internal Destinations (Al... All Users 23-0ct-2018, 19:05 ®

by: Tzafit
OfficeTimelineStartUp.e... Any path Unconfirmed Executable

666041 maktubransomware.exe .\Ransomware.Maktub PUP All Collector Groups 167.114.64.227 Al Users 23.0ct-2018, 18:51 %

by: Tzafit
maktubransomware.exe .\Ransomware.Maktub PUP
maktubransomware.exe .\Ransomware.Maktub PUP

142648 camstudio.exe Sers\TM.CDE\Desktop Malicious File Detected All Collector Groups Internal Destinations (AL All Users 25.5ep-2018, 23:16 H1

by: Tzafit

197019 Cisco WebEx Start Any path PUP Home users 184.87.163.50 All Users 05-Nov-2017, 13:35 H1

by: admin
Cisco WebEx Start Any path PUP

ﬂ If the exception includes a free-text comment, you can hover over the Event ID in
I the Exception Manager to display it.

EXCEPTION MANAGER

STORR, FortnetClousarvicss, ot 06-0ct-2020, D04172 Malicious File Detected All Collector Group: All Destinations AN Usé PP p—
& The fle ek exe is classibied as Good. y: Fortineccloudse
On e device WINIOSS

ﬂu can delete one or more exceptions simultaneously by selecting the checkbox at the beginning
its row and then clicking the Delete button.

EXCEPTION MANAGER

H EXECUTED WITH H ES COLLECTOR GROUPS

442648 camstucio.exe sersyTM.COEDESKOp wialicious File Detected Al Collector Group: internal Destinations (Al... All Users 2 316 H1
197019 Cisto WebEx Start Any path PUP Home users 184.87.163.50 All Users 05-New-2017, 1335 11
by: admir

2. Tofilter the exception list, click the Advanced button. The window displays various filter boxes at the
top of the window, which you can use to filter the list by specific criteria.

EXCEPTION MANAGER
Process Path Rule ~  Group ~ Destination User Close
Click the Basic search button to access the standard search options.

Click the Edit Exception an button in an exception row to edit that exception. For more details, see
Editing Security Event Exceptions on Editing security event exceptions on page 121.
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===
Click the Delete M button in an exception row to delete that exception.

Changes can be made on multiple exceptions at the same time by checking the Exceptions that you
would like to edit and then clicking on the Edit tool, as shown below:

EXCEPTION MANAGER

Search Exception Advanced
S Edt W Delete [ export + Showing 1-10/459 | » || »1
EVENT PROCESS PROCESS PATH EXECUTED WITH PATH RULES COLLECTOR GROUPS DESTINATIONS USERS LAST UPDATED =
4427089 eicar.com Any path Malicious File Detected All Collector Groups All Destinations All users 13Jan-2021, 08:37 -4
by: FortinetCloudServi...
grid.appScope.getMaxAlerte
v 4418037 TeamViewer_Service.exe  Any path PUP liortest1 2a00:11¢0:26:351:188:1 AllUsers 13-Jan-2021, 04:11 ={
2a00:11c0:2:351:21322. by: sofi
2a00:11¢0:63:351:188:1
grid.appScope.getMaxAlerte
v 4425068 ConnectivityTestAppNe... ...nnectivityTestAppNew Malicious File Detected TTGroup Internal Destinations (Al... All Users 134an-2021, 04:09 H'e
by: sofi

grid.appScope.getMaxAlert

The following window displays in the which you can choose to add new Collector Groups in addition to
existing ones or to replace all Collector Groups with the new Collector Group values that you select:

EDIT MULTIPLE EXCEPTIONS

2 Exceptions selected

Collector groups

e | Cloud X~ All Groups Add To Existing v

« Add To Existing
Destinations
Replace Al
e v All Destinations P A s

Type comments

Save Changes RN

This same procedure can be used to edit the IP sets of the destination addresses of the selected
exceptions.
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Exclusion Manager

The Exclusion Manager enables you to define which processes, files, or domains are excluded from Security
Policies monitoring. Three types of exclusions can be defined in the Exclusion Manager:

* (PC only) Process Exclusions: This type of exclusion specifies that FortiEDR does not inspect the
actions that are performed by specific processes, so that these processes do not trigger security
events. The processes that are excluded are identified by the attributes of the processes, according to
your definitions.

There may be various reasons for excluding a process in this manner. For example, when a process’s
performance/functionality is affected by FortiEDR’s inspection, but the customer knows that this
process is good/safe (this example is relevant, even when the process does not trigger security
events). Therefore, in this case, the exclusion will specify that FortiEDR no longer inspects the specified
processes.

Please note that adding this type of exclusion excludes this process from being monitored by all
FortiEDR features and all activities of this process are ignored.

» Execution Prevention Exclusions: The Execution Prevention policy inspects/scans files and then blocks
their execution if they are identified as malicious or suspected to be malicious. Execution Prevention
Exclusions specify that FortiEDR does not apply the Execution Prevention policy inspection, which
analyzes files in order to find evidence of malicious activity, as described in Security Settings on page
196. The files that are excluded are identified by the attributes of the files that are the target of the
Execution Prevention actions, according to your definitions.

* (Mobile only) Domain Exclusions: The Malicious URL/IP Detected policy inspects/scans URLs/domains
and blocks connections to them if they are identified as malicious or suspected to be malicious. Domain
Exclusions specify that FortiEDR does not apply the Malicious URL/IP Detected policy inspection. The
domains that are excluded are identified according to your definitions.

To manage exclusions:

Select SECURITY SETTINGS > Security Events > Exclusion Manager. The following window displays, showing
the list of previously created exclusions:

EXCLUSION MANAGER

(B Add lst~ [7 ot [ Import .2, (@Add Exclusionv

Mobil
[
@ KissLand 2024-04-17 03:31:28 by FortiED, @ Enabled

New Exclusion List (0) [}

No groups assigned

The list of exclusions in the Exclusion Manager page contains the following columns:

Column Description

Checkbox Enables you to select multiple rows.
Icon Represents the type of exclusion

¢ II-T - Process
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Column Description

¢ @ - Execution Prevention

* %’P - Domain
SOURCE ATTRIBUTES Specifies the attributes that were defined in order to identify the
Process/File/Domain, as described in Defining exclusions on page 213
oS Specifies the operating system to which the exclusion applies.
LAST UPDATED Specifies when this exclusion was last updated and by whom.
STATE Specifies whether this exclusion is enabled or disabled.
y E] Edit and delete excursion tools.

The following actions can be performed in the Exclusion Manager page:

 Filtering on page 211

» Defining Exclusion Lists on page 211

« Defining exclusions on page 213

« Exporting and importing exclusion lists on page 222

Filtering

To filter the Exclusion List names and their content, simply enter text in the Search field. Afterwards, only
the Exclusion Lists that match the provided text are displayed showing only the relevant exclusions.

To filter the list of exclusions by type, click one of the following options:

[|JProcess | & Execution Prevention '@;Dnmain

Defining Exclusion Lists

An Exclusion List contains a list of exclusions. You can assign Collector Groups to an Exclusion List in order
to specify that the exclusions in the Exclusion List apply to the Collectors in the Collector Groups assigned

to it. Exclusion Lists enable you to logically organize, categorize and group exclusions based on the type of
activity data they are to exclude.

For example, let’s say that you want to collect network activity data for your system, but a specific
application generates quite a bit of uninteresting logistical network activity that you do not want to collect.
In this case, you can define an Exclusion List named after that application that contains one or more
exclusions that relate specifically to the network activity generated by that application. Exclusion Lists can
be organized anyway you see fit. For example, you can create an Exclusion List for security products, a
different one for PDF documents, a different one for HR-related software and so on.
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FortiEDR provides two types of exclusion lists: PC and mobile, which can be applied to PC Collector groups
and mobile Collector groups, respectively. The type is indicated by the PC or mobile icon at the top right
corner of the exclusion list card.

Al
‘Q' The Mobile option is available only if mobile is enabled in the organization setting.
- See Step 2 - Defining or importing an organization on page 419.

(B Addlistv [ Export [ import .5,

Mew Exclusion List (0) Q

Mo groups assigned

MNew Exclusion List (0) D

Mo groups assigned 4

Adding an Exclusion List

To define an Exclusion List:

1. Click the + Add List option, select the type (PC or Mobile), and provide a name to create a new Exclusion
List.

Ay
‘?' The Mobile option is available only if mobile is enabled in the organization
|| setting. See Step 2 — Defining or importing an organization on page 419.

2. Add (define) the exclusions of this Exclusion List (as described on the following page). Each exclusion
that you add belongs to a specific Exclusion List.

3. Assign Collector Groups to this Exclusion List (as described below) in order to determine to which
Collector Groups these exclusions apply. A Collector Group can be assigned to multiple Exclusion Lists.

Assigning a Collector Group to an Exclusion List

New Exclusion List (0) Q

No groups assigneq ==
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You can perform the following operations on an Exclusion List:

Operation Description

Assign a Collector Group Click the + button in the Exclusion List to which to assign a Collector
Group. Then, select the Collectors groups to which to assign this list and
approve it. Note that a Collector Group can be assigned to multiple
Exclusion Lists.

Unassign a Collector Group Click the + button and uncheck the Collector Group to be removed from
an Exclusion List.

. . . . . . . . . .
Delete Exclusions List Click the Delete W button. Note that all Exclusions in this list will be

removed and will no longer be applied to the assigned Collector groups.

Defining exclusions

All exclusions must belong to an exclusion list. Select an exclusion list on the left to display the exclusions
that are defined in it.

The following describes how to define a Process Exclusion (PC only), Execution Prevention Exclusion, and
Domain Exclusion (mobile only).

Adding a Process Exclusion

1. In the left pane, click the PC Exclusion List to which to add the process exclusion.

2. Intheright pane, click the + Add Exclusion button. The following displays providing a choice of the two
types of exclusions that you can define.

@F&dd Exclusions

Process

Execution Prevention E
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3. Select Process. The following displays:
PROCESS EXCLUSION

Exclude the process below from monitoring by the various FortiEDR features
Mote: all Process activities will be ignored

Operating system | Windows w
Define process by

# Hash

Attributes

>  Advanced

Exclusion List MNew Exclusion List

Comments

1]
-
=]
o

The Operating system dropdown menu specifies Windows, which is currently the only operating system
supported for exclusions.

[ &

Define the processes to be excluded using one of the following options: Hash or any combination of File
Name / Path / Signer, as follows:
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» Hash: Mark the Hash radio button and specify the Hash that uniquely identifies this process.
Define process by

Hash

» File Name / Path / Signer: Mark the Attributes radio button and check at least one of the File Name /
Path | Signer fields checkboxes and fill the relevant values, as follows:

o Attributes

File name

Path

Signer

Y Advanced

Do not monitor also actions applied on the process, in addition to activities done by the process

o Specify the file and/or directory to be excluded by filling in the File name field, the Path field or
both. If you fill in both fields, then that file is only excluded in that path. If you only fill in the File
name field, then that file is excluded wherever it appears. Refer to the Defining an exclusion
path on page 220 section for more details about defining an exclusion path.

o |f you want to specify a signer, select Signer, then either upload the Signer’s Certificate,
provide its thumbprint or provide the Signer’'s name.

°o When a process is identified by file name and/or path only (which means Signer is not
selected), you can disable monitoring of the process completely, including actions applied on
the process, by selecting Do not monitor also actions applied on the process, in addition to
activities done by the process under Advanced.

This option significantly reduces FortiEDR protection on the process and
S ! /, lowers the security level of the process. Use this option only for issues
9 that regular exclusions cannot solve, such as VDI freezes or other
- application malfunctions due to basic monitoring of the process by the
FortiEDR Collector.

6. The Exclusion List field specifies the Exclusion List that was selected, when the Add Exclusion option
was selected. This field is not editable.
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7. Click the Add button. This new exclusion is then listed in the Exclusion Manager page, as shown below:
EXCLUSION MANAGER

Search Q [ Process | @ Execution Prevention | @Domain

@Addlist [ Export  [§ import .2, (D Add Exclusion~

New Exclusion Lis (0) (]
it Callector ..+

m NOTE: APPLY NEW EXCLUSIONS ON COLLECTORS

New Exclusion List (0) (] @ test \Device\HarddiskVolume2\Users\root\AppData\Local AVAST Software\ [ ] Pending save ® Enabled
No groups assigned

8. The newly defined exclusions appear with a green background and the words Pending save appear in
their LAST UPDATED column. To define that these exclusions take effect, you must click the Apply
button and then click the Save button in the window that pops up. Their LAST UPDATED column then
shows the timestamp when they were saved.

Adding an Execution Prevention Exclusion

1. Inthe left pane, click the Exclusion List to which to add the exclusion.

2. Intheright pane, click the + Add Exclusion button and select Execution Prevention. Depending on the
exclusion list type (PC or mobile), one of the following windows displays:
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EXECUTION PREVENTION EXCLUSION

Exclude the files / directories below from Execution Prevention (NGAV) scanning
Operating system  Windows

Define file/directory by

File name

Path

> Advanced

Exclusion List Maw Exclusion List

Comments

@D )
P -
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EXECUTION PREVENTION EXCLUSION

Operating system  Android b
Define by

Package name

Exclusion List Mew Exclusion List
Comments
@ -
\‘ ! 'l
q The Android option is available only if mobile is enabled in the organization
|| setting. See Step 2 — Defining or importing an organization on page 419.

4. Specify the values to define the exclusion:
» For PC, follow the steps below:

Ay
‘Q' The Operating system dropdown menu specifies Windows, which is currently
|| the only operating system supported for exclusions.

i. Specify the file and/or directory to be excluded by filling in the File name field, the Path field or
both. If you fill in both fields, then that file is only excluded in that path. If you only fill in the File
name field, then that file is excluded wherever it appears. Refer to the Defining an exclusion
path on page 220 section for more details about defining an exclusion path.

FortiEDR 7.2.0 Administration Guide 218
Fortinet Inc.



Security Settings

Define file/directory by

File name

Path

ii. Under Advanced, you can select Do not monitor the files for other functionalities as well to
disable monitoring of the file/directory completely, including backup of the files for
Ransomware protection.

Ny This option significantly reduces FortiEDR protection on the files and
‘Q' lowers the security level of the files. Use this option only for issues that
|| regular exclusions cannot solve, such as VDI freezes or other application

malfunctions due to basic monitoring of the files by the FortiEDR Collector.

“ Advanced

Do not monitor the files for other functionalities as well

iii. The Exclusion List field specifies the Exclusion List that was selected, when the Add Exclusion
option was selected. This field is not editable.
« For mobile, select Android for Operating system and specify the package name. Note that FortiEDR
does not support execution prevention on iOS.
5. Click the Add button. This new exclusion is then listed in the Exclusion Manager page, as shown below:

EXCLUSION MANAGER

@Addlistw [T Export [ Import .2, (D) Add Exclusion v

Lis (0)

NOTE: APPLY NEW EXCLUSIONS ON COLLECTORS

D test \Device\HarddiskVolume2\Users\rootAppDatalLocalAVAST Software\ 5 Pending save Enabled

EXCLUSION MANAGER

Q [ Process @ Execution Prevention | Domain

@Addlistv [ Export (4 Import &, (@Add Exclusions

New Exclu

@ test Pending save Enabled

7. The newly defined exclusion appears with a green background and the words Pending save appear in
its LAST UPDATED column. To define that these exclusions take effect, you must click the Apply button
and then click the Save button in the window that pops up. Their LAST UPDATED column then shows
the timestamp when they were saved.
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(Mobile only) Adding a Domain Exclusion

1. In the left pane, click the mobile Exclusion List to which to add the domain exclusion.

2. Intheright pane, click the + Add Exclusion button. The following displays providing a choice of the two
types of exclusions that you can define.

@ﬂdd Exclusions
Execution Prevention
Domain

3. Select Domain. The following displays:

DOMAIN EXCLUSION

Operating system  Android W
Define domain by

Domain

Exclusion List Mobile URL

Comments

In the Operating system dropdown menu, select Android or iOS.

Specify the domain to exclude.

Click the Add button. This new exclusion is then listed in the Exclusion Manager page., as shown below:
The newly defined exclusions appear with a green background and the words Pending save appear in
their LAST UPDATED column. To define that these exclusions take effect, you must click the Apply
button and then click the Save button in the window that pops up. Their LAST UPDATED column then
shows the timestamp when they were saved.

N o R

Defining an exclusion path

The table below provides examples of exclusion paths with explanations of which folders apply or do not
apply:
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Exclusion path Folders that apply Folders that do not apply

\Documents\Personal\ \Documents\Personal e \Documents
e \Documents\Personal\t

emp

\Documents\Persona ¢ \Documents\Personal\subfolder\ e \Documents

1\* e \Documents\Personal\subfolder\subfolder e \Documents\Personal

\etc\
\Documents\Persona ¢ \Documents\Personal \Documents
1\ ¢ \Documents\Personal2
¢ \Documents\Personal\subfolder\

*\Documents\Persona ¢ \Documents\Personal e \Documents

1\ ¢ \Windows\Documents\Personal e \Documents\Personal\t
emp

*\Documents\Persona e \Documents\Personal\subfolder\ ¢ \Documents

1\* e \Parent\Documents\Personal\subfolder e \Documents\Personal

 Including a wildcard in a path excludes only the parent folders and/or sub-
folders and files within those parent and/or sub-folders but not the folder itself.
To exclude a directory and also the parent or sub-directories, you must define

) ! /, an exclusion path for each case. For example, to exclude \Documents\Personal
9 and all the sub-folders, define the following exclusion paths:
- e \Documents\Personal

e \Documents\Personal\*

» Physical prefix (e.g. \Device) and logical prefix or drive (e.g., C:\) are not
required in the exclusion path.

Setting the state of an exclusion

The Set State button enables you to enable or disable the selected exclusion(s). By default, an exclusion is
enabled.

For changing the state of multiple Exclusions, check the checkboxes of all relevant exclusions and then
select the state from the Set State dropdown under the toolbar.

Deleting an exclusion

The Delete Exclusion button enables you to delete the selected exclusion(s).

To delete multiple Exclusions, check the checkboxes of all relevant exclusions and then select the Delete
option in the toolbar.
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Exporting and importing exclusion lists

You can export or import exclusion lists for Process Exclusions and Execution Prevention Exclusions using
the Export and Import buttons at the top-left of the Exclusion Manager page. This function is handy in a
muiti-tenant environment where you can easily duplicate the exclusion lists for some or all organizations
without the need to re-define exclusions for each organization separately.

EXCLUSION MANAGER

@ Add list Export Import .+ (DAdd Exclusionw

New Exclusion Lis (0) (]
Defaut Collector ..+

New Exclusion List (1) (]

AF Android (1 Collectors)

To export one or multiple exclusion lists:

1. In the Exclusion Manager page, click Export at the top-left corner.
2. Inthe window that appears, select the list(s) to export. To export all lists, select All lists.

EXPORT SECURITY EXCLUSION LISTS

Select lists to export

All lists ~
New Exclusion List
Mew Exclusion List1
Mew Exclusion List1111
MNew Exclusion List12
MNew Exclusion Lists

New Exclusion_110
Cancel )

3. Click Export.

4. After the export is complete, click Download to save the file and then click Close.
The file includes all exported exclusions and the exclusion lists that each exclusion belongs to.
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To import one or multiple exclusion lists:

1. In the Exclusion Manager page, click Import at the top-left corner.
2. Select the list(s) to import (that you have saved or exported) and click Open.
3. Wait for the import to complete and click Close.

IMPORT SECURITY EXCLUSIONS LISTS

\" S\ \wNwtwaZ\"\w\w\w\wwAay

All Security Exclusion Lists were successfully imported

If alist name in the imported list already exists in the system, FortiEDR adds a
Ny suffix to the name of the newly imported list without touching the existing list.

‘Q' For example, if the list name "AV" already exists, FortiEDR renames the imported
- list as "AV_1" that will appear in addition to the existing "AV" list. If such a list
= name ("AV") gets imported again, FortiEDR increments the number in the suffix
of the list name for each subsequent import, which would be "AV_2", "AV_3", etc.

Application Control

The Application Control policy enables FortiEDR to block pre-defined applications from running, so that it
does not launch. It enables limiting the usage of hon-desired applications on specific collector groups.

enables you to control which applications can communicate outside of the

s‘é’, This differs from Applications on page 168 under Communication Control, which
- organization, but does not stop them from launching.

This section describes how to define the applications to be blocked by adding them in the Application
Control. In addition, applications can be added to the list of applications to be blocked by adding them from
the Investigation View on page 92. These applications are then listed in the Application Control Manager.

In general, in order to block applications so that they are not launched

» The applications must be added to the Application Control Manager under the user-defined group
e Collector groups must be assigned to this policy
e The blocklist rule must be enabled on the Application Control Policy.
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To add applications to the blocklist:

1. Select SECURITY SETTINGS > Application Control .

Security Settings ~ Inven

»  Security Events
Application Control

> Threat Hunting
Flaybooks

Disk Encryption

The following window displays, showing a list of different groups of applications that have been defined
to be blocked by the Application Control policies.

APPLICATION CONTROL MANAGER

‘System-defined v Search Q Policy State Enabled Disabled

(@ Add Applications

Application Name Application Attributes Policy Tag 0S  Last Updated Updated by State 11}

<=2 ootb.application.conirol.
=% (55/55)

a v v v

User-defined
(2/2)
python310 Application Control = @ Enabled

sdfgsdg Application Control = @ Enabled

Predefined application groups (indicated by the Fortinet logo by the group name) are always at the top
of the application list and are assigned to the Application Control policy by default. You cannot add or
delete applications from predefined application groups but you can disable specific applications or
change the policy settings.

Applications added by the user are automatically categorized under the User-defined group with a
default state of disabled, which means they are not blocked by default.

blocked by default, enable the Enable Default application state option in the

s‘é’, To change the default state of new applications to enabled so that they are
- Application Control Manager on page 334 section under Administration > Tools.

2. You can then perform any of the following actions:
e Adding application(s) to be blocked on page 225
» Exporting the list of applications to be blocked on page 230
» Enabling/disabling application blocking on page 231
« Changing the policy under which the application is blocked on page 231
» Searching and filtering applications on page 232

>
* Editing an Application by selecting the Edit # button on the right side of that Application’s row.
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« Deleting an Application by selecting the Delete Application option at the top of the window or

ol

selecting the Delete * button on the right side of that Application’s row.

Ay
S L4
? You cannot delete a group, change or search any group names.

Adding application(s) to be blocked

To add an application(s) to be blocked:

1. Click the + Add Application option. The following displays:
(+)add App icafion
Add application

. . ]
Upload applications

This dropdown menu provides two options for adding applications to be blocked:
* Manually adding an application to be blocked on page 226
» Uploading application(s) to be blocked on page 229
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Manually adding an application to be blocked

To manually add an application to be blocked:

1. Select Add application. The following displays:

ADD APPLICATION

Application Name

Folicy All e
Operating System  Windows
Tag +

® Hash

Attributes

File name

Path

Signer Certificate numbpnnt Name

2. Inthe Application Name field, specify a name to identify the application. The application name must be
unique within the User-defined group.
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3. From the Policy dropdown menu, select one or more of the Application Control policies in which to block
this application or select the All option to specify that this application is to be blocked by all Application
Control type policies. FortiEDR is provided out-of-the-box with a single Application Control type policy
and you can clone it in order to create additional Application Control type policies as needed.

4. You can optionally use the Tag field in order to classify this application. Tags can be helpful for

classifying and filtering long lists of applications. In the Tag field, click the Add button + to specify the
tag to be added to the application. You can assign a previously defined tag or define a new tag.

Q |

FileShare

RemoteTool
( 4+ )

f P )

5. Define the application(s) to be blocked (so that they are not executed) using one of the following
options: Hash or any combination of File Name / Path / Signer, as follows:

S ! ’, FortiEDR blocks only executables and DLLs that meet the defined criteria. When
q determining whether a file is an executable, DLL, or another type, FortiEDR
] adheres to the file nature rather than the file name (such as the .exe extension).

» Hash: Mark the Hash radio button and specify one or more Hashes. Each hash is the unique
identifier of an individual application. If you enter multiple hashes, then they must be comma
separated. Supported hash formats are specified under the field.

Hash

OR

« File Name / Path / Signer: Mark the Attributes radio button, check at least one of the File Name /
Path / Signer fields checkboxes and fill the relevant values, as follows:

o Specify the executable file of the application to be blocked by filling in the File name field.

o Specify the path to the executable file of the application to be blocked by filling in the Path
field.

If you fill in both the File name field (described above) and the Path field, then that application
is only blocked if its executable is in that path. If you only fill in the File name field, then that
application is blocked no matter where its executable file appears.

Wildcards can be used in a folder name by placing a single wildcard (*) at the beginning, end
and middle of the path.

For example: *\foldero\folderi*\folder2*
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® Attributes

v File name

Path

o |f you select Signer, then either upload the Signer’s Certificate (as shown below), provide its
thumbprint or type in the Signer’'s name. Uploading a certificate or specifying thumbprint is
more secured that specifying signer name and hence recommended.

signer

For example, selecting the Name radio button, then entering the word Microsoft, blocks the
execution of any application that was signed by Microsoft. You must enter the exact name of
the Signer.

¥ Signer Certificate Thumbprint (® Name
I

Microsoft

6. Click the Add button. The application is then listed under the User-defined group.
When a Collector Group is assigned to the application control policy (specify above), then all these
applications are blocked and cannot be launched.
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Uploading application(s) to be blocked

To upload a list of applications to be blocked from a file:

1. Select Add Application > Upload Applications. The following displays:

Upload Applications

Policy Application Control
Operating System Windows
Tag +

e g

browse

o |

Click here for a sample file

| Cancel )

2. From the Policy dropdown menu, select one or more of the Application Control policies in which to block
the applications specified in the file to be uploaded.

3. You can optionally use the Tag field in order to classify this application. Tags can be helpful for
classifying and filtering long lists of applications. In the Tag field, click to specify the tag to be added to
the application. You can assign a previously defined tag or define a new tag.

FortiEDR 7.2.0 Administration Guide 229
Fortinet Inc.



Security Settings

Q |

FileShare

RemoteTool
(+)

[ Apply ( cancel )

4. In the bottommost field of this window, select the CSV file that contains the list of applications to be
blocked. This file should be a CSV file in which the five leftmost columns (shown below) identify the
application to be blocked. A sample file can be downloaded from this window. Alternatively, you can
use the same file as can be exported, as described in Exporting the list of applications to be blocked on
page 230.

F::RTINET Report reated by user Confid

APPLICATIONS CONTROL

aaaaaaa indows 2024-02-0

Userdefred | aaaaaaa Windows 2024-02-0

Userdefred | aaaaaaa Windows 2024-02-0

User-defined uuuuu2 Windows 2024-02-0'
User-defined uuuuu2 Windows 2024-02-0'
User-defined Application_-1749470844 Windows 2024-02-0'
User-defined uuuu Windows 2024-02-0'
User-defined test Windows 2024-02-0'
User-defined sewefsefsfse Windows 2024-01-2,
User-defined hash13 Windows 2024-01-2{

5. Click the Add button. The Application Control Manager then lists a row for each application in the
uploaded file under the User-defined group.
When a Collector Group is assigned to the Application Control policy (specify above), then all the
applications that are added will be blocked and will not be launched.

Exporting the list of applications to be blocked

To export the list of FortiEDR applications to be blocked:

1. Select the group(s) that you want to export.
2. Click Export to export the applications list as an Excel file.
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Enabling/disabling application blocking

If you wish to disable the blocking of all the applications that are under a specific policy, we recommend
simply disabling the blocklist rule of that policy. Alternatively, in order to temporarily block only specific
applications, then we recommend enabling/disabling each application separately. If an application no longer
needs to be on the blocklist, then we recommend deleting it using the Delete button in the right-most
column or in the toolbar.

To enable/disable the blocking of specific applications:

1.

Select SECURITY SETTINGS > Application Control to display the Application Control Manager. Each row
represents an application to be blocked.

Select the application(s) to block. To block all applications in a specific group, select the group instead.

In the STATUS column on the right, toggle the value between Enabled and Disabled. Alternatively, you
can check the checkboxes of the desired application rows, and then select the Enabled or the Disabled
option from the Set State dropdown.

Set State wr
Erak :-IH[':%

Disabled

Newly added applications are set to be disabled by default, which means they
S ! ’, are not blocked. To change the default state of new applications to enabled (so
q that they are blocked by default), enable the Enable Default application state
- option in the Application Control Manager on page 334 section under
Administration > Settings.

Changing the policy under which the application is
blocked

To change the policy that blocks an application:

1. Select SECURITY SETTINGS > Application Control to display the Application Control Manager. Each row
represents an application to be blocked.
2. Inthe Application Control Manager window, select the application(s) to change policy. To change policy
of all applications in a specific group, select the group instead.
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3. Click the Policy Assignment option. The following displays.

POLICY ASSIGNMENT

Manage policy assignment for 3 selected applications

Policy
B Application 1 (1/3 Selected application)
= Application 2 (2/3 Selected application)
Application Control (0/3 Selected application)
Application Control clone (0/3 Selected application)
¥| Application Control Einat (2/3 Selected application)

{ C3 )
| 4 -
L Lallle J

The policies that have a checkbox to their left have already been assigned all the selected

applications. The policies that have a green minus sign = to their left have already been assigned
some of the applications. The right side of the window indicates how many of the applications that you
selected in the Application Control Manager window have been assigned to that policy. The policies
that have an empty box to their left were not assigned any of the selected applications.

4. In the Policy Assignment window, check (or uncheck) the checkboxes of the policies that should block
the currently selected applications.

5. Click the Save button.

A ! /, Alternatively, in order to mtzdify the policy to which a specific application is
9 assigned, select the Edit # button in the Application Control Manager window in
- the right side of that application’s row.

Searching and filtering applications

To filter the list of applications defined in the Application Control Manager, use the fields at the top of the
window, as follows:
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1. Enter text in the Search field. This search field uses exact word matching.
» By default, the System-defined option is selected, which specifies that the search is performed on

the most relevant fields and then the list is filtered accordingly. Alternatively, from this dropdown
menu, you can select the column that is searched, as follows:
System-defined v | Search Q
« System-defined
Application
Creator | ATTRIBUTES
Updated by

Tag

2. Select the relevant policy from the Policy field.
3. Inthe State field, select Enabled or Disabled.

Threat Hunting

FortiEDR’s threat-hunting capabilities feature a set of software tools and information sources focused on
detecting, investigating, containing, and mitigating suspicious activities on end-user devices.

A\,

‘Q' Threat Hunting Settings is a license-dependent add-on. You may contact Fortinet
Support for more information.

To set up Threat Hunting in FortiEDR, configure the following:

» Collection profiles on page 233
» Collection Exclusions on page 236
e Threat Hunting data retention on page 243

Collection profiles

A\,

‘?' Threat Hunting Settings is a license-dependent add-on. You may contact Fortinet
Support for more information.
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Threat Hunting Collection Profiles control the type of activity data that is collected for the Threat Hunting
feature (which is described in Threat Hunting on page 125). Activity data that is collected is stored on the
Repository server.

To access Threat Hunting settings, select SECURITY SETTINGS > Threat Hunting Setting > Collection Profiles.
The following page displays:

THREAT HUNTING COLLECTION PROFILES

@ Threat Hunting Data Retention: 162 days

FiRTINET
Inventory Profile

Event Collection And Storage
Collect and store Activity Events of the following categories and Types.

Comprenensive Profile (clone) File

48 groups assigned (5 Collectors)
File Created File Write File Read File Rename File Delete File Time Set

Direct Volume Access Direct Volume Write File Extended Attributes Query File Extended Attributes Set File Owner Change File Permissions Change

nventory Profile (clone)

The left side of the Threat Hunting Settings page shows a list of profiles. A profile defines the activity event
categories and actions to be collected. FortiEDR comes with several predefined profiles, which cannot be
modified. In addition to the pre-defined profiles, you can define your own custom profiles by cloning an
existing profile.

The default collection profile for Collector groups is Inventory Profile, which is indicated by the Default
Collection Profile ( ) icon). To change the default profile, hover over to the top-right corner of the target
profile card and click the Set profile as the default profile (=) icon.

You can also assign a collection profile to one or more Collector groups. See Assigning a Collector group to
a profile on page 234.

The pane on the right side of the page lists all activity event categories and their associated actions. These
categories are the same as those described on Threat Hunting on page 125. Selecting a profile on the left
displays the categories and actions defined for that profile in the right pane. Check the checkboxes of the
actions for which FortiEDR will collect activity data.

Assigning a Collector group to a profile
Profiles are assigned to Collector groups. Only a single profile can be assigned to each Collector group.

To assign a Collector group to a profile:

1. In the Profiles pane, click the + button of the profile to which to assign a Collector group. The following
displays showing the list of all Collector groups:
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THREAT HUNTING COLLECTION PROFILES

@ Threat Hunting Data Retention: null days

Event Collection And Storage

Collect and store Activity Events of the following categories and Types

File Detected

Screen Capture Process Termination Process Creation Process Start Thread Created Executable Loaded Driver Loaded

Library Loaded Keystroke Consumption

lior 2.0.3120)
NewG (0 Collectors) Home Users (1)
Research-Ben (0) File Write File Read File Rename File Delete File Time Set Direct Volume Access
david_profile 50.2132(0)
No collector groups assigned Moshe_test (0)
5.1.0(0)
MyTest (0) pbled

Write

anatoly (1) Socket Network Statistics Socket Connect DNS Query Socket Listen Socket Close Socket Accept
sofi (1)

2. Select the checkbox(s) of the Collector group(s) to assign to the profile.
3. Click Assign.

4. When prompted with a message that the selected groups are currently assigned to another profile and
will be reassigned, click Assign to confirm.

Creating/cloning a profile

In order to create a new Profile, you must first clone an existing Profile and then customize the clone.

1. Click the Clone icon that appears on the right of the profile to be cloned.

FiERTINET
nventory Profile (default)

All collector groups

2. Enter the name of the new profile.

3. Ontheright side, enable the activity events to be collected and disable the activity events that should
not be collected.

4. Click Save.

5. Assign the Collector group(s) on which to apply the newly created profile. See Assigning Collectors to a
Collector Group on page 263.
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Collection Exclusions

Exclusions are needed for reducing the amount of Threat Hunting data that is collected and by doing so
prolonging the data retention. The less data that is collected, the longer it will be stored in the databases.

Exclusions enable you to define certain types of activity events to be excluded from being collected by
Threat Hunting data (even though should be collected according to the Threat Hunting Collection Profile
assigned to a Collector group, which was described in Collection profiles on page 233). For example, if you
know that a certain process is legitimate, but it creates many activity events that are not relevant to your
Threat Hunting investigation, you can use the Collection Exclusions to define that these activities are not
collected.

The Collection Exclusions enables you to define and manage exclusion lists and the exclusions that they

contain.
Exclusions are different than security event exceptions, as follows:
) ! /. » Exclusions define which activity events should be collected. They are
q exclusions to the Threat Hunting Profile.
- » Security event exceptions are defined after a particular security event has

occurred. They are an exception to the assigned Security Policy.

To access the Collection Exclusions, select SECURITY SETTINGS > Threat Hunting > Collection Exclusions.

The Collection Exclusions page contains the following areas:

THREAT HUNTING COLLECTION EXCLUSIONS

Filters

To filter the Collection Exclusion list names and its content, simply enter text in the Search field. Afterwards,
only the Exclusion lists that match the provided text are displayed showing only the relevant exclusions.
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Defining Collection Exclusion Lists

A Collection Exclusion List contains a list of exclusions. You can assign Collector Groups to an Exclusion
List in order to specify that the exclusions in the Exclusion List apply to the Collectors in the Collector
Groups assigned to it. Exclusion Lists enable you to logically organize, categorize and group exclusions
based on the type of activity data they are to exclude.

For example, let’s say that you want to collect network activity data for your system, but a specific
application generates quite a bit of uninteresting logistical network activity that you do not want to collect.
In this case, you can define an Exclusion List named after that application that contains one or more
exclusions that relate specifically to the network activity generated by that application. Exclusion Lists can
be organized anyway you see fit. For example, you can create an Exclusion List for security products, a
different one for PDF documents, a different one for HR-related software and so on.

Adding an Exclusion List

To define an Exclusion List:

1. Click the + Add List option and provide a name to create a new Exclusion List.

2. Add (define) the exclusions of this Exclusion List (as described on the following page). Each exclusion
that you add belongs to a specific Exclusion List.

3. Assign Collector Groups to this Exclusion List (as described below) in order to determine to which
Collector Groups these exclusions apply. A Collector Group can be assigned to multiple Exclusion Lists.

Assigning a Collector Group to an Exclusion List

New Exclusion List (0) g

MNo groups assigneq <4

You can perform the following operations on an Exclusion List:

Operation Description

Assign a Collector Group: Click the + button in the Exclusion List to which to assign a Collector
Group. Then, select the Collectors groups to which to assign this list and
approve it. Note that a Collector Group can be assigned to multiple
Exclusion Lists.

Unassign a Collector Group Click the + button and uncheck the Collector Group to be removed from
an Exclusion List.

Delete Exclusions List Click on the Brefiaie 'ﬁ' button. Note that all Exclusions in this list will be

removed and will no longer be applied to the assigned Collector groups.
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Defining Collection Exclusions

All exclusions must belong to an Exclusion List. Select an Exclusion List on the left to display the exclusions
that are defined in it.

Exclusions can be defined for a
« Source (process) — Which is identified by a source attribute, such as a Signer.

» Type/Action - Activity event types, as described in Threat Hunting on page 125.
e Target - Which is identified by a target attribute, such as IP & Port.

Exclusion can include all of these three or any combination. However, defining an exclusion that only
contains a Type is not valid, because this kind of exclusion should be defined in a Threat Hunting Profile.

For example, you can define to exclude activity events of a specific Type that have a specific source and a
specific target or to exclude (for example) activity events that have a specific source and any activity or
target.
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Adding an Exclusion

1. In the left pane, click the Exclusion List to which to add the exclusion.
2. Intheright pane, click the + Add Exclusion button. The following displays:

Threat Hunting Data Collection Exclusion

Exclude Activity Events with ...

Operating System Select v
Evant type 37 ltemns Selected bl
N
;'_ 3 T
Exclusion List name
Comments

3. From the Operating system dropdown menu, select the OS, such as Windows.

4. To define that an exclusion includes a specific Activity Event Type, select the type of action(s) to
exclude from the displayed dropdown list. Alternatively, select the Any option (the default option),
which means that you are not specifying a specific action type.

All action types to be collected are listed according to Category. You can select one or more actions
from a single Category. Actions cannot be selected from different categories. For example, you can
select the Process Termination and the Process Start options from the Process Category in the same
exclusion. However, you cannot select the Key Created option together and the Thread Created options
in the same exclusion - to do this you must create two different exclusions.
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ANy

Process Termination Process Creation
Process Start Thread Created

Executable Loaded  Key Created

Key Deleted  Key Renamed

Value Created Value Read

| Q, kearch

' Process Termination
' Process Creation

v Process Start

v Thread Created

3 v Executable Loaded

5. To define that an exclusion includes a Source attribute condition, from the Select box, select Source
attribute, which can be identified by file name, path, hash and signer for Source Process or Event Log
Name for event log related activity events, as shown below:
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LA
m
[ 1]
M

}

Event Log Name
Hash
Path
File Mame
Signer
If you select Hash, then specify the hash, as shown below:

Source attribute ~ s |Hash AR

If you select Path, then specify the Path, as shown below. A path can include wild cards. If you wish to
include sub-folders as well, check the Select sub folders checkbox.

Source attribute v 5 | Path ®| W

Include sub folders

If you select File Name, then enter the file name.

If you select Signer, then either upload the Signer’s Certificate, provide its thumbprint or provide the
Signer’'s name.
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Source attribute v s |Signer X v

® ) Certificate Thumbprint Name

P o o e e e e e e e e e e e e e e e e e e e e e e = e —— e ——————-———==q

booocoocccccccccccce Ssoooooooooooooooood

6. To define that an exclusion includes a Target attribute condition, click the + button. From the Select
box, select the Target Attribute and then define the target criteria, as described below:
Targets can be identified by various criteria, depending on the selected Activity Event Category.
e A process Category event is identified by hash, path, file name or Signer.
» A network Category event is identified by network-related properties, such as a remote IP and port.

» A registry Category event is identified by a registry key path, value name, value type or value size.

» An Eventlog Category event is identified by the Event Log ID.
When defining an exclusion that contains multiple conditions, an AND relationship exists between
the conditions.
Note: If an OR relationship is heeded between the conditions that you define, simply create another
exclusion.

7. Click the Add button. This new exclusion is then listed in the Collection Exclusions page, as shown
below:

THREAT HUNTING COLLECTION EXCLUSIONS

8. The newly defined exclusions appear with a green background and the words Pending save appear in
their LAST UPDATED column. To define that these exclusions take effect, you must click the Apply
button and then click the Save button in the window that pops up. Their LAST UPDATED column then
shows the timestamp when they were saved.
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Setting the state of an Exclusion

The Set State button enables you to enable or disable the selected exclusion(s). By default, an exclusion is
enabled.

Deleting an Exclusion

The Delete button enables you to delete the selected exclusion(s).

To delete multiple exclusions, check the requested exclusions checkboxes and click Delete in the toolbar.

Threat Hunting data retention

Because the size of the Threat Hunting Repository database is limited, the data that is written to it is
overwritten in a cyclical manner when it gets full.

Therefore, the amount of time that the data is retained is dependent upon -

* The size of the repository database.
- AND -
« The amount of data that is collected.

The amount of data that is collected is dependent upon -

* The Threat Hunting Data Collection Profiles, which is defined in SECURITY SETTINGS > Threat Hunting >
Collection Profiles
- AND -

e The Threat Hunting Data Collection Exclusions, which is defined in SECURITY SETTINGS > Threat
Hunting > Collection Exclusions

In order to extend the data retention period, you can -

* Increase the size of the repository database by purchasing additional Threat Hunting Repository add-
ons.
- AND/OR -

» Reduce the amount of data that is collected, by either defining the Collection Profiles (so that they
collect less data) or defining more Collection Exclusions (so that they exclude more data), as described
above.

Regarding Threat Hunting Collection Profiles, switching from the Inventory Scan Profile typically reduces
data retention by at least 50% and switching to the Comprehensive Profile typically reduces data retention
by an additional 50%.
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To see an estimate of the Threat Hunting data retention:

e Select ADMINISTRATION > LICENSING and look next to the Threat Hunting row.
-0OR-

» Select SECURITY SETTINGS > Collection Profiles. The data retention period is displayed in the top left
corner.

Playbook policies

The FortiEDR Playbooks feature determines which automatic actions are triggered, based on the
classification of a security event. Playbook policies enable administrators to preconfigure the action(s) to
be automatically executed according to a security event’s classification. Typically, Playbook policies only

need be configured once, and can be modified thereafter, if needed. FortiEDR classifies each security event
into one of five categories.

FortiEDR provides the following Playbook policy out of the box:

- Default Playbook: This Playbook policy specifies the default actions for the Collector Groups assigned
to the policy. By default, all Collector Groups are assigned to this policy.

Automated Incident Response - Playbooks Page

The AUTOMATED INCIDENT RESPONSE - PLAYBOOKS page displays a row for each Playbook policy. To
access this page,select SECURITY SETTINGS > Playbooks.

Security Settings ~ Invent

> Security Events
Application Control

»  Threat Hunting

Playbooks

Disk Encryption

Each Playbook policy row can be expanded to show the actions that it contains, as shown below:

FortiEDR 7.2.0 Administration Guide 244
Fortinet Inc.



Security Settings

AUTOMATED INCIDENT RESPONSE - PLAYBOOKS ASSIGNED COLLECTOR GROUPS

NAME MALICIOUS SUSPICIOUS PUP INCONCLUSIVE | LIKELY SAFE
o [EL Default Playbook FEIRATINET
NOTIFICATIONS (sent in protection and simulation modes)

Send mail notification v v v v v

Open ticket v v v v v
INVESTIGATION
Isolate device with Collector v
Isolate device with NAC Nac_HK v v
Move device to the High Security Group
REMEDIATION
Terminate process v
Delete file
Clean persistent data v

Block address on Firewall Sharon v v

D> ADVANCED PLAYBOOKS DATA

You can drill down in a Playbook policy row to view the actions for that policy by clicking the icon.

e There are more options and actions than those shown above that can be added
to a Playbook policy, such as the blocking of a malicious IP address. You may
consult Fortinet Support about how to add them.

S : !, » Automatic Incident Response Playbook features can also be triggered by
? extended detection events when follow-up actions are configured for the
= Collector Group of a device on which the event triggered. This enables the
system to follow up upon the detection of such an event and execute a
sequence of actions, such as to block an address on a firewall or to isolate the
device in which part of the event occurred.

Assigned Collector Groups

The Assigned Collector Groups pane on the right lists the various Collector Groups in the system. By
default, all Collector Groups are assigned to the Default Playbook policy. You can reassign one or more
Collector Groups to different Playbook policies, if preferred.

Note: When upgrading your FortiEDR system, all existing Collector Groups are automatically assigned to the
Default Playbook policy.

Cloning a Playbook Policy

Cloning a Playbook policy unassigns the policy from one Collector Group and then reassigns it to a different
Collector Group. A Collector Group can only be assigned to one Playbook policy.

1. Inthe AUTOMATED INCIDENT RESPONSE - PLAYBOOKS page, select the Playbook policy row that you
want to clone in the Playbook Policies list.
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2. Do one of the following:
a. Select the checkbox(es) of the Collector Group(s) in the Assigned Collector Groups pane that you
want to assign to the cloned Playbook policy. Then, click the Unassign Group button in the Assigned
Collector Groups pane.

AUTOMATED INCIDENT RESPONSE - PLAYBOOKS ASSIGNED COLLECTOR GROUPS
B Unessign Group
High Security Collector Group (0 collectors included
NAME MALICIOUS | SUSPICIOUS PUP INCONCLUSIVE | LIKELY SAFE mulat llectors included)
v Bl oefault Playbook Foamner (00 v Sllectors included)

NOTIFICATIONS (sent in protection and simulation modes)

Send mail notification v v v v v

Open ticket v v v v v
INVESTIGATION
Isolate device with Collector

Admin

Move device to the High Security Group v
REMEDIATION

Terminate process v

Delete file

Clean persistent data v

[3 [EL] Test playbook
> [EL victims Playbook
D [EL] victims Playbook clone

> ADVANCED PLAYBOOKS DATA

b. Click Collector Group in the Assigned Collector Groups pane that you want to assign to the cloned
Playbook policy. Then, drag the Collector Group onto the cloned Playbook policy in the Playbook
Policies list, as shown below:

AUTOMATED INCIDENT RESPONSE - PLAYBOOKS ASSIGNED COLLECTOR GROUPS

NAME MALICIOUS SUSPICIOUS PUP INCONCLUSIVE | LIKELY SAFE
[ [EL] pefault Playbook FeRTINET
b [EL] est playbook
[3 [EL] Test playbook clone ensilo employees (2 collectors included)
o E“]\umms Playbook
[ L] victims Playbook clone

The following message displays.
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CONFIRM

Group [enSilo employees] is already assigned to [Playbook] policy -

[Test playbook].

A Collector Group cannot be assigned to more than one [Playbook]
policy and therefore will be removed from the previous one.

Do you want to continue?

Click Yes.

Advanced Playbooks Data

&
Yes [ No )
, A

The ADVANCED PLAYBOOKS DATA area at the bottom of the AUTOMATED INCIDENT RESPONSE —
PLAYBOOKS page displays more details about the action selected in the Playbook Policy list.

AUTOMATED INCIDENT RESPONSE - PLAYBOOKS

) Clone Playbook (B Set Mode + Assign Collector Group [ Delete
NAME
< v Bl pefault Playbook Fomrmer ()

NOTIFICATIONS (sent in protection and simulation modes)

Send mail notification

Open ticket
INVESTIGATION
Isolate device with Collector
Move device to the High Security Group
REMEDIATION

Terminate process

< ADVANCED PLAYBOOKS DATA

ACTION NAME: Send mail notification

ACTION DETAILS

This option enables you to receive an email each time an event is triggered by Fortinet, based on an event-specific classification. Each email contains all the raw data items collected by Fortinet about that event. This operation is performed both in Simulation and Prevention

modes.
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ASSIGNED COLLECTOR GROUPS

High Security Collector Group (0 collectors included)
INCONCLUSIVE | LIKELY SAFE emulation (4 collectors included)

v ensilo employees (2 collectors included)

v v
Admin sett
v v
Admin
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Playbook policy actions

Playbook policy actions are divided into the following types:

* Notifications on page 248
* Investigation on page 249
» Remediation on page 251
e Custom on page 252

Each of these categories contains different types of actions that can be performed when a security event is
triggered.

Notifications

Notification actions send a notification when a relevant security event is triggered. These actions are
implemented in both FortiEDR modes (Simulation and Prevention).

Notifications can be one of the following types:

e Emails
e Syslog
e Open Ticket

NP Notification actions must be enabled in order to be implemented by a Playbook
‘Q' policy. If notifications are disabled, they are not implemented by the Playbook
- policy, even if that policy is configured to send notifications. For more details see

SMTP on page 308.

Each row under Notifications corresponds to a single type of notification (mail [email] notification, Syslog
notification or Open Ticket notification). In the Notifications area, you configure each notification type to
indicate whether or not it is to automatically send the relevant notification, once triggered by a security
event.

The Malicious, Suspicious, PUP, Inconclusive, and Likely Safe columns correspond to the possible
classifications (see Overview on page 90 and Incidents pane on page 86) for a security event. When a
checkmark # appears in one of these columns, it means that a notification of the specified type is sent
when an event is triggered with that classification.

By default, the Default Playbook policy is set to Simulation mode, and only email notifications are
automatically enabled, as shown below:
E 3 E:3
NAME MALICIOUS SUSPICIOUS PUP INCONCLUSIVE | LIKELY SAFE
v ¥ EDefauIt Playbook FuAnner (@

NOTIFICATIONS (sentin protection and simulation modes)

send mail notification v v v v v

SMTP, Syslog and Open Ticket must already be configured in order to send their respective notifications. If
their settings are not already configured, the relevant row in the Notifications list displays a message

FortiEDR 7.2.0 Administration Guide 248
Fortinet Inc.



Security Settings

indicating that you must first configure it, The word Admin in each of these messages points to the
following configuration page when clicked:

LICENSING OPEN TICKET
ORGANIZATIONS R
System name [splunk Email address  * [mysplunk@test.com
USERS
DISTRIBUTION SYSLOG NOTIFICATIONS
LIST! "
[WDefine New Syslog
EXPORT
SETTINGS
TOOLS

Notifications are sent based on the Core or FortiEDR Cloud Service (FCS) classification of the event,
depending on whether the FCS classification happens within the timeout period and whether the FCS
classification result differs from the one from the Core:

L}
‘9' The default timeout period for FCS classification is 3 minutes. To change the default

FCS timeout value for your dedicated environment, contact Fortinet Support.

 |If the FCS classification is received within the timeout period, the notification is sent based on the FCS
classification.

« |If the FCS classification result is not received within the timeout period, a notification is sent by the end
of the timeout based on the initial Core classification.

» |f the FCS classification comes in after the timeout with a different result from the Core classification,
an updated notification is sent based on the final classification by the FCS.

Investigation

Investigation actions enable you to isolate a device or assign it to a high-security Collector Group, in order
to further investigate the relevant device’s activity.

* £
NAME MALICIQUS SUSPICIQUS PUP INCONCLUSIVE | LIKELY SAFE
< E Default Playbook FEIRTINET

NOTIFICATIONS (sentin protection and simulation modes)

Send mail notification v v v v v
Adr

Open ticket v v v v v

INVESTIGATION
Isolate device with Collector v
Isclate device with NAC Nac_HK - v
Move device to the High Security Group

Investigation actions can be one of the following types:
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 |solate device with Collector on page 250
» |solate device with NAC on page 250
¢ Move device to High Security Group on page 250

All investigation actions are performed based on FortiEDR Cloud Service (FCS) classification. If FCS is not
running, FortiEDR performs investigation actions based on Core classification instead.

Isolate device with Collector

This action blocks the communication to/from the affected Collector. This action only applies for endpoint
Collectors. For example, if the Playbook policy is configured to isolate the device for a malicious event, then
whenever a maliciously classified security event is triggered from a device, then that device is isolated
(blocked) from communicating with the outside world (for both sending and receiving). This means, for
example, that applications that communicate with the outside world, such as Google Chrome, Firefox and so
on, will be blocked for outgoing communications.

A checkmark #* in a classification column here means that the device is automatically isolated when a
security event is triggered with that classification.

|solate device v v v

Isolate device with NAC

This action blocks the communication to/from the affected device by disabling this host on an external
Network Access Control system. A NAC connector must already be configured in order to perform this
action. For details about how to configure NAC connectors, see Network Access Control (NAC) integration
on page 350.

In the dropdown menu next to the action, you can specify which NAC to use for disabling the host or select
all of them.

Y Unlike devices that are isolated using the FortiEDR Collector for which there is an
‘?' isolation indication on Inventory tab and un-isolation is available, devices that were
- isolated using an external system such as a NAC are not indicated as such on the

FortiEDR Console and un-isolation is only possible on the external NAC system.

Move device to High Security Group

FortiEDR provides two default Collector Groups: the Default Collector Group and the High Security Collector
Group. Both of these default Collector Groups are initially assigned to the Default Playbook policy, and
cannot be deleted.

A checkmark # in a classification column here means that the device is automatically moved (assigned) to
the High Security Collector Group when a security event is triggered that has that classification. This
feature is useful when you want to mark Collectors that triggered malicious events.

Move device to High security group o ‘, ¢ v
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Remediation

Remediation actions enable you to remediate a situation in the FortiEDR system, should malware be
detected on a device.

All FortiEDR remediation actions are based on the final classification of a security event by the FortiEDR
Cloud Service (FCS), which is a cloud-based, software only service that determines the exact classification
of security events with a high degree of accuracy.

Remediation actions can be one of the following types:

* Terminate process on page 251

» Delete file on page 251

» Clean persistent data on page 251

e Block address on Firewall on page 252

Terminate process

This action terminates the affected process. It does not guarantee that the affected process will not
attempt to execute again. This action can also be performed manually using the Forensics add-on, as
described on Remediating a device upon malware detection on page 160

A checkmark # in a classification column here means that the affected process is automatically terminated
on the device when a security event is triggered that has that classification.

Delete file

This action ensures that the file does not attempt to exfiltrate data again, as the file is permanently removed
from the device. This action can also be performed manually using the Forensics add-on, as described on
Remediating a device upon malware detection on page 160

A checkmark # in a classification column here means that the affected file is automatically removed on the
device when a security event is triggered that has that classification.

Clean persistent data

This action cleans the registry keys in Windows. This action can also be performed manually using the
Forensics add-on, as described on Remediating a device upon malware detection on page 160.

A checkmark # in a classification column here means that the affected registry key is automatically
cleaned on the device when a security event is triggered that has that classification.
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Block address on Firewall

This action ensures that connections to remote malicious addresses that are associated with the security
event are blocked. A Firewall Connector must already be configured in order to perform this action. For
details about how to configure firewall connectors, see Firewall Integration on Firewall integration on page
341.

In the dropdown menu next to the action, you can specify which firewalls are used to perform the blocking
or select all of them, as shown below:

REMEDIATION

Terminate process v
Delete file
Clean persistent data v
Block address on Firewall FortiGate300 v v
D ETest playbook All Firewalls
b E‘J\[t\ms Playbook ¥ FortiGate300
D E\f\ct\ms Playbook clone e

A checkmark # in a Classification column means that communication with the affected destination is
automatically blocked when a security event is triggered that has that classification.

The firewall must already be configured in order to add malicious destinations to blocked addresses. If its
settings are not already configured, the relevant row in the Remediation list displays a message indicating
that you must first configure it, as shown below:

REMEDIATION

Terminate process v
Delete file
Clean persistent data v
\‘ ! 'l
q Clicking the Integration Admin link in this message jumps to the relevant place in the
user interface to configure it (in the Integration page under the Administration tab).
Custom

Custom actions enable you to automatically trigger an incident response in a third-party system as the
result of a security event detected by FortiEDR, according to the Custom Integration connector (and its
actions) that you define.

CUSTOM

Re-profile a device fortinac fortidem. . - v v v v

AWS Lambda Logout User fortigate fortide - v v v

Disable interface fortigate fortide v v

Slack Notification fortigate. fortide v v vl v v v

The CUSTOM section of the Playbook page lists the actions that have been defined for Custom Integration
Connectors, as described on Custom integration on page 370.
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Ay
b ] L4
q This list appears empty if no custom integration connector has been defined.

A checkmark # in a classification column here means that the defined action is triggered in the third-party
system when a security event is triggered that has that classification.

Other options in the Playbooks tab

You can perform the following operations using the toolbar at the top of the tab:

e Clone Playbook: Clones a Playbook policy, as described on Playbook policies on page 244.

» Set Mode: Changes the mode of the Playbook policy. This process is similar to that for setting the mode
for a standard security policy, which is described on Setting a security policy’s Prevention or Simulation
mode on page 201

» Assign Collector Group: Assigns a Playbook policy to a Collector Group. This process is similar to that for
assigning a standard security policy to a Collector Group, which is described on Assigning a security
policy to a Collector Group on page 205.

» Delete: Deletes a cloned Playbook policy. Default Playbook policies cannot be deleted.

Ay
‘?' The default Playbook policy (hamed Default Playbook) is mandatory and cannot be

deleted.

Disk Encryption (COLLECTOR 6.1 OR LATER)

Use the Security Settings > Disk Encryption page to configure disk encryption policies to enforce disk
encryption on Windows 7 or later (using BitLocker, TPM required) and macOS (using FileVault) endpoints to
ensure consistent security configurations and compliance with regulatory requirements. You can also
configure disk decryption policies to allow users to decrypt an encrypted disk.

FortiEDR 7.2.0 Administration Guide 253
Fortinet Inc.


https://learn.microsoft.com/en-us/windows/security/operating-system-security/data-protection/bitlocker/
https://support.apple.com/guide/mac-help/protect-data-on-your-mac-with-filevault-mh11785/mac

Security Settings

Security Settings ~ Inven

*  Security Events
Application Control
*  Threat Hunting

Flaybooks

| Disk Encryption |

Disk Encryption

Policy State os Encryption Method

Disk encryption [ o] = AES 256-bit

Encryption Attribute Collector Group

ncrypt, entire disk test ) (Test )(#9 ) 4 2 B o

To configure a disk encryption policy to enforce disk encryption on specific Collector groups:

N -

Specify a name for the policy.

In the Security Settings > Disk Encryption page, click the Add button at the top left corner.

3. Enable the policy if you want to enforce the policy immediately after creation. You can also choose to

enable it later.

4. Select the OS and configure the relevant options:

Windows macOS

1. Under Action, select Encrypt all
disks or Encrypt only used disk.

2. Under Method, select an
encryption method for Windows
10 or later.

5. Click Save.

1.
2.

Under Action, select Encrypt.

Under Method, select the number of allowed user logins
with an unencrypted disk. For example, if 3 is selected,
the user will not be able to log in on the third attempt
without confirming the disk encryption.

Upload the FileVaultMaster certificate.

The policy appears in the disk encryption policies table.
6. Enable or disable the policy by toggling the button in the State column.
7. Add orremove Collector groups for the policy in the Collector Group column.

8. (macO0S) To verify the disk encryption status, run sudo fdesetup status on the endpoint. You can run
the command multiple times to see the progress. When the encryption is complete, the status will show
that FileVault is on. Encryption speed depends on HD size and Mac model.
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To configure a disk decryption policy to allow users of specific Collector groups to decrypt an
encrypted disk:

1.
2.
3.

In the Security Settings > Disk Encryption page, click the Add button at the top left corner.
Specify a name for the policy.

Enable the policy if you want to enforce the policy immediately after creation. You can also choose to
enable it later.

Select the OS and select Decrypt under Action.

Click Save.

The policy appears in the disk encryption policies table.

Enable or disable the policy by toggling the button in the State column.

Add or remove Collector groups for the policy in the Collector Group column.

(macOS) Users from those Collector groups can then manually disable FileVault (user credentials
required) from Setting > FileVault > Disable FileVault. If the Collector is not assigned to the decrypt
policy, the disk will be automatically encrypted again even after the user manually disables FileVault.

(macOS) To verify the disk decryption status, run sudo fdesetup status on the endpoint. You can run

the command multiple times to see the progress. When the decryption is complete, the status will show

that FileVault is off. Decryption speed depends on HD size and Mac model.
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Assets

The Assets tab displays separate pages for Inventory on page 256 and loT devices on page 269.

Assets v Administration

Inventory
Workloads

lot Devices

Inventory

The Inventory page displays a list of the previously defined Collector Groups, which can be expanded to
show the FortiEDR Collectors that each contains. Additional Collector Groups can be defined by you, as
described on Defining a new Collector Group on page 262. FortiEDR Collectors automatically register with
the system after installation. By default, each FortiEDR Collector is added to the Collector Group called All.
You can move any Collector to another Collector Group, as described on Assigning Collectors to a Collector
Group on page 263.

To access this page, click the down arrow next to Assets and then select Inventory, as shown below.

Assets v Administration

Inventory

Workloads

lot Devices
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212 FortiEDR |

Collectors

Collectors N Al statuses

13 results

Name
Ayala
Ayala testing

Default Collector Group

Name

& High Security Gollector Group
ot
OTi for final lambo
Upgrade

group_1

4 Add Group

Dashboard

Assigned policy

Status

B Running

® Discomected

® Discomected

Disk encryption

Disabled

Disabled

Disabled

Incidents  Threat Hunting  Communication Control Security Settings Inventory ~

DEVICE SECURITY LAST LOGGED o0s P MAC ADDRESS
N/A
N/A

N/A

VERSION

Administration

000

LASTSE.. = 000
Now
4 days ago

18 days ago

If there are Collectors in the Degraded state, the following indication appears at the right top corner, which
you can click to filter the view to only show the Collectors in the Degraded state.

1 Degraded Collectors were found 0

You can select to display all Collectors that are in one of the specific states (New, Running, Disabled,
Degraded, Disconnected, Isolated, Selected, Pending Reboot, Migrated, Pending Migration, or Unmanaged)
using the dropdown menu at the top left of the window, as shown below:

All statuses
Degraded
Disconnected
Disabled

Isolated

LR T |

The default Collector Group is a group to which new Collectors are automatically added.

Click the Expand icon to expand the list and display the FortiEDR Collectors that the Collector Group

contains.
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Dashboard Incidents  ThreatHunting  Communication Control Security Settings Invent

Collectors

Collectors v Running v + Add Group Q

Name Assigned policy 000

I:Il Defauit Collector Group S 0 =2 R

Name Status Disk encryption DEVIGE SECURITY LAST LOGGED o0s P MAG ADDRESS VERSION LASTSE.. =L 000

windows7-64 B Running Disabled N/A windows7-6d\us..  Windows 7 Ultimate Now

The following information is provided for each Collector. Some columns are hidden by default. You can

toggle them on using the Choose Columns button (l][“] Choose Columnsy 4t the top right corner of the
page.

Information Field Description

Checkbox Check this checkbox to select the Collector. You can then use one of the
buttons at the top left of the window, such as the Delete button.

Collector Group Name Name of the Collector Group to which the Collector is assigned.

Device Name Device name taken from the communicating device on which a FortiEDR
Collector is installed.

oS Operating system of the communicating device on which the FortiEDR
Collector is installed.

IP IP address of the communicating device on which the FortiEDR Collector
is installed.

Version Version of the FortiEDR Collectors installed on the communicating
device.

State Current state of the FortiEDR Collector. Hovering over the STATE value

pops up the last time the STATE was changed. Possible value for STATE
are as follows:

State Description

Running The FortiEDR Collector is up and all is well.

Disconnected The device is offline, powered down or is not
connected to the FortiEDR Aggregator.
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Information Field Description
State Description

Last Seen

Last Logged

MAC Address

Device Security

FortiEDR 7.2.0 Administration Guide
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Pending Reboot

Disabled

Degraded

After the FortiEDR Collector is installed, you may
want some devices to be rebooted before the
FortiEDR Collector can start running. This status
means that the FortiEDR Collector is ready to run
after this device is rebooted. The reboot is
performed in the usual manner on the device
itself.

The FortiEDR Collector was disabled in the
FortiEDR Central Manager. This feature is not yet
available in version 1.2.

The FortiEDR Collector is prevented from
performing to its full capacity (for example, due
to lack of resources on the device on which it is
installed or compatibility issues).

Counts the number of days passed from the last time this Collector
communicated with the Core.

Specifies the last user that logged into the device on which the Collector
is installed. It shows the domain of the computer/username. If this device
has not been logged into, then this column is blank. In addition, if the
Collector is not V3.0.0.0 or above, then this column is empty and the
events from this Collector will not contain the user from which the
security event was triggered.

Physical address of the device. If a device has multiple MAC addresses,
three dots (...) display. You can hover over the MAC Address to display
the value (or values, in case of multiple MAC addresses) in a tooltip.

Security posture indicator of Windows and macOS endpoints based on
OS-level configurations. The device is marked as compliant if two or
more of the following criteria are met.

V) The device security compliance status is informational

Endpoints are always protected by FortiEDR, regardless

‘Q' and has no impact on FortiEDR protection effectiveness.

of the compliance status.

Windows macOS

» Host Firewall—Host firewall is » Host Firewall—Host
enabled to control incoming and firewall is enabled to
outgoing network traffic to control incoming and
protect the endpoint against outgoing network traffic
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Information Field Description
Windows macOS

unwanted connections.

Security Centre—FortiEDR is
registered as anti-virus and
threat protection agents in
Administration > Settings >
Windows Security Center on page
283

Disk Encryption—Disk encryption
is enforced on the endpoint using
BitLocker (TPM required).

User Account Control (UAC)—
Windows User Account Control is
enabled to protect the operating
system from unauthorized
changes.

Windows updates—The latest
Windows update has been
installed.

to protect the endpoint
against unwanted
connections.

Disk Encryption—Disk
encryption is enforced on
the Mac using FileVault.

Gatekeeper Status—
Gatekeeper is enabled to
ensure that only trusted
software runs on the Mac.

System Integrity
Protection (SIP) Status—
System Integrity
Protection is enabled to
help protect the Mac from
malicious software.

To view compliance details of each criteria, hover over the status text.

Windows updates: Disabled
Host Firewall: Enabled

Dizk Encryplion: Disabled
Security Centre: Disabled
UAC: Enabled

@ Mot compliant

Endpoints that are not in connected state show N/A.

| Defailt Collector Group 2 I B @ ©

Name status Diskencryption  DEVICESECURITY  LASTLOGGED os P MAC ADDRESS VERSION  LASTSE.. =

® Running Disabled Now
2RSS @ Running Disabled A Now

windows 8 Running Disabled NA Now

Uninstalling a Collector

Use the Uninstall button to uninstall a Collector from a device. Use caution when using this option, as a
Collector cannot be reinstalled after removal using the FortiEDR user interface. Therefore, it is
recommended to disable a Collector using the Enable/Disable option rather than uninstalling it.
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Mobile

To access the mobile Collectors page, use the following filter at the top left of the Assets > Inventory page.

Ay
‘Q' The Mobile option is available only if mobile is enabled in the organization setting.
|| See Step 2 - Defining or importing an organization on page 419.

All statuses

| ~

Collectors
Maobile

The Mobile page displays a list of the previously defined mobile Collector Groups, which can be expanded to
show the FortiEDR mobile Collectors that each contains.

Mobile N All statuses N + Add Group Q

2 results,

Name Assigned policy 000

Default Mobile Group ]

Name Account os P VERSION Status LAST SEEN = oo
iPhone 16 Pro Max i0s18.2.1 B Running Now

SM-S908UT Android 14 B Running Now

Pixel 62 Android 15 Degraded Now

KB2007 Android 14 Degraded Now

Pixel 7 Android 15 ® Disconnected Yesterday

Pixel 7 Android 15 @ Disconnected Yesterday

SM-S908U1 Android 14 ® Disconnected 7 days ago

Additional mobile Collector Groups can be defined by you, as described in Defining a new Collector Group
on page 262. FortiEDR mobile Collectors automatically register with the system after installation. By default,
each FortiEDR mobile Collector is added to the Default Mobile Group. You can move any mobile Collector to
another Collector Group, as described in Assigning Collectors to a Collector Group on page 263.

The following information is provided for each Collector:

Information Field Description

Checkbox Check this checkbox to select the mobile Collector. You can then use
one of the buttons at the top left of the window, such as the Delete
button.

Collector Group Name Name of the mobile Collector Group to which the mobile Collector is
assigned.

Device Name Device name taken from the communicating device on which a FortiEDR

mobile Collector is installed.
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Information Field Description

(ON] Operating system of the communicating device on which the FortiEDR
mobile Collector is installed.

IP IP address of the communicating device on which the FortiEDR mobile
Collector is installed.

Version Version of the FortiEDR mobile Collector installed on the communicating
device.
State Current state of the FortiEDR mobile Collector. Hovering over the STATE

value pops up the last time the STATE was changed. Possible value for
STATE are as follows:

State Description

Running The FortiEDR mobile Collector is up and all is
well.
Disconnected The device is offline, powered down or is not

connected to the FortiEDR Aggregator.

Disconnected
(Expired)

Pending Reboot After the FortiEDR mobile Collector is installed,
you may want some devices to be rebooted
before the FortiEDR mobile Collector can start
running. This status means that the FortiEDR
Collector is ready to run after this device is
rebooted. The reboot is performed in the usual
manner on the device itself.

Disabled The FortiEDR mobile Collector was disabled in
the FortiEDR Central Manager.

Degraded The FortiEDR mobile Collector is prevented from
performing to its full capacity (for example, due
to lack of resources on the device on which it is
installed or compatibility issues).

Last Seen Counts the number of days passed from the last time this mobile
Collector communicated with the Core.

Defining a new Collector Group

Creating multiple Collector Groups enables you to assign different FortiEDR policies
) ! /. to different FortiEDR Collectors, which means to different end user groups. In
? addition, it enables data segmentation in FortiEDR and reports according to user
- groups. For example, you may want to assign a more permissive policy to the CEO of
your organization.
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1. Click the Add Group button. The following window displays:

New Collector Group

Cancel

2. Enter any name for this group and click Create.

Assigning Collectors to a Collector Group

1. In the Inventory page, select the checkboxes of the FortiEDR Collectors to be moved to a different

group.
2. Select the Move to Group button.

?2mtof2| State v ~ l:lv X,

B Name Move to Group $

The following window displays with the name of the current Collector Group selected:

Move Collectors

Moving 1 endpoints to:

Organization

liorne1 w

[3 v

Mote: 1183 endpoints licenses remaining

Select collector group .

3. Select the Collector Group to which to move the selected Collectors. FortiEDR shows how many

Collectors each group contains.
4. Click the Move button.
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Deleting a Collector Group/Collector

Deleting a Collector Group simply means that you are deleting a logical grouping of Collectors. These
Collectors then become available to be selected in the default Collector Group. The Collector Group
assigned as the default Collector Group cannot be deleted.

Deleting a Collector only deletes it from the FortiEDR Central Manager’s console. If the FortiEDR Collector is
not uninstalled on the device, it will automatically reappear in the FortiEDR Central Manager's COLLECTOR
list.

To delete a Collector Group/Collector:

1. Select the Collector Group’s/Collector’s checkbox.
2. Click the Delete button.

Enabling/disabling a Collector

You can enable or disable one or more Collectors simultaneously.

To enable one or more Collectors simultaneously:

1. In the Inventory page, select the checkboxes of the FortiEDR Collectors to be enabled. All selected
Collectors must be in a Disabled (** ) state.
2. Click the down arrow in the Select state dropdown and select Enabled.

Enabled

Collectors

2 results

Disabled

B Name Assignedjp

v Default Collector Group & la O

Name Status Disk encryption DEVICE SECURITY LAST LOGGED 0s P MAC ADDRESS

The Select state dropdown is available only if one or more Collectors are selected.
3. Click Enable.

To disable one or more Collectors simultaneously:

1. Inthe COLLECTORS page, select the checkboxes of the FortiEDR Collectors to be disabled. All selected
Collectors must be in a Running () state.
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2. Click the down arrow in the Select state dropdown and select Disabled.

All statuses v + Add Group ,_; @. x 03

Enabled

Collectors

2 results
Disabled

B Name Assigned|p

v Default Collector Group = La

Name Status Disk encryption DEVICE SECURITY LAST LOGGED 0s P MAC ADDRESS

The Select state dropdown is available only if one or more Collectors are selected.
3. Click Disable.

Device isolation

An isolated device is one that is blocked from communicating with the outside world (for both sending and
receiving). A device can be isolated manually from the Assets > Inventory page or the Investigation View on
page 92.

Isolation mode takes effect upon any attempt to establish a network session after
) ! /. isolation mode has been initiated. Connections that were established before device
9 isolation was initiated remain intact. The same applies for Communication Control
- denial configuration changes. Note that both Isolation mode and Communication
Control denial do not apply on incoming RDP connections and ICMP connections.

For more details about device isolation, see Investigation on page 249.

To isolate a device from the Assets > Inventory page:

1. In the Inventory page, hover your mouse to the right of the row of the FortiEDR Collector that you want
to isolate and click the Isolate device button.

Collectors - All statuses N + Add Group Q

13 results

Name Assigned policy 000

Defauilt Collector Group. (=R

Name Status Disk encryption DEVICE SECURITY LASTLOGGED os P MAC ADDRESS VERSION LASTSE.. =| 000

(@ windows7-64 B Running Disabled N/A Now ,—»ﬁ &y
WIN10-328IT isconnected Disabled NA 5 days ago

Disabled N/A 19 days ago

Alternatively, select the Collector and click Isolate device button.
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Collectors Al statuses v + Add Group
7 resuts
Name Assigned policy
123123
Default Collector Group
&2 High Security Collector Group

- ~ @, 8% 0v 0

Isolate device

B Name Disk encryption
@ | D Remove isolstion Dissbled
® Disconnected (Expi Disabled

2. Click Isolate.

DEVICE SECURITY

LASTLOGGED o0s 1 MAC ADDRESS

N/A

NA

VERSION ~ LASTSE. =y
Today

74 days ago

Isolate collector?

You are about to isolate collector.

000

000

The Isolate icon appears next to the relevant Collector to indicate that the Collector has been isolated,

as shown below:

Collectors All statuses N + Add Group

7 results

Name Assigned policy

123123

Default Collector Group

| i High Security Collector Group OIN=}

~ @y s OBy o
B name Status Disk encryption
Davlds—vwr\ua\'Machme local @ Disconnected Disabled

LenaPC ® Disconnected (Expi Disabled

DEVICE SECURITY

NA davdat

N/A Lena-PC\Lena

LAST LOGGED os P MAC ADDRESS

mMacoS 13.6 Ventur 192.168.64.14  00-1C-42-2E-C3-9...

Windows 7 Profess 10.151.121.27  00-50-56-BE-CS-EC

VERSION LASTSE.. =|
6.0.10.1010  Today

5260053  74daysago

To remove isolation from a device from the Inventory > Collectors page:

1. Inthe COLLECTORS page, select the checkbox(es) of the FortiEDR Collector(s) whose isolation you

want to remove.

2. Click the down arrow on the Isolate button and select Remove isolation, as shown below.

Collectors - All statuses + Add Group
7 results
Name Assigned policy
123123
Default Collector Group 0 & L
3 High Security Collector Group O & 0L
N ~ @, % OBy O
Name Isolste device Disk encryption

® Disconnected (Expi Disabled

3. Click Remove.
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Remove isolation?

You are about to remove isolation.

Unmanaged devices

The Inventory page also indicates the number of unmanaged devices found in the system at the top of the
page, meaning those non-loT devices on which no Collector is installed.

E:E FortiEDR ‘ Dashboard Incidents Threat Hunting Communication Control ~ Security Settings ~ Assets v Administration v
Inventory
53 Unmanaged devices were found %
Collectors - All statuses - + Add Group Q
4results
Name Total number of collectors Assigned policy (11}
Default Collector Group 9 0L @ g
€4 High Security Collector Group 0
. | ,
Y toutofl | satev ~ Ov x, (Av @O
Name Status Disk encryption DEVICE SECURITY LAST LOGGED os P MAC ADDRESS VERSION LASTSE.. =| o
| B Running Disabled N/A ensilo & macos Now ~ O x o
workloads ]

When new unmanaged devices are detected, FortiEDR sends real-time notifications with a link that
redirects to the unmanaged devices view.
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§o8 FerulDR Oashboard  incidents.  Threal Huting  Communication Control = Security Settings ~
Inventory [res——
AT Unmnanaged e
R
L]
]
]
[ ]
[ ] a
L] w0
]
| ]
| ]
& ! /, Unmanaged devices are not protected in the system. Therefore, it is recommended
? that you either install a Collector on each such device or remove it from your
] network.

To view the list of unmanaged devices, ensure you have enabled [oT Device Discovery on page 331 at least
once after deploying Collectors and then select Unmanaged in the filter at the top left of the page.

FortiEDR | Dashboard Incidents Threat Hunting Communication Control v Security Settings ~ Assets v Administration v~

Inventory

Cotecters . @

1 results
Name Total number of collectors Assigned policy oon

v Unmanaged devices 53

7 s
Name Status LAST LOGGED 0s P MAC ADDRESS VERSION LASTSE.. 3| ﬂﬂl]
@ Unmanaged = Windows 2 days ago O =5
N/A @ Unmanaged O Linux (VM) 2 days ago

None of the action buttons for managed Collectors are available for unmanaged devices, as there is no
Collector installed on these devices.

You can activate the firewall playbook to block address on firewall for unmanaged devices. The block action
triggers an integration using the firewall connector to block the device.
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Dashboard Incidents Threat Hunting Communication Control v Security Settings v Assets v Administration v @ Prevention

Inventory
Collectors - Unmanaged - Q
1 results
Name Total number of collectors Assigned policy oo
v Unmanaged devices 53
7 s
Name Status LAST LOGGED 0s P MAC ADDRESS VERSION LASTSE.. =| 1]
@ Unmanaged = Windows 2 days ago o
N/A @ unmanaged O Linux (VM) 2 days ago
N/A @ Unmanaged O Linux (VM) 2 days ago

loT devices

The IOT DEVICES page lists the non-workstation devices, such as printers, cameras and so on, that are part
of your network. To access this page, click the down arrow next to INVENTORY and then select loT.

This option is only available to users who have purchased the Discover and Protect or the Discover, Protect
and Response license.

FortiEDR provides you with visibility to any device in your network, including those on which FortiEDR
components are not installed. oTs are proactively discovered from existing FortiEDR Collectors. For more
details, see |oT Device Discovery on page 331.

10T DEVICES (102/102)
Al v 9% Create Group Move to Group Delete Devic:
DEVICE GROUP NAME DEVICE NAME CATEGORY MODEL NTERNAL IP MAC ADDRESS LOCATION FIRST SEEN LAST SEEN

Default IOT Group
(4r)

Other Dell 10.51.102.55 8C-04-BA-75-9D-AD Israel 57 days ago 6 days ago
EBpired  Other Microsoft, Linux32-49  10.51.102.21 00-15-5D-2E-D4-0F Israel 87 days ago 27 days ago
Bpied  Other Dell 10.51.102.5 A4-4C-CB-BE-4D-83 Israel 134 days ago 113 days ago

Other Sony Interactive Entertai..  10.51.102.26 20-CC-44-87-22-AC Israel 203 days ago 6 days ago

Media device
(373)

Network device
(5/5)

Other

(83/83)

Power device
arn

Printer

(2/2)

Remote management
(0/0)

Storage
(373)

Video Device
arny

This page provides all the collected information about each discovered device, including its name, Category
(device type), model number, internal IP address, MAC address, the physical location where the device was
detected (based on its external IP address) and when it was first and last seen. FortiEDR presents all the
information it collected for each device. Information that was not available for a device is marked as N/A in
that device’s row in the table. The New indication indicates that the device was discovered within the last
three days. The Expired indication indicates that the device has not been seen for more than one week.
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The default 10T Group to which new |oT devices are automatically added is marked with a yellow group icon

. You can change to a different default loT Group by clicking the group icon of another IoT Group.
Alternatively, you can use Category-based grouping, where each new loT device is automatically added to
the group that represents its Category (for example, network devices, cameras, printers and so on).

Defining a new loT group

1. Click the Create group button. The following window displays:

Mew Collector Group

2. Enter any name for this group.
3. Click Create new group.

Assigning devices to an loT group

1. Inthe IOT DEVICES page, select the checkboxes of the loT devices to be moved to a different group.

2. Select the Move to group button. The following window displays showing the names of the current loT
Groups and how many devices each contains:
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IOT GROUPS

Moving 5 10T devices to:

\ OT GROUP NAME # OF DEVICES
\ Computer 190
d Media device 3
| Network device 16
| Other 1
Power device 1

( Cancel )

3. Select the loT Group to which to move the selected devices.
4. Click Move to Group.

Deleting an loT device/loT group

Deleting an IoT Group simply means that you are deleting a logical grouping of IoT devices. These devices
then become available to be selected in the default IoT Group. The IoT Group assigned as the default [oT
Group cannot be deleted.

Deleting an loT device deletes it from the FortiEDR Central Manager’s console. However, if the device is still
connected to your network, it will re-appear following the next network scan.

To delete an loT device/loT group:

1. Select the loT group’s/loT device’s checkbox.
2. Click Delete.
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Refreshing loT device data

You can run a scan for a specific loT device to recollect data for that device.
To rescan an loT device(s):

1. Select the loT device’s checkbox for the device(s) that you want to scan and then click the Device

Details button. A confirmation window displays.

DEVICE DETAILS

Are you sure you want to rescan the 2 selected devices?

Rescan devices JEReERE

2. Click Rescan devices.

Exporting loT information

To export the list of loT devices:

1. Click the Export button.
2. Select Excel.

To export details for an loT device:

1. Check the checkbox of the device of interest.
2. Select Device Info under the Export button.

S ! ’, You can only export details for one device at a time. This report exports all collected
9 data for the loT device of interest, including additional data beyond what is
- presented in the user interface.
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Exporting logs

The Export Logs feature enables you to retrieve technical information from the FortiEDR devices deployed
in the organization, such as from Collectors, Cores, Aggregators and the Management server. The
retrievable technical content describes the activities of each FortiEDR device. Typically, the technical
content contains logs and statistical information. The retrieved technical content is password-protected.
The password is enCrypted.

Logs only need to be retrieved when Fortinet technical support requests that you provide them. There is no
need for you to analyze the data contained in the FortiEDR logs. You can retrieve logs for the following:

» Exporting logs for Collectors on page 273

» Exporting logs for Cores on page 274

» Exporting logs for Aggregators on page 275

Ay
b ] L4
q To retrieve threat hunting logs, see Exporting threat hunting logs on page 166.

Exporting logs for Collectors

You can export logs for Collectors that are in Running status.

To export Collector logs:

1. In the Collectors page, select the checkbox of the FortiEDR Collector for which you want to export logs
and click the down arrow on the Export dropdown menu and select Collector Logs.
Note you can only export the logs for one Collector at a time and the Collector has to be in Running
status.

4 ~r BBy B & O+ 0O

/ Excel
B Name fatus on DEVICE SECURI

Collector Logs
® Running vIsapiea N/A

@ Disconnected (Expi Disabled N/A
2.

3. A progress window displays, showing the status of the Collector log retrieval process:
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RETRIEVE COLLECTOR SYSTEM LOGS

Operation in progress

I.-rl.- -HI
| Cancel )
L
After the retrieval process completes, the following window displays:

RETRIEVE COLLECTOR SYSTEM LOGS

Operation completed successfully on device

Download

! Close

4. Click Download to automatically send the retrieved logs to Fortinet technical support.

Exporting logs for Cores

1. Inthe SYSTEM COMPONENTS page, select the checkboxes of the FortiEDR Cores for which you want to
export logs.
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2. Click the down arrow on the Export dropdown menu and select Core Logs.

SYSTEM COMPONENTS

‘ CORES (1/1) Search Cores Q ‘

Woeee [3 Export v
PDF
Y Al NAME DEPLOYMENT MODE VERSION STATE
Excel
v Cloud 4105 % Running
Core Logs

‘ AGGREGATORS (1/1)

‘ REPOSITORIES (1/1) ‘

A progress window displays, showing the status of the log retrieval process:
After the retrieval process completes, the following window displays:

RETRIEVE CORE LOGS

Operation completed successfully on 1 devices

Download

Close

3. Click Download to automatically send the retrieved logs to Fortinet technical support.

Exporting logs for Aggregators

1. Inthe SYSTEM COMPONENTS page, select the checkboxes of the FortiEDR Aggregator for which you
want to export logs.
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2. Click the down arrow on the Export dropdown menu and select one of the following options:
SYSTEM COMPONENTS
CORES (1/1)
AGGREGATORS (1/1)

Woeee [ EBoport ~

PDF
v NAME

co COLLECTORS VERSION
Excel
v 7.0.0.1:8081 Fortinet 46 4105

System Logs
REPOSITORIES (1/1)

a. Aggregator Logs: Exports the log for the selected Aggregator(s).

b. System Logs: Exports the logs of the central Manager.
A progress window displays.

After the retrieval process completes, a window displays.
Click Download to automatically send the retrieved logs to Fortinet technical support.
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Administration

This chapter describes the FortiEDR Administration options, which are fully available to users with Admin
permissions, partially available to users with IT or Senior Analyst permissions, and read-only for users with
read-only permissions.

Licensing

Selecting LICENSING in the ADMINISTRATION tab displays all the entitlements provided by your license.

This window also shows your Serial Number, which is your FortiEDR unique identifier with Fortinet.

Licensing
nstallation 1D: Name Serial Numbe Expiration Date:
Endpoints License Type s Discover
¢« Protect
s Response
License Capacity 20 Seats
eXtended Detection v
Communication Control v
Forensics v
Threat Hunting v v No Repository storage add-ons
Estimated Threat Hunting Data Retention: 182 days (4% of the storage is utilized)
Vulnerability Management v
S ! ’, The tab bar at the top of the window may display a white circle(s) with a number
q inside the circle to indicate that new security events have not been read by the user.
- For Administration, the number represents the number of unread system events.

Users

The USERS option specifies who is allowed to use the FortiEDR Central Manager console. During installation
of the FortiEDR Central Manager, you must specify the user name and password of the first FortiEDR Central
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Manager console user. This is the only user who can log in to the FortiEDR Central Manager console for the
first time.

To add a user:

1. Click the Add User button ( 1+ Add User
2. Fillin the displayed window.

User Name First Name Last Name Email Address Role Role Capability Password 2FA il

Disabled v X

3. Define this user’s password. Make sure to remember it and notify the user about this password.
4. Select the user’s role. The system comes with the following predefined user roles:

Role Description

Admin Highest-level super user that can perform all operations in the FortiEDR Central
Manager console for the organization.

Senior Analyst Analysts supervisor who can define security policies in addition to all the actions
that can be performed by an Analyst.

Similar to admin users but without system configuration privileges under the
ADMINISTRATION tab. A senior analyst can view information and perform actions,
such as marking security events as handled, changing policies and defining
exceptions, but cannot access the system configuration options under the
ADMINISTRATION tab.

Analyst SOC/MDR service analyst who can perform actions as required in the day-to-day
activities of handling events.

Similar to senior analyst users but without access to security configuration. An
analyst can view information and perform actions, such as marking security
events as handled, but cannot access the ADMINISTRATION tab or define/change
policies.

IT IT staff who can define settings related to the FortiEDR integration with the
customer ecosystem.

This role has system configuration access only. They can deploy and upgrade
system components and perform system integration with external systems using
the ADMINISTRATION tab but do not have access to other areas, such as security
configuration, alert monitoring, or Forensics options.

Read-Only Basic role with read-only access to all functions except system configuration.
\‘ ! " . . . .
9 For Multi-tenancy (organizations) on page 415 systems, you can also configure
|| the user with role-specific access to all organizations.

5. Select any advanced options as nheeded. Some options are available to users with specific permissions
only.

FortiEDR 7.2.0 Administration Guide 278
Fortinet Inc.


https://docs.fortinet.com/document/fortiedr/7.2.0/administration-guide/212387/configuring-the-fortiedr-central-manager-server-and-console

Administration

Option Description

Rest API Specifies whether to allow the user to access the FortiEDR Central Manager
through API calls.

Guide. You must log in to the Fortinet Developer Network to

\‘é’, For more information about APIs, see the FortiEDR RESTful API
- access the guide.

Custom script Specifies whether to allow the user to upload and manage (add, modify and
delete) Python scripts that call third-party system APIs (see Connectors on page
339). Those scripts will then be automatically triggered by FortiEDR as incident

responses.
by
‘Q' This option is only available to users with Admin and IT
|| permissions.

FortiEDR Connect Specifies whether to allow the user to use FortiEDR Connect capabilities which
provide direct access to FortiEDR-protected devices running on Windows
through a remote Shell connection, as described in FortiEDR Connect on page
109.

This option is only available to users with Admin, Analyst, and
V) Senior Analyst permissions. This option takes effect only when
‘9' the Allow FortiEDR Connect - remote shell connection checkbox
- is selected under Administration > Settings, which means the
- FortiEDR Connect functionality is enabled at the organization
level.

6. If the Require 2FA option is disabled in Password Policy, you can enable 2FA for this particular user by
configuring the 2FA prompt frequency to be Always, Daily, or Weekly. See Two-factor authentication on
page 279 for more information.

Ay
S L4
q This option is available only if Require 2FA is disabled in Password Policy.

7. Click Apply (the checkmark) to save the user.

Two-factor authentication

You can require two-factor authentication for all FortiEDR users or specific users, which means those users
must provide additional proof in addition to his or her user name and password when logging in to FortiEDR.
To verify the user’s identity, FortiEDR supports two-factor authentication using FortiToken or any third-
party authentication application, such as Google Authenticator, Microsoft Authenticator, Okta, or Duo.
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» To enforce two-factor authentication on all users, check the Require 2FA checkbox when setting up the
password policy.

» To require two-factor authentication on specific users, disable the Require 2FA checkbox in Password
Policy and check the enable the 2FA option for that user, as described in Users on page 277.

The following is an example of how a user logs in using two-factor authentication with Google
Authenticator:

1. When prompted with the following window during your first login, enter the user name and password
and click LOGIN.

FE:RTINET

2. On your mobile device, click the Google Authenticator icon G to launch Google Authenticator. A QR
code displays in the FortiEDR window, as shown below:

INSERT AUTHENTICATOR CODE

to Login

3. Scan the QR code using your mobile device. A FortiEDR token appears on the mobile device, as shown
below. Note that this token (code) changes every 30 seconds.
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ForiEDR

346788

adrien “

4. In the FortiEDR login window, click the INSERT AUTHENTICATOR CODE button. The following window
displays:

tRTINET

Authenticator code

SuUBMIT

€ Back

5. Enter the authentication token (code) you received in step 3, and then click SUBMIT. Be sure to enter
the latest code, as the code changes every 30 seconds.
Depending on the 2FA prompt frequency you set up for the user(s), FortiEDR verifies the user's identity
for each login or on a daily or weekly basis by asking for a new token, when the user has to repeat steps
1through 5 to re-authenticate. To set a different cycle on a standalone environment, please contact
Fortinet Support.

Resetting a user password

You can set a new password for a user in the following cases:

» A user forgets his or her password and cannot log in.

¢ A user password is compromised and poses a security risk.

* A user account gets locked after five or more consecutive failed login attempts due to an incorrect

password.

If a user who must use two-factor authentication cannot access the FortiEDR application because of a lost
or replaced mobile device, that user must repeat the procedure in Two-factor authentication on page 279 in
order to log in. Before performing this procedure, you must first reset that user’s password to accept a new
two-factor authentication token.

To reset a user password:

1. Inthe ADMINISTRATION tab, click the USERS link. The user list displays.
2. Place your cursor on the row of the user whose password you want to reset and click the Reset
Password button.
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User Name First Name Last Name Email Address Role
Brook Brook Chelmo bchelmo@fortinet.com Admin

Chris Chris Dos Santos cdossantos@fortinet.com Read-Only

If the user account is locked, the buttonis in red.

Account Locked
3. Inthe Reset Password window that appears:

@ Set a new password

Password

Confirm Password

Require a change of password in the next sign in

Reset the Two-Factor authentication token

Role Capability

» Click the Set a new password radio button and define a new password for the user. Make sure the

Do one of the following:

password follows the password policy. You can also require the user to change the password

during the next login.

2FA

Always

» For a user that must use two-factor authentication, click the Reset the Two-Factor authentication
token radio button to force user identity verification using two-factor authentication during that

user’'s next login. This means that the user must complete the procedure in Two-factor

authentication on page 279 in order to log in.
4. Click Apply.

Now you can ask the user to log in using the new password.

Defining a password policy

To enhance security and better secure the access to the FortiEDR system, you can define a password policy
to enforce some basic rules that apply to all user passwords, including the default password you create for
each user and existing users that are created before the password policy is defined. All existing users with
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a password that does not comply with the new password policy will be prompted to change the password at
their next login.

To define a password policy:

1. Click the Password Policy button (@ passwordPoliey )
2. Fillin the displayed window. The requirements you define will be applied to all new and existing users.

Password Policy

Password policy is disabled

Option Description

Minimum password length Specify the minimum number of characters the password must
include.
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Option Description

Brute-force protection Specify whether to block user login after five failed login attempts in
the Manager console or Rest API. Blocked users will not be able to log
in before an administrator resets the password in the Administration >
Users tab.

Require 2FA Require all users to use Two-factor authentication on page 279. You
can further configure the 2FA prompt frequency to be one of the
following:

* Always—The user has to re-authenticate for each login.
e Daily—The user has to re-authenticate every 24 hours.

¢ Weekly—The user has to re-authenticate every 7 days.

) This option enforces 2FA on all users. To require only

‘9' specific users to use 2FA, leave this option empty and

- enable the 2FA option for specific users, as described
- in Users on page 277.

Require a combination of at Require all passwords to include at least three of the following
least three of the following character types:
character types e Uppercase letters
* Lowercase letters
¢ Digits
e Symbols
Close open sessions Force close any open sessions from users that do not comply with the
immediately password policy.

3. Click Save.

After you save the password policy, all new users must follow the password policy. Existing users with a
password that does not comply with the new password policy will be prompted to change the password at
their next login.

LDAP authentication

Lightweight Directory Access Protocol (LDAP) authentication is an open, industry-standard application
protocol for accessing and maintaining distributed directory information services over an IP network. LDAP
provides a central place to store usernames and passwords. This enables many different applications and
services to connect to an LDAP server to validate users. This has a major benefit that allows a central place
to update and change user passwords.

When LDAP authentication is enabled in FortiEDR, whenever a user attempts to log in to FortiEDR, the
system looks for that user name and password in the central directory, instead of within the FortiEDR
directory. If the user is not found on the LDAP server, the system checks whether the user is defined locally
(under Administration > Users > Local Users).
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Before you start firewall configuration, make sure that your FortiEDR deployment includes an on-premise
Core that has connectivity to the LDAP server. Details about how to install a FortiEDR on-premise Core can

be found in Setting up the FortiEDR Core on page 511.

To set up LDAP authentication in FortiEDR:

1.

For multi-tenancy environments, in the Organization dropdown list at the top left, verify the selected
organization is the one that you want to grant the LDAP users access to. To grant the LDAP users
access to all organizations, select Hoster View.

In the Organization dropdown list at the top left, select the organization that you want to grant the user
access or select Hoster View if you want to grant the user access to all organizations.

Select Admin in the Role list for the group when you configure LDAP or SAML users.
Click the LDAP AUTHENTICATION tab.

Users

Local Users LDAP Authentication SAML Authentication

The following page displays:

Users &3 Password Policy

Local Users LDAP Authentication SAML Authentication

LDAP Enabled

Jumpbox

® No Jumpbox selected
Active Directory
Server Host* Bind User DN * @

None «  BindPassword* ®

Server Port
389 x

Role/Group mapping

Base DN o

Specify the LDAP group DN that determines the LDAP user's permission role:

Clear

5. Fillin the following fields:

Field Definition

LDAP Enabled Check this checkbox to enable LDAP authentication in FortiEDR.

Jumpbox Select the FortiEDR Core to communicate with the LDAP server. Only
FortiEDR Cores on page 403 configured with Jumpbox functionality
appear in the list. If no such core exists in the system, the list is empty
and FortiEDR displays a warning message.
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Field Definition

Directory Type Specify the type of central directory in use. FortiEDR supports Active
Directory and OpenLDAP. The default is Active Directory.

Server Host Specify the IP address of your LDAP server.

Security Level Specify the protocol to be used for the secured connection: TLS, SSL,
or None.

Server Port This value is dependent on the security protocol that was selected.

Bind User DN/Bind Password Specify the user and password for the authentication of FortiEDR in
the Central Directory.

Role/Group mapping Specify the base DN and define group/role mapping and permissions
of the group:

Base DM

Specify the LDAP group DN that determines the LDAP user's permission role:

+ Add group

1. In Base DN, specify the location in the Central Directory hierarchy
where the Groups that are used for permission mapping can be
found. For example, the DN for the root of the domain should
always work, but results in low performance.
Click Add group.
3. Define group/role mapping and permissions of the group:

a. Inthe Group field, specify the LDAP group DN as defined in

your central directory (Active Directory or OpenLDAP).

Specify the LDAP group DN that determines the LDAP users permission role

g

| | v Advanced o

| | v Advanced o

To check the LDAP group DN, run dsquery group -name
"Group_Name" on the Active Directory server.

e "FEDRAdmins"

"FEDRUsers™

b. Under Role, select a role from the list. See Users on page 277
for more information about the roles.

c. Under Advanced, enable any additional privileges for the
group. Some options are role-dependent.
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Field Definition

4. Click Add group and repeat step 2 for each role you want to map
to a group or multiple groups.

For example:

To give the user John Admin permissions in FortiEDR (for both the

FortiEDR application and the custom script), assign John to a

FortiEDRUsers group that is defined in your Central Directory:

1. Under Group, specify the LDAP group DN of the FortiEDRUsers
group.

2. Select Admin under Role.

3. Check the Custom script checkbox under Advanced.

During authentication, FortiEDR determines the relevant role for the

user John by checking that the Central Directory exists and that the

password used in the FortiEDR login page matches the password in

the Central Directory. If both exist and are correct, FortiEDR then

checks the FortiEDRUsers group to which John is assigned and

matches the user role permissions.

6. If users must use two-factor authentication to log in, check the Require two-factor authentication for
LDAP logins checkbox. For more details about two-factor login, see the Two-factor Authentication
section in Two-factor authentication on page 279.

N ! /., Click the Reset 2FA Token button to reset the two-factor authentication token for
q a specific user. This process works in the same way as described in Resetting a
- user password on page 281.
7. Click Save.
NP Users in Active Directory must not have a backslash (\) in the user name, in order
‘Q' for the name be supported by the FortiEDR Console. In some cases in Active
- Directory, a backslash is added when there is a space between a user’s first and

last names. For example, CN=Yell\,.

SAML authentication

Security Assertion Markup Language (SAML) is an XML-based open standard for exchanging authentication
and authorization data between parties, particularly between an identity provider (IdP) and a service
provider (SP).

FortiEDR can act as an SP to authenticate users with a third-party IdP, enabling transparent user sign-in to
the FortiEDR Central Manager Console.

To set up SAML authentication in FortiEDR:

1. For multi-tenancy environments, in the Organization dropdown list at the top left, verify the selected
organization is the one that you want to grant the SAML users access to. To grant the SAML users
access to all organizations, select Hoster View.
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2. Inthe Administration > Users page, go to the SAML Authentication tab.

Users

Local Users LDAP Authentication SAML Authentication

The following window displays:
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Local Users LDAP Authentication SAML Authentication

Download Service Provider Metadata

SAML Enabled

https://liorne1.fortiedr.com/saml2/liorne

6

IDP Metadata: @ File URL

Upload or drag and drop the SAML Identity

Provider metadata file browse

Role/Group mapping

Y

Specify name of the SAML attribute containing the groups information:

D

3. Click the Download button to download and save SP data from FortiEDR, which is used by your |dP
server during SAML authentication. Then, upload this FortiEDR data as is to your IdP server using a

standard method.

If your IdP requires manual configuration, you can extract the following fields from the XML file that you

downloaded and use them for manual configuration:
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Field Description

Entity ID Located under the md:EntityDescriptor tag, in the entityID attribute.

Logout Address Value Located under the md:SinglelLogoutService tag, in the Location
attribute.

Login Address Value Located under the md:AssertionConsumerService tag, in the Location
attribute.

Certificate Value (Public) Located under the ds:X509Certificate tag.

4. Fillin the following fields:

Field Definition

SAML Enabled Check this checkbox to enable SAML authentication in FortiEDR.

SSO URL Specify the URL to be used by users to log in to FortiEDR. If necessary,
you can edit the suffix of this URL (shown in green) by clicking the Edit

button & and then modifying it as needed. You can also copy the

=
URL to the clipboard using the Copy button O (for example, in order
to email the FortiEDR SAML login page to your users).

https:/I ¢ 0

Make sure that the suffix does not include any spaces and is
comprised of only letters, numbers and underscores.

IDP Description Specify a free-text description. For example, you may want to specify
the IdP server that you are using here.

IDP Metadata Upload the IdP metadata to FortiEDR. You can either upload an XML
file or a URL. To upload a file, click the File radio button and then click
the Select File button to navigate to and select the applicable *. XML
file. To upload a URL, click the URL radio button and then specify the
requisite URL.

IDP Metadata: File @ URL

Enter the SAML ldentity Provider metadata URL

Role/Group mapping Specify the attribute name and define group/role mapping and
permissions of the group:
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Field Definition

Role/Group mapping

Specify name of the SAML attribute containing the groups information:

Advanced:

+ Addgroup

1. In Attribute Name, specify the name of the attribute to be read by
FortiEDR, in order to determine the permissions and role to be
assigned to that user in FortiEDR. This attribute must be included
as part of the response from the identify provider server to
FortiEDR when a user attempts to log in to FortiEDR.

Click Add group.

3. Define group/role mapping and permissions of the group:

Specify name of the SAML attribute containing the groups information:

=

a. Inthe Group field, specify an attribute value to be granted
FortiEDR permissions.

b. Under Role, select a role from the list. See Users on page 277
for more information about the roles.

c. Under Advanced, enable any additional privileges for the
group. Some options are role-dependent.

4. Click Add group and repeat step 2 for each role you want to map
to an attribute value.

V) If more than a single role is mapped to the user,
‘Q' FortiEDR expects to get multiple roles as a list of
- values and not in bulk in the SAML assertion that is
- sent by IdP.

5. Click Save.

The examples below describe how the Azure, Okta or FortiAuthenticator SSO services can be used as an
IdP that provides authorization and authentication for users attempting to access the FortiEDR Central
Manager console. It demonstrates how to exchange metadata between the two entities, how to define
group attributes and how to associate them with SAML users so that user permissions are dictated by the
Group/Roles mapping in FortiEDR SAML configuration.

SAML IdP configuration with Azure

Ay
‘Q' Azure may require a license to support SAML integration with their Enterprise
| Application. Contact Microsoft’s support for further information.
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To configure general SAML IdP portal settings:

1.

Before you start configuring SAML on Azure, download and save SP data from the FortiEDR SAML

configuration page (fortiEDR.sp.metedata.id.1.xml), as described in SAML authentication on page

287.

Sign in to the Azure Dashboard.

In the Azure services, select and navigate to the Azure Active Directory.
From the left menu, select Enterprise applications.

Click New Application and then Create your own application.

In the window that appears, leave the default and click Create.

o v A ®WN

support-test@azure-stg.. @

nsioun &

= Microsoft Azure P search resources, services, and docs (G+/)
Home > enSilo Ltd > Enterprise applications

Browse Azure AD Gallery (Preview)

+ Create your own application (D) Request new gallery app Q Got feedback:

@ Ciick here to switch back to the old app gallery experience. =
L NS
Search application Single Sign-on - Al User Account Mansgement : All Categories : Al
Cloud platforms
Amazon Web Services (AWS) Google Cloud Platform Oracle SAP

2

Google Cloud

On-premises applications

Add an on-premises application

Configure Azure AD Applcation Proxy to enable secure remote

Learn about Application Proxy Manage Application Proxy connectors

ed 550

Featured applications

Adobe Creative Cloud Adobe Identity ADP Globalview Amazon Web Servi
‘ rosoft Corporation ‘ Management ADPLLC o (AWS)
> ;- v
Adobe Adobe o ¢

‘

What are you locking to

O confi

o

We found the following applications that may match your entry
We recommen: g gallery applications when possible.

7. Click Assign users and groups to configure the users and groups to grant access to the FortiEDR

application.

8. Select Users and groups and then + Add user/group to create a new user group.
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9. Add users to the group so that they will be eligible to authenticate with FortiEDR Manager.

All services > Enterprise applications | Al applications > SAMLNEW
2a SAML_NEW | Users and groups X
Enterprise Application
« + Add user/group ZZ Columns | 2P Gotfeedback?
i Overview E
The sppiication will appear fo sssigned users within My Apps. Set vsible to users? to no n propertes o prevent this. >
S © Theapp oo i 'y App: prop: 2
X Diagnose and solve problems
Assign users and groups to app-roles for your application here. To create new app-roles for this application, use the application registration.
Manage
.2 First 200 shown, to search all users & groups, enter a display name.
it properties
Display Name Object Type Role assigned
2 owners

O -

&, Roles and administrators
2 Users and groups

D single sign-on

® Provisioning

1 application proxy

G self-sevice

security

& Conditional Access

S permissions

@ Token encryption
Activity

D sign-in logs

6l Usage & insights
& Auditlogs

& Provisioning logs

9= Access reviews

10. Go to the groups properties and note down the object Id which will be used in later steps.

11. Click Set up single sign on.

Home » Enterpise applications
sz FortiEdr 5 | Overview

H
Enterprise Application

B oveniew Properties
Deployment Plan Name @
FortiEdr 5
Manage e ——
" Application 1D ©
Il Properties — o
9854dCH1-T2e0-4184-874b-2.. 0
& Ouwners chedis ®

&, Roles and administrators (Preview) 05512039 acdd-4514-a19¢-. [ |

28 Users and groups .
Getting Started

D single sign-on

 proviioning

© 1. Assign users and groups 2. 52t up single sign on
Ak Assio group: 3) 2 .setupsingle sig

Enable users 1o sign into their application
using their Azure AD credentials

ysers and groups Get sta

(2) 3. Provision User Accounts
Provide specific users and groups access

to the applications

Automatically create and delete user
s in the application

€ self-senice

Security

®& Conaitional Access

€ 5.selfservice

Enable users to
application usin
credentials

I E—
5t access to the
heir Azure AD

Activity

Get sta

il Usage & insights (Preview)

What's New

Sign in charts have moved!
Access reviews The new Insights view show 'g with other useful app!

ign ininfo alon

tion data. View insights

Delete Application has moved to Properties

You can

lete your application from the Properties page. View properties

Getting started has moved to Overview
The Getting Started page has been replaced by the step:

12. When prompted to select a single sign-on method, select SAML.

Select a single sign-on method  Help me decide

O 3

Disabled

Single sign-on is nat enabled. The user
won't be able to launch the app from
My Apps

SAML

Rich and secure authentication to
applications using the SAML (Security
Assertion Markup Language) protocol

Password-based
Password storage and replay using a
web browser extension or mabile app

&
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13. Click Edit in the Basic SAML Configuration box.
FortiEdr 5 | SAML-based Sign-on

Enterprise Application

netadata file Change single sign-on mode Test this application J Got feedback?
B Overview

[ Deployment Plan

et up Single Sign-On with SAML

%

Manage Read the configuration guide o' for help integrating FortiEdr 5.
H perties o
Basic SAML Configuration 7 i
A Owners & Edit
. 8 2 Identifier (Entity ID) Required
» Roles a isirators (Preview) e i mran ?
ly - Roles and acrninkstratons: (Preview) Reply URL (Assertion Consumer Service URL) Required
&8 Users and groups Sign on URL Op {
Relay State
D Single sign-on Logout Ur
D Provisioning
e User Attributes & Claims 2 Edit
C  Self-service c
givenname usergivenname
SECIJ[IT}' sumame user.surname
emailaddress user.mail
& Conditional Access name user.userprincpalnams
Unique User Identifier user.userprincipalname
© Token encryption 0
SAML Signing Certificate Z it
Activity =

Status Active

Thumbprint T W e W T S R
fisl Usage & insights (Preview) Expiration 12/20/2025, 10:50:17 PM

Notification Emai . .

App Federation Metadata Url i - i

&

& Provisioning logs [Previe Certificate (Base64)
Certificate (Raw)
Federation Metadata XML

Access reviews

o Set up FortiEdr 5
You'll need to configure the application to link with Azure AD.

Login URL

Azure AD Identifier |

2|0 ||&

Logout URL

View step-by-step instructions

14. Click Upload metadata file and browse to select the FortiEDR SP metadata file
(fortiEDR.sp.metedata.id.1.xml) that was downloaded from FortiEDR SAML configuration page during
SAML authentication on page 287. Alternatively, you can manually copy the entitylD and the Reply URL
values from FortiEDR metadata file and paste them to the relevant input text boxes.
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15. Click Save. The required SAML configuration fields displays populated with details, as shown below:
o Basic SAML Configuration

dentifier (Entity 10} hitps '_-;ﬂs-ic.::ﬂ'.-':am /metadata/alias/1
Reply URL (Assertion Consumer Service URL)  https:/ |- silo.com/saml/s50/alias/1

Sign on URL

Relay State

Logout Ur https '_:-’u;.i-c.::-"r.-':am /singleLogout/alia

ef
2y

ks
I
=1
=

16. Click Edit in the Attributes & Claims box.

17. In the Attributes & Claims window, click Add a group claim.

18. In the Group Claims window, select Groups assigned to the application to include groups assigned to the
FortiEDR application in the token.
These specific groups should be specified in the Role/Group mapping on the SAML configuration page
of the FortiEDR console in order to determine the permissions of the signed in user.

Group Claims X
USGI’ Attributes & Claims Manage the group claims used by Azure AD to populate SAML tokens issued to your app
Which groups associated with the user should be returned in the claim?
-+ Add newclaim -+ Add a group claim == Columns
O None
@ All groups
Required claim (O security groups
Claim name Value O Directory roles

| O Groups assigned to the application

Unique User Identifier (Name ID) user.userprincipalname [nam

Source attribute *

Additional claims

| Group ID v
Claim name Value
Advanced options
fortiEdrGroups user.groups
http://schemas xmlsoap.org/ws/2005/05/identity/claims/emailaddress user.mail Costomizethilname:of:the gratipclainy
http://schemas xmlsoap.org/ws/2005/05/identity/claims/givenname user.givenname Name (required)
http://schemas. xmlsoap.org/ws/2005/05/identity/claims/name user.userprincipalname ‘ fortiFdrGroups ‘
http//schemas.xmlsoap.org/ws/2005/05/identity/claims/surname user.surname Naiicspace (GptionaD
7] Emit groups as role claims @
\‘ ! 'l
q FortiEDR does not currently support consuming group overage (group.links)
claim resolution or nested group resolution.
-—
-

19. Select the Customize the name of the group claim checkbox.

Note down the Azure "name of the group claim", which you will need to specify as Attribute Name when
configuring SAML in FortiEDR later.

20. Inthe FortiEDR Central Manager console, in the Attribute Name field, enter the attribute name that was
specified on the SAML configuration page of the FortiEDR console during SAML authentication on page
287.In our example, it is fortiEdrGroups, as shown below. The Group should be the Azure Group object Id
noted earlier in step 10.
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Role/Group mapping

Attribute Name fortiEdrGroups

Specify name of the SAML attribute containing the groups information:

Group Role Advanced

| Senior Analyst v + Establish FortiEDR Connect sessions

® Adagroup

21. Click Save.

22. Download the Federation Metadata XML file from the SAML Signing Certificate section on Azure, as
shown below:

a SAML Signing Certificate )

Expiration 2727142025, 11:10:09 AR

Notification Email sup|
App Federation Metadata Urd h I}

Certificate (Basedd)
Certificate (Raw Dovwnload

Federation Metadata XML Chor 'll:_ g

23. Inspect the SAML assertion using SAML Tracer or Azure Token View to verify claim emission.
24. Select and upload the XML file into the FortiEDR Central Manager, as follows:

IDP Metadata: @ File URL

Upload or drag and drop the SAML Identity
Provider metadata file browse

Alternatively, you can use the App Federation Metadata URL from Azure, select the URL radio button in
the IDP Metadata configuration on the FortiEDR console and paste it to the same location:

IDP Metadata: File @ URL

Enter the SAML |dentity Provider metadata URL

Azure can now be used as an IdP that awards authorization and authentication to users trying to access the
FortiEDR Central Manager console. When logging into the FortiEDR console via an SSO URL that is specified
under the SAML settings page, an Azure user is awarded access rights to the FortiEDR Central Manager
according to the User Groups to which that user was added in Azure.
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SAML IdP configuration with Okta

To configure general SAML IdP portal settings:

1.

2.

Before starting to configure SAML on Okta, you must download and save SP data from the FortiEDR
SAML configuration page (fortiEDR.sp.metedata.id.1.xml), as described in SAML authentication on
page 287

Sign in to the Okta Admin dashboard. The following displays:

(% Dasht
& o H 1 o
Feopis AT
E »
Bl gt E——
H i AL ST
. b -
. 2, hoa Peoo
j
Jl
. L
' e

In your Okta org, click Applications and then Add Applications.
Click Create New App . The following displays:

OlBE Detoar Doy Agphostont  Geceny  Worfow  Bepors  Geting My Aoss ©

.F:t
Placiam sk g

e Of Mo

In the Platform field, select Web.
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6. In the Sign on method field, select SAML 2.0.
Click Create.

8. In the General Settings page, select a name for the application. For example, FortiEDRConsole.
Optionally, you can also add the FortiEDR logo here.

N

LS

Qe
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9. Click Next. The Configure SAML page displays:

=4

10. Copy the following values that are taken from the FortiEDR SP metadata file
(fortiEDR.sp.metedata.id.1.xml) that was downloaded from FortiEDR SAML configuration page, as
described in SAML authentication on page 287.

» Single sign on URL: Under the md:AssertionConsumerService tag, in the Location attribute (For
example, https://myexample.fortiedr.com/saml/SS0/alias/1).

e Audience URI (SP entity ID): Under the md:EntityDescriptor tag, in the entityID attribute (For
example, https://myexample.fortiedr.com/saml/metadata/alias/1).

11. In Advanced Settings, in the Assertion Encryption field, select Encrypted.

12. Use Notepad or another text editor to copy the entire attribute <ds:X509Certificate>XXX
</ds:X509Certificate> from the FortiEDR SP metadata file (fortiEDR.sp.metedata.id.1.xml) that was
downloaded from FortiEDR SAML configuration page. Then, save this attribute as a .crt file to be used
as a certificate.
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13.

<?xml version="1.0" encoding="UTF-8"?>
<md:EntityDescriptor entitylD="https://nsl le.ensil saml/
- <md:SP! D ipte e i i

Upload this .crt file to the Encryption Certificate box on Okta, as shown below:

- «md:KeyDescriptor use="signing">
- <ds:KeyInfo xmlns:ds="http:/ /www.w3.0rg/2000/09 /xmldsig#">

- <ds:X509Data>
<ds:X500Cartificata» MIZNADON

MAOGCSqGSIb3DQ!
96/11t70IkfTRgiSY
VvWOcchuyCDSC}
YsmGGYGIZLeWdx{
RECILEQ+vsl1/|

</ds:X509Data>
</ds:KeylInfo>
</md:KeyDescriptor>

- <md:KeyDescriptor use="encryption">

- <ds:KeyInfo xmins:ds="http: / /www.w3.0rg/2000/09 /xmlidsig#">
- <ds:X500Data>
<ds:X500CertificatexTTT

JTNETR) 21

1 L il \_sam|_i _alias_1" xmins:md="ur i 22, o

i “false" i “true">

7. o 71z MR AYNT! TUYMIAYD: £ g9
ADOGeRS5VIZru
saLYNSqme
3c/24597702va

T AGUSCIS (aF 7 E5FUHSMQRXYMAXPIIVES EOXXLS /O LOIMBAT/ I ATYUIE 7 P LPSLOT

HVkxYwv
ns=</ds:X509Certifi

oY

RICILEO-
</ds:X509Data>
<fds:KeyInfo>

/1" Binding="ur i :2.0:bindi ITTP-POST"/>
ingleLogoutService Location="https://nsloeng.console.ensilo.com/saml/SingleL ias/1" Binding= i :2.0:bindi ITTP-Redirect”/>

DFormat i s1.1x id- i /md:NameIDFormat>

DFormat i

Format i i DFormat>

DFormat: i DFormats

DFormat: i j DFormats
<md:AssertionConsumerService Location .com/saml/SS0/alias/1" Binding="ur 2.0:bil TTP-POST" "true” index="0"/>
<md:AssertionConsumerService Location="https://nsloeng.console.ensilo.com/saml/SS0 /alias/1" Binding= i :2.0:bindi ITTP-Artifact” index="1"/>

</md:SPSSODescriptors

</md:EntityDescriptor>
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14. Leave the default values in the rest of the settings. For example, as shown below:

Hide Advanced Settings

Response & Signed v
Assertion Signature @ Signed v
Signature Algorithm &) RSA-SHA256 *
Digest Algorithm SHAZ56 v
Assertion Encryption € Encrypted v
Encryption Algorithm & AES256-CBC v
Key Transport Algorithm & RSA-OAEP v
Encryption Certificate 0 my_cert.crt ¥
Uploaded by Alex Bandel on Sun Dec 27 16:24:24 UTC

2020

In 3420 days
Enable Single Logout &) I:I Allow application to Initiate Single Logout
Assertion Inline Hook None (disabled) v
Authentication context class &) PasswordProtected Transport v
Honor Force Authentication € Yes v
SAML Issuer ID € hitp:/Awww.okta.com/${org.extermaliey}

Name MName format (optiona Value

15. Groups will be used in the assertion so that FortiEDR roles will be assigned according to the current
groups in the Okta directory. For example, to assign the Okta Engineering group to have Admin roles on
FortiEDR, add it to Okta as follows:
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The mapping of this group to the FortiEDR Admin role is then performed in the SAML settings page of
the FortiEDR Central Manager console as follows:

Specify name of the SAML attribute containing the groups information:

v Advanced:

+ Add group

16. Previewing the assertion should appear similar to the following example:

17.
18.

19.

<2l version="1.0" encoding="UTF-8">
="2020-12-27T12:13:33.8382" ID="id80825067641464161630120810">

<saml. = :2.0: ion” Version="2.0"
<saml2: Issuer Format= i 2 i http://www.okt: Issuer</sami2::
- <saml2; Subject>
<saml2:NamelD Format="ur i a1 i ified”>userName</sam|2:NameID >
- <saml2: SubjectConfirmation Method= 2
<sami2: SubjeztconfumalmnData Recipient="https://sw.console.ensilo.com/saml/SSO /alias/1" NotOnOrAfter="2020-12-27T12:18:33.8712"/>

</saml2:SubjectConfirmation>
</saml2:Subject>
<saml2: Conditions NotOnOrAfter="2020-12-27T12:18:33.8712" NotBefore="2020-12-27T12:08:33.8712">

- <sami2: AudienceRestriction>-
<saml2:Aud /1

</samiz: Aud\en(eResm:Uon>
</saml2:Conditions>
<saml2: AuthnStatement AuthnInstant="2020-12-27T12:13:33.8382">

- <saml2: AuthnContext>
12: AuthnContextClassRef: 2 port< ontextClassRef>

I il saml/ alias/ 1</saml2;: Audience>

<fsaml2:AuthnContext>
</saml2:AuthnStatement>
- <saml2: AttributeStatement>
- <saml2:Attribute NameFormat="u i ="groups’
sami: Attributavalue xsi:type="xs:string" xminsisi= http /[ Www.w3. urg/zﬂnl/XMLSchema instanéer xmins:xe= "http://www.w3.0rg/2001/XMLSchema">GroupName Match Contains "Engineering” (ignores case) </saml2: AttributaValues

</saml2:Attribute>
</saml2:AttributeStatement>
</saml2:Assertion>

Click Next and then click Finish.
When you configure SAML SSO on the FortiEDR console, use the URL for Identity Provide Metadata from

the application Sign On settings in Okta, as shown below:

Paste it into the FortiEDR Central Manager as follows:

IDP Metadata: File @ URL

Enter the SAML Identity Provider metadata URL

Okta can now be used as an IdP that awards authorization and authentication to users trying to access the
FortiEDR Central Manager console. When logging into FortiEDR console via the SSO URL that is specified
under the SAML settings page, an Okta user is awarded access rights to the FortiEDR Central Manager
according to the User Groups to which that user was added in Okta.
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SAML IdP Configuration with FortiAuthenticator

FortiAuthenticator configuration is comprised of the following steps:

1. Setting up FortiAuthenticator as an IdP on page 303
2. Setting up user group management on page 303 (if not configured already)
3. Setting up service provider for FortiEDR on page 305

Setting up FortiAuthenticator as an IdP

To configure general SAML IdP portal settings:

1. Go to Authentication > SAML IdP > General and select Enable SAML Identity Provider portal.

2. Configure the following settings:

Setting Definition

Device FQDN To configure this setting, you must enter a Device FQDN in the System
Information widget in the Dashboard.

Server address Enter the IP address or FQDN of the FortiAuthenticator device.

Username input format Select one of the provided options. In our example, we used
username@realm.

Realms Select Add a realm to add the default local realm to which the users

will be associated.

Login session timeout Set the user’s login session timeout limit to between 5 -1440 minutes

(one day). In our example, we used 500 minutes.

Default IdP certificate Select a default certificate the IdP uses to sign SAML assertions from

the dropdown menu.

Edit SAML Identity Provider Settings

© Enable SAML Identity Provider portal
Device FQDN; 1051.122.65

Allow local users to override remote users

Login session timeout:

Default IdP certificate:

3. Click OK to apply these changes.

Setting up user group management

To configure on FortiAuthenticator the assertion attribute that will be used to map users’

permissions to access FortiEDR:

1. Go to Authentication > User Management > User Groups.
2. Select Create New.
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3. Specify a name for the group to be used for setting User access permissions for FortiEDR. In our
example, we used groupuser.

4. Inthe Users section, select all the FortiAuthenticator users to be assigned with User permission to the
FortiEDR Central Manager Console in order to add them to this User Group.

5. Click OK to save the configuration.

6. Repeat steps 1-5 above to create a group for each role and select the users to be assigned to that
group with the corresponding permissions to the FortiEDR Central Manager Console.

In our example, we created a group named groupadmin and assigned this user the same Admin permissions
to the FortiEDR Central Manager Console, as shown below:

Create New User Group

Name: groupadmin
Type: ® Local
) Remote LDAP

") Remote RADIUS
) Remote SAML
o MAC

Users: Avalable users @ ——
Q[ Filter sam

admin

demol

demoZewew

demoZorgl

Becm_user
john

kim

orl
sharon

yosefcd

Choose all visible

Remove all
Password policy: Default w

(O Usage Profile

| Please Select ] w

Ay
‘?' New or existing FortiAuthenticator users can also be configured into groups on the
|| Local Users create and edit page.
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Setting up service provider for FortiEDR

To configure FortiEDR as a SAML service provider on FortiAuthenticator:

1.
2.

3.

4. Click Download IDP metadata to save the FortiAuthenticator IDP data file to be used for uploading into
FortiEDR. Refer to step 3 in SAML authentication on page 287 for more information.

5. Click Import SP metadata and select the SP data file that was downloaded from FortiEDR. Refer to step 2

Go to Authentication > SAML IdP > Service Providers.
Select Create New.

Create New SAML Service Provider

SP name:
IDP prefix: Generate prefix
Server certificate: Detautt-5erwer-Certificate | C=US5, ST=California, L=5unnyvake, O=Fortinet, OU=Fortiauthenticator. CN=Default- Server-Certificate-4F2C01B6  ~
IDP single sign-on URL: https:/f /saml-idp/xcx/login/ ]
IDP single logout URL: https://1 'saml-idp/xxx/logout/ =3
Download IDP metadata mport SP metadata
SP entity ID:

SP ACS (login) URL.
SP 5LS (logout) URL:
& Support ldP-initiated assertion response
Relay state:
® Participate in single logout
& SAML request must be signed by SP

Certificate type: 5P certificate ~

Certificate fingerprint: Import certificate

Fingerprint algorithm:

Alternative certificate fingerprint: Import certficate

Fingerprint algorithm:
» Use ACS URL from SP authentication request (override ACS URLs configured abowe)

Authentication
Authentication method: ) Mandatory two-factor authentication
@ Verify all configured authentication factors
) Password-only authentication
) Token-only authentication
B Bypass FortiToken authentication when user is from a trusted subnet [Configure subnets
Assertion Attributes
Subject NamelD: Username w

» Include realm name in subject NamelD

Format: Unspexified |~
B Debugging Cptions
» Do not return to service provider autormatically after successful authentication, wait for user input.
® Disable this service provider
Fill in the following fields:
* SP name: Enter a name for the FortiEDR SP.

» IDP prefix: Select Generate prefix in order to generate a random 16-digit alphanumeric string or

i

Alternative ACS URLs

alternatively enter a prefix for the IDP that is appended to the end of the IDP URLs.

in SAML authentication on page 287 for more information.
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Import Service Provider Metadata x

Filetype: @ Metadata () Certificate

File: Choose File | forfEDR.sp....tedata.id.1.xml

6. All other service provider configuration fields are auto-filled after the SP data file import:

= _= FortiAuthenticator VM FAC-VMTM20000586
System © Successtully imported the metadata information. Please complete the rest of the configuration
Authentication v
sp p: sharenhondapl
& User Account Policies > fame srenhendae
@ User Management » IDP prefix [Generate unique prefix
& Self-service Portal N IDP certificate: [ Please Select ] -
& Guest Portals > | IDP address: 10.51.122.65
=8 Remote Auth. Servers 5 IDP entity id: http:/10.51.122.65/saml-idp/réwlojawy? linosx/metadata/ @
& RADIUS Service > B
IDP single sign-on URL: https://10.51.122.65/saml-idp/réwlojawy9 linosx/login/ 2]
& LDAP Service >
& OAuth Service N IDP single logout URL: https:/10.51.122.65/saml-idp/réwlojawy9 linosx/logout/ (@)
B samLicP - [ d I0P metadata] [Import SP metadata]
General SP entity ID: https: 1l/metadata/alias/ 34005
Replacement Messages SPACS (login) URL: https /550 alias/34005 [Alternative ACS URLSs
i ider:
N EE T SPSLS (logout) URL hitps SingleLogout/alias/34005
22 FAC Agent > B
O SAML request must be signed by SP
Fortinet SSO Methods > B . )
Certificate fingerprint: 4dé 3ddal [Import SP certificate]
Monitor >
Fi int algorithm:
Certificate Management > ingerprint algorithm sha256
Logging » | Authentication
Authentication method: O Enforce two-factor authentication

@ Apply two-factor authentication if available (authenticate any user)
(O Password-only authentication (exclude users without a password)
) FortiToken-only authentication (exclude users without a FortiToken)

(® Bypass FortiToken authentication when user is from a trusted subnet [Configure subnets]
Debugging Options

Assertion Attributes
Subject NamelD: Username 2

Format: Unspecified v

7. Click OK to apply the changes.

8. Go to Authentication > SAML IdP > Service Providers and double-click to open the Service Provider that
you created in the previous step.

9. Inthe SAML Attribute section, click Create New.

10. In the popup window, enter the attribute name that was configured in the FortiEDR SAML

Authentication settings and select FortiAuthenticator Group as the User Attribute.
In our example, we use fortiedr_role as an attribute name, as shown below:
Role/Group mapping

fortiedr_rolg ®

Specify name of the SAML attribute containing the groups information:

Role v Advanced: Custom script Establish FortiEDR Connect sessions 'D

Role v Advanced: Custom script Establish FortiEDR Connect sessions 'lj

And therefore the configuration on FortiAuthenticator appears as follows:

FortiEDR 7.2.0 Administration Guide 306
Fortinet Inc.



Administration

Create New Assertion Attribute

SAML attribute: fortiedr_role

User attribute Group v

“ canee

11. Click OK to save the changes.

FortiAuthenticator can now be used as the IdP, which provides authorization and authentication for users
trying to access the FortiEDR Central Manager Console. When logging into the FortiEDR Console via the
SSO url that is specified in the SAML settings page, a FortiAuthenticator user is awarded access
permissions to the FortiEDR Central Manager according to the User Groups into which he/she was added.

Distribution lists

The DISTRIBUTION LISTS option enables you to specify recipients who will receive an email each time a
security event is triggered by FortiEDR.

vy
‘?' You must configure SMTP before using the Distribution List option. For more details,
|| see SMTP on page 308.
S ! ’, Emails are only sent for security events that occur on devices that are part of
q Collector Groups that are assigned to a Playbook policy in which the Send Email
- Notification option is checked.

Each email contains all the raw data items collected by FortiEDR about that security event. The system is
provided with a Distribution List called All Recipients that contains all FortiEDR Central Manager users. All
other recipients that are added to the system are also automatically added to the All Recipients list.

DISTRIBUTION LISTS NOTIFICATIONS

= crese List | B8 Add Recipient

NAME TITLE FIRST NAME LAST NAME EMAIL Showing 1-1/1

> Al Recipients

This window displays a row for each Distribution List. Click the Expand button (%7) in a row to view the
recipients assigned to that list.

Use the Create List button ( = Create L E1:) to create a new distribution list.
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+ .
Use the Add Recipient button (h Add QECIF} Em) to add a recipient or user to a distribution list.

DISTRIBUTION LISTS NOTIFICATIONS
=¥ creste List Delete Liss | BB Add Recipient
NAME TITLE FIRST NAME LAST NAME EMAIL Showing 1-1/1

< All Recipients
Tech Writer Barbara Sher barbara@docustar.co.il ¢' Edit
Proguct Einat Yellin einar@ensilo.com & edit
Einaty Einaty Einaty Einaty@Einaty & edit
Cognit Tzafit Tirkel tzafit@cognit.co.il ¢ Edit
aasa aasa aasa 3333@f com & e
bbbb bbbb bbbb bbbb@g.com & Ean

Select a distribution list row and then use the Enabled/Disabled option in the NOTIFICATIONS pane on the
right to enable or disable the list per event type (system events or security events).

DISTRIBUTION LISTS NOTIFICATIONS
= Create List Delete List | B=¥ Add Recipient
ORGANIZATION NAME TITLE FIRST NAME LAST NAME EMAIL Showing 1-17/100 | »| [+
All organizations. mjhfveim ¢~Ed\t List Security Events Disabled
3 liorgolf444 All Recipients System Events Disabled
3 organization10 All Recipients
3 organization10 Keren & edit List

Export settings

The EXPORT SETTINGS option provides access to the following options:
« SMTP on page 308

* Open Ticket on page 309

« Syslog on page 310

SMTP

The SMTP option enables you to configure the SMTP server to be used for sending emails. You can also
check the connectivity to the SMTP server.
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SMTP
I Clear
Name net Email address  *  |syp com
ort 2525 + Use SMTP authentication
EFZ';C[C"\[":DS LS u name
nder Pas:
OPEN TICKET
System name Email address  *
Used for rece ving tickets from all o ganizations
SYSLOG NOTIFICATIONS
| oetine new sysicg
\‘ ! ’I
9 In a single-organization system, SMTP settings are only accessible in Hoster view
(for administrators of all organization), or to the administrator of that organization.

To configure SMTP server settings:

1. Inthe SMTP area, enter standard SMTP settings and then click Save.

To test SMTP server connectivity:

1. Inthe SMTP area, click Test. An error message displays if there is no connectivity to the server.

ﬂ Save E Clear

Test X Connection to SMTP server
failed. Please check the SMTFP

Settngs.

Open Ticket

The Open Ticket option enables you to send events to an event-management tool such as Jira or
ServiceNow. Open Ticket automatically opens a ticket and attaches the relevant event to a ticket.

In order for the Open Ticket feature to work properly, you must set up an email feed in the event-
management tool to be used.

FortiEDR 7.2.0 Administration Guide 309
Fortinet Inc.



Administration

Y Most event-management tools are supported. FortiEDR has tested and verified that
‘Q' Open Ticket works with the ServiceNow and Jira systems. For more details about
- setting up the email feed required for this feature, see Appendix A — Setting up an

email feed for open ticket on page 448.

are part of Collector Groups that are assigned to a Playbook policy in which the

s‘é’, Security events are only sent to a ticketing system when they occur on devices that
- Open Ticket option is checked.

OPEN TICKET

System name Email address
SYSLOG NOTIFICATIONS
|Woenine New sysiog

To configure Open Ticket settings:

1. Inthe Open Ticket area, in the System name field, enter the system name for the tool to be used for
event management. This is a free-text field.

2. Inthe Email address field, enter the email address that is the destination to which all tickets are to be
sent from FortiEDR. All tickets from all organizations are sent to this email.

3. Click Save.

Syslog

The SYSLOG option enables you to configure FortiEDR to automatically send FortiEDR events to one or more
standard Security Information and Event Management (SIEM) solutions (such as FortiAnalyzer) via Syslog.

OPEN TICKET

System name | Email Address ~ * I:

SYSLOG

IH‘DET\HE New Syslog

Name | | Host: <] | port:+| | Protecor: TP~ v TLS [ Cllentcentficate T Fomat Semicoln ~ o

All Syslog messages in FortiEDR originate from the Central Manager. The source IP address for syslog
messages is the IP of the Central Manager. The FortiEDR Central Manager server sends the raw data for
security event aggregations. Each entry contains a raw data ID and an event ID. Raw data items belonging
to the same security event aggregation share the same event ID, which enables the SIEM to combine them
into one security event on the SIEM side, in order to remain aligned with the FortiEDR system.
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part of Collector Groups that are assigned to a Playbook policy in which the Send

\‘é’, Syslog messages are only sent for security events that occur on devices that are
- Syslog Notification option is checked.

To define a new Syslog destination:

+
1. Click the lh Define New Syslog ) von.

2. Specify the following attributes:

Syslog Name Free-text field that identifies this destination in the FortiEDR.

Host Host name of the Syslog server.

Port Port of the Syslog server.

Protocol Protocol of the Syslog server. You can select TCP or UDP.

TLS When TCP is selected in Protocol, use this option to specify whether to enable

TLS. If the Syslog server requires a client-side certificate, you must enable TLS
before you can upload the certificate.

Client Certificate If the Syslog server requires a client-side certificate, enable TLS and use this
option to upload a certificate. For example, if your FortiAnalyzer server requires
a client-side certificate, contact Fortinet Support to obtain appropriate client
certificate files and upload them here.

ATTACH CLIENT CERTIFICATE

Private key file: Select file

Certificate file: Select file

Private Key Password: |

o ™,

( Cancel )
o -

Format Select the type of the syslog server:
» Semicolon—Select this option if the syslog server is not one the following
three. FortiEDR then uses the default CSV syslog format.
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Attribute Description

« FAZ—The syslog server is FortiAnalyzer. FortiAnalyzer Cloud is not
supported.

e CEF—The syslog server uses the CEF syslog format.
e LEEF—The syslog server uses the LEEF syslog format.

Refer to FortiEDR Syslog Message Reference for more details about syslog
message fields for different formats.

3. Click the Test button to test the connection to the Syslog destination server.

4. Click the ﬁ button to save the Syslog destination.

To select which syslog messages to send:

1. Select a syslog destination row.

2. Use the sliders in the NOTIFICATIONS pane on the right to enable or disable the destination per event
type (system events, security events or audit trail) as shown below:

NOTIFICATIONS

Security Events (&) Enabled -ﬂ-
System Events (®) Enabled

Audit trail (®) Enabled

To select which fields will be included in the syslog messages:

Click the 'n' button on the right of the event type and check the checkbox of the fields that you want to be
sent to your Syslog.

FortiEDR 7.2.0 Administration Guide 312
Fortinet Inc.


https://docs.fortinet.com/document/fortiedr/7.2.0/syslog-message-reference/529358/introduction

Administration

SECURITY EVENTS NOTIFICATIONS

Organization
Event ID
Device Name
MAC Address
Source IP
Process Path
Severity
Destination
Last Seen
Count

Rules List
Script

Autonomous System

Process Hash

Threat Family

Organization ID

Raw Data ID

Device State

Operating System

Process Name
Process Type
Classification
First Seen
Action
Certificate
Users

Script Path
Country
Threat Name

Threat Type

| Cancel |
,Lancel

You can also define a Syslog destination via REST API, including the upload of a

and all notifications options, including security, system, and audit events, are

s‘é’, certificate using Rest API during the process. By default, all available syslog fields

enabled. For more details, refer to the FortiEDR RESTful APl Guide. You must log in

to the Fortinet Developer Network to access the guide.

Warning: If syslog is configured for both Hoster view and an organization, two
syslog events will be sent.
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For more information on syslog messages, such as message types and fields, see FortiEDR Syslog Message

Reference.

Settings

The Administration > Settings page provides access to the following configuration options:

\y

Some options are only available to specific roles. For more information about user

S L4
9 roles and permissions, see Users on page 277.
-

¢ Audit Trail on page 314

¢ Deployment URL on page 316

e« Component Authentication on page 316
» File Scan on page 319

» End Users Notifications on page 320

« Personal Data Handling on page 325

e |oT Device Discovery on page 331

* Windows Security Center on page 333
e Application Control Manager on page 334
» FortiEDR Connect on page 334

e Reputation Service on page 335

Audit Trail

FortiEDR’s audit mechanism records every user action in the FortiEDR system. System actions are not
recorded. You can download the audit trail (up to 30 days) to a CSV file for further analysis.

Each time a new audit trail is created, it can be sent through the Syslog.

~ Audit Trail

rrom o
Download audit trail Dec 08, 2024 = - Jan 08, 2025 = Generate Audit

To generate the audit trail:

1. Navigate to the Administration > Settings page.
2. Expand the Audit Trail section and specify the From and To dates in the respective fields.
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3. Click the Generate Audit button. A progress window displays:

(i) Generate Audit X

100%

Successfully generated audit trail

Download

Click the Download link to download the audit trail to a CSV file or spreadsheet, such as the example
shown below, displays:

Home | Inset  Pagelayout  Formulas  Data  Review  View  Acobat

& o Caiori AN BRI { | Normal Bad = Autosum #a
B B su- e A~ = s conations rormot | I T o Format | 2" e L=
F Format Painter R : : Formatting * s Table - - @Cear~ e Select~ | Document
Clipboard 5 Font 5 Algnment Number styles cels Editing
D37 ~ (" X « f| Collector [ga-performance-2-Test_1] was deleted v
A 3 c [ ) F G H [ ) 3 E
1 Dateand Time  Sub system User Name Description %
2 | 2/12/202014:41 Administration Barbara Audit trail from 11-02-2020 to 12-02-2020 was generated
3 | 2/12/202014:40 Administration Barbara Audit trail from 11-02-2020 to 12-02-2020 was generated
4| 2/12/202014:15 System Barbara system login
5| 2/12/202013:34 System Barbara system logout
6 | 2/12/202012:46 System Barbara 0sx Collectors version "3.1.5 revision 14" for Collector group/s linsiders] was updated
7 | 2/12/202012:44 System Barbara Automatically update collectors to the latest version was disabled
8 | 2/12/202012:42 System Barbara Automatically update collectors to the latest version was enabled
9 | 2/12/202012:28 Events Barbara Event/s [145793] sent to forensics
10 | 2/12/202012:27 Events Barbara Event/s [141353] sent to forensics
11 2/12/202012:23 Events Barbara Event/s [145793] sent to forensics
12| 2/12/2020 12:20 Events Barbara Event/s [166577, 166692, 170174] sent to forensics
13| 2/12/2020 12:17 Events Barbara Event/s [142194, 142211, 152854, 142203, 142220] sent to forensics
14 2/12/202012:14 Events Barbara Event/s [145793, 145803] sent to forensics
15 2/12/202012:14 System Barbara system login
16 2/12/202012:14 System Barbara system logout
17 | 2/12/2020 12:13 Events Barbara Event/s [142194, 142211, 152854, 142203, 142220] sent to forensics
18 2/12/202012:12 Events Barbara Event/s [142194, 142211, 152854, 142203, 142220] sent to forensics
19 2/12/2020 12:10 Communication Control Fortinet Application [Windows Update] version [10.0.17763.1 (WinBuild.160101.0800)] from vendor [Microsoft Corporation] was marked as resolved
20 | 2/12/2020 12:09 Events Barbara Event/s [163078, 171302] sent to forensics
21 2/12/2020 12:07 Events Barbara Event/s [163078, 171302] sent to forensics
22 2/12/202012:05 System tior system logout
23 2/12/202011:56 Events Barbara Event/s (142194, 142211, 152854, 142203, 142220] sent to forensics
24 2/12/202011:56 Inventory Barbara Collector [Panda1] was unisolated
25 2/12/202011:52 Inventory Barbara Collector [Pandal] was isolated
26 2/12/202011:49 Events Barbara Event/s [180468] sent to forensics
27 2/12/202011:46 Events Barbara 2events were marked as read
28| 2/12/2020 11:46 System Barbara system login
29 2/12/202011:46 System Barbara system login failed
30 2/12/202010:19 System tior system logout
31 2/12/20209:41 Administration lior 10T discovery was enabled
32 tior 10T test was stopped
£ tior system login
3 tior 10T test started on Collector [214980]
35 2/12/20209:16 Administration lior 10T test was stopped
36 2/12/20209:14 Administration tior 10T test started on Collector [214980]
37| 2/12/20209:13 Inventory lior Collector [ga-performance-2-Test_1] was deleted
38 2/12/20209:13 Inventory tior 10 10T device(s) were deleted
39 2/12/20209:13 Administration lior 10T test was stopped
a0 tior 10T test started on Collector [214628]
a1 : inistration ior 10T discovery was disabled -
M 4 b W] audit_11-02-2020_to_12-02-2020_ /%3 M4l [ (0}

Each row in the audit trail file contains the following columns of information:

Definition

Date and Time Displays the date and time in the format yyyy-mm-dd hh:mm:ss.

Sub system Displays the change type, such as System, Configuration,
Administration, Forensics, Events, Inventory, Communication Control

or Health.
User Name Displays the name of the user.

Description Displays the action and/or a description.

The following actions can be audited:

« Policy actions

Forensic actions
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* Administrative actions

« Events

e Inventory actions
e System health changes

A\,

If an employee’s/user’s data was removed from FortiEDR for GDPR compliance, then
the affected record for that person still displays in the audit trail but shows GDPR_
ANONYMIZE instead of actual user data. For example, as shown below:

6/20/2018 15:57 Administration
6/20/2018 15:57 System
6/20/2018 15:57 Administration

admin
GDPR_ANONYMIZE
admin

GDPR report was generated
System login
GDPR Deletion

Deployment URL

This section displays the URL of the environment that you can copy. The URL is read-only and includes the

domain information that you will need in order to use FortiEDR APIs.

» Deployment URL

FortiEDR URL

hitps.//

fortiedr.com |

Component Authentication

In order to install, upgrade or uninstall a Collector, you must supply the registration password. The

registration password is the same for all Collectors in the FortiEDR system. This password is defined when

you configure the FortiEDR Central Manager Server and console.

The Component Authentication section provides options to retrieve a lost registration password or revoke a

compromised registration password.
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If you forget the registration password, retrieve it by following the steps below:

1. Navigate to the Administration > Settings page.
2. Expand the Component Authentication section and click the Display button.

~  Component Authentication

Display device registration password || Display _

The device registration password is required in order to install or uninstall components from the system

Advanced Password Management

The password is shown temporarily for you to view to copy.

~  Component Authentication

Display device registration password = 0

The device registration password is required in order to install or uninstall components from the system

Advanced Password Management

To revoke a compromised registration password:

1. Navigate to the Administration > Settings page.
2. Expand the Component Authentication section and click Advanced Password Management.

~  Component Authentication

Display device registration password | Display _

The device registration password is required in order to install or uninstall components from the system

Advanced Password Management
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3. Enter the new password, confirm it, and click Revoke.

Advanced Password Management

Revoke registration password

Password b

Confirm Password b

v Display previous registration passwords

Close

After you revoke an existing registration password with a new one, the new password is required for
subsequent connections with connected or new Collectors. However, you still need the revoked
password for reconnection or uninstallation of disconnected Collectors. You can see a list of revoked
passwords under Display Previous Registration Passwords with information of revoked time and number
of Collectors still using that password.

Advanced Password Management

Revoke registration password

~ Display previous registration passwords

You can revoke the registration password four times maximum, after which the Revoke button is
disabled and you must delete an old password in order to create a new one.

Ay
‘Q' Fortinet recommends that you generate a new custom Collector after revoking a
|| compromised registration password.
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File Scan

FortiEDR can perform periodic scans of the files in the system on a scheduled or on-demand basis, based
on its execution prevention policy. During a periodic scan, only the files on the hard drive are scanned and
no memory scan is performed. For a periodic scan, each file on the hard drive is scanned. If a malicious file
is identified during a scan, a security event is triggered.

To schedule a periodic scan:

1. Navigate to the Administration > Settings page.

2. Inthe File Scan area, check the Perform scheduled scan checkbox. This checkbox must be checked to
perform the scan according to the designated schedule.

Malicious files that are found during scan will trigger Execution Prevention security event.

Periodic Scan Ad hoc scan
Perform scheduled scan Last scan: 30-Dec-2024 TReer
All Collectors v
Bi-Weekly ~ Monday = 2:00 AM

Scan executable files only

. AYALA-PYTHON-NEW
Collectors

collector37-new38

DESKTOP-OKCBAJR

Scan executable files only

w

In the Frequency dropdown list, select how frequently to execute the scan. Options are Weekly, Bi-
Weekly (every two weeks), or Monthly.

4. Inthe Day dropdown list, select the day of the week to execute the scan.
5. Inthe Hours dropdown list, select the hour of the day to execute the scan.

6. Use the radio button to select on which devices the scheduled scan should be performed. When
selecting Collector Groups or Collectors, you should specify which Groups or Collectors should be
included in the scan. Devices that are not listed here are not scanned.

7. Click the Save button. The scan is performed as scheduled.

To perform an on-demand file scan:

1. Navigate to the Administration > Settings page.

2. Inthe Ad hoc scan area, select which devices to scan by specifying one or more Collectors or Collector
Groups, or selecting the All Collectors option to scan all devices with installed Collectors.
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Ad hoe secan

Apply an
All Collectors ~

Scan executable files only

3. Check the Scan executable files only checkbox to only scan executable files. This option enables a
quicker scan, but neglects documents, scripts and other potentially malicious files.

4. Click Scan. The scan is performed immediately.

End Users Notifications

Each device protected by FortiEDR can display an icon in the system tray to indicate its state.

The FortiEDR icon indicates the current state of the device, as follows:

g
L&
A J

Protection On

Protection Off/Disabled

| Degraded

Q‘ |
A Isolated

L}
‘9' Terminating a FortiEDR process ends this process and stops the display of the
|| FortiEDR icon in the system tray, but does not stop FortiEDR protection.

When the FortiEDR icon is configured to display on FortiEDR-protected devices, a popup message displays
whenever something is blocked on a protected device (based on the blocking policy set for that device).
File modifications (due to suspected ransomware), the exfiltration of external connections and execution

FortiEDR 7.2.0 Administration Guide 320
Fortinet Inc.



Administration

prevention actions can be blocked. For example, the following shows that a TCP port listening action was
blocked for the DynamicCodelListenTests.exe process.

FiERTINET

TCP port listen blocked for process
DynamicCodeListenTests.exe (PID 5172)

Contact your system administrator if a
trusted application is blocked

vy
‘?' This notification is displayed only once for the same process. If the same process is
|| blocked multiple times, only a single FortiEDR pop up is displayed.

You can choose to show or hide end-user notifications (pop-ups) for the next 24 hours. To do so, right-click
the FortiEDR icon in the system tray and then check the checkbox to hide notifications or leave the
checkbox unchecked to display notifications.

Hide FortiEDR notifications for 24 hours

» Hide FortiEDR notifications for 24 hours (23:59:51)
T U

~ N\
’ 2/25/2020
You can double-click the FortiEDR icon in the system tray to review recent blocking activity on the device
as shown below. Each row includes a single event (that can be composed of multiple occurrences) and
displays the process name, the first and last occurrences times, the process ID, and the type of blocking:
either security or communication control.
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F:=RTINET

FortiEDR. Protection ON

Version 5.0, 3. 206

Activity Log
Policy

@ Security
@ Security
@ Security
@ Security
@ Security

Process

msedge.exe

firefox.exe

DynamicCodelistenTests, exe

DynamicCodeTests, exe

StackPivotTests. exe

First Seen

7/1/2021 10:31:01

7/1/2021 10:30:12

5/23/2021 11:40: 18

5/23/2021 11:43:03

5/23/2021 11:49:07

Last Seen

7/1/2021 10:31:54

7/1/2021 10:30:12

5/23/2021 11:40: 18

5/23/2021 11:43:03

5/23/2021 11:49:07

FID

2296

10383

4208

1980

4172

[] Hide notifications for 24 hours

Expanding the arrow on the right of each event reveals more details per event including the process path

and the number of occurrences of the same blocking event:
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==ATINET

FortEDR. Protection ON

Version 5.0, 3. 206

Activity Log
Policy Process
@ Security msedge. exe

Metwark connection blocked

Count: 7
@ Security firefox.exe

@ Security DynamicCodelistenTests, exe

First Seen

7/1/2021 10:31:01

7/1/2021 10:30:12

5/23/2021 11:40: 18

Last Seen

7/1/2021 10:31:54

Path: \Device\HarddiskVolume4\Program Files (x38) \Microsoft\Edge\Application\msedge.exe

7/1/2021 10:30:12

5/23/2021 11:40:18

FID

2296

10333

4208

[] Hide notifications for 24 hours

FortiEDR icon configuration

The behavior of the FortiEDR icon in the system tray must be configured in the Administration > Settings

page.
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To configure FortiEDR icon behavior:

1. Navigate to the Administration > Settings page.
2. Inthe End Users Notifications area, configure the following settings:

~ End Users Motifications

Enable FortiClient notifications

Show system tray icon with collector status

Show notification on file read attempt

Show a pop-up message for any prevention activity

Contact your system
administrator if a
trusted application is

Maximum 250 characters

Setting Definition
Enable FortiClient Check this checkbox to display notifications sourced from FortiClient.
notifications This option is specific to FortiEndpoint deployments. See the

FortiEndpoint Administration Guide for more details.

Show system tray icon with ~ Check this checkbox to display the FortiEDR icon on each FortiEDR-

collector status protected device or leave the checkbox unchecked to hide the icon on
each protected device. Your selection here is applied on all protected
devices. The default is checked.

Show notification on file Check this checkbox to enable notifications for file read attempts.
read attempt

Show a pop-up message for Check this checkbox to enable the display of pop-up messages (end-

any prevention activity user notifications) on FortiEDR-protected devices. Pop-up messages
display whenever a process was prevented. By default, the name of
the activity of the blocked process is displayed in the pop-up
message. The default is checked.

In the text box below the checkboxes, you can customize the text that is displayed in the pop-up
message. Enter the text you want to display in the text box.

3. Click the Save button.
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Personal Data Handling

The FortiEDR system fully complies with the General Data Protection Regulation (GDPR) standard. The
GDPR is a regulation in European Union (EU) law regarding data protection and privacy for all individuals
within the EU and the European Economic Area (EEA). It also addresses the export of personal data outside
the EU and EEA areas. The goal of the GDPR is primarily to give control to citizens and residents over their
personal data and to simplify the regulatory environment for international business by unifying the
regulation within the EU.

In FortiEDR, the GDPR feature is implemented in the Personal Data Handling section of the Administration >
Settings page.

~ Personal Data Handling

Export report of monitored users m

Use this section for the following GDPR compliance purposes:

« Remove all relevant data for an employee of a company that is using the FortiEDR system or a FortiEDR
user from the FortiEDR system, once he/she no longer has access to or uses the FortiEDR system. The
data includes the employee’s/user’s device name, IP address, MAC address, and user name.

» Notify your users, should the FortiEDR system be hacked. To export the list of monitored users in the

FortiEDR system, use the Export report of monitored users button. See example report below:
. Users_reporti2 Feb 2020-14-55a% ¥ Microzoft Excel T

. ) e T T ] Zresec Ap =
- =WrapTet ~ General - - - 7 5
SiWrap Text General ﬂ ijgd Normal Bad Good Neutral e o ¥ A
| Bverenceer«| 8 < 5 » |8 28| Sondmort romet | [OOSR cxlonctry... [ nkes ce T et e roma S ova
B merge &« Center Formatting » as Table * Y L sl T URETT Qoears Fiters selects | Documen
Cipboara Font Alignment Number stytes cels diting
B1 - Fe | liorgolfaaa
A B 9 D E F G
F::RTINET liorgolf444 Report created by user Barbara on 12-Feb-2020, 14:55 Confidential
1
2 Users
[ useRNAVE
a
5
6
7

To remove employee/user data from the FortiEDR system for GDPR compliance:

1. Uninstall the Collector from the employee’s/user’s computer. This step is important, so that no further
data is collected from that Collector. For more details about uninstalling, see Uninstalling FortiEDR
Collectors on page 70.

2. Navigate to the Administration > Settings page.

3. Expand the Personal Data Handling section, specify the device name, IP address, MAC address, or user
name of the employee/user to be removed from FortiEDR.

FortiEDR 7.2.0 Administration Guide 325
Fortinet Inc.



Administration

You must remove all device name, IP address, MAC address, and user name data

NP from FortiEDR in order to fully comply with the GDPR standard. This is an iterative
S L4 . . .
q process that must be performed four times in order to remove the device name,
- IP address, MAC address, and user name of the employee/user successively,

one after another. You can remove this data in any order that you prefer. This
example starts by removing all Device name data for the employee/user.

4. In the Search by dropdown list, select Device name. This field determines which criterion to search for in
the FortiEDR system (device name, IP address, MAC address or user name).

5. Inthe adjacent field, enter the device name for the employee/user whose data you want to remove.

Username

Device name

P address
MAC address

You can copy/paste this information into the adjacent field after locating it elsewhere in the FortiEDR
user interface. For example, you can locate the relevant device name in the Last Logged column in the
Collectors list in the Inventory window, such as shown below, and then copy that value into the relevant
field in the Personal Data Handling area. Similarly, you can also readily locate the MAC address and IP
address using the Collectors list in the Inventory window.

COLLECTORS (11/12) Showing 1-15/23 | » | b1
Al M $% Create Group ove to Group Delete Enable/Disable solate Export Uninstal
COLLECTOR GROUP NAME DEVICE NAME LAST LOGGED 0s P MAC ADDRESS VERSION STATE LAST SEEN
5 .- High Security Collector Group
00
a
k (0/0)
k (0/0)
5 Accounting
(0/0)
b AVictim
(0/0)
5 Default VDI Group
(0/0)
emu
v /) Es
DESKTOP-RMROSTH-0-Test 6 None windows 7 05-50-56-BE-79-A2 3.0036 [] (DE‘:,E‘O,!;)EUM 916 days ago
DESKTOP-RMROSTH-0-Test.7  None windows 7 06-50-56-BE-79-A2 3.0036 [] (DE‘:,E‘O,!;)EUM 916 days ago
DESKTOP-RMROSTH-0-Test 8 None windows 7 07-50-56-BE-79-A2 3.0036 [] (DE‘:,E‘O,!;)EUM 916 days ago
DESKTOP-RMROSTH-0-Test 9 None windows 7 08-50-56-BE-79-A2 3.0036 [] (DE‘:,E‘O,!;)EUM 916 days ago
Tzafit-Lenovo FIEEEYEREER  windows 10 Pro 192.168.1437  F8-63-3F-AF-28-A5, 8C-..  3.1.0.407 ® Disconnected  Today

If you prefer, you can use another method of your choice to identify the device hame.

6. After entering the details for the device name, click Search to search for all occurrences of the device
name in the FortiEDR system.
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~ Personal Data Handling

Device name ¥ test * m
Export report of monitored users m

The following displays, listing all matching results.
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Activity report

The report does not contain any Activity Events, including the selected result. To
review the Activity Events that include the selected result, go to the Threat Hunting
tab and enter the query, as described in the Threat Hunting chapter of the
FortiEDR Installation and Administration Guide.

Device name contains ‘test’

1 result(s) found

WIN-10-64- (3 record) 20

(@ The number of records in the exported report, may be larger than the initial report

Close
& ! /, Threat hunting activity event data is not included in the search result but will be
9 deleted. To see the activity data that will be deleted, use the Search option of the

Threat Hunting feature, as described in Threat Hunting on page 125.

7. Select an entry in the search result list and do one of the following:
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e To verify the data or to keep a record of the data:

A
i. Click the Export (r_l ) icon to export the data to a report.
ii. When the report is ready, click the Download link to download the Excel report.

Activity report

The report does not contain any Activity Events, including the selected result. To
review the Activity Events that include the selected result, go to the Threat Hunting

tab and enter the query, as described in the Threat Hunting chapter of the
FortiEDR Installation and Administration Guide.

Device name contains ‘test’

1 result(s) found

WIN-10-64-

(3 record) Downlnadl 0

Font

a e e T —
A 0 c D € T F g H E
F::RTINET liorgolf444 Report created by user Barbara on 12-Feb-2020, 15:14 Confidential

Search value 10.51.121.109

j Personal Data

: Collector Pandal 10.51.121.109 00-0C-29-54-97-18 PANDA1\root
\‘ ! 'l

9 GDPR compliance requires that all traces of the employee’s/user’s data be
permanently removed, including this report.
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« Toremove all the data for the employee/user, click the Delete () icon.

Activity report

The report does not contain any Activity Events, including the selected result. To
review the Activity Events that include the selected result, go to the Threat Hunting
tab and enter the query, as described in the Threat Hunting chapter of the
FortiEDR Installation and Administration Guide.

Device name contains ‘test’

1 result(s) found

WIN-10-64-LATEST-UDXAQ (3 record) Download [ 1]

i. Click Delete to remove all device name data for the employee/user from FortiEDR.

Delete general.admin.tools.gdpr.records? b4

Mote that all Activity Events, that include the WIN-10-64- i record,
will be deleted. The report does not contain Activity Events. To review the
relevant Activity Events before deletion, refer to the Threat Hunting tab and
enter the query, as described in the Threat Hunting chapter of the FortiEDR
Installation and Administration Guide.

Are you sure you want to delete all data for WIN-10- ?

To avoid further data collection, uninstall the relevant Collector.

The data is deleted from FortiEDR in real time, from everywhere that it appears in the FortiEDR
system (for example, from the Inventory, Incidents tab, Audit Trail and so on).

8. Click Continue to proceed with removing the other required data for the employee/user (IP address,
MAC address and user name).
9. Repeat steps 4-8 to remove the relevant IP address from FortiEDR. Be sure to select IP Address in step
4.
10. Repeat steps 4-8 to remove the relevant MAC address from FortiEDR. Be sure to select MAC Address in
step 4.
11. Repeat steps 4-8 to remove the relevant user name data from FortiEDR. Be sure to select User Name in
step 4.
12. Delete any reports that might include data about this user as required by GDPR.
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13. If the employee/user has multiple computers on which Collectors are installed, repeat the steps above
for each of his/her computers.

loT Device Discovery

IoT device discovery enables you to continuously perform discovery to identify newly connected non-
workstation devices in the system, such as printers, cameras, media devices and so on. During the
discovery process, each relevant Collector in the system periodically probes all its nearby neighboring
devices. Most nearby devices will respond to these requests by pinging the originating Collector device and
providing information about itself, such as its device/host name (for example, ABC PC, Cameral123), IP
address and so on.

Such discovered devices can be seen in the IOT DEVICES page, as described in 0T devices on page 269.

The following default configuration applies to IoT scans by the FortiEDR Collectors:

« For operational reasons, Collectors that are running on servers or Collectors
that are reported to be in one of the following states: degraded, disabled or
isolated. Collectors do not take part in the 0T probing process.

» In order to refrain from scans on home or other non-enterprise networks, only
subnets in which there is a minimal number of Windows Collectors are scanned
in order to find Connected IoT devices.

» Extremely large subnets are excluded from scans.

If needed, in order to tune the scans to be more comprehensive and more granular,
NV contact Fortinet Support who will change the default configuration.

‘q'
-—
-

Perform ongoing device discovery ad hoc network discovery ¥
Ad hoc network discovery

Exclud

Mone v

To enable loT device discovery, check the Perform ongoing device discovery checkbox. Note that when
doing so, all relevant Collectors in the system perform sniffing in order to identify new connected devices in
the system. When performing this discovery process, FortiEDR uses only the most powerful Collectors in
each sub-network to perform sniffing, and excludes weaker Collectors for this process (disabled and
degraded Collectors). This means that FortiEDR collects all the required information in the most efficient
manner possible.

You can exclude specific Collector Groups from this discovery process. To do so, select the relevant
Collector Group(s) in the Exclude Collector Groups dropdown list.

By default and when your organization has more than a single external IP address, FortiEDR ignores the
external IP address of the loT device while identifying and matching them. You can choose to list devices

FortiEDR 7.2.0 Administration Guide 331
Fortinet Inc.


https://support.fortinet.com/

Administration

that use different external IP addresses separately by unchecking the checkbox next to the Consider
devices with different external IP(s) as separated ones option. However, in this case the same device might
be listed more than once in the loT inventory page.

The Inventory Auto Grouping option enables you to group discovered devices by device type. For example,
cameras, network devices, media devices, printers and so on. Select the Category option in the dropdown
list to group discovered devices by device type or None. When you select Category, devices are auto-
grouped in the IOT DEVICES page, as shown on |oT devices on page 269.

Click Save to save the configuration.

We recommend testing loT the device discovery process to ensure that it works as expected across all your
organizations before enabling the on-going periodic network scan. Testing can only be performed when loT
device discovery is not enabled, meaning the Perform ongoing device discovery checkbox is not checked.
Select the Collector to use to test the [oT device discovery process in the Ad Hoc Network Discovery
dropdown list and then click the Test button, as shown below.

You can search in the Ad Hoc Network Discovery dropdown list. For example,
searching for "a" results in all collectors with letter "a" in their name being displayed

Ny in the list. An exception is when the search results list includes more than 100
N entries, only exact matches will be displayed. If no exact match is found, the list will
be empty.

If searching for a single letter or a broad term does not return the expected results,
we recommend entering at least three or more specific characters in the search box
to narrow down the list and ensure the correct collectors are displayed.

Perform cngoing device discovery

windows7-64
Exclud

The selected Collector sniffs the network once to identify new connected devices. After the test discovery
process begins, you can stop it at any time by clicking the Stop button. In all cases, the scan will be stopped
within a predefined time period (usually 30 minutes).

Ad hoc netwaork discovery

windows7-64 w

[[res ]
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Windows Security Center

FortiEDR is fully integrated with Windows Security Center and has been certified by Microsoft as an anti-
virus and threat protection application. You can choose whether to register FortiEDR Collectors as anti-
virus and threat protection agents in Windows Security Center. The default is no registration. The
registration status has no impact on FortiEDR protection.

Register collectors to Windows Security Center

When multiple AV products are installed, refer to the following guidelines for configuring this option:
e To consolidate all SOC activities to FortiEDR, you must register FortiEDR Collectors with Windows
Security Center.

e To maximize protection from multiple AV products without the need of SOC activity consolidation in
FortiEDR, do not register FortiEDR Collectors with Windows Security Center as the registration may
prevent other AV products from installing or functioning properly.

To register FortiEDR Collectors with Windows Security Center:

In the Administration > Settings page, expand the Windows Security Center section and check the Register
collectors to Windows Security Center checkbox.

When registered, FortiEDR will be listed under Windows Security (as shown below) and all SOC activities will
be consolidated to FortiEDR if multiple AV products are installed.

Windows Security - [m] b4
& Security providers
Manage the apps and services that protect your device. Have a question?
e Home Get help
O Virus & threat protection O Antivirus
Help improve Windows Security
A cool protecton Fortinet Endpoint Detection and Response Give us feedback
Fortinet Endpoint Detection and Response is turned on.
P Firewall & network protection
1 App & browser control Microsoft Defender Antivirus Change your privacy settings
Microsoft Defender Antivirus is turned off, v g ) )
iew and change privacy settings
B Device securit
7 for your Windows 10 device.
P Device performance & health Privacy settings
) Firewall Privacy dashboard
B Family options Privacy Statement
Windows Firewall
Windows Firewall is tumed on,
B Web protection
No providers
Find security apps in Microsoft Store

Fortinet Inc.



Administration

Application Control Manager

Under Security Settings > Application Control on page 223, the default block state of new applications is
disabled, which means new applications are not blocked by default. To change the default block state of
new applications so that they are blocked by default, check the Enable Default application state option under
Administration > Settings > Application Control Manager.

Enable Default application state

FortiEDR Connect

The FortiEDR Connect feature opens a console that provides direct access to FortiEDR-protected devices
(endpoints) that are running a Windows operating system through a remote Shell connection, as described
in FortiEDR Connect on page 109. This enables you to respond to incidents immediately and to perform in-
depth investigation by running commands on the device, running scripts on the device, collecting and
downloading forensic data from the device, remediating threats and so on.

Select the Allow FortiEDR connect - remote shell connection checkbox to enable the FortiEDR Connect
functionality for the organization. Otherwise, the Connect to Device button is deactivated for all users of the
organization.

Allow FortiEDR connect - remote shell connection

To further allow a user access to the FortiEDR Connect functionality, select the Establish FortiEDR Connect
sessions checkbox in the user profile. Otherwise, the Connect to Device button is deactivated for the user.
For more information about user roles and permissions, see Users on page 277.

Ay
‘?' The Establish FortiEDR Connect sessions checkbox is available for Admin, Analyst,
|| and Senior Analyst users only.
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Reputation Service

This section displays a list of GCP regions where a reputation service instance is installed on and the
relevant URLs of all selected regions. You can select any region you want to connect to. By default, all
regions are selected. When a region is selected, the relevant reputation service URLs are displayed so that
you can open them in your firewall.

~ Reputation Service

GCP regicns

asia-northeast1, europe-westl, +13 w

URL
reputation-asia-02.fortiedr.com:443
reputation-eu-02 fortiedr.com:443
reputation-eu-05.fortiedr.com:443
reputation-na-01.fortiedr.com:443
reputation-us-04.fortiedr.com:443
reputation-sa-03.fortiedr.com:443
reputation-us-03.fortiedr.com:443

reputation-eu-03.fortiedr.com:443

-~ e ' e

System events

Selecting SYSTEM EVENTS in the ADMINISTRATION tab displays all the system events relevant to the
FortiEDR system.
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System Events

Alltypes ~ Last 30 days - Q
55 results

Component Name Component Type State Date

b1 Aggregator Aggregator | -b-1] state was changed to "Running" 2025 02:57:44

b1 Aggregator Aggregator -b-1] state was changed to "Diseonnected 2025 02:56:42

b1 Aggregator Aggregator -b-1] state was changed to "Running 2025 07:16:34

b1 Aggregator Aggregator | -b-1] state was changed to "Disconnected 2025 07:15:42

b1 Aggregator Aggregator -b-1] state was changed to "Running 2025 07:05:44

b1 Aggregator Aggregator | -b-1] state was changed to "Disconnected 2025 07:04:42

b1 Aggregator Aggregator -b-1] state 0 "Running 2025 07:01:11

b1 Aggregator Aggregator -b-1] state was 0 "Disconnected 2025 06:58:46

b1 Aggregator Aggregator -b-1] state ged to "Running 2025 01:14:10

b1 Aggregator Aggregator|....... -... -c...- ......-b-1] state was changed to "Disconnected 2025 01:13:07

DESKTOP- Collector Collector ¢ 3] state was changed 1o "Degraded" . Wamings: The Collector driver could not properiy load. Please contact supp. 2025 04:02:56

PC Collector Collector [ *-PC] state was changed to "Running 2025 03:37:56

Use the search bar on the top right corner to filter system events by keywords.
Q

Use the following filters to filter system events by component with a date range.

All types w Last 30 days v
& ! /, System events can also be retrieved using an APl command. For more details, refer
9 to the FortiEDR RESTful APl Guide. You must log in to the Fortinet Developer
- Network to access the guide.

Each time a system event is triggered and created, the user receives an email notification for each of them
if that system event is enabled for the user’s Distribution lists on page 307. You can also configure Syslog
on page 310 to send system events messages.

The following events are defined as system events in the system:

» Core state was changed to Disconnected (and another event when the Core state was returned to the
Connected state immediately afterward)

« Core state was changed to Degraded (and another event when the Core state was returned to THE
Connected state immediately afterward)

» Aggregator state was changed to Disconnected (and another event when the Aggregator state was
returned to the Connected state immediately afterward)

» Aggregator state was changed to Degraded (and another event when the Aggregator state was
returned to the Connected state immediately afterward)

» Threat Hunting Repository state was changed to Disconnected (and another event when the Repository
state was returned to the Connected state immediately afterward).
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» Threat Hunting Repository state was changed to Degraded (and another event when the Repository
state was returned to the Connected state immediately afterward).

e Collector registered for the first time (only UI/API; is not sent by email/Syslog)
« Collector was uninstalled via the Central Manager console

» Collector state was changed to Disconnected Expired

e Collector state was changed to Degraded

YL
‘?' This event is disabled by default. To enable it, please contact Fortinet support to
|| apply a configuration change on the backend.

» License will expire in 21/7 days/1 day

e License expired

» License capacity of workstations has reached 90/95/100%

» License capacity of servers has reached 90/95/100%

« System mode was changed from Prevention to Simulation or vice versa
« FortiEDR Cloud Service (FCS) connectivity is down

IP sets

IP Sets enable you to define a set(s) of IPs to include or exclude for some security events. This feature is
used when defining exceptions.

Ay
S L4
? This page is only available to users with Admin, IT, or Senior Analyst permissions.

IP SETS
% Define new 1P set

Internal Destinations FERTINET
Exclusions Demo

test_einat
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IP Sets can only be defined if all Collectors are V3.0.0.0 and up. If you attempt to
define an exception and all Collectors are not V3.0.0.0 or above, the following error
message displays:

ERROR

Ay . i .
Using IP Sets in exceptions is not supported since there are stil

\ql
— Windows Collectors with version older than 3.0.0.0. Please up
your environment.

Each row in the IP Sets window represents an IP inclusion/exclusion definition. The Internal Destinations row
is provided by default (as indicated by the adjacent FortiEDR logo), which defines the default IPs that are
included in and excluded from the FortiEDR system. All organizations in a multi-organization system are
provided with this default IP set. In a single-organization system, the main organization is provided with it.
The Internal Destinations IP set cannot be deleted. However, an Administrator can add Included IPs or
Excluded IPs to it.

The IP Sets page lists all the IP sets. Users can only edit an IP set that was specifically created for his/her
organization. For example, if the administrator is assigned to only organization A, he/she can edit an IP set
create for organization A but not an IP set that applies to all organizations.

Click the FEZRTIMET logo in the Internal Destinations row to view its definition, as shown below:

IP SETS
&% Define new IP set Search IP

N FRTInET ncluded Ps  + Excluded IPs
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To define an IP set:

1.

6.

at : . R
Click the Define new IP set button (s Define new 1P set) pytton. The following window displays:
IP SETS

& Define new IP set

f— Included IPs  + Excluded IPs  +

D Internal Destinations FEATINET
> DB Net

P Microsoft Cloud

In the Set Name field, enter a name for the IP set.

In the Organization dropdown list, select the organization to which the IP set applies or select All
organizations for the IP set to apply to all organizations in the FortiEDR system.

In the Description field, enter a description for the IP set.

In the Included IPs area, click the Add button (¥) to add an IP, IP range, or IP mask to be included in the
IP set’s definition. Each click of the Add button () adds a new line to the list. Each entry appears in its
own line. For example, you could add 192.168.23.2, 192.168.23.1-192.168.232 or 192.168.0.0/16.
Similarly, in the Excluded IPs area, click the Add button (#) to add an IP, IP range, or IP mask that is to
be excluded.

Click the Save button.

The Search IP field at the top-right of the page enables you to search for a specific IP in all of the IP sets
defined. The search option identifies matching IPs, even if they are part of a range in an IP set’s definition.

To use an IP set:

Select an IP set in the Destinations area when defining an exception.

Connectors

Connectors enable you to configure connectors to external systems, which enables you to trigger
predefined types of actions. FortiEDR provides various connectors out-of-the-box, such as Firewalls and
NAC systems. The out-of-the-box FortiEDR connectors utilize Fortinet products’ APIs to automatically
perform the required actions in order to extend its automatic Playbook actions.

Admin and IT users with custom script permission can also define customized connectors to any third-party
system in order to trigger any action on that system using an API. For more information about user roles and
permissions, see Users on page 277.

You can set up an unlimited number of connectors for each type and use them by associating Playbook
policies or Security policies to the actions defined for these integration connectors, as described below.
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Ay
‘Q' The Connectors menu is only available when the environment is connected to
| Fortinet Cloud Services (FCS).

To display the Connectors page:

1. Select Administration > Connectors.

Connectors
All connector types  ~ + Add Connector v E@B Action Manager

8 results
Name State Connector type Action
;'"‘ Firewall: FGT (® Enabled Response Block address on Firewall
E'"‘ Firewall: qqqq (® Enabled Response Block address on Firewall
@ Sandbox: SBT @® Enabled Response Send file for analysis
:-I—;E} () Disabled Detection
E Identity Management: FortiClient-EMS-Cloud ® Enabled Response ZeroTrust device tagging
E Identity Management: FortiClient-EMS On-Prem (® Enabled Response ZeroTrust device tagging
;'"‘ Firewall: FortiGate 100F (® Enabled Response Block address on Firewall
:-I_—'E} Threat Intelligence Feed:* (@ Enabled Detection Fetch Feed

The top left of this page provides two buttons, as shown below:

+ Add Connector v @ Action Manager

e Adding connectors on page 340 enables you to add and configure connectors for integration with
FortiEDR.

« Action Manager on page 393 enables you to upload and manage (add, modify and delete) actions
(Python scripts that call third-party system APIs) to be automatically triggered by FortiEDR as
incident responses. Python 2.7 or later is supported.

permissions and have the Custom script option enabled. For more information

\‘é’, The Action Manager button is only available to users with Admin or IT
3 about user roles and permissions, see Users on page 277.

Adding connectors

The following types of integration connectors are provided to be configured:

« Firewall integration on page 341
» Network Access Control (NAC) integration on page 350
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e Sandbox integration on page 356
» eXtended detection source integration on page 358
e Custom integration on page 370

s‘é’, Custom integration is only available to users with Admin or IT permissions and

have the Custom script option enabled. For more information about user roles
and permissions, see Users on page 277.

« |dentity Management integration on page 376
» User Access integration on page 384
« Threat Intelligence Feed integration on page 391

You can enable or disable a connector by clicking the Enabled/Disabled button next to the connector name.
This button toggles between Enabled/Disabled.

Connectors
All connector types + Add Connector ~ 81 Action Manager

8 results
Name State Connector type Action
= _
= Firewall: FGT-2020 (® Enabled Response Block address on Firewall
=l
-y _
'.@ Firewall: qqqq (® Enabled Response Block address on Firewall
m!

Firewall integration

When a firewall connector is set and Playbook policies are configured, automatic incident response actions
can include blocking of malicious IP addresses by a firewall upon security event triggering.

For more details about integrating FortiEDR with FortiGate or FortiManager, refer to the FortiGate
Integration Guide or FortiManager Integration Guide.

Before you start firewall configuration, make sure that:

e Your FortiEDR deployment includes a Jumpbox that has connectivity to the firewall. Details about how
to install a FortiEDR Core and configure it as a Jumpbox are described in Setting up the FortiEDR Core
on page 511. You may refer to Cores on page 403 for more information about configuring a Jumpbox.

» The FortiEDR Central Manager has connectivity to the Fortinet Cloud Services (FCS).

e You have a valid APl user with access to the external firewall. See the FortiGate Integration Guide or
FortiManager Integration Guide for detailed instructions.

Follow the steps below to automatically deny access on the firewall to malicious destination addresses
detected by FortiEDR.

The example below describes how to define an address group on FortiGate and associate it with a FortiGate
policy rule, such that it blocks connections to the addresses in the group. The address group is then used
when configuring the FortiEDR connector so that it is automatically populated with malicious destinations
upon detection by FortiEDR.
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The same address group can obviously be used for multiple firewall policies in order to cover any VLAN-to-

WAN interface in the network.

FortiGate configuration

To set up an address group and policy on FortiGate:

1. Go to Policy & Objects > Addresses.

2. Create a new address group to be populated by FortiEDR. The new address group now appears in the

FortiGate Addresses table.

&"= FortiGate VM64-GCP  FGYMO

Favorites > Edit Address Group
@ Dashboard b
. Group Name FortiEDR Malicious Destinations
NX Security Fabric >
Color = | Ch
I Fortiview > = anee
Members & none x
o Network b +
£ System * Exclude Members e ]
I &, Policy & Objects ¥ Showin Address List [ o]
1Pv4 Policy Static Route Configuration
Authentication Rules Comments Members of this group will be
IPv4 Do Policy automatically added by FortiEDR | s10ss
Addresses rd

Wildcard FQDN Addresses

Internat Service Natahase

3. Goto Policy & Objects > IPv4 Policy.

4. Create a new policy to deny traffic to any address in the address group that was created as part of step

2. The new policy now appears in the FortiGate Policies table.
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MNew Policy
Name €@ Block malicious by FortiEDR
Incoming Interface 21 SSLVPN tunnel interface (ssl.root «
Qutgoing Interface [ port1 hd
Source B al ®
& SSLVPN x
+
Destination T3 FortiEDR Malicious Destinations %
+
Schedule 0o always -
Service I ALL ®
+
Action v ACCEPT ~EalaN\g
@Log\a’iolatl’on Traffic
Comments | This policy blocks trafficto

malicious destinations that were

auto-detected by FortiEDR | sBroz3

Enable this policy €@

FortiEDR firewall connector configuration

To set up a Firewall connector with FortiEDR:

1. Click the Add Connector button and select Firewall in the Connectors dropdown list. The following
displays:

Name State Connector type Action

5?')‘ Firewall @ Enabled Response Block address on Firewall

Actions

Jumpbox
Block address on Firewall £3

® No Jumpboxis selected.

Name * Type

Host* 443 x

(@ APIKey Credentials

APIKey* Cancel

2. Fillin the following fields:

Field Definition

Jumpbox Select the FortiEDR Jumpbox to communicate with the firewall.
Name Specify a name of your choice to be used to identify this firewall.
Type Select the type of firewall to be used in the dropdown list.
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Field Definition

Type

CheckPoint

Cisco

FortiGate

FortiManager

PaloAlto

Host Specify the IP or DNS address of your firewall.
Port Specify the port that is used for APl communication with your firewall.

APl Key / Credentials Specify authentication details of your firewall. To use an API token,
click the API Key radio button and copy the token value into the text
box. To use API credentials, click the Credentials radio button and
enter the Firewall APl username and password.

3. Inthe Actions area on the right, define an action to be taken by this connector.

You have the option to either use an action provided out-of-the-box with FortiEDR (for example, Block

address on Firewall) or to create and use your own custom actions.

a. To block an address on the Firewall, in the Address Group field, specify the name of a previously
defined address group on the firewall. For FortiManager and FortiGate integrations, you can
optionally specify the name of the VDOM domain in the VDOM field. FortiEDR uses the default root
VDOM if the VDOM field is empty.

- OR -

b. Totrigger a custom action on the Firewall, click the Add Action button to display the following

popup window:
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ADD CUSTOM ACTION

Action -

AD Logout user

He-profile a device

( Cancel )

* In the Action dropdown menu, select one of the previously defined custom integration actions
(which were defined in FortiEDR as described in Custom integration on page 370).
-OR-

Click the Create New Action button in this popup window to define a new action on the
Firewall to be triggered according to the definitions in the Playbook, as described below. The
following displays:
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Action Manager

New action +

MName

MNew action *

Description

mnmnmnmnim x

Action Scripts (7)

Drag & Drop or browse

a unicodify.py é (H]
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Fill out the fields of this window as follows in order to define a new action to be triggered in
response to an incident.

In order to trigger this action, a Playbook policy must be defined that
triggers this action to execute the script when a security event is
) ! ’, triggered. The definition of this new action here automatically adds this
9 action as an option in a Playbook policy. This action however, is not
- selected by default in the Playbook policy. Therefore, you must go to the
Playbook policy and select it in order for it to be triggered when a security
event is triggered.

Field Definition

Name Enter any name for this action.
Description Enter a description of this action.
Upload Upload a Python script that calls an APl in the third-party

system in order to perform the relevant action. Python 2.7 or
later is supported. This Python script must be created
according to the coding conventions that can be displayed by

clicking the icon next to the Action Scripts field. The
following displays providing an explanation of these coding
conventions and provides various links that you can click to see
more detail and or/to download sample files.
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Field Definition

Creating a Custom Incident Response Action X

The following describes how to create and upload your own Python script to be assigned to
an incident response action. Playbook policies that are configured to use this action will
automatically execute this script when a security event is triggered.

Code Conventions

« A FortiEDR Jumpbox on which one or more scripts are executed is deployed with
various standard Python packages.

Alist of the packages that are deployed with this type of FortiEDR
Jumpbox.

» At the moment, only Python 2 is supported.

« Parameters
o Integration scripts can use properties that are part of a Connector’s
configuration, such as API keys or information that is part of the triggering
event (such as the process name).

o These properties are stored in the config.json file and can be used as script
parameters.

o Click here to see a sample config.json file and a sample action script:
4, custom_script.py &, config.json

Troubleshooting

Script execution (either in test mode or as part of a realtime incident response) is defined
as successful if the script exits with code 0. Any other exit code will be reported as a
failure. Each script can also be manually invoked using the Test button. A test execution will
get the sample parameter file (which is available for download above) with an added JSON
section — "TestMode": true. The stderr and stdout Script output will be available after the
test completes or when script execution fails (with an error icon next to the action name).

Close

4. Click Save. The new action is then listed in the Actions area.
5. You can click the Test button next to an action to execute that action.

NP If you are working with a FortiManager in order to manage firewalls, use the same
‘9' instructions to integrate with the firewall, but select FortiManager as the integrated
- device Type when configuring the FortiEDR Connector in the Administration >
- Integration page.

Playbooks configuration

To configure an automated incident response that uses a firewall connector to
block malicious destinations upon security event triggering:

1. Navigate to the SECURITY SETTINGS > Playbooks page.

2. Open the Playbook policy that is applied on devices for which you want the block IP incident response
to apply and place a checkmark in the relevant Classification column next to the Block address on
Firewall row that is under the REMEDIATION section. In the dropdown menu next to the action, you can
specify which firewalls to use to perform the block or select all of them, as shown below:
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FortiEDR is now configured to add malicious IP addresses to the blocking policy on the firewall upon

triggering of a security event. You can check that malicious IP addresses are added to the address
group that was configured on the firewall following FortiEDR security events.

To configure an automated incident response that uses a firewall connector to
perform a custom action upon the triggering of a security event:

1. Navigate to the SECURITY SETTINGS > Playbooks page.

2. Open the Playbook policy that is applied on devices for which you want the custom action (defined
above) to apply.

3. Inthe CUSTOM section, place a checkmark in the relevant Classification columns next to the row of the
relevant custom action.

4. Inthe dropdown menu next to the relevant custom action, select the relevant firewall connector with
which to perform the action, as shown below:

CUSTOM

Re-profile a device - v 4 B4 v

AWS Lambda Logout User SelectAll v v v

Disable interface « fortinac.fortideme.com

Slack Notification fortigate fortide: - ., ,, ,, v v

FortiEDR is now configured to trigger this action in the third-party system upon the triggering of a
security event.

Automatic incident response actions are listed in the Overview tab when you select the incident and click
Investigate in the Incidents pane, as shown below:

Incidents > —_— Full Screen 3 New Tab
1D tatus Organiz: Assi to st Seen ast Seen
PUP
Unhandled N/A
Overview Event Analysis
[ Handle Incident

Activity Audit Devices involved (1) Processes involved (1

FortinetCloudServices Response

PUP

FortinetCloudServices

Violated Policies

FortinetCloudServices Response () Execution Prevention

Malicious File Detected

Fortinet

FortinetCloudservices Response
ATTECK
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Network Access Control (NAC) integration

When a Network Access Control connector such as FortiNAC is set and Playbook policies are configured,
automatic incident response actions can include isolating a device by a NAC system upon security event
triggering.

Before you start NAC configuration, make sure that:

e Your FortiEDR deployment includes a Jumpbox that has connectivity to the NAC server.
Details about how to install a FortiEDR Core and configure it as a Jumpbox are described in Setting up
the FortiEDR Core on page 511. You may refer to Cores on page 403 for more information about
configuring a Jumpbox.

» The FortiEDR Central Manager has connectivity to the Fortinet Cloud Services (FCS).

* You have a valid APl user with access to FortiNAC or equivalent network access control system.
Follow the steps below in order to automatically isolate a device by NAC upon the detection of a FortiEDR

security event. The example below describes how to define an APl user on FortiNAC in order to enable
FortiEDR to perform automatic device isolation after a FortiEDR security event.

NP Make sure to add FortiEDR domains and/or IP addresses to the exclusion list on the
‘Q' VLAN that is being used for isolation on the FortiNAC system such that the FortiEDR
- Collector would still be able to communicate with its servers when the device is

being isolated.

FortiEDR Connector configuration

To configure NAC integration:

1. Click the Add Connector button and select NAC in the Connectors dropdown list. The following displays:

Connectors

All connector types + Add Connector v 3 Action Manager

8 results
Name state Connector type Action

@ NAC: @ Enabled Response Isolate device on NAC

Actions
Jumpbox

Isolate device on NAC &3
@ No Jumpbox is selected.

Name* Type

Host* 443 X

@® APikey Credentials

APIKey* Gancel

2. Fillin the following fields:

Field Definition

Jumpbox Select the FortiEDR Jumpbox that will communicate with this NAC
system.

FortiEDR 7.2.0 Administration Guide 350
Fortinet Inc.



Administration

Field Definition

Name Specify a name of your choice which will be used to identify this NAC
system.

Type Select the type of NAC to be used in the dropdown list, for example:
FortiNAC.

Host Specify the IP or DNS address of the external NAC system.

Port Specify the port that is used for communication with the external NAC
system.

APl Key Specify authentication details of the external NAC system. To use an

API token, click the API Key radio button and copy the token value into
the text box. To use API credentials, click the Credentials radio button
and fill in the external NAC system APl username and password.

3. 3Inthe Actions area on the right, define the action to be taken by this connector.

You have the option to either use an action provided out-of-the-box with FortiEDR (for example, Isolate
Device on NAC)

— OR —

To create or select one of the Custom Integration actions (if one or more have already been defined in
FortiEDR, as described in Custom integration on page 370.

e To trigger an action on a custom connected third-party system, click the + Add Action button to
display the following popup window:

ADD CUSTOM ACTION

Action -

AD Logout user

Re-profile a device

( cancel )

a. Inthe Action dropdown menu, select one of the previously defined actions (which were defined in
FortiEDR as described in Custom integration on page 370).
-OR -

b. Click the Create New Action button in this popup window to define a new action that can be
triggered according to the definitions in the Playbook, as described below. The following displays:
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FortiEDR 7
Fortinet In

.2.0 Administration Guide
C.

Action Manager

New action

MName

MNew action

Description

mnmnmnmnim

Action Scripts (7)

a unicodify.py

Drag & Drop or browse

Cancel
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Fill out the fields of this window as follows in order to define a new action to be triggered in
response to an incident.

In order to trigger this action, a Playbook policy must be defined that triggers

NP this action to execute the script when a security event is triggered. The
‘Q' definition of this new action here automatically adds this action as an option
- in a Playbook policy. This action however, is not selected by default in the

Playbook policy. Therefore, you must go to the Playbook policy and select it
in order for it to be triggered when a security event is triggered.

Field Definition

Name Enter any name for this action
Description Enter a description of this action
Upload Upload a Python script that calls an API from the third-party

system in order to perform the relevant action. Python 2.7 or later
is supported. This Python script must be created according to the
coding conventions that can be displayed by clicking the icon

next to the Action Scripts field. The following displays providing an
explanation of these coding conventions and provides various links
that you can click to see more detail and/or to download sample
files.
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Creating a Custom Incident Response Action X

The following describes how to create and upload your own Python script to be assigned to
an incident response action. Playbook policies that are configured to use this action will
automatically execute this script when a security event is triggered.

Code Conventions

= A FortiEDR Jumpbox on which one or more scripts are executed is deployed with
various standard Python packages.

5 A list of the packages that are deployed with this type of FortiEDR
Jumpbox.

= At the moment, only Python 2 is supported.

= Parameters
o Integration scripts can use properties that are part of a Connector’s
configuration, such as API keys or information that is part of the triggering
event (such as the process name).

= These properties are stored in the config.json file and can be used as script
parameters.

= Click here to see a sample config.json file and a sample action script:
&, custom_script.py &, config.json

Troubleshooting

Script execution (either in test mode or as part of a realtime incident response) is defined
as successful if the script exits with code 0. Any other exit code will be reported as a
failure. Each script can also be manually invoked using the Test button. A test execution will
get the sample parameter file (which is available for download above) with an added JSON
section — "TestMode": true. The stderr and stdout Script output will be available after the
test completes or when script execution fails (with an error icon next to the action name).

Close

4. Click Save. The new action is then listed in the Actions area.
5. You can click the Test button next to an action to execute that action.
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Playbooks configuration

To configure an automated incident response that uses a NAC connector to isolate
a device upon security event triggering:

1. Navigate to the SECURITY SETTINGS > Playbooks page.

2. Open the Playbook policy that is applied on devices for which you want the isolation response to apply
and place a checkmark in the relevant Classification column next to the Isolate device with NAC row
that is under the INVESTIGATION section.

INVESTIGATION
Isolate device with Collector v
Isolate device with NAC Nac_HK v e

Move device to the High Security Group

FortiEDR is now configured to automatically isolate the device upon triggering of a security event.
Automatic incident response actions are listed in the Overview tab when you select the incident and click
Investigate in the Incidents pane, as shown below:

Incidents - - Full Screen [ NewTab
D Status Organization Assigned o First Seen ast Seen
PUP
Unhandled N/A
Overview Event Analysis
[P Handle Incident

Activity Audit Devices involved (1) Processes involved (1)

FortinetCloudservices Response

PUP

FortinetCloudServices

Violated Policies
FortinetCloudServices Response ) Execution Prevention
Malicious File Detected

Fortinet

FortinetCloudServices Response
ATTRCK

Note that isolation by NAC will only be done for devices that are managed on the specified NAC.

To configure an automated incident response that uses a NAC connector to
perform a custom action upon the triggering of a security event:

1. Navigate to the SECURITY SETTINGS > Playbooks page.

2. Open the Playbook policy that is applied on devices for which you want the custom action (defined
above) to apply.

3. Inthe CUSTOM section, place a checkmark in the relevant Classification columns next to the row of the
relevant custom action.

4. Inthe dropdown menu next to the relevant custom action, select the relevant NAC connector with
which to perform the action, as shown below:
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cusTOoMm

Re-profile a device - £ £ v v

AWS Lambda Logout User Select All v v v

Disable interface « fortinac fortideme.com

Slack Notification fortigate. fortide - 3 3 3 3 v

FortiEDR is now configured to trigger this action in the third-party system upon the triggering of a
security event. This automatic incident response action appears in theOverview tab when you select
the incident and click Investigate.

Incidents Full Screen [3 New Tab

P Unhandled N/A

Overview Event Analysis

iR
a

FortinetCloudServices Re:

PUP

FortinetCloudServices

FortinetCloudServices Re: Execution Preven tion

Malicious File Detected

FortinetCloudServices Re:

Sandbox integration

When a sandbox such as FortiSandbox is configured and the Sandbox Analysis Policy rule is enabled, files
that meet several conditions and that have not been previously analyzed trigger a sandbox analysis event
on FortiEDR and are sent to the sandbox. The conditions are a combination of several items, such as the file
was downloaded from the Internet and was not signed by a known vendor. If the file is found to be clean,
the event is automatically classified as safe and marked as handled. If the file is determined by the sandbox
to be suspicious or malicious, then the event is classified as non-safe and any future execution attempt of
the file in the environment is blocked by one of the Pre-execution (NGAV) Policy rules. Note that in all cases
the first file execution is not delayed or blocked.

For more details about integrating FortiEDR with FortiSandbox, refer to the FortiSandbox Integration Guide.
Before you start sandbox configuration, make sure that:

e Your FortiEDR deployment includes a Jumpbox that has connectivity to the sandbox.

» Refer to Setting up the FortiEDR Core on page 511 for details about how to install a FortiEDR Core
and configure it as a Jumpbox.

» Refer to Cores on page 403 for more information about configuring a Jumpbox.
» The FortiEDR Central Manager has connectivity to Fortinet Cloud Services (FCS).

» (FortiSandbox) A FortiSandbox administrator account with JSON APl access enabled. Refer to the
FortiSandbox Integration Guide for detailed instructions.
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» (FortiSandbox Cloud) A valid FortiCloud APl user under a permission profile with read/write access to
the FortiSandbox Cloud portal. See the FortiCloud IAM documentation for detailed instructions about
creating a permission profile and an APl user.

To set up a sandbox connector with FortiEDR:

1. Click the Add Connector button and select Sandbox in the Connectors dropdown list. The following

displays:

Connectors

All connector types + Add Connector v

8 results

Name =T

lﬁ Sandbox

Jumpbox

® No Jumpbox is selected

Name* Type

63 Action Manager

state Connector type Action

@® Enabled Send file for analysis

Actions

Send file for analysis &

Host* 443

Credentials

@® APikey

APIKey *

2. Fillin the following fields:

Cancel

Field Definition

Jumpbox

Name

Type

Host

Port

API Key / Credentials

3. Click Save.

Select the FortiEDR Jumpbox that will communicate with this sandbox.

Specify a name of your choice which will be used to identify this
sandbox.

Select the type of sandbox to be used in the dropdown list, for
example: FortiSandbox.

Specify the IP or DNS address of you sandbox.

Specify the port that is used for APl communication with your
sandbox.

Specify authentication details of the FortiSandbox or FortiSandbox
Cloud.
* (FortiSandbox) To use an API token, select API Key and copy the
token value into the text box. To use credentials, select
Credentials and fill in the FortiSandbox username and password.

* (FortiSandbox Cloud) Select AP/ Key and copy the token value
into the text box.

In order to complete sandbox integration, the Sandbox Scan rule must be enabled with the FortiEDR

Central Manager.
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To enable the Sandbox scan rule:

1.
2.

Navigate to the SECURITY SETTINGS > Security Policies page.

Open the Execution Prevention policy that is applied on devices for which you want the sandbox scan
to apply and click the Disabled button next to the Sandbox Analysis rule to enable it, as shown below:

DASHBOARD EVENT VIEWER @ COMMUNICATION CONTROL v (k) SECURITY SETTINGS v INVENTORY W e ADMINISTRATION @ER)

SECURITY POLICIES Showing 1-10/23 | »||#1 I Search *Q

POLICY NAME RULE NAME ACTION STATE
4 ' Execution Prevention FoATNET ()
Malicious File Detected @ Block ® Enabled
Privilege Escalation Exploit Detected - A malicious escalation of privileges was detected @ Block @ Enabled
QQ ot
Stack Pivot - Stack Pointer is Out of Bounds @ Block @ Enabled
Suspicious Driver Load - Attempt to load a suspicious driver Block ® Enabled
suspicious File Detected @ Block @® Enabled
Suspicious Script Execution - A script was executed in a suspicious context Block ® Enabled

FortiEDR is now configured to send unknown files to the sandbox.

You can check file analysis on your sandbox console.

In addition, you can see sandbox analysis events in theOverview tab when you select the incident and click
Investigate in the Incidents pane. Events of files that were found to be clean appear under the Handled filter
and events of files that were found to be risky are displayed under the All statuses filter. A sandbox analysis
digest is added to the security event’s handling comment.

eXtended detection source integration

You can connect to external systems to collect activity log by adding a new connector for extended
detection. The aggregated data is then being sent to Fortinet Cloud Services (FCS) where it is correlated
and analyzed to detect malicious indications that will result in security events of eXtended Detection policy
rule violations.

FortiEDR supports extended detection with the following external systems:

FortiAnalyzer or FortiAnalyzer Cloud on page 358

FortiSIEM or FortiSIEM Cloud

Google Cloud Security Command Center (SCC) on page 361
AWS GuardDuty on page 364

Custom on page 367

FortiAnalyzer or FortiAnalyzer Cloud

You can integrate FortiEDR with FortiAnalyzer or FortiAnalyzer Cloud to correlate data between FortiEDR
and the Fortinet Security Fabric and issue eXtended detection alerts. To complete the integration, you must

FortiEDR 7.2.0 Administration Guide 358
Fortinet Inc.



Administration

configure an eXtended detection source connector for FortiAnalyzer or FortiAnalyzer Cloud and enable the

eXtended detection rules and FortiEDR Threat Hunting events collection.

Prerequisites

Before you start integrating FortiEDR with FortiAnalyzer or FortiAnalyzer Cloud, verify you have the
following:

» A valid license for eXtended Detection Response—While you can create an eXtended detection source
connector without a valid license for eXtended Detection Response, the license is required for a
successful XDR definition.

¢ A Jumpbox with connectivity to FortiAnalyzer:

» Refer to Setting up the FortiEDR Core on page 511 for details about how to install a FortiEDR Core
and configure it as a Jumpbox.

» Refer to Cores on page 403 for more information about configuring a Jumpbox.
e Connectivity from the FortiEDR Central Manager to the Fortinet Cloud Services (FCS).

» (FortiAnalyzer) A FortiAnalyzer administrator account with JSON APl access enabled. Refer to the
FortiAnalyzer Administration Guide for more information.

« (FortiAnalyzer Cloud) A valid FortiCloud APl user under a permission profile with read/write access to
the FortiAnalyzer Cloud portal. See the FortiCloud IAM documentation for detailed instructions about
creating a permission profile and an APl user.

Setting up a connector for FortiAnalyzer or FortiAnalyzer Cloud

1. Click the Add Connector button and select eXtended Detection Source in the Connectors dropdown list.
The following displays:

CONNECTORS
@ AddConnecior ¥ ifp Action Manager
v :{g eXtended Detection Source @© Enabled

Jumpbox
Details

) APIKey Credentials

2. Fillin the following fields:

Field Definition

Enabled Check this checkbox to enable blocking of malicious IP
addresses by the FortiAnalyzer or FortiAnalyzer Cloud.

Jumpbox Select the FortiEDR Jumpbox that will communicate with the
FortiAnalyzer or FortiAnalyzer Cloud.

Name Specify a name of your choice to identify the connector.

Type Select FortiAnalyzer.
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Field Definition

Host Specify the IP or DNS address of the FortiAnalyzer or
FortiAnalyzer Cloud.

Port Specify the port that is used for APl communication with the
FortiAnalyzer or FortiAnalyzer Cloud.

API Specify authentication details of the FortiAnalyzer or
Key/Credentials/Authentication FortiAnalyzer Cloud.
» (FortiAnalyzer) Select Credentials and fill in the
FortiAnalyzer username and password.
» (FortiAnalyzer Cloud) Specify the username and password
of the FortiCloud APl user with read/write access to the
FortiAnalyzer Cloud portal.

Actions Configure the FortiGate and VDOM logs to be correlated with
FortiEDR data by specifying the FortiGate or VDOM name in the
following fields. If both fields are empty, FortiEDR uses the
default value, which is All.

Actions

Get Security Alerts fro... filtered by

+ Add another FortiGate

3. Click Save.

Setting up FortiEDR Central Manager

In order to complete the integration with FortiAnalyzer or FortiAnalyzer Cloud, the eXtended detection rules
and FortiEDR Threat Hunting events collection must be enabled with the FortiEDR Central Manager, as
follows.

To enable eXtended detection rules:

1. Navigate to the SECURITY SETTINGS > Security Policies page.

2. Open the eXtended detection policy that is applied on devices on which you want the eXtended
detection policy to apply and click the Disabled button next to each of the underlying rules to enable it,
as shown below:
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DASHBOARD EVENT VIEWER @ COMMUNICATION CONTROL v (23] SECURITY SETTINGS Vv INVENTORY ™ a ADMINISTRATION]

SECURITY POLICIES showing 1-10/40 | »|[wm] | search “Q
v A POLICY NAME RULE NAME ACTION STATE
4 ' Execution Prevention FORMNET (I
4 My Exfiltration Prevention FEATINET (0
4 E Ransomware Prevention  F&RTINET (TR
4 & Device Control FoRNNEr (@)
- ‘#’ extended Detection FUATINET (@)
Suspicious activity Detected (® Enabled
Suspicious authentication activity Detected @® Enabled
Suspicious email activity Detected @ Enabled
@ Enabled

Suspicious network activity Detected

To enable FortiEDR Threat Hunting events collection:

1. Navigate to the SECURITY SETTINGS > Threat Hunting > Collection Profiles page.
2. Open the Threat Hunting collection profile that is applied on devices on which you want the eXtended
detection policy to apply.
3. Select the following event types on that profile:
» Socket Connect
* Process Creation
e File Create
» File Detected

Event Collection And Storage
Collect and store Activity Events of the following categories and Types

Inventory (9 Enabled

| File Detected

Process  (2) Enabled

Screen Capture Process Termination ~| Process Creation Process Start Thread Created Executable Loaded Driver Loaded

Library Loaded Keystroke Consumption
File

Network () Enabled

HTTP Request Socket Network Statistics v Socket Connect DNS Query Socket Listen Socket Close Socket Accept

FortiEDR is now configured to issue eXtended detection alerts from FortiAnalyzer or FortiAnalyzer Cloud.

Google Cloud Security Command Center (SCC)

To integrate FortiEDR with Google Cloud Security Command Center (SCC) to collect activity log and issue
eXtended detection alerts, you must configure Google SCC for threat logging and APl access, configure an
eXtended detection source connector with Google Cloud SCC in FortiEDR, and enable the eXtended
detection rules and FortiEDR Threat Hunting events collection in FortiEDR.
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Prerequisites

Before you start integrating FortiEDR with Google SCC, verify you have the following:
* Google Cloud licensing of Security Command Center Premium tier that has Event Threat Detection
feature.

» A valid FortiEDR license for eXtended Detection Response—While you can create an eXtended
detection source connector without a valid license for eXtended Detection Response, the license is
required for a successful XDR definition.

e A Jumpbox with connectivity to Google SCC. Details about how to install a FortiEDR Core and configure
it as a Jumpbox are provided in Setting up the FortiEDR Core on page 511. You may refer to Cores on
page 403 for more information about configuring a Jumpbox.

» Connectivity from the FortiEDR Central Manager to the Fortinet Cloud Services (FCS).

Configuring Google SCC

Perform the following steps to configure Google SCC:

1. Enable threat logging in Google SCC:

a. Enable Event Threat Detection per monitored project in the organization. The following Event
Threat Detection rules are required:

¢ Malware: bad IP
¢ Malware: bad domain
Make sure to enable all log source types that are needed for these rules detectors to work, such as

Cloud DNS logs and Admin Activity log. For more details about Event Threat Detection rules and the
required log sources, see Google Documentation.

b. Verify that raw log items now show on Google’s Logs Explorer and Event Threat Detection findings
show on Security Command Center as described in Google Documentation.

2. Enable APl access to Google for fetching threat logs:
a. Setup aservice account on Google, as described in Google Documentation.

b. Download the json key file for this service account. This file should be uploaded via FortiEDR
console as part of setting up the extended detection source connector (see section below).

c. Grant the following permission to the service account to allow APl access:
¢ Organization Admin (resourcemanager.organizationAdmin)
¢ Security Command Center Admin (securityCenter.admin)
See Google Documentation for more details about permissions.

Setting up a connector for Google SCC

1. Click the Add Connector button and select eXtended Detection Source in the Connectors dropdown list.
The following displays:
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CONNECTORS

AddConneccor ¥ i Action Manager
o
v ¥ extended Detection Source @ Enabled
Jumpbox
Details Actions
® APIKey Credentials
Delete

2. Fillin the following fields:

Field Definition

Enabled Check this checkbox to enable blocking of malicious IP addresses by
Google SCC.

Jumpbox Select the FortiEDR Jumpbox that will communicate with Google SCC.

Name Specify a name of your choice to identify the connector.

Type Select Google SCC.

Authentication Upload the JSON file that was created for your Google Service
account.

Actions Specify the unique organization resource identifier in Google cloud or

ID of Google cloud project to use for fetching alerts.

Actions
Get Security Alerts from

eXtended Detection Organization ID l:l Project ID :

Source

3. Click Save.

Setting up FortiEDR Central Manager

In order to complete the integration with Google SCC, the eXtended detection rules and FortiEDR Threat
Hunting events collection must be enabled with the FortiEDR Central Manager, as follows.

To enable eXtended detection rules:

1. Navigate to the SECURITY SETTINGS > Security Policies page.

2. Open the eXtended detection policy that is applied on devices on which you want the eXtended
detection policy to apply and click the Disabled button next to each of the underlying rules to enable it,
as shown below:
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DASHBOARD EVENT VIEWER @ COMMUNICATION CONTROL v (23] SECURITY SETTINGS Vv INVENTORY ™ a

SECURITY POLICIES showing 1-10/40 | »|[wm] | search “Q
v A POLICY NAME RULE NAME ACTION STATE
4 ' Execution Prevention FORMNET (I
4 My Exfiltration Prevention FEATINET (0
4 E Ransomware Prevention  F&RTINET (TR
4 & Device Control FoRNNEr (@)
- ‘#’ extended Detection FUATINET (@)
Suspicious activity Detected (® Enabled
Suspicious authentication activity Detected @® Enabled
Suspicious email activity Detected @ Enabled
@ Enabled

Suspicious network activity Detected

To enable FortiEDR Threat Hunting events collection:

1. Navigate to the SECURITY SETTINGS > Threat Hunting > Collection Profiles page.
2. Open the Threat Hunting collection profile that is applied on devices on which you want the eXtended

detection policy to apply.

3. Select the following event types on that profile:

e Socket Connect
* Process Creation
e File Create

» File Detected

Event Collection And Storage

Collect and store Activity Events of the following categories and Types

Inventory (9 Enabled

| File Detected

Process  (2) Enabled

Screen Capture Process Termination ~| Process Creation Process Start
Library Loaded Keystroke Consumption

File

Network () Enabled
HTTP Request Socket Network Statistics || Socket Connect DNS Query

Thread Created Executable Loaded Driver Loaded

Socket Listen Socket Close Socket Accept

FortiEDR is now configured to issue eXtended detection alerts from Google SCC.

AWS GuardDuty

To integrate FortiEDR with AWS GuardDuty to collect activity log and issue eXtended detection alerts, you
must configure AWS GuardDuty, configure an eXtended detection source connector with AWS GuardDuty
in FortiEDR, and enable the eXtended detection rules and FortiEDR Threat Hunting events collection.
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Prerequisites

Before you start integrating FortiEDR with AWS GuardDuty, verify you have the following:

« A valid license for eXtended Detection Response—While you can create an eXtended detection source
connector without a valid license for eXtended Detection Response, the license is required for a
successful XDR definition.

¢ A Jumpbox with connectivity to AWS GuardDuty. Details about how to install a FortiEDR Core and
configure it as a Jumpbox are provided in Setting up the FortiEDR Core on page 511. You may refer to
Cores on page 403 for more information about configuring a Jumpbox.

» Connectivity from the FortiEDR Central Manager to the Fortinet Cloud Services (FCS).

Configuring AWS GuardDuty

Perform the following steps to configure AWS GuardDuty:

1. Enable Amazon GuardDuty in your account as described in AWS Documentation.
The following GuardDuty finding types are correlated with the FortiEDR events:
» Backdoor:EC2/C&CActivity.BIDNS

» Discovery:Kubernetes/MaliciouslIPCaller
You are encouraged to test that GuardDuty generates these findings as described on AWS
documentation.

2. Create |IAM user on AWS console as described here:
a. Set Programmatic Access for this user to allow API calls.
b. Set full permissions to access GuardDuty service.

c. Show and copy access key ID and secret access key of this user, which will be used on FortiEDR
console when you set up the extended detection source connector in the following section.

Setting up a connector for AWS GuardDuty

1. Click the Add Connector button and select eXtended Detection Source in the Connectors dropdown list.
The following displays:

CONNECTORS
@ AddConnector ~ igp Adtion Manager
v E:}: eXtended Detection Source ® Enabled

Jumpbox
Details Actions

® APIKey () Credentials

2. Fillin the following fields:

Field Definition

Enabled Check this checkbox to enable blocking of malicious IP addresses by
AWS GuardDuty.
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Field Definition

Jumpbox

Select the FortiEDR Jumpbox that will communicate with AWS

GuardDuty.

Name
Type
Authentication

Actions

3. Click Save.

Specify a name of your choice to identify the connector.
Select AWS GuardDuty.
Specify the access key ID and secret access key.

Specify the AWS region for API calls.

Actions

Get Security Alerts from
extended Detection
Source

Setting up FortiEDR Central Manager

In order to complete the integration with AWS GuardDuty, the eXtended detection rules and FortiEDR Threat
Hunting events collection must be enabled with the FortiEDR Central Manager, as follows.

To enable eXtended detection rules:

1.
2.

Navigate to the SECURITY SETTINGS > Security Policies page.
Open the eXtended detection policy that is applied on devices on which you want the eXtended

detection policy to apply and click the Disabled button next to each of the underlying rules to enable it,

as shown below:

DASHBOARD

I

COMMUNICATION CONTROL v @2} SECURITY SETTINGS Vv INVENTORY v ° ADMINISTRATION]

evenT viewer (B

SECURITY POLICIES showing 1-10740 | » v [ s2arch Q
- POLICY NAME RULE NAME ACTION STATE
4 ' Execution Prevention FEIRATINET (70
3 Wy Exfiltration Prevention FERTINET ()
3 E Ransomware Prevention  FoRTINET (Y
3 & Device Control FEATINET. (T @)
- ‘®’  extended Detection FORTINET ()
Suspicious activity Detected @ Enabled
Suspicious authentication activity Detected ® Enabled
Suspicious email activity Detected ® Enabled
® Enabled

Suspicious network activity Detected
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To enable FortiEDR Threat Hunting events collection:

1. Navigate to the SECURITY SETTINGS > Threat Hunting > Collection Profiles page.

2. Open the Threat Hunting collection profile that is applied on devices on which you want the eXtended
detection policy to apply.

3. Select the following event types on that profile:
e Socket Connect
* Process Creation
» File Create
» File Detected

Event Collection And Storage

Collect and store Activity Events of the following categories and Types
Inventory Enabled

| File Detected

Process Enabled
Screen Capture Process Termination | Process Creation Process Start Thread Created Executable Loaded Driver Loaded

Library Loaded Keystroke Consumption
File

Network Enabled

HTTP Request Socket Network Statistics v Socket Connect DNS Query Socket Listen Socket Close Socket Accept

FortiEDR is now configured to issue eXtended detection alerts from AWS GuardDuty.

Custom

To integrate FortiEDR with a custom system to collect activity log and issue eXtended detection alerts, you
must configure an eXtended detection source connector with the custom system and enable the eXtended
detection rules and FortiEDR Threat Hunting events collection.

Prerequisites

Before you start integrating FortiEDR with a custom system, verify you have the following:

< Avalid license for eXtended Detection Response—While you can create an eXtended detection source
connector without a valid license for eXtended Detection Response, the license is required for a
successful XDR definition.

* A Jumpbox with connectivity to the custom system. Details about how to install a FortiEDR Core and
configure it as a Jumpbox are provided in Setting up the FortiEDR Core on page 511. You may refer to
Cores on page 403 for more information about configuring a Jumpbox.

» Connectivity from the FortiEDR Central Manager to the Fortinet Cloud Services (FCS).

Setting up a connector for the custom system

1. Click the Add Connector button and select eXtended Detection Source in the Connectors dropdown list.
The following displays:
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CONNECTORS

AddConneccor ¥ i Action Manager
o
v ¥ extended Detection Source @ Enabled
Jumpbox
Details Actions
® APIKey Credentials
Delete

2. Fillin the following fields:

Field Definition

Enabled Check this checkbox to enable blocking of malicious IP addresses by
the custom system.

Jumpbox Select the FortiEDR Jumpbox that will communicate with the custom
system.

Name Specify a name of your choice to identify the custom system.

Type Select Custom.

Host Specify the IP or DNS address of the custom system.

Port Specify the port that is used for APl communication with the custom
system.

API Key/Credentials Specify authentication details of the custom system.

Actions Parameters 1. Upload a script file that contains all the authentication details for

the external system and the query for FortiEDR to pull data from
the system. Use the sample script as a starting point to build your
own script by replacing all the values with those for your system.

2. Specify the name of the data source field in the external system
for FortiEDR to correlate with. You can add fields as needed.

3. For each data source field, select the corresponding Threat
Hunting Event Type and Threat Hunting Field for FortiEDR to
correlate data with.

Actions

Get Security Alerts fro...

File Data Source Field Threat Hunting Event Type Threat Hunting Field
— I - -
Sample script +Add Field
3. Click Save.
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Setting up FortiEDR Central Manager

In order to complete the integration with the custom system, the eXtended detection rules and FortiEDR

Threat Hunting events collection must be enabled with the FortiEDR Central Manager, as follows.

To enable eXtended detection rules:

1. Navigate to the SECURITY SETTINGS > Security Policies page.

2. Open the eXtended detection policy that is applied on devices on which you want the eXtended

detection policy to apply and click the Disabled button next to each of the underlying rules to enable it,

as shown below:

:| DASHBOARD EvEnT VIEwER (ED) COMMUNICATION CONTROL v INVENTORY v (@) ADMINISTRATION|
SECURITY POLICIES showing 1-10/40 | »|[wm] | search “Q
- POLICY NAME RULE NAME ACTION STATE
4 ' Execution Prevention FORMNET (I
4 My Exfiltration Prevention FEATINET (0
4 E Ransomware Prevention  F&RTINET (TR
4 & Device Control FoRNNEr (@)
- ‘#’ extended Detection FUATINET (@)
Suspicious activity Detected (® Enabled
Suspicious authentication activity Detected @® Enabled
Suspicious email activity Detected @ Enabled
@ Enabled

Suspicious network activity Detected

To enable FortiEDR Threat Hunting events collection:

1. Navigate to the SECURITY SETTINGS > Threat Hunting > Collection Profiles page.
2. Open the Threat Hunting collection profile that is applied on devices on which you want the eXtended

detection policy to apply.
3. Select the following event types on that profile:
« Socket Connect
* Process Creation
» File Create
» File Detected
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Event Collection And Storage

Collect and store Activity Events of the following ca

Inventory Enabled

| File Detected

Process Enabled
Screen Capture Process Termination ~| Process Creation Process Start Thread Created Executable Loaded Driver Loaded

Library Loaded Keystroke Consumption

File

Network Enabled

HTTP Request Socket Network Statistics v Socket Connect DNS Query Socket Listen Socket Close Socket Accept

FortiEDR is now configured to issue eXtended detection alerts from the custom system.

Custom integration

The CUSTOM section enables you to connect to any third-party system in order to automatically trigger an
incident response in that third-party system as the result of a security event detected by FortiEDR. After
you define a Custom Integration connector (and its actions) and configure a relevant Playbook policy, an
automatic incident response action will be triggered in the third-party system upon the triggering of a
security event.

the Custom script option enabled. For more information about user roles and

s‘é’, Custom integration is only available to users with Admin or IT permissions and have
- permissions, see Users on page 277.

To set up a custom integration connector in FortiEDR:

1. Click the Add Connector button and select Custom Connector from the dropdown list. The following
displays:
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aenrvEnen @ communicATic . UENTORY

LICENSING CONNECTORS

RGANIZATIONS _

(@) AddConnector i Action Manager
JSERS

v
DISTRIBUTION
LISTS Jumpbox

; Details Actiens
EXPORT
SETTINGS Name Host | Ponfas | + Add action
TOOLS ® APl Key Credentials
Key

SYSTEM
EVENTS
INTEGRATIONS > &) Firewall : fortigate.fortidemo.com

b :1')': eXtended Detection Source : fortianalyzer.fortidemo.com
> ¢ Sandbox : fortisandbox fortidemo.com
> &7 Gustom Gonnector : AD_FTNT

> @ NAC : fortinac.fortidemo.com

2. Fillin the following fields:

oumistaarion @D

Protection v

nabled

nabled

nabled

nabled

nabled

Field Description

Jumpbox Select the FortiEDR Jumpbox that will communicate with the third-
party system. A FortiEDR deployment must include a Jumpbox that
has connectivity to the external system of this custom integration
connector. This Jumpbox must be exclusive to this organization and

cannot function as a Core.

Name Specify a name of your choice to be used to identify this custom
connector.

Host Specify the IP or DNS address of the relevant third-party application.

Port Specify the port that is used for APl communication with the relevant

third-party application.
API Key/Credentials

Specify authentication details of the relevant third-party application.

To use an API token, click the API Key radio button and copy the token
value into the text box. To use API credentials, click the Credentials
radio button and enter the relevant third-party application’s API

username and password.

3. Inthe Actions area on the right, define the action to be taken by this custom connector, as follows:

» To trigger an action on a custom connected third-party system, click the + Add Action button to

display the following popup window:
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ADD CUSTOM ACTION

Action -

AD Logout user

Rea-profile a device

( Cancel )

1. Inthe Action dropdown menu, select one of the previously defined actions (which were defined
in FortiEDR as described Custom integration on page 370).
-OR-

2. Click the Create New Action button in this popup window to define a new action that can be
triggered according to the definitions in the Playbook, as described in the next section below.
The following displays:
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Action Manager

New action +

Mame

New action *

Description

mnmnmnmnm x

Action Scripts (7)

Drag & Drop or browse

Q unicodify.py é: 1]
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Fill out the fields of this window as follows in order to define a new action to be triggered in
response to an incident.

In order to trigger this action, a Playbook policy must be defined that
triggers this action to execute the script when a security event is
) ! ’, triggered. The definition of this new action here automatically adds this
q action as an option in a Playbook policy. This action however, is not
- selected by default in the Playbook policy. Therefore, you must go to the
Playbook policy and select it in order for it to be triggered when a security
event is triggered.

Field Definition

Name Enter any name for this action.
Description Enter a description of this action.
Upload Upload a Python script that calls an API from the third-party

system in order to perform the relevant action. Python 2.7 or
later is supported. The Python script must be created according
to the coding conventions that can be displayed by clicking the

icon next to the Action Scripts field. The following displays
providing an explanation of the coding conventions and
provides various links that you can click to see more detail
and/or to download sample files.
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Field Definition

Creating a Custom Incident Response Action X

The following describes how to create and upload your own Python script to be assigned to
an incident response action. Playbook policies that are configured to use this action will
automatically execute this script when a security event is triggered.

Code Conventions

« A FortiEDR Jumpbox on which one or more scripts are executed is deployed with
various standard Python packages.

Alist of the packages that are deployed with this type of FortiEDR
Jumpbox.

« At the moment, only Python 2 is supported.

« Parameters
o Integration scripts can use properties that are part of a Connector’s
configuration, such as API keys or information that is part of the triggering
event (such as the process name).

= These properties are stored in the config.json file and can be used as script
parameters.

o Click here to see a sample config.json file and a sample action script:
&, custom_script.py 4, config.json

Troubleshooting

Script execution (either in test mode or as part of a realtime incident response) is defined
as successful if the script exits with code 0. Any other exit code will be reported as a
failure. Each script can also be manually invoked using the Test button. A test execution will
get the sample parameter file (which is available for download above) with an added JSON
section - "TestMode": true. The stderr and stdout Script output will be available after the
test completes or when script execution fails (with an error icon next to the action name).

3. Click Save. The new action is then listed in the Actions area.
4. Select this action to associate it with the custom connector.
5. You can click the Test button next to it to execute this action.
A new row is added to the CUSTOM section of the Automated Incident Response — Playbooks page. In

order for this custom integration connector to trigger an action, you must define it in the Playbook, as
described below.

The actions that you define here can also be selected as an action for a Firewall
integration on page 341 connector or Network Access Control (NAC) integration

NP on page 350 connector. These integration connectors might use the same API.
‘9' Alternatively, you may need to upload a different script that will be used to
- perform the same action on different third-party products. You can associate

several scripts with the same action and select the appropriate one per
connector. For example, an IM notification action could have two scripts —one for
notifications via Slack and the other for notifications via Teams.

Playbooks configuration

To configure an automated incident response that triggers an action using this custom integration
connector upon the triggering of a security event:

FortiEDR 7.2.0 Administration Guide
Fortinet Inc.

375



Administration

1. Navigate to the SECURITY SETTINGS > Playbooks page.

2. Open the Playbook policy that is applied on devices for which you want the custom action (defined

above) to apply.

3. Inthe CUSTOM section, place a checkmark in the relevant Classification columns next to the row of that

action.

4. Inthe dropdown menu next to the action, select the connector with which to perform the action or click

Select All, as shown below:
CUSTOM
Re-profile a device

AWS Lambda Logout User Select All

« fortinac fortidemo.com

Disable interface

Slack Notification fortigate fortide:

v

The example above showed how to configure two custom connectors by using the same action named
IM notification in the Playbook — one for notifications via Teams and the other for notifications via Slack.

FortiEDR is now configured to trigger this action in the third-party system upon the triggering of a
security event. This automatic incident response action appears in the Overview tab when you select

the incident and click Investigate in the Incidents pane.

Incidents >

Unhandled N/A

FortinetCloudServices Response

FortinetCloudServices

FortinetCloudServices Response ) Execution Prevention

Malicious File Detected

FortinetCloudservices Response

Identity Management integration

Full Screen 3 New Tab

When an Identity Management connector, such as FortiClient Endpoint Management Server (EMS), is set
and Playbook policies are configured, automatic incident response actions can include ZeroTrust device

tagging on FortiClient EMS upon security event triggering.

For more details about integrating FortiEDR with FortiClient EMS, refer to the FortiClient EMS Integration

Guide.

Prerequisites

Before you start Identity Management configuration, verify the following:
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e Your FortiEDR deployment includes a Jumpbox that has connectivity to the identity management
server.

» Refer to Setting up the FortiEDR Core on page 511 for details about how to install a FortiEDR Core
and configure it as a Jumpbox.

» Refer to Cores on page 403 for more information about configuring a Jumpbox.
e The FortiEDR Central Manager has connectivity to the Fortinet Cloud Services (FCS).

¢ You have a valid user with access to the identity management system. For FortiClient EMS, the
following type of user is required depending on the deployment type:
 FortiClient EMS On-Premise—A valid APl user. See the FortiClient EMS Integration Guide for
detailed instructions.

» FortiClient EMS Cloud— FortiCloud master user (e.g. email address) with read/write access to the
FortiClient EMS Cloud portal. Sub user accounts cannot be used. See the FortiCloud IAM
documentation for detailed instructions about creating a permission profile and an APl user.

Follow the steps below to tag a device as non-trusted automatically upon the detection of a FortiEDR
security event.

Configuring a FortiEDR Connector

To configure Identity Management integration:

1. Click the Add Connector button and select Identity Management from the dropdown list.
The following displays:
Connectors

All connector types + Add Connector v £83 Action Manager

8 results
Name state Connector type Action

'rﬁl Identity Management: @ Enabled Response ZeroTrust device tagging

Actions
Jumpbox

® No Jumpbox is selected ZeroTrust device tagging & 129 "ame * @

Name* Type

Host * 443

@ APIKey Credentials

APIKey* cancel

2. Fillin the following fields:

Field Description

Jumpbox Select the FortiEDR Jumpbox that will communicate with this Identity
Management system.

Name Specify a name of your choice to be used to identify this Identity
Management system.

Type Select the type of Identity Management to be used in the dropdown
list. For example, FortiClient EMS.
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Field Description

Host Specify the IP or DNS address of the external Identity Management
system.
Port Specify the port that is used for communication with the external

Identity Management system.

API Key/Credentials Specify authentication details of the external Identity Management
system. Fill in the external Identity Management system API
username/Account and password/key.

For FortiClient EMS, specify the following depending on your
deployment type:

¢ (FortiClient EMS on-premise) Specify the username and
password of the FortiClient EMS Admin User.

* (FortiClient EMS cloud) Specify the account (e.g. email address)
and password of the FortiCloud master user with read/write
access to the FortiClient EMS Cloud portal. Sub user accounts
cannot be used.

3. Inthe Actions area on the right, define the action to be taken by this connector:

» To use an action provided out-of-the-box with FortiEDR (for example, Zero Trust device tagging on
FortiClient EMS), tag the device as non-trusted the Identity management system and specify the
classification tag to apply on the device in the Tag name field.

This step is optional for FortiClient EMS 7.2 or later as it has the following fabric tags predefined for
FortiEDR. Both the predefined fabric tags and classification tags, if any, will be used by FortiClient
EMS 7.2 or later to tag the device.

* FortiEDR_Malicious: FortiEDR has classified this endpoint as malicious.

* FortiEDR_PUP: FortiEDR has detected a potentially unwanted program on this endpoint.

* FortiEDR_Suspicious: FortiEDR has detected suspicious activity on this endpoint.

+ FortiEDR_Likely_Safe: FortiEDR has detected this endpoint as likely to be safe.

* FortiEDR_Probably_Good: FortiEDR has determined that this endpoint is not a safety risk.

See the FortiClient EMS Administration Guide for more information about endpoint tagging in
FortiClient EMS.
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e To use a custom integration action:
i. Click the + Add Action button. The following popup window displays:

ADD CUSTOM ACTION

Action -

AD Logout user

RHe-profile a device

( Cancel )

ii. Inthe Action dropdown menu, select one of the previously defined actions (which were defined
in FortiEDR as described in Custom integration on page 370), or define a new action that can
be triggered according to the definitions in the Playbook:
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i. Click the Create New Action button. The following displays:

FortiEDR 7.2.0 Administration Guide 380
Fortinet Inc.



Administration

Action Manager

New action +

Mame

Mew action *

Drescription

mnmnmnmnm x

Action Scripts (7)

Drag & Drop or browse

a unicodify.py é 0
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ii. Fill out the fields of this window as follows in order to define a new action to be triggered in
response to an incident.

In order to trigger this action, a Playbook policy must be defined that
triggers this action to execute the script when a security event is
) ! ’, triggered. The definition of this new action here automatically adds
9 this action as an option in a Playbook policy. However, this action is
- not selected by default in the Playbook policy. Therefore, you must go
to the Playbook policy and select it in order for it to be triggered when
a security event is triggered.

Field Definition

Name Enter any name for this action.
Description Enter a description of this action.
Upload Upload a Python script that calls an API from the third-party

system in order to perform the relevant action. Python 2.7 or
later is supported. The Python script must be created
according to the coding conventions that can be displayed

by clicking the icon next to the Action Scripts field. The
following displays providing an explanation of the coding
conventions and provides various links that you can click to
see more detail and/or to download sample files.

FortiEDR 7.2.0 Administration Guide
Fortinet Inc.

382



Administration

Field Definition

Creating a Custom Incident Response Action X

The following describes how to create and upload your own Python script to be assigned to
an incident response action. Playbook policies that are configured to use this action will
autormatically execute this script when a security event is triggered.

Code Conventions

« A FortiEDR Jumpbox on which one or more scripts are executed is deployed with
various standard Python packages.

Alist of the packages that are deployed with this type of FortiEDR
Jumpbox.

« At the moment, only Python 2 is supported.

« Parameters
o Integration scripts can use properties that are part of a Connector's
configuration, such as API keys or information that is part of the triggering
event (such as the process name).

These properties are stored in the config.json file and can be used as script
parameters.

Click here to see a sample config.json file and a sample action script
&, custom_script.py b, configjson

Troubleshooting

Script execution (either in test mode or as part of a realtime incident response) is defined
as successful if the script exits with code 0. Any other exit code will be reported as a
failure. Each script can also be manually invoked using the Test button. A test execution will
get the sample parameter file (which is available for download above) with an added JSON
section — "TestMode": true. The stderr and stdout Script output will be available after the
test completes or when script execution fails (with an error icon next to the action name).

Close

iii. Click Save. The new action is then listed in the Actions area.
4. You can click the Test button next to an action to execute that action.
5. Click Save to save the connector configuration.

Configuring Playbooks

To configure an automated incident response that uses an Identity Management

connector to tag a device upon security event triggering:

1. Navigate to the SECURITY SETTINGS > Playbooks page.
2. Open the Playbook policy that is applied on devices for which you want the identity management

response to apply.

3. Place a checkmark in the relevant Classification column next to the Zero Trust device tagging row under

the REMEDIATION section.

FortiEDR is now configured to automatically tag a device as non-trusted upon triggering of a security

event.
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REMEDIATION

To configure an automated incident response that uses an Identity Management
connector to perform a custom action upon the triggering of a security event:

Terminate process v
Delete file

Clean persistent data v
Block address on Firewall

ZeroTrust device tagging FortiClientEMS ... = v

Reset user password

1. Navigate to the SECURITY SETTINGS > Playbooks page.

2. Open the Playbook policy that is applied on devices for which you want the custom action (defined

above) to apply.

3. Inthe CUSTOM section, place a checkmark in the relevant Classification columns next to the row of the

relevant custom action.

4. Inthe dropdown menu next to the relevant custom action, select the relevant Identity Management

connector with which to perform the action.

FortiEDR is now configured to trigger this action in the third-party system upon the triggering of a

security event.

Automatic incident response actions are listed in the Overview tab when you select the incident and click

Investigate in the Incidents pane, as shown below:

Incidents >

1D Status Organization Assigned to
Unhandled N/A

PUP

Overview Event Analysis

Activity Audit

FortinetCloudservices

PUP

FortinetCloudServices

FortinetCloudservices

Fortinet

FortinetCloudservices

Devices involved (1)

Response

Response v
Malicious File Detected

Response
ATTECK

User Access integration

When a user access connector, such as Active Directory, is set and Playbook policies are configured,
automatic incident response actions can include resetting user’s password or disabling user account on

domain controller upon security event triggering.
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For more details about integrating FortiEDR with Active Directory, refer to the Active Directory Integration

Guide.

Prerequisites

Before you start User Access configuration, verify the following:

e Your FortiEDR deployment includes a Jumpbox that has connectivity to the domain controller server.
Details about how to install a FortiEDR Core and configure it as a Jumpbox are described in Setting up
the FortiEDR Core on page 511. You may refer to Cores on page 403 for more information about

configuring a Jumpbox.

« The FortiEDR Central Manager has connectivity to the Fortinet Cloud Services (FCS).

e You have a valid APl user with access to Active Directory or equivalent domain control system. See the
Active Directory Integration Guide for detailed instructions about creating an Active Directory admin

user.

Follow the steps below to perform user access actions automatically upon the detection of a FortiEDR

security event.

Configuring a FortiEDR Connector

To configure User Access integration:

1. Click the Add Connector button and select User Access from the dropdown list.

The following displays:

Connectors

All connector types + Add Connector v £83 Action Manager

8 results
Name State Connector type

o®  UserAccess @ Enabled

Actions
Jumpbox

@ No Jumpbox is selected Disable user aceount &3

Name Type . Reset user password £

Host* 443 X

@® aPikey Credentials

API Key *

2. Fillin the following fields:

Action

Disable user account, Reset user password

Base DN*

Base DN *

Cancel

Field Description

Jumpbox Select the FortiEDR Jumpbox that will communicate with this User
Access system.

Name Specify a name of your choice to be used to identify this User Access
system.
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Field Description

Type Select the type of user access to be used in the dropdown list. For
example, Active Directory.

Host Specify the IP or DNS address of the external User Access system.

Port Specify the port that is used for communication with the external User
Access system.

API Key/Credentials Specify authentication details of the external user access system:
e Touse an APl token, click the APl Key radio button and copy the
token value into the text box.

* To use API credentials, click the Credentials radio button and fill in
the external User Access system APl username (or Bind User DN)
and password.

3. Inthe Actions area on the right, define the action to be taken by this connector:

» To use an action provided out-of-the-box with FortiEDR (for example, Disable user account on
Active Directory), in the baseDN field of Disable user account or Reset user password, specify where
FortiEDR starts searching for the user upon which actions are performed.

» To use acustom integration action:
i. Click the + Add Action button. The following popup window displays:

ADD CUSTOM ACTION

Action -

AD Logout user

Re-profile a device

i
[ Cancel |

ii. Inthe Action dropdown menu, select one of the previously defined actions (which were defined
in FortiEDR as described in Custom integration on page 370), or define a new action that can
be triggered according to the definitions in the Playbook:
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i. Click the Create New Action button. The following displays:
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Action Manager

New action +

Mame

Mew action *

Drescription

mnmnmnmnm x

Action Scripts (7)

Drag & Drop or browse

a unicodify.py é 0
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ii. Fill out the fields of this window as follows in order to define a new action to be triggered in
response to an incident.

In order to trigger this action, a Playbook policy must be defined that
triggers this action to execute the script when a security event is
) ! ’, triggered. The definition of this new action here automatically adds
9 this action as an option in a Playbook policy. However, this action is
- not selected by default in the Playbook policy. Therefore, you must go
to the Playbook policy and select it in order for it to be triggered when
a security event is triggered.

Field Definition

Name Enter any name for this action.
Description Enter a description of this action.
Upload Upload a Python script that calls an API from the third-party

system in order to perform the relevant action. Python 2.7 or
later is supported. The Python script must be created
according to the coding conventions that can be displayed

by clicking the icon next to the Action Scripts field. The
following displays providing an explanation of the coding
conventions and provides various links that you can click to
see more detail and/or to download sample files.
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Field Definition

Creating a Custom Incident Response Action X

The following describes how to create and upload your own Python script to be assigned to
an incident response action. Playbook policies that are configured to use this action will
autormatically execute this script when a security event is triggered.

Code Conventions

« A FortiEDR Jumpbox on which one or more scripts are executed is deployed with
various standard Python packages.

Alist of the packages that are deployed with this type of FortiEDR
Jumpbox.

« At the moment, only Python 2 is supported.

« Parameters
o Integration scripts can use properties that are part of a Connector's
configuration, such as API keys or information that is part of the triggering
event (such as the process name).

These properties are stored in the config.json file and can be used as script
parameters.

Click here to see a sample config.json file and a sample action script
&, custom_script.py b, configjson

Troubleshooting

Script execution (either in test mode or as part of a realtime incident response) is defined
as successful if the script exits with code 0. Any other exit code will be reported as a
failure. Each script can also be manually invoked using the Test button. A test execution will
get the sample parameter file (which is available for download above) with an added JSON
section — "TestMode": true. The stderr and stdout Script output will be available after the
test completes or when script execution fails (with an error icon next to the action name).

Close

iii. Click Save. The new action is then listed in the Actions area.
4. You can click the Test button next to an action to execute that action.
5. Click Save to save the connector configuration.

Configuring Playbooks

To configure an automated incident response that uses a user access connector to
reset user password or disable a user upon security event triggering:

1. Navigate to the SECURITY SETTINGS > Playbooks page.

2. Open the Playbook policy that is applied on devices for which you want the user access response to
apply.

3. Place a checkmark in the relevant Classification column next to the Disable user row under the
INVESTIGATION section or the Reset user password row under the REMEDIATION section.

FortiEDR is now configured to automatically perform user access actions upon triggering of a security
event.
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INVESTIGATION
Isolate device with Collector
Admin
Move device to the High Security Group

Disable user FEDR-QA AD v -/

To configure an automated incident response that uses a User Access connector to
perform a custom action upon the triggering of a security event:

1. Navigate to the SECURITY SETTINGS > Playbooks page.

2. Open the Playbook policy that is applied on devices for which you want the custom action (defined
above) to apply.

3. Inthe CUSTOM section, place a checkmark in the relevant Classification columns next to the row of the
relevant custom action.

4. Inthe dropdown menu next to the relevant custom action, select the relevant User Access connector
with which to perform the action.
FortiEDR is now configured to trigger this action in the third-party system upon the triggering of a
security event.

Automatic incident response actions are listed in theOverview tab when you select the incident and click
Investigate in the Incidents pane, as shown below:

Incidents > - @ Full Screen [ New Tab
D Status Organization Assigned to First Seen ast Seen
PUP
Unhandled N/A
Overview Event Analysis
[ Handie Incident

Activity Audit Devices involved (1) Processes involved (1)

L]
2

FortinetCloudServices Response

PUP

FortinetCloudServices

Violated Policies

FortinetCloudServices Response O Execution Prevention

Malicious File Detected

Fortinet

FortinetCloudServices Response
ATTECK

Threat Intelligence Feed integration

When a Threat Intelligence Feed connector is configured, FortiEDR creates a Threat Hunting query based on
the data fetched from STIX/TAXII feed. The related query is updated upon each scheduled retrieval of
collection data which covers the following indicators: hashes, file names, files size, paths, IPs, usernames,
registry keys, URLs, and domain names. You can find the relevant queries under Threat Hunting > Saved
Queries.
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S ! /, As one Threat Hunting query can include only 150 to 1000 conditions, depending on
q the indicator type, FortiEDR may create multiple query entries for the same
- collection.

To set up a Threat Intelligence Feed connector with FortiEDR:

1. Click the Add Connector button and select Threat Intelligence Feed in the Connectors dropdown list. The
following displays:
Connectors

All connectortypes + Add Connector v 83 Action Manager

8results
Name state Connector type. Action

»H,:) Threat Intelligence Feed @ Enabled Detection Fetch Feed

e Actions
Name* TAXI (XML) v Repests By Firttime fetch

Fetch Feed g3 () Hours N 12 N at M One day old - data (3

URL* Collection Name *

Authentication

O]

2. Inthe Details section, fill in the following fields:

Field Definition

Name Specify a name of your choice which will be used to identify this
Threat Intelligence Feed Collection.

Type Select the syntax type of the original query, for example: TAXIl (JSON)
or TAXII T (XML).

URL Specify the IP or DNS address of the Threat Intelligence server.

Collection ID Specify the collection name of the XML query or collection ID of the
JSON query.

Authentication Select this option to specify authentication details of your Threat

Intelligence Feed. To use an API token, click the APl Key radio button
and copy the token value into the text box. To use API credentials,
click the Credentials radio button and fill in the external system API
username and password.

Enabled Use this option to enable or disable FortiEDR integration with this
Threat Intelligence Feed.

3. Inthe Actions section, specify the schedule for FortiEDR to retrieve the provided collection data, which
covers the following indicators: hashes, file names, files size, paths, IPs, usernames, registry keys,
URLs, and domain names.

4. Specify the age of collection data for the initial retrieval. For example, One day old means that only
indicators that were added to the Collection during the last day will be retrieved for the initial retrieval.

5. Click the Test button to execute the action.
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6. Click Save.
The Threat Intelligence Feed connector is set up and relevant queries will be created in Saved Queries
under Threat Hunting on page 125.

Action Manager

M The Action Manager button is only available to users with Admin or IT permissions
q and have the Custom script option enabled. For more information about user roles
- and permissions, see Users on page 277.

FortiEDR enables you to define connectors to external systems, so that FortiEDR will automatically trigger
predefined actions when a security event is triggered in FortiEDR. You can define your own actions while
defining a Custom integration connector, Firewall integration connector or NAC integration connector (as
described above). Each action is comprised of a Python script (one or several ones) that calls an APl from
the third-party system in order to perform the relevant action.

The Action Manager enables you to upload and manage (add, modify and delete) these actions and the
Python scripts that call third-party systems’ APIs. Python 2.7 or later is supported.
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To display the Action Manager:
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1. In the Administration tab, select Connectors.
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2. Click the Action Manager button. The following displays:
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Action Manager

New action +

Mame

Mew action *

Description

mnmnmnmnm x

Action Scripts (%)

Drag & Drop or browse

a unicodify.py é ]j
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To define a new action:

1. Click the + Add action button.
2. Fill out the fields of this window as follows in order to define a new action to be triggered in response to

an incident.
In order to trigger this action, a Playbook policy must be defined that triggers this
NP action to execute the script when a security event is triggered. The definition of
‘Q' this new action here automatically adds this action as an option in a Playbook
- policy. This action however, is not selected by default in the Playbook policy.

Therefore, you must go to the Playbook policy and select it in order for it to be
triggered when a security event is triggered.

Field Definition

Name Enter any name for this action.
Description Enter a description of this action.
Upload Upload a Python script that calls an API from the third-party system in

order to perform the relevant action. Python 2.7 or later is supported.
This Python script must be created according to the coding
conventions that can be displayed by clicking the icon next to the
Action Scripts field. The following displays providing an explanation of
these coding conventions and provides various links that you can
click to see more detail and/or to download sample files.
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Field Definition

3. Click Save.

To modify the script of an action:

Creating a Custom Incident Response Action X

The following describes how to create and upload your own Python script to be assigned to
an incident response action. Playbook policies that are configured to use this action will
automatically execute this script when a security event is triggered.

Code Conventions

« A FortiEDR Jumpbox on which one or more scripts are executed is deployed with
various standard Python packages.

A list of the packages that are deployed with this type of FortiEDR
Jumpbox.

« At the moment, only Python 2 is supported.

» Parameters
o Integration scripts can use properties that are part of a Connector's
configuration, such as API keys or information that is part of the triggering
event (such as the process name).

= These properties are stored in the config.json file and can be used as script
parameters.

= Click here to see a sample config.json file and a sample action script:
N, custom_scriptpy &, config.json

Troubleshooting

Script execution (either in test mode or as part of a realtime incident response) is defined
as successful if the script exits with code 0. Any other exit code will be reported as a
failure. Each script can also be manually invoked using the Test button. A test execution will
get the sample parameter file (which is available for download above) with an added JSON
section — "TestMode": true. The stderr and stdout Script output will be available after the
test completes or when script execution fails (with an error icon next to the action name).

Close

1. In the Administration tab, select Connectors.
2. Click the Action Manager button.

3. Select the action of the script to be modified.
4

In the Action Scripts area, hover over the name of the script in order to display various tools, as follows:

Tool Description

+

—_J

O
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Tool Description

To upload a new Python script that calls an API from the third-party
system in order to perform the relevant action. Python 2.7 or later is
supported.

5. Click Save.

Deployment

The Administration > Deployment menu includes the following pages:

e System Components on page 400
¢ Collector on page 405

System Components

The Administration > Deployment > System Components page lists the FortiEDR Aggregators, Cores and
Repositories.
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Administration

Licensing
Organizations
Users
Distribution Lists
Export Settings
Settings

System Events
Ip Sets
Connectors

~ Deployment

System Components

Collector

Workloads Deployment

The following displays:
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System Components

v Cores (1/1)

All statuses v V4 Q
P Name Status Deployment mode Functionality Version oo
B Rumning Cloud Both
v Aggregators (1/1)
All statuses v v+ [ Q
P Name Status Connected collectors Version oo
B Running 21
v Repositories (1/1)
P Status Version (I11}
B Running

The AGGREGATORS area lists the FortiEDR Aggregators.
System Components

> Cores (1/1)

v Aggregators (1/1)

All statuses v Y+ O Q
P Name Status Connected collectors Version oo
B Running 2 oo
> Repositories (1/1)
Click the Expand icon ( % ) to expand the list. The following information is provided for each FortiEDR
Aggregator:
Information Field Description
Checkbox Check this checkbox to select the Aggregator. You can then use one of
the buttons at the top left of the window, such as the Delete button.
IP Specifies the IP address of the communicating device on which the
FortiEDR Aggregator is installed.
Name Specifies the Aggregator name entered during installation.
Connected Collectors Specifies the number of FortiEDR Collectors that have been configured to
operate with this Aggregator.
Version Specifies the version of the Aggregator software.
State Specifies the current state of the FortiEDR Aggregator.
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Cores

The CORES area lists the FortiEDR Cores.

System Components
~ Cores (1/1)
All statuses v V4

P Name Status

B Running

> Aggregators (1/1)

> Repositories (1/1)

Deployment mode Functionality Version oon

Cloud Both

Click the Expand icon ( % ) to expand the list. The following information is provided for each FortiEDR Core:

Information Field Description

Checkbox Check this checkbox to select the Core. You can then use one of the
buttons at the top left of the window, such as the Delete button.

Organization Specifies the name of the organization in a multi-organization FortiEDR
environment. In a single-organization FortiEDR system, this column does
not appear.

IP Specifies the IP address of the communicating device on which the

FortiEDR Core is installed.

Name Specifies the FortiEDR Core name entered during installation.

Deployment Mode Specifies whether the FortiEDR Core is physically deployed on your
organization's premises (On-Premise) or in the cloud provided by
Fortinet (Cloud). The following deployment options are available.

e Cloud
e On-premise

Functionality Specifies the core's functionality and enables you to modify it by
selecting one of the following options:

FUNCTIOMNALITY

Both

r

» Core only — Specifies that the system provides basic FortiEDR Core
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Information Field Description

functionality: events processing, communication control handling,
activity events proxy to the Repository and so on.

» Jumpbox — Specifies that the FortiEDR Core is used by the Central
Manager (the central web user interface) as a Jumpbox, while the
Jumpbox connects to the LDAP, sandbox or to the products. No
basic Core functionalities are provided.

\‘é’, The Jumpbox option is unavailable for cloud Cores.

To configure a cloud Core to function as Jumpbox,
please contact Fortinet Support.

e Both - Provides both Core and Jumpbox functionality, as described
above.

It is not mandatory to have a Core with Jumpbox
V) functionality. However, removing Jumpbox functionality
‘9' (by selecting the Core only option) may affect previously
|| defined connectors, thus causing them to be
- nonfunctional. In this case, an appropriate message is

displayed.
Version Specifies the version of the FortiEDR Core.
State Specifies the current state of the FortiEDR Core.

Repositories

The REPOSITORIES area shows details about the FortiEDR Threat Hunting Repository server.
System Components

> Cores (111)

5 Aggregators (1/1)

v Repositories (1/1)

P Status Version oo

B Running

Click the Expand icon ( % ) to expand the list. The following information is provided for each FortiEDR
Repository:

 |P: Specifies the IP and port address of the communicating device on which the FortiEDR Repository is
installed.

» STATE: Specifies the current state of the FortiEDR Repository.
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Collector

Perform the following tasks on the Administration > Deployment > Collector page:

» Updating the Collector version on page 405

» Loading a server certificate on page 408

» Requesting and obtaining a Collector installer on page 409
¢ Requesting and obtaining a mobile installer on page 412

Updating the Collector version

Use the Update Collector Version feature to update a FortiEDR Collector version, such as from 5.0.3 to 5.2.

NP This feature does not support upgrading a macOS Collector from 5.2 to 6.0, which
‘Q' can only be done via JAMF. See Installing FortiEDR on MacOS devices using Jamf
- PRO on page 58. Upgrading macOS Collector 6.0 to a later build using this option
- will work.

The Automatic Collector Updates feature updates the patch and revision for a given FortiEDR version upon
the availability of a new Collector build. The patch and revision numbers are the third and fourth digits of
the FortiEDR version number. For example, for FortiEDR version 3.1.y.x, y indicates the patch number and x
indicates the revision number.

When the Automatically update Collectors to the latest patch revision checkbox is checked, whenever the
content contains a new build (for example, 5.0.3.508 is a new build of 5.0.2.342), all Collectors are updated
to that build. This means that all Collectors in all Collector Groups in all environments and operating
systems are updated to the latest FortiEDR revision available (as provided by Fortinet using the Load
Content feature). For more details about the Load Content feature, see Content Updates on page 477

In the Advanced section you can choose to disallow automatic updates of the Collector’s policy logic library.
When the checkbox is checked, the engine library is updated on the Collector whenever new engine
becomes generally available. Automatic Policy engine library update keeps the core detection functionality
within the Collector up to date and as it does not enforce any downtime or restart of the device is
recommended.

Content

Content Version: 12467 (VLS CCRE 0TS Request Collector Installer Request Mobile Installer

Automatically update Collectors to the latest patch version

“ Advanced

Automatically update policy engine to the latest revision
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When you click the Update Collectors button in the Licensing window, the Update Collector Version window
displays. This window lists all available Collector Groups. The Windows Version, macOS Version, and Linux
Version columns indicate the current FortiEDR version for the Collectors in a Collector Group.

UPDATE COLLECTOR VERSION

COLLECTOR GROUP a WINDOWS VERSION MACOS VERSION LINUX VERSION
aa N/A N/A N/A
create_new_group NIA N/A N/A
customer_installer N/A N/A N/A
davdat-osx NIA N/A N/A
Default Collector Group 5.2.2 Rev. 581 N/A N/A
emulation N/A N/A N/A
emulationd N/A N/A N/A

Update 0 selected group(s) to
Windows version: 52 2 Rev 581 MacOS version: 6.0.8 Rev. 100¢ Linux version: 515 Rev 1038

Note: Version update involves sending 10Mb of data from the Central Manager to each Collector.

You can update the version for the Collectors in a Collector Group for each operating system.

If the Automatically update Collectors to the latest patch version checkbox is enabled
M, on the Administration > Deployment > Collector page, then the Update Collector
? Version window does not display the revision number in the Windows Version,
] macOS Version and Linux Version columns, as the revision is automatically updated
with the Automatic Updates feature.

UPDATE COLLECTOR VERSION

COLLECTOR GROUP a WINDOWS VERSION MACOS VERSION LINUX VERSION
aa NIA N/A N/A
create_new_group N/A N/A N/A
customer_installer N/A N/A N/A
davdat-osx N/A N/A N/A
Default Collector Group 5.2.2 Rev. 581 N/A N/A
emulation N/A N/A N/A
emulation4 N/A N/A N/A

Update 0 selected group(s) to
Windows version: 5.2 2 Rev 521 MacCOS version: 6.0.8 Rev. 1009 Linux version: 515 Rey 1038

Note: Version update involves sending 10Mb of data from the Central Manager to each Collector.
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To update the version for the Collectors in a Collector Group:

1. Check the checkbox of the Collector Group(s) whose Collectors you want to update. You can select

more than one Collector Group.

2. Select the checkbox of the operating system(s) to update and in its adjacent dropdown list, select the
FortiEDR version for the Collectors in the designated Collector Group. You can select more than one

operating system.

UPDATE COLLECTOR VERSION

COLLECTOR GROUP a WINDOWS VERSION MACOS VERSION
a3 MNIA NIA
create_new_group N/A N/A
customer _installer N/A N/A
davdat-0sx NIA N/A
Default Collector Group 5.2.2 Rev. 5681 NiA
emulation NIA N/A

emulationd NIA N/A

Update 1 selected group(s) to

indows version] 5.2.2 Rev. 581 v + MacOS version: 6.0.8 Rev. 1009 v
Note: Version updatq v P22 Rey 5 data from the Central Manager to each Collector.

524 Rev. 0016
5.2.3 Rev. 0085

No Update Required

LINUX VERSION
N/A
N/A
N/A
N/A
N/A
N/A
N/A

v Linux version: 5.1.5 Rev. 1038 v

3. Click Update. FortiEDR gradually updates all the Collectors in the Collector Group(s) to the required
version for the specified operating system(s), and displays the following window:

UPDATE COLLECTORS VERSION

A gradual update of Collectors to a higher version Windows version
522 Rev. 581 MacOS version 6.0.8 Rev. 1002 Linux version 5.1.5

Rev. 1038 is in progress.

4. Click Close.
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Loading a server certificate

To load a certificate:

1. Click Central Manager Certificate (). The Load Central Manager Certificate

dialog opens.

LOAD CENTRAL MANAGER CERTIFICATE

Certificate file: | Choose File | No file chosen

Private kev file: | Choose File | No file chosen

Private Key Password:

o~ .
f N
gl e—
. Cancel )
Upload [ Cancel |

2. Click Choose File to upload the certificate file. Only PEM certificates (.pem) are supported.

Ay
‘?' The certificate common name (CN) must match the FQDN of the FortiEDR

machine. Otherwise, an error will occur.

Click Choose File to upload the private key file.
Enter the certificate password in the Private Key Password field.
Click Upload.
Configure the certificate as follows:
» For cloud deployment, please contact Fortinet Support.

U S

» For on-premise deployment, add or edit the following entries in the
/opt/FortiEDR/webapp/application-customer.properties file on the FortiEDR Manager VM:

e connector.ssl.externalAddress={certificate domain/DNS name of machine}
e smtp.template.server.login={certificate domain/DNS name of machine}

vy
‘?' The properties are case-sensitive and must be in lowercase. Space is not

allowed.
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7. Restart the FortiEDR Manager VM.

Requesting and obtaining a Collector installer

. Request Collector Installer . .
You can click the Request Collector Installer button () to obtain a Collector installer

file that can be used to install a Collector. This option enables you to request an installer for a particular
operating system(s), such as Windows, MacOS, or Linux. This installer is similar to the standard wizard
used to install a Collector, except that many of the fields in the wizard have already been filled in for you.

The requested Collector installer will then emailed to you. You can unzip it with 7-Zip using the registration
password (available under Administration > Settings > Component Authentication on page 316) and install it
by following the instructions in Installing FortiEDR Collectors on page 23, based on the operating system on
which it is to be installed.

A\,

To minimize the risk of extraction failures and compatibility issues, we recommend
using 7-Zip to extract the contents of the MSI package to ensure that all necessary
files within the collector package are properly retrieved for further use or
configuration. Using WinRAR or the Windows built-in extractor may cause errors or
incomplete extractions.

To configure custom installer settings to determine the type of installer to request :

1. On the Administration > Deployment > Collector page, click the Request Collector Installer button (

). The following displays:

CUSTOM COLLECTOR INSTALLERS

Select the installers you would like to generate

Windows version

Aggregator address

Organization

» Advanced

Send installers link to

macOS version LINUX Version

i Group  Default Collector Group -

1L.Com

2. Inthe Select the installer you would like to generate area, select the checkbox of the installer(s) you want
to request. Multiple installers can be requested at the same time.
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Select the installers you would like to generate
v Windows version  4.1.0.128 - macOs version LINUX Versian
3. Inthe adjacent dropdown list, select the installer version. When selecting installers for more than one

operating system, you must specify the version for each of them. Specify the version in the same
manner as described on Updating the Collector version on page 405

4. Inthe Aggregator Address dropdown list, select the aggregator to which this Collector is registered.

5. In a multi-tenant system, select the organization to which the installed Collector is registered in the
Organization dropdown list.

6. Inthe Group dropdown list, select the Collector Group to which the installed Collector is assigned, or
leave the field empty for the Collector to be assighed to the default Collector Group.

(5 roug I

ACGroup [
Beta 4.0.0.0

Beta4.1.0

Crediford

David

7. Inthe Advanced area, specify the following:

¥ Advanced
VDI (Virtual Desktop Infrastructure) installation
Use system proxy settings
Start after device reboot

» VDI (Virtual Desktop Infrastructure) Installation: If you are installing the Collector on a VDI
environment, check this checkbox. For more details, you may refer to the Working with FortiEDR on
VDI Environments section on page 54.

e Use System Proxy Settings: If you use a web proxy to filter requests in this device’s network, then
check the Use System Proxy Settings checkbox. Note that Windows must be configured to use a
proxy and tunneling must be allowed from the Collector to the Aggregator on port 8081 and from
the Collector to the Core on port 555. (Run as Administrator: netsh winhttp set proxy <proxy IP >).

» Start After Device Reboot: Check this checkbox in order to delay data collection until a device
reboot is applied. This is only required in rare cases. Typically, this checkbox remains unchecked.

8. Inthe Send Installers Link To field, specify the email address to which the installer is to be sent.
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9. Click the Send Request () button. A confirmation message displays.

CUSTOM INSTALLER REQUEST

Installers generation process takes a few minutes.
Once ready, link to Collector installers will be sent to:
barbara@

10. Click OK. After the installer is generated by FortiEDR, it is emailed to the specified email address. Note
that the link to download installers is only available for several hours. Be sure to download the installers
within the required time period so that the link does not expire.

-

FortiEDR Collector Installers

Hello,

FortiEDR Collector installers are ready

Download Installer

Expires XF.Mar-H)

I the @eowe link does not work, oopy and paste the followdng URL
o your web browsar

Note that in the presence of an email filtering system and/or a mail transfer agent that modifies the URL
content, the installer download URL might include space(s) or %20s in it, that are added by the
system/agent. In these cases, browsing directly to the URL will fail with a signature error message from
the installer storage. In such cases, the URL should be amended to drop the redundant space/%20
before it can be used.
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Requesting and obtaining a mobile installer

On the Administration > Deployment > Collector page, you can click the Request Mobile Installer button (

) to obtain a mobile Collector installer file that can be used to install on Android and

iOS endpoints. The requested installer is then emailed to you. After you receive the installer file from
FortiEDR, simply scan the QR code provided in the email using the mobile endpoint and follow the
instructions attached in the email to install the mobile Collector.

Ay
‘Q' The Request Mobile Installer option is available only if mobile is enabled in the

organization setting. See Step 2 - Defining or importing an organization on page 419.

To request a mobile installer:

1.

N

For multi-tenant systems, verify the correct organization (to which the mobile Collector will be
registered) is selected at the top-left corner.

On the Administration > Deployment > Collector page, click Request Mobile Installer (

ng
). The following displays:

MOBILE INSTALLERS

Aggregator Address v

Qrganization

Domain ‘ ‘

Send installers link to |

( cancel )

In the Aggregator Address dropdown list, select the aggregator to which this Collector is registered.
Confirm the organization for the Collector to register with, if applicable.

To change the organization, you must exit the window and change it at the top-left corner of the
Central Manager console.

Specify the domain, which will be used for validation during account activation (see the FortiEDR
Android and iOS User Guide).

For example, if the domain is set to fortinet.com, the user must specify a valid username with a

matching Fortinet email address. Account activation will fail if the username fails the domain validation.

Specify the email of the recipient of the mobile Collector.
Click Send Request. The Android and iOS collector installers and instructions will be sent via email.
Click Close in the REQUEST MOBILE INSTALLER window.
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©® REQUEST MOBILE INSTALLER

Mobile installer request was sent. Installers generation process takes a
few minutes. Once ready, link to Mobile installers will be sent to:

Close

9. Inthe Send Installers Link To field, specify the email address to which the installer is to be sent.
10. Verify that the mobile Collector installers have been received in the specified email.
11. Follow the instructions to install the mobile Collector on desired Android or iOS devices.

activation.pdf .
] ] KB

FortiEDR Collector Installers

Hello,

FortiEDR Mobile Collector installers are available

o
" Android Collector ‘ Tos Collector

Instructions

1. Download the app from the relevant store using the above links
2. When launching the app an activation code will be required
3. scan the QR code attached

12. After the mobile Collector is installed, activate it using the registration code attached in the email.
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(Android only) After activation, the Collector automatically scans all files (including APKs) and
applications on the mobile device for potential vulnerabilities. You can also trigger a scan anytime or
schedule periodic scanning based on your needs (see File Scan on page 319). When a malicious
application or file is detected, executed, or installed, the Collector sends a notification and prevents the
execution or installation based on the policy setting. You can then view the details of the activity in the
Incidents menu of the FortiEDR Central Manager console.
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Multi-tenancy (organizations)

This chapter describes the operations that can be performed by an Administrator in a FortiEDR multi-
organization system.

This chapter is only relevant for administrators in a multi-organization system. If you do not have
Administrator rights, there is no need to read this chapter.

What is a multi-organization environment in
FortiEDR?

Beginning with 3.0, the FortiEDR system can be set up as a single-organization or multi-organization
environment. When set up as a single-organization system, the FortiEDR system and all its operations and
infrastructure serve a single tenant, called an organization in the FortiEDR system, and work as described in
all the previous chapters of this guide.

Ay
b ] L4
q Prior to 3.0, the FortiEDR system only supported a single tenant (organization).

In a multi-organization FortiEDR system, someone with Administrator rights can perform operations and
handle data for all organizations in the system. For example, think of a multi-organization environment like a
hotel chain, which has a parent company along with hotels in various cities. In this scenario, the ABC Hotel
corporate entity represents the main organization, and each ABC Hotel branch location represents a
separate, discrete organization. For example, ABC Hotel Los Angeles, ABC Hotel New York, ABC Hotel
Boston and so on.

FortiEDR uses organizations to distinguish between tenants in a multi-tenant environment. Each
organization uses the same FortiEDR user interface and shares the same FortiEDR database.

Multi-organization and user roles

FortiEDR uses a series of predefined roles to control access to organizational data, as follows:

Role Description

Admin Highest-level super user that can access all data and perform all operations in the
FortiEDR Central Manager console for one specific organization or all organizations,
as defined in the user settings.
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Role Description

In a FortiEDR multi-organization system, the system comes with one predefined
Administrator user. More than one user with the Admin role is permitted.

Prior to 3.0, the FortiEDR system only supported a single tenant

s";’, There must always be at least one Administrator in the system.
- (organization).

Senior Analyst Analysts supervisor who can define security policies in addition to all the actions that
can be performed by an Analyst.
Similar to admin users but without administration privileges. A senior analyst can
view all information and perform actions, such as marking security events as
handled, changing policies and defining exceptions, but cannot access the
Administration on page 277 tab.

Analyst SOC/MDR service analyst who can perform actions as required in the day-to-day
activities of handling events.

Similar to senior analyst users but without access to security configuration. An
analyst can view all information and perform actions, such as marking security
events as handled, but cannot access the ADMINISTRATION tab or define/change
policies.

IT IT staff who can define settings related to the FortiEDR integration with the customer
ecosystem.

This role has system configuration access only. They can deploy and upgrade
system components and perform system integration with external systems using the
ADMINISTRATION tab but do not have access to any security configuration, alert
monitoring, or Forensics options.

Read-Only Basic role with read-only access to all non-administrative functions.

Component registration in a multi-organization
environment

Collector registration

Each organization has its own registration password. The Collector installer specifies the Collector
organization name. If the Organization field is left empty during installation, the Collector is added to the
default Hoster account, as shown below:
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o

Collector Configuration ]
Aggregator Address: |_ Port: |Eﬂ3‘1

Registration Password: | sessssss

Organization:

Advanced:
] vDI (Vitual Desktop Infrastructure) installation

[] Use System Proxy Settings

Cancel < Back | @ Install

After registration, the Collector receives the organization ID. You can rename the organization if preferred.

To specify the organization when installing from a command line, run the following command:

msiexec..\qn ORG=<organization name> AGG=

For more details about Collector installation, see Installing FortiEDR Collectors on page 23.

Core registration

Most Cores are shared between organizations. It is possible to install a Core that belongs only to your
organization by installing it on-premises. In this case, you must specify the organization during the Core
installation process.

Collectors that do not belong to an organization cannot see that organization’s organization-specific Core.

For more details about Core installation, see Setting up the FortiEDR Core on page 511.
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Workflow

The following general workflow applies for Administrators when working in a FortiEDR multi-organization
system:

Logging In to a Multi-organization
System

Defining or Imperting an
Organization

Navigating Between

Organizations

Defining a Local Administrator for
an Organization

Performing Operations in the
FortiEDR System

Step 1-Logging in to a multi-organization system

For a FortiEDR multi-organization system, a user must also specify the organization when logging in to the
system.

FERTINET

A user must be defined for an organization in order to log in to that organization. When logging in, the user
must specify the organization name in the Organization Name dropdown list unless he/she is an
administrator with privileges to all organizations, in which case he/she is logged in to the main organization
by default without the need to specify an organization.
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Step 2 - Defining or importing an organization

The ORGANIZATIONS page lists all the organizations defined in the FortiEDR system.

ORGANIZATIONS

+ “
Bg Add Organization B8 Import Organization

Endpoints Licenses 10T Devices Licenses
NAME CAPACITY IN USE CAPACITY IN USE EXPIRATION DATE MIGRATION
Gartner2025 (hoster) 20 1® 100 53 02-Apr-2026
Mobile 5 10 0 13-May-2026
New 1 1 0 23-0ct-2025

Organization_WINDOWS_10_64_yKaPJLDJG 10 21-Jan-2026

Test 50 100 2 08-Apr-2026

By By Ee By B B
TH ME ME ME ME ME
LD S0 SR SR L Y
B &8 3 8 &

VerityloT 20 200 41 15-Apr-2026

The Default (hoster) organization is predefined in the system. This organization represents the main
organization in the system, such as the ABC Hotel chain described before. The Default (hoster) main
organization cannot be deleted.

The default organization can be accessed by an Administrator with permissions to the default organization
or to all organizations.

organization. To set up a multi-organization system, see Moving from a single-

s";’, In a single-organization system, the Default (hoster) organization is the only
- organization to multi-organization structure in FortiEDR on page 423 in FortiEDR.

The Organizations window contains the following information:

Field Definition

Name Specifies the name of the organization.

Endpoint Licenses Capacity For the organization, specifies the number of endpoint licenses (which
includes workstations and servers) allocated to the organization.

Endpoint Licenses in Use Specifies the number of endpoint licenses (which includes workstations
and servers) in use (installed).

loT Devices Capacity For the organization, specifies the maximum number of IoT devices that
can be detected in the organization.

IoT Devices in Use Specifies the number of 0T devices detected in the organization.

Expiration Date Specifies the expiration date of licenses for the organization.

Click the Edit button in an organization row to edit the properties of that organization.

You can delete an organization as long as it does not have any workstations or servers in use. Click the
-

Delete . button in an organization row to delete that organization.

=q:|
Click the Migrate Organization E"' button in an organization row to migrate that organization. For more
details, see Migrating an organization on page 425.
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To define an organization:

1. Click the ADMINISTRATION tab and then click ORGANIZATIONS in the left pane. The ORGANIZATIONS
page displays.
2. Click the Add Organization button. The following window displays:

ORGANIZATION DETAILS

MName

Serial Number

Registration Password

Confirm Password

Expiration date =

+ Vulnerability and loT Management
+ Threat Hunting
Repository storage add-ons E of 0 available globally

" exiended Detection
Maobile
Workloads

ORGANIZATION LICENSE CAPACITY

Endpoints out of 4 globally available

loT Devices ‘:I out of 579 globally available

|/-—-\\
[ Cancel )
., A

3. Fillin all fields in this window. All fields are mandatory.

Field Definition

Name Define the name of the organization. Supported characters in the
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Field Definition

Serial Number

Registration Password

Expiration Date

Vulnerability and loT
Management

FortiEDR 7.2.0 Administration Guide
Fortinet Inc.

organization name:
0123456789:=@ABCDEFGHIJKLMNOPQRSTUVWXYZ_
abcdefghijkimnopqgrstuvwxyz. Spaces are also allowed. For example,
you can specify the organization name of a hotel branch as ABC_
Hotel@Los Angeles.

Your FortiEDR unique identifier with Fortinet, which can be found at
the top of the Administration > Licensing tab.

Specifies the registration password for the organization. Each
organization can have a different registration password. You set the
value for this password.

Supported special characters in the password: !, #, %, &, +, -, ., /[, :, <,
=>2@/L\1L N L G) ~ and,

organization by selecting Administration> Settings>

s‘é’, You can display the registration password for an
- Component Authentication > Display.

If third-party software attempts to stop the FortiEDR
Collector service, the system prompts for the
registration password. This is the same password
Wy, used when installing the Collector. If an incorrect
‘?' password is supplied at the prompt, the message
- Access Denied displays on the Collector device. In this
- case, the FortiEDR Collector service is not stopped.
For more details about the required password to
supply in this situation, refer to Component
Authentication on page 316.

Specifies when this license expires. Notifications are sent to you
beforehand. Each organization can have its own expiration date.

If the Default (hoster) organization expiration date is
M/, earlier than that for the organization, then the
9 expiration date for the Default (hoster)organization
- applies. Whenever there is an expiration date conflict,
the earlier date always applies.

Check this checkbox for the organization to have access to these
features. This option is only available on setups that have purchased a
Discover and Protect license or Discover, Protect and Response
license.
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Field Definition

Threat Hunting

eXtended Detection

Mobile

Endpoint / IoT Devices
License Capacity

The various license types in FortiEDR enable access to
different FortiEDR features. The Administrator can
) s ’, configure the various organizations in a multi-tenant
9 environment to each have access to different features
- in the product. For example, Organization A may have
access to the Threat Hunting feature and Organization
B may not.

Check this checkbox to provide the organization access to threat
hunting. This option is only available on setups that have purchased a
Discover, Protect and Response or Protect and Response license.
¢ Repository storage add-ons: Specifies the number of repository
add ons, out of the total number of add on purchases, to enable
this organization to use.

Check this checkbox to give the organization access to this feature.
This option is only available on setups that have purchased an
eXtended Detection add on. See Licensing on page 277 for details on
how to check the license type.

Check this checkbox to enable mobile-related features. See Mobile on
page 261.

Specifies the number of license seats for the organization, meaning
the number of Collectors that can be installed in this organization.
Before allocating licenses to an organization, you may need to verify
the number of available licenses that can be distributed. All currently
unallocated licenses are available for allocation to an organization.
You cannot enter a number that is greater than the number of licenses
available for allocation.

The License Capacity field in the Licenses window
) s ’, shows the total number of license seats for the entire
9 FortiEDR system, which are divided into endpoints
- (which includes workstations and servers) and loT
devices.

The Default (hoster) organization initially receives the total allocation
of licenses. The Administrator is responsible for allocating these
licenses among organizations. In a single-organization FortiEDR
system, licenses do not need to be allocated between organizations,
as there is only one organization.

4. Click the Save button. Note that it may take a minute or so to create the organization.
After creating the organization, the organization appears as a new row in the Organization dropdown

list.
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Hoster View

Incidents % proc

PUP
40

Overview Evi

If a user attempts to use a feature that is not available with their license, a
warning message displays. For example, as shown below.

X

Threat Hunting license was not purchased

ot more detais

Moving from a single-organization to multi-organization structure
in FortiEDR

In a single-organization system, the Default (hoster) organization is the only organization.

To create a multi-organization (multi-tenant) system, an Administrator simply needs to add one or more
organizations to a single-organization system. When there are multiple organizations in the system, you can
select the organization of interest in the Organization dropdown menu that appears at the top left of the
window, as described below.

Step 3 - Navigating between organizations

In a multi-organization system, all types of information are now organized per organization.

Administrators can view information in the FortiEDR system for a specific organization or for all
organizations together. To do so, use one of the following methods:

a. Select the Hoster view in the Organization dropdown menu at the top left of the window to display
information for all organizations together. For more details about Hoster view, see Hoster view on page

434.
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b. Select the organization of interest in the Organization dropdown list.

Hoster View

Incidents proc

| s

4(

PUP

Overview Ei

In Hoster view, each row in the Organizations pane represents a different organization. Note that after
you select an organization, the entire user interface only shows information for that organization.

If that multiple web browser tabs or windows are opened on the same device and

NP each of them navigates to a different organization on the FortiEDR Central
‘?' Manager Console, they all show the data of the same organization, which is the
- last organization that was selected in the Organization dropdown list. In this

case, the dropdown may look as if it points to Organization A however the data
would be of Organization B.

Step 4 - Defining an Administrator for an organization

Administrators can create one or more Administrators for an organization or for all organizations. You
should define at least one Administrator for each organization.

To define an Administrator for an organization:

1. In Hoster view, click the ADMINISTRATION tab and then click USERS in the left pane.
2. Click the Add User button.
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3. Select the organization in the Organization field, as shown below.

USER DETAILS

Organization demo521 .
User Name All organizations
Title + demo521
First Name ANS
Last Name Google
lior

Email Address

Password | moshe_A |
Confirm Password | |
Role Admin -
Advanced Rest API Custom script

Establish FortiEDR Connect sessions

Require two factor authentication for this user

( cancel )

4. Fillin the displayed window, as described in Users on page 277.
5. Click Save.

Step 5 - Performing operations in the FortiEDR system

Administrators can perform all of the operations described from Security Settings on page 196 to Threat
Hunting on page 125 in this guide using the user interface of the FortiEDR Central Manager for all
organizations in the system.

Administrators can monitor the system per organization or using Hoster view, which shows data for all
organizations together.

Migrating an organization

FortiEDR’s Consolidation feature enables you to copy all the data and definitions within an organization from
one environment to another environment. This feature copies an organization from one environment
(source setup/environment) to another (destination setup/environment). The copy operation adds to the
content in the destination environment, and does not replace the target’s existing content.
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A\,

b ] L4
q This feature is only available to Administrators.

Organization migration involves three steps, which are described in detail in the procedure below.

To migrate an organization:

1. Click the ADMINISTRATION tab and then click ORGANIZATIONS in the left pane. The Organizations

window displays.

ORGANIZATIONS
YT Jur—
Endpoints Licenses loT Devices Licenses

NAME CAPACITY IN USE CAPACITY IN USE EXPIRATION DATE
Gartner2025 (hoster) 20 14 100 53 02-Apr-2026

New 1 0 1 0 23-Oct-2025

Test 50 2 100 43 08-Apr-2026

VerifyloT 20 2 200 47 15-Apr-2026

-3

2. Click the Migrate organization E * button in the row of the source organization that you want to copy

to another environment. The following window displays:
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MIGRATE ORGANIZATION
(1] 2 3

Export organization Import organization Transfer collectors

ts collectors from the source
environment

Export organization

Setan organization name in the destination environment

organization100 w

From this window, you perform three steps to migrate the organization to another environment:
a. Export the Organization: This step exports all the data of the selected organization to a zip file.

b. This step imports all the organization’s data using the zip file exported in step 1. Note that this step
is performed on the destination environment.
c. This step moves all the Collectors of the selected organization from the source environment to the
destination environment.
3. Inthe Export organization field, specify the name of the organization to appear for this data in the
destination environment. Make sure that you assign an organization name that does not already exist in
the destination environment.

4. Click the Export button. All the data and definitions for the organization are exported to a zip file. The

zip file is named as follows: <source organization name>_<environment name>_FortiEDR_<timestamp>_

Export.zip. For example, ad_localhost.localdomain_enSilo Feb.05.2019 Export.zip.
After the export completes, a Download link displays in the window:

Export organization

LAV A VAL L LV TERA AV AL AN N
Data for the § organization was generated successfully

Download

FortiEDR 7.2.0 Administration Guide
Fortinet Inc.

427



Multi-tenancy (organizations)

Ay
b ] L4
q You can cancel the migration process at any time by clicking the Abort button.

5. Click the Download link to download the exported zip file.

Click the Close button if you want to close this window and continue the
migration process at a later time. This action saves the relevant organizational
Y data. You can later continue this migration process by using the Continue

b ] L4 _)E
q Migration B¢ “°™ putton.

If you click the Close button before downloading the exported zip file, a warning
displays. In this case, you must perform the migration process again from the
beginning.

6. Click Next. The following window displays:

MIGRATE ORGANIZATION

o e 3
Export organization Import organization Transfer collectors

ts collectors to the destinatlon
environment

Import organization
Log in to the system to which you migrate the organization and perform "Impaort organization” using

the exported file from the previous step.
Please enter the code you have received at the end of the import organization process.

Import code

( Aport ) ( Close )

7. Login to the destination environment.
8. Click the ADMINISTRATION tab and then click ORGANIZATIONS in the left pane.
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9. Inthe ORGANIZATIONS page, click the Import Organization button. The following window displays:

IMPORT ORGANIZATION

Load organization file

10. Select the exported zip file to load and then click Import. This step copies all the data and environment
definitions of the exported organization.

You cannot import an exported organization that has a name that already exists
in the destination environment.
To import an organization, the FortiEDR platform version must be the same in
M, both the source and destination environments.

q The content version must be the same in both the source and destination

= environments. You can see the Content Version at the bottom of the Licensing
on page 277 window.
You must have sufficient workstation and server licenses in the destination
environment.

At the end of the import process, the Import Organization window displays a code. Write down this
code, as it will be entered later as part of the migration process.
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IMPORT ORGANIZATION
" SSsSssesaweswaswasas

org A organization was successfully imported.
Import code: 14560

Use this code for verification in the Migrate Organization process at
the source environment

Close
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The Import code also displays in the Organization Details window, which you can
display at any time by clicking the Edit button in an organization row in the
Organizations window.

ORGANIZATION DETAILS

Name org A
Registration Password [sssssess
Expiration date 01-01-2020
‘\é', Workstations allocated (500 6580 available for allocation)
- Servers allocated SO0 6580 available for allocation

mported organization (import code - 14560)

=

[ Cancel )

Note that the name of the organization cannot be changed in this window, and is read-only.
11. In step 2 of the Migrate Organization window, enter or copy the import code into the Import code field.

If you previously closed the Migrate Organization window, then click the Continue

3
Migration B Cont button in the source organization row in the ORGANIZATIONS
page.

Ay

A s ORGANIZATIONS
-—

-

E
« & & « ¢
[

-»
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12. Click Next. The following window displays:

13.

MIGRATE ORGANIZATION

o o

Export organization

Transfer collectors

Transfer all collectors of the org organization to the org A organization in the destination environment

FROM:

Aggregator Fortinet (127.0.0.1:8081)

@ Important! Verify that the aggregator
details are valid

( Abor

Import organization

©

source environment to th
estination environment

TO:

Aggregator Address

Transfer collectors

| Close )

In this window, you move the Collectors from the source environment to the destination environment.

The Collectors cannot be registered to both environments at the same time.

Note that until this step is completed, the Collectors are still registered to the organization in the source
environment and their status and security events are displayed there. In the destination environment,
Collectors are displayed with the Pending Migration state, as shown in the Inventory window. This state
indicates that the Collector has not yet been transferred from the source environment to this
environment. Collectors in the Pending Migration state are still registered to the source environment.

COLLECTORS (2/2)
Al v $% Create Group ove to Group Delete ¥ Enable/Disable ¥ solate ¥

COLLECTOR GROUP NAME DEVICE NAME

... High Security Collector Group
= (0/0)

Default Collector Group.

(2/2)

Collector1

MICHAL-COL

Specify the Aggregator Address in the To field.

Collectors in the destination environment.
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Export ¥ Uninstal

LAST LOGGED os 3

COLLECTORT\root  Windows 10 Home 10.51.121.231

windows 10
MICHAL-COL\root enterprise 20161755 1051121113

VERSION

41052

3.1.0.425

A\ 178 Unmanaged devices were found

STATE LAST SEEN

Running
Now
(Autonomously)
Disconnected
® (Pending 4days ago
Migration)

Each Collector is connected to one Aggregator. In this
field, you specify the IP address or DNS name and the port of the Aggregator that will service the
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Transfer collectors

Transfer all collectors of the org organization to the org A organization in the destination environment

FROM: TC:

Agzregator Fortinet (127.0.0.1:8081) Aggregator Address

14. Click the Transfer button. The Collectors are transferred from the organization in the source
environment to the organization in the destination environment. A progress indicator counter displays

as the Collectors are transferred.
I ———— (D The organization is in the midst of a migration process. 1/ 2 collectors have already been transferred T E—————————.,

\NIZATIONS

.
4d Organization [ Import Organization

Workstations Licenses Servers Licenses 10T Devices Licenses
e CAPACITY IN USE CAPACITY IN USE CAPACITY IN USE EXPIRATION DATE MIGRATION
ult (hoster) 10000 s 10000 0 2000 209 02-Feb-2021 EE
1 o 1 ] 1 0 7Fep2020 B con.

The progress indicator counter continues to display until the organization is
deleted in the source environment, which is recommended after all Collectors

) ! ’, have been transferred from the source environment to the destination
9 environment. See step 16 below.
= If you click the Abort button at this step, any Collectors already transferred from

the source environment to the destination environment remain in the destination
environment.

After a Collector has been transferred from the source environment to the destination environment, its

state is Migrated in the source environment, and is Running (functional) in the destination environment.
T — (@ The organization is in the midst of a migration process. 1/ 2 collectors have already been transferred T —

COLLECTORS (2/2) Search Collectors or Groups ¥ Q
Al v | 8% create Group ove to Group Delete v Enable/Disable ¥ solate ¥ Export ¥ Uninsta A 183 Unmanaged devices were found
COLLECTOR GROUP NAME DEVICE NAME LAST LOGGED 0s P MAC ADDRESS VERSION STATE LAST SEEN

- High Security Collector Group

Default Collector Group
(@12)
Disconnected

Collector? COLLECTORT\root  Windows 10 Home 10.51.121.231 00-50-56-BE-77-E1 41.052 [ ] (Migrated) Today

Windows 10
MICHAL-COL MICHAL-COL\root 10.51.121.13 00-50-56-8F-E5-76 3.1.0.425 Disconnected 4 days ago
Enterprise 2016 LTSB L Vs ag

Ay
S L 4
9 Collector protection remains in effect throughout the entire migration process.

15. (Optional) Click the Stop Transfer button to pause the Collector transfer process. You can resume the
transfer process by clicking the Transfer button again.
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If a user enters the source organization while a migration process is in progress
for it, a warning displays. Any changes made by this user will not be migrated or
included in the destination organization. Any changes made to an organization
while it is being migrated are ultimately lost.

MIGRATION PROCESS

A

b ] L4
q The organization is being migrated to a new environment. Your
- work on this organization will not be saved. For more details
please contact support.

16. After all the Collectors were successfully migrated from the organization on the source environment to
the organization on the destination environment, delete the source organization. To do so, select the
Administration tab and then click Organizations in the left pane. In the Organizations window, click the
Delete button in the row of the source organization to be removed.

Al
‘Q' Collector protection and functionality remain throughout the entire migration

process.

Hoster view

When you select Hoster view in the Organization dropdown list, all windows in the user interface are
affected. In general, this view shows aggregated data for all organizations.

However, some data is only available in Hoster view, such as the following:

e Export Settings: In a multi-organization system, SMTP-related information is only displayed in Hoster
view.
» Administration > Settings: The Session Time Out setting is available only in Hoster view.

In addition, there are some special cases where you cannot view administration data in Hoster view, and
can only view data for a specific organization, such as the following:
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e Component Authentication
» Automatic Updates

» End User Notifications

» Periodic Scan

Many of the windows that display aggregated data for all organizations have some special features when
displaying data in Hoster view. In general, in Hoster view, these windows have an additional column or field,
and require that you specify the organization in order to add the item. Several examples are provided below.
The examples below are not all-inclusive.

Licensing

When in Hoster view, the Licensing window shows aggregated information for all organizations.

Licensing

stallation ID Name Serial Number Expiration Date:

Endpoints License Type + Discover
« Protect
* Response

License Capacity 20 Seats

eXtended Detection v
Communication Control v

Forensics v

Threat Hunting ~ v No Repository storage add-ons

Estimated Threat Hunting Data Retention: 182 days (4% of the storage is utilized)

Vulnerability Management v

For example, the Workstations and Servers diagrams indicate the number of allocated and available
licenses for all workstations and servers, respectively, in the entire FortiEDR system. The Licenses in Use
numbers represent the number of Collectors that have been installed out of the total permitted to be
installed.

The Load Content option loads content to all organizations. Once loaded, the new configuration applies to
all organizations, including new Collector installers. However, Collectors are not being updated yet.

When in this view, you cannot load content to a specific organization.

When you click the Update Collectors button in the Licensing window, the Update Collector Version window
displays, and includes an Organization Name column. Use the checkboxes in this column to update the
organization for a Collector Group. All other functionality in this window works in the standard manner.
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UPDATE COLLECTOR VERSION

ORGANIZATION NAME COLLECTOR GROUP o WINDOWS VERSION MACOS VERSION LINUX VERSION
lorgolfad4 Default Collector Group 410Rev. 23 315Rev. 14 315Rev. 72 '
liorgolfa44 emulation N/A N/A N/A
| liorgolfad4 group’ 410Rev. 23 315Rev. 14 315Rev. 72
liorgolfaaa group2 410Rev. 23 315Rev 14 315Rev. 72
! liorgolfaaa High Security Collector Group ~ 4.1-0Rev. 23 31.5Rev. 14 3.1.5Rev.72
lorgolfasa Insiders 410Rev. 23 315Rev. 14 315Rev. 72
I lorgolfa4 Linux 4.10Rev. 23 315Rev. 14 3.15Rev.72

Update 0 selected groups 10

Windows version 4.0.1 Rev. 153 macOs version  3.1.5Rev. 14 Linux version 3.1.5Rev.72

{ Note: Version update involves sending 10Mb of data from the Central Manager to each Collector.

Users

In Hoster view, this window includes an Organization column.

Users €83 Password Policy
Local Users LDAP Authentication ~ SAML Authentication
+ Add User Search Usel Q
50 results
User Name Organization First Name Last Name Email Address Role Role Capability Password 2FA oon
Senior Analyst Rest API ek Always
All organizations Admin wermeiar Disabled
All organizations Admin FOrtiEDR Gonnect ek Always
All organizations Admin Rest API ey Always
All organizations Admin Custom script, FOrtiEDR Connect  *ress Disabled
All organizations Admin Rest API, Custom script, FortiE..  *ss Disabled
All organizations Admin FOrtiEDR Connect wermear Weekdy
All organizations Admin ek Always
All organizations Admin wermeiar Always
All organizations Read-Only ek Always
All organizations Admin Rest API kkkak Always
All organizations Admin Rest API Rt Disabled

When you click the Add User button from this window, you must specify the Organization field . You can
assign the user to one specific organization or All organizations.
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All Organizationd)

Role Capability

Al Organizations

Settings

In Hoster view, the Administration > Settings page only includes the Audit Trail on page 314 and Session

Time Out sections.

Senior Analyst

Admin

Admin

Admin

825 FortiEDR | Hosterview| Dashboard  Incidents  Threat Hunting  Communication Control v

RestAPI

FOrtiEDR Connect

Rest APl

ffffffff

¢¢¢¢¢¢¢¢

Administration v

2FA

Disabled

Always

Disabled

Always

Always

000

Settings
Audit Trail

v Session Time Out

The Session Time Out section is specific to hoster view and can be used to configure the idle session
timeout period, which is the duration (in minutes) before a session expires and users are prompted for
credentials. The session timeout setting applies to all FortiEDR Console tabs except Dashboard. The default

is 15 minutes. The acceptable value range is 1 - 1440.

The following sections are unavailable in the Administration > Settings page in Hoster view:

» Component Authentication on page 316

« File Scan on page 319

» End Users Notifications on page 320

e Personal Data Handling on page 325

» |oT Device Discovery on page 331

¢ Windows Security Center on page 333

» Application Control Manager on page 334
e FortiEDR Connect on page 334

Dashboard

In Hoster view, some information does not display in the Dashboard. The information that does display is
aggregated for all organizations, such as Collectors, System Components, Repositories and so on, as

shown below.
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S75 FortiEDR | HosterView Dashboard  Incidents  ThreatHunting  Communication Control v Security Settings v Inventory v Administration v

Hoster view

To view Dashboard information for a specific organization, you must select the organization of interest in
the Organization dropdown list at the top left corner.

Incidents

In Hoster view, the Incidents tab displays the security events from all organizations. The Organization
column indicates the organization in which the security event occurred.

FortiEDR ‘ Hoster View Dashboard Incidents Threat Hunting Communication Control v Security Settings v Inventory v Administration v

Incidents Exception Manager >
Starus Tipe Lost Seer
All v All - Last 30 days - Vs (e Q
All Incidents  Mobile Incidents
103 results
Classifi..  Incident Num. of Ev..  Status D Assigned to Device Organization| ~First Seen Last Seen (11}
@ * 1 Unhandled =
1 Unhandled =
* 1 Unhandled =
L 1 Unhandled =
@ L] 1 Unhandled =
= ¥ 2 unhandled =
2 Unhandled =
L] 1 Unhandled =
@ 1 Unhandled =
@ 1 unhandled =
] - ) linhandled -
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Ay
‘Q' The same security event can occur in multiple organizations. In this case, it is
displayed in separate rows per organization.

The various options in the toolbar can be applied on multiple organizations simultaneously. For example,
you can handle security events from different organizations at once using the Handle Incident button and
you can export security events from different organizations using the Export button.

You can also use the Handle Incident button to handle security events from multiple organizations.

Threat Hunting

In Hoster view, this window includes an Organization column.

THREAT HUNTING
careoR oevce B e
V' ancategories v All Devices v Last hour ~
v
All Activity (3.1K)  Process (266)  File (787)  Network(534)  Registry (1.3K)  Log (199,
000 choose Columns
DEVICE
ORGANIZATION NAME CATEGO! TIME ~ os NAME TYPE BEHAVIOR ~ PROCESS AND ATTRIBUTES TARGET ~ EVENTATTRIBUTES

3 28rFep202417 Win-1064...  File Read splunkd exe D % = ocalmeta  Jogis” Program Fie..

[@  2sFeb202a17 Win-10-64.  File Read splunkd exe S derautmeta 004 Eﬂ);]ram e 0

[ 2sFep202a17 Win-10-64...  File Read splunkd exe 3 % & localmeta  300as " Program File..

[@  28Feb2o2a17 Win-10-64.  File Read splunkd exe SN -A app.cont Joeas ” E?I);]ram e F

[ 2s-Fep-202417 Win-10-64...  File Read splunkd exe 2% 6 appcont Sosas " ProgiamFie.

[@  28Feb2o2a17 Win-10-64.  File Read splunkd exe SR A app.conf Josas E‘rg;"am e S

[2  2sFepa02s17 Win-10-64...  File Read splunkd exe 28 6= appcont Jooss " Programeie

o SOURCEPID  REGISTRY PATH

28-Fen-2024 17 Win-81-64..  Value Read flebeat exe e T SOETWARE Classest

Communication Control

The Communication Control window is not available in Hoster view.

Security settings

SECURITY POLICIES page

In Hoster view, the SECURITY POLICIES page displays all policies from all organizations.

FortiEDR 7.2.0 Administration Guide 439
Fortinet Inc.



Multi-tenancy (organizations)

SECURITY POLICIES Showing 1-10/103 | »| [m| | Search ~Q ASSIGNED COLLECTOR GROUPS
- A ORGANIZATION POLICY NAME RULE NAME ACTION STATE
> A @ Execution Prevention e
3 A_ Mgy Exfiltration Prevention (&)
> A & ransomware Prevention  Furmner (@
4 A & Device Control FoRmnEr (g
> A_Big_Bank @ Execution Prevention @
> A_Big_Bank Ry Exfiltration Prevention e
b A_Big_Bank £ ransomware prevention ®
3 A_Big_Bank & Device Control FERNNET (T
b A_Big_Bank @ Block-Execution Preventi. @
3 A_Big_Bank M Block-Exfiltration Preven.. (@)

FortiEDR’s multi-organization feature enables you to clone a security policy from one organization to
another. To do so, you must be in Hoster view. When not in Hoster view, you can only clone a policy within
the same organization.

AUTOMATED INCIDENT RESPONSE - PLAYBOOKS page

In Hoster view, you can view all the notifications for the entire organization, based on the actions defined in
the Hoster Notifications Playbook. This Playbook policy is only available in Hoster view.

AUTOMATED INCIDENT RESPONSE - PLAYBOOKS ASSIGNED COLLECTOR GROUPS
+ & #
NAME MALICIOUS SUSPICIOUS PUP INCONCLUSIVE IKELY SAFE
" ] Hoster notficato. werer

=]

Formrer @)
remmrer (C8)
Farmer (@)
rammrer (@)

> ADVANCED PLAYBOOKS DATA

Exception Manager

In Hoster view, the Exception Manager page displays all exceptions from all organizations.
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EXCEPTION MANAGER

Advanced
Showing 1-10/201 | » || »1
PROCESS PATH EXECUTED WITH PATH RULES ORGANIZATION ~ COLLECTORGROUPS ~ DESTINATIONS USERS LAST UPDATED =
663219 EXCEL.EXE Any path Suspicious Macro ensilo High Security Collector ... 92.122.136.167 All Users 06-Nov-2020, 17:45 He
by: Barbara
30558956  netsh.exe \Windows\System32  PanGpHip.exe Any path Suspicious Script Execution  ensilo Al groups of ensilo All Destinations All users 23-Mar-2020, 09:47 =2
by: Tzaf
665954 OfficeTimelinestartUp.e... Any path Unconfirmed Executable  enSilo Allgroups of enSile Internal Destinations... All Users 23-0ct-2018, 19:05 =
by: Tzafit
OfficeTimelinestartUp.e... Any path Unconfirmed Executable
666041 e LR Maktub PUP ensilo Al groups of ensilo 167.114.64.227 Al Users 23-0ct-2018, 18:51 B
by: Tzafit
m e LR Maktub PUP
maktubransomware.exe .\Ransomware.Maktub PUP
442648 camstudio.exe ..sers\TM.CDE\Desktop Malicious File Detected All Organizations  All Collector Groups Internal Destinations... All Users 25-5ep-2018, 23:16 H4
by: Tzafit

When creating an exception in Hoster view, the organization in which the security event occurred is also
shown in the Exception Creation window, as well as the event ID.
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EVENT EXCEPTIONS

Exceptions for event 663219 from enSilo organization

Last updated at 05-Oct-2020, 11:45 By Einat

Exception 1 +

Created from event 663219

Collector groups

®) | High Security Collector Gro... = All groups (enSilo) All organizations

Destinations

52,122.136.167 @ All destinations

Users

Triggered Rules:

CLL)

D Suspicious Macro

Type comments

Remove Exception

|/- -\u
| Cancel |
L A

The Exception Manager page also shows the organization to which the exception applies. In addition, the
Collector Groups column indicates the Collector Groups to which the exception applies.
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EXCEPTION MANAGER

Search Exception Advanced
Delete Expo Showing 1-10/201 | » || »1
NT EXECUTED WITH PATH RULES ORGANIZATION ~ COLLECTORGROUPS  DESTINATIONS USERS LAST UPDATED »
663219 EXCELEXE Any path Suspicious Macro ensilo High Security Collector ... p2.122.136.167 All Users 06NOV-2020,1745 B4
by: Barbara
30558956 netsh.exe \Windows\System32  PanGpHip.exe Any path Suspicious Script Execution|  ensilo Al groups of ensilo Il Destinations All Users 23-Mar-2020, 09:47 H4
by: Tzaf
665954 OfficeTimelinestartUp.e... Any path Uncenfirmed Executable ensilo All groups of ensilo nternal Destinations... All Users 23-0ct-2018, 19:05 ®
by: Tzafit
OfficeTimelinestartup.¢... Any path Unconfirmed Executable
666041 m . Maktub PUP ensilo All groups of ensilo 67.114.64.227 All Users 23-0ct-2018, 18:51 1
by: Tzafit
maktubransomware.exe ..\Ransomware.Maktub PUP
maktubransomware.exe ..\Ransomware.Maktub PUP
42648 camstudio.exe sers\TM.CDE\Desktop Malicious File Detected All Organizations  All Collector Groups Internal Destinations... All Users 25.5ep-2018, 23116 -4
by: Tzafit
In Hoster view, the Assets > Inventory page shows all the Collectors from all organizations.
Colectors v || Anstatuses v + Add Group Q
235 results
Organization  Name Assigned policy 000

max
Open

lena g 0 2 R
lena O =@ @

MOAB

Open Default Collector Group )] G = @
Qa1 Defaut Collector Group [= I P

lena Default Collector Group £ ) 2
ORG_c51 Defaut Collector Group 2 R &
ORG_fcbd9.. Default Collector Group 3 @ Q
ORG_33f1d. Default Collector Group b @

ORG_6 Default Collector Group =2 R
ORG_e34a. Default Collector Group ) @ @

When in Hoster view, you can move Collectors between organizations using this window.

M, Only Collectors from 3.0 and above can be in the non-default organization. All older
q Collectors can only be installed in the default organization.

Only Collectors from 3.0 and above can be moved between organizations.
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To move a Collector between organizations in Hoster view:

1.

Check the checkbox of the Collector Group or check the checkbox(es) of one or more Collectors.

Collectors v All statuses N + Add Group

Organization  Name Assigned policy

adrien Default Collector Group

. @v SRERNCI

B Name Moveto Group | Status Disk encryption DEVICE SECURITY LASTLOGGED os P MAC ADDRESS

® Disconnected Disabled NA

B Running Disabled N/A

Click the Move to group button. The following window displays:

Move Collectors

Moving 1 workstations to:

Cancel

000

LASTSE.. =| 000
Today

Now

In the Organization field, select the organization to which to move the Collector(s).

Click Move.
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Troubleshooting

This chapter describes how to troubleshoot various problems that you may encounter in the FortiEDR

system.
NP For debugging and troubleshooting, Fortinet Support may request that you provide
‘Q' the logs for the FortiEDR devices deployed in your organization (Collectors, Cores,
- Aggregators). You may refer to Exporting logs on page 273 for details about how to
= do so.
& ! /, If your system includes the Forensics add-on, you can use the Retrieve Memory
? function to retrieve memory related to a specific stack on a specific Collector. For
- more details, you may refer to Retrieving memory on page 100.

A FortiEDR Collector does not display in the
INVENTORY tab

After a FortiEDR Collector is first launched, it registers with the FortiEDR Central Manager and is displayed
in the INVENTORY tab. If it does not appear to have registered, then perform the following:

1. Check that the device on which the FortiEDR Collector is installed is powered on and has an Internet
connection.

2. Validate that ports 8081 and 555 are available and that no other third-party product is blocking these
ports.

No events on the FortiEDR Central Manager console

If no events are displayed in the FortiEDR Central manager console, then perform the following.

Validate that there is network connectivity between all the system components.

To do so, we recommend:

¢ Running Telnet on the FortiEDR Collector and connecting to the FortiEDR Core IP via port 555.
e Running Telnet on the FortiEDR Core and attempting to connect to the FortiEDR Aggregator IP on port

8081.
A\,
S r'd
? Make sure that Telnet is enabled on Windows.
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User cannot communicate externally or files
modification activity is blocked

Microsoft Windows-based devices

The Windows Event Viewer records whenever a FortiEDR Collector blocks communication from a device or
file modification related to ransomware activity. This information is recorded in the Windows Event Viewer
log located in the following location: Event Viewer > Windows Logs > Application.

{8 Event Viewer — [u] X
File Action View Help

= 7w BE

[2] Event Viewer (Local)
_-i, Custom Views

Application Number of events: 1,436 Actions
e ——

- -‘ Windows Logs Level Date and Time Source EventID Task Category ~ | | Application -~
{] Application ()Information  1/26/2020 5:21:34 PM EventSystem 4625 None 7= Open Saved Log...
=] Security (@) Information  1/2/2020 10:38:53 AM EventSystem 4625 MNone W Create Custom View...
] Setup ¢l Information  2/6/2020 6:55:18 PM FortiEDR Collector Import Custom View...
] System @ Information  2/6/2020 £:55:19 PM FortiEDR Collector 20 MNene
] Forwarded Events () Information  2/6/2020 £:55:21 PM FortiEDR Collector 20 None Clear Log...
» . Applications and Services Lo (D Information  2/6/2020 2:11:49 PM FortiEDR Collector 10 None ¥ Filter Current Log...
. Subscriptions (DInformation  2/6/2020 4:56:20 PM FortiEDR Collector 70 None ] Properties
(i)Information  2/6/2020 £:55:15 PM FortiEDR Collector 20 None P—
® Information  2/6/2020 £:55:22 PM FortiEDR Collector 10 None % Find...
()Information  2/4/2020 7:13:11 PM FortiEDR Collector 10 None I Save All Events As..
® Information  2/4/2020 3:24:02 PM FortiEDR Collector 70 MNone Attach a Task To this L...
()Information  2/6/2020 7:42:21 PM FortiEDR Collector 70 None View N
()Information  2/6/2020 6:55:23 PM FortiEDR Collector 20 None
@ Information  2/6/2020 £:55:25 PM FortiEDR Collector 20 MNene & Refresh
@ Information  2/6/2020 6:55:27 PM FortiEDR Collector 20 None ﬂ Help »
@ Information  1/13/2020 4:06:07 PM Msilnstaller 11707 MNone .
(@) Information  1/13/2020 402:17 PM Msilnstaller 1040 None v E:"ZO' FortiEDR Collector =
(-] Event Properties
Event 20, FortiEDR Collector x g Attach Task To This Eve...
General Details 5z Copy »
~ el Save Selected Events...
Internet access blocked for process \Device\HarddiskVolume2\Windows\System32
\browser_broker.exe (PID 6848) | Refresh
EH Hep 4
Log Name: Application
Source: FortiEDR Collector Logged: 2/6/2020 6:55:18 PM
Event ID: 20 Task Category: None
Level: Information Keywords: Classic
< o lear N/A Camniter rollactnr? v

macOS-based devices

The mconsole records whenever a FortiEDR Collector blocks communication from a device or file
modification related to ransomware activity. This information is recorded in the macOS console log located
in the following location: Applications > Utilities > Console > All Messages, as shown below:
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Feb 26 20:06:50 Mac7@ fortiEDRCollector[3654]: Fortinet Endpoint Detection and Response: Connection blocked for process /System/Library/PrivateFrameworks/
IMFoundation.framework/XPCServices/IMRemoteURLConnectionAgent.xpc/Contents/Mac0S/IMRemoteURLConnectionAgent (pid:3813)
Feb 26 20:06:51 --- last message repeated 2 times —--——

Feb 26 20:86:51 Mac7@ fortiEDRCollector[3654]: Fortinet Endpoint Detection and Response: Connection blocked for process /System/Library/PrivateFrameworks/

IMFoundation. framework/XPCServices/IMRemoteURLConnectionAgent.xpc/Contents/Mac0S/IMRemoteURLConnectionAgent (pid:3814)

Threat Hunting tab does not show expected
activity events

If the Threat Hunting tab does not show expected activity events after installation, perform the following
troubleshooting steps:

1.
2.

Check which Collectors group the triggering device belongs to.

Check the Threat Hunting Collection profile assigned to this group and make sure the profile includes
the activity events you are searching for in the Threat Hunting tab.

If the profile includes the activity events but the Threat Hunting tab still does not show them, check the
installation status of the Threat Hunting repository by running the kubectl get pods -n edr2-onprem
command in the Threat Hunting repository console.

Verify the status is Running for all entries. See example below. Otherwise, reinstall the Threat Hunting
repository.

masterl [T1# kubectl get pods —m edrZ-onprem

NAME STATUS RESTARTS AGE
edrZ-onprem—edr-streamer-c4d4dc9f4-25=cqg Rumming S4m
edrZ-onprem—edr-streaner—c4d4dcIf4-unw2r Runming S6m
edrZ-onpren—edr-streaner—s ink-5d47?9bd87c4-2r506m Runming Sdm
edrZ-onpren—edr-streaner—sink-5479bd87c4-66plhb Runming Sedm
edrZ-onprem—entity-operator-56855b7b8d-grmZm Runmning 6d14h
edrZ-onprem—kafka-0 Running 6d14h

edrZ-onprem—kafka-exporter-bc648bhchS-vbut9 Runmning 6d14h
edrZ-onpren—-niddleware-5d4f46877bo—uwg 1x6 Rumning S57m

edrZ-onprem—od-kibana—-8567c97c88-m9g1x Rumning 6d14h
edrZ-onprem—od-master-0 Rumming 6d14h
edrZ-onprem—od-opend istrovarn-data-0 Rumming 6d14h
edrZ-onprem—zookeeper-0 Runming 6d14h
suclb-edrZ-onpren—niddleware—xtfom Runming 6d14h

Collector is slow or hangs

If an endpoint is slow or hangs, check the Collector logs. It might be caused by collision with another AV
product that FortiEDR is running in parallel with. You can fix the collision by excluding AV exceptions in both
FortiEDR and the other AV product.
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Appendix A - Setting up an email feed
for open ticket

The Open Ticket feature enables you to send events to an event-management tool such as Jira or

ServiceNow.

In order for the Open Ticket feature to work properly, you must set up a receiving email feed in the event-
management tool to be used. This appendix provides an example that describes how to set up the required
email feed in ServiceNow.

To set up an email feed in ServiceNow:

1. Launch ServiceNow.
2. Inthe window that opens, select System Properties > Email Properties. The following window displays:

service

(7 system pro

= *
Basic Configuration UI16
My Company
Ul Properties
Mobile Ul Properties
Tablet Ul Properties
Css
System
Email Properties

Import Export

Approval Engines

LDAP

SLA

Service Management

Email Properties

Email accounts can be created or modified in the Email Accounts table.
Email account ion status and

ion can be found on the Email Diagnostics page.

Outbound Email Configuration

Email sending enabled (7)

[@)¥es | No

Send all email to this test email address (non-production testing) (3)

Append timezone to dates and times in sent email (3)

@ Yes | No

Create visible watermark in sent email. If false, create invisible watermark via hidden div tag. ()

@ Yes | No

Resend email if server retumns these SMTP error codes (3)

421,450,451,452

Do not resend emailif server returns these SMTP error codes ()

500,501,502,503,504,550,551,552,553,554

Resend email when server returns unknown SMTP error codes. ()

wYes | No
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Inbound Email Configuration

Email receiving enabled (2)

@ Yes|No

Identify email as a reply by these subject prefixes (3)

re:,aw:,r:,Accepted: Tentative:,Declined:

Identify email as a forward by these subject prefixes (3)

fw:, fwd:

Discard everything below this text if found in a reply bady (comma separated, case sensitive) (2)

\n\n——Original Message-——\n\n \n\nFrom:

Ignore mail with these headers (comma separated name:value pairs) (2)

X-ServiceNow-Spam-Flag:YES X-ServiceNow-Virus:INFECTED,Auto-Subm

Ignore email when subject starts with text (comma separated, case insensitive) (%)

out of office autoreply, undeliverable:, delivery failure: returned mail;,au

Ignore email from these senders. Use the name before the @ sign. (comma-separated) (2)
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3. Inthe Inbound Email Configuration area, check the Email receiving enabled checkbox.
Inbound Email Configuration

Email receiving enabled (%)

@ Yes| No

Identify email as a reply by these subject prefixes (3)

res,aw:,r;,Accepted:,Tentative:,Declined:

Identify email as a forward by these subject prefixes (7)

fw:, fwed:

Discard everything below this text if found in a reply body (comma separated, case sensitive) (2)

\n\n---—Qriginal Message

————— A\n\n \n\nFrom:

Ignore mail with these headers (comma separated name:value pairs) (7)

X-ServiceNow-Spam-Flag:YES,X-ServiceNow-Virus:INFECTED,Auto-Subm

Ignore email when subject starts with text (comma separated, case insensitive) (2)

out of office autoreply, undeliverable:, delivery failure:,returned mail:,au

Ignore email from these senders. Use the name before the @ sign. (comma-separated) (%)

4. Inthe left pane, select System Security > Users and Groups > Users. The following window displays:

service

(S users

=

Departments
Companies
Manufacturers
Vendors
Locations

Location Map

System Security

W Users and Groups

Groups

Roles

®

Service Management

CRECARCRRCARCRICRECRECRNCRNCRECRECRNC)]

= User ID

lucius.bagnoli

jimmie barninger

melinda.carleton

jewel.agresta

sean.bonnet

jacinto.gawron

laystle.stika

billie.cowley

christian.marnell

naomigreenly

jess.assad

cherie.fuhri

gerlforness
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= Name

Lucius Bagnoli

Jimmie Barninger

Melinda Carleton

Jewel Agresta

Sean Bonnet

Jacinto Gawron

Krystle Stika

Billie Cowley

Christian Marnell

Naomi Greenly

Jess Assad

Cherie Fuhri

Geri Forness

= Email

lucius.bagnoli@example.com

jimmiebaminger@example.com

melinda.carleton@example.com

jewel.agresta@example.com

sean.bonnet@example.com

jacinto.gawron@example.com

krystle.stika@example.com

billie.cowley@example.com

christian. mamell@example.com

naomi.greenly@example.com

jess.assad@example.com

cherie fuhri@example.com

geri-fomess@example.com

= Active

true

true

true

true

true

true

true

true

true

true

true

true

true

@ System Administrator ~

<4

= Created

2012-02-17 19:04:49

2012-02-17 19:04:49

2012-02-17 19:04:49

2012-02-17 19:04:49

2012-02-17 19:04:50

2012-02-17 19:04:50

2012-02-17 19:04:50

2012-02-17 19:04:50

2012-02-17 19:04:50

2012-02-17 19:04:53

2012-02-17 19:04:49

2012-02-17 19:04:49

2012-02-17 19:04:50

1 | to20 of 565

= Updated

2012-10-29 09:44:41

2012-10-29 09:44:49

2012-10-29 09:44:58

2012-10-29 09:45:07

2012-10-29 09:45:15

2012-10-29 09:45:22

2012-10-29 09:45:37

2012-10-29 09:45:46

2012-10-29 09:46:24

2012-10-29 09:46:37

2012-10-29 09:46:47

2012-10-29 09:47:04

2012-02-2513:17:18

>

S NORC:

»>
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5. Click the New button to create a new user. The following window displays:

= User

€| = Newrecord

User ID

First name

Last name

Title

Department

Password

Password needs reset
Locked out

Active

Web service access only

Internal Integration User

Submit

Related Links

View Subscriptions

Email

Language

Calendar integration

Time zone

Date format

Business phone

Mobile phone

Photo

support@ensilo.com

—None -

Outlook

System (US/Pacific-New)

System (yyyy-MM-dd)

Click to add...

# = coo Submit
=

0]

6. In the Email field, enter the email address of the FortiEDR messaging system. This email address is
specified in the Email Address field of the FortiEDR Open Ticket settings, which can be accessed by
selecting Administration > Export Settings in the FortiEDR user interface, as shown below:

COMMUNICATION CONTROL v

SECURITY SETTINGS v

INVENTORY v

ADMINISTRATION €@)

®  Protection v

LICENSING
'ORGANIZATIONS
USERS

DISTRIBUTION
LISTS

EXPORT
SETTINGS

TOOLS

SYSTEM
EVENTS

IP SETS

EvenTViEWER @D
SMTP
Server Name
port * [s87
Encryption type s

Sender Name

OPEN TICKET

* Used for receiving tickets from all organizations

SYSLOG

[ D<tine New sysiog

Email address  *

User name

Password

Organization: * | Al organiza.. ~  Name: *[QAsyslog server | Host: *[10.0.1.34
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*

| Port: *[10s14 | Protocol: | 7cp  ~ | UsessL:

FortiEDRAdmin@fortinet.com

' Use SMTP authentication

admin

Email address  *

|

o

L1

NOTIFICATIONS
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7. Inthe left pane, select System Policy > Email > Inbound Actions. The following window displays:

service serviceManagement

(5 systemPo = Inbound Email Actions m Goto Updated v l:] << <

= T A
& O, =Name = Active
Favorites
(D CreateEnsiloincident true
System Policy - Inbound Actions ~ ©)
()  Createincident true
System Policy
» (D Unsubscribe from Notification ~ true

Templates (D) UpdateIncident (BP) true
Layo

@ Update Approval Request true
Client Templates

(i) CreateLive Feed Reply true
Quick Messages
cundbction (i) CreateLive Feed Like Reply true

'V Rules

(D  Reopenlincident true
Data Lookup Definitions

() CreateIncident (Forwarded) true
Assignment Lookup Rules
Priority Lookup Rules @ Update Service Category Request  true
Assi ent

ionmen ©  Undatechange true

@ System Administrator ~

= Event name = script = Target table

email.read J/Note: current.opened_by s already se...  Incident [incident]

email.read J/Note: current.opened_byis already se...  Incident [incident]

email.read (function runAction(/*GlideRecord*/ curr...  Notification Messages [cmn_notif_message]

gs.include(validators);
email.read Incident [incident]
if (current.g..

email.read /"global current, email, gs, GlideContro...  Approval [sysapproval_approver]

var lfUtil = new LiveFeedUtil();

email.read Live Feed Message [live_message]
var rep...
var [fUtil = new LiveFeedUtil();

email.read Message Liked by [live_message_like]
varre...

email.read Incident [incident]

email.read J/Note: current.opened_by s already se...  Incident [incident]

email.read if (current.getTableName() == "catalog_c... Service Category [catalog_category_request]
gs.include(validators');

email.read Change Request [change_request]

1 tol50f15

= Updated ¥

2018-09-05 06:58:50

2018-05-28 03:49:28

2016-06-29 09:58:15

2015-10-27 10:02:55

2015-04-28 12:58:40

2014-11-2100:38:59

2014-11-21 00:36:00

2014-10-15 13:37:20

2014-01-17 14:07:38

2013-12-13 08:48:29

2013-09-10 09:48:39

8. Click the New blue button to create new inbound email actions. The following window displays:

Q&G

> »>

= Order

10

100

100

100

100

100

50

100

100

100

¢ = InboundEmail Actions
= New record

Inbound email actions specify how ServiceNow creates or updates task records in a table when the instance receives an email. The inbound email action looks for awatermark in the email to associate it with a specific task. Ifthe conditions specified in the inbound action are met, the script is

run. More Info

Name Fortinet inbound email
Target table Incident [incident] v
Action type Record Action M

Whentorun | Actions  Description
Only emails of the selected Type will trigger this inbound action.

Type New N

Order determines when to run relative to other inbound actions. The inbound action with the lowest order runs first.

Order 100

All of the following conditions must be true, to trigger this inbound action.

Conditions Add Filter Condition || Add "OR" Clause

— choose field - v | —oper—

Condition

9. Fillin the following fields in this window:

Definition

Application Global
Adive [+
Stopprocessing |/

Only emails from senders with the Required roles wil trigger this inbound action.

Required roles 72

©nly emails from this sender will rigger this inbound action.

From Fortinet Fortinet

- value -

@ =

Name Enter a free-text name for the inbound email feed. For example,
Fortinet inbound email.

Target table Select Incident [incident] in the dropdown list.

Action type Select Record Action in the dropdown list.

Active Check this checkbox to select it.

Stop Processing Check this checkbox to select it.
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10. In this window, select the When to run tab and then in the From field, select the FortiEDR user created in
step 6.

Whentorun | Actions Description
Only emails of the Selected Type willtrigger this inbound action. Only emails from senders with the Required roles will trigger this inbound action.

Type New v Required roles 2

Order determines when to run relative to other inbound actions. The inbound action with the lowest order runs first. Only emails from this sender will trigger this inbound action.

Order. 100 From Fortinet Fortinet ol e

All of the following conditions must be true, to trigger this inbound action.

Conditiens Add Filter Condition | Add "OR" Clause

— choose field - v | —oper— —value

Condition

11. Select the Actions tab and then paste the provided JavaScript (see below) into the email body. You can
modify this script, as needed.

// Note: current.opened by 1is already set to the first UserID that matches the From: email
address

current.caller_id = gs.getUserID();

current.comments = “received from: “ + email.origemail + “\n\n” + email.body_text;
current.short_description = email.subject;

current.category = “request”;

current.incident_state = 1;

current.notify = 2;

current.contact_type = “email”’;

//set highest priority for emails from FortiEDR notification

if (email.origemail == "doNotReply@fortinet.com") {

current.impact=1;

current.urgency=1;

}
if (email.body.assign != undefined)
current.assigned_to = email.body.assign;
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if (email.importance != undefined) {
if (email.importance.tolLowerCase() == "high")

current.priority = 1;

if (email.body.priority != undefined)

current.priority = email.body.priority;

var severityStart = email.body_text.indexOf('Severity:') + 9;

var classificationStart email.body text.indexOf('Classification:') + 15;

var

var

var

destinitionStart

severity = email

classification

email.body_text.indexOf('Destinations:"');

.body_text.slice(severityStart, classificationStart -15 );

email.body text.slice(classificationStart, destinitionStart);

current.insert();

12. When pasting in the JavaScript, make sure that:
» The emails address on line 11(see above) is the same as that specified in Email Address field of the
FortiEDR Open Ticket settings (see step 6).
e You set the current.impact and current.urgency fields on lines 12 and 14 to specify the impact and
urgency values for ServiceNow.
Various types of information can be extracted from the email sent by FortiEDR. For example, the
text on line 33 in the JavaScript (see above) is an example of how to extract the classification value
of this event from the email.
13. Click the Submit button in the ServiceNow window. This completes the email feed setup.
When FortiEDR sends an email to ServiceNow, a JSON file is attached to it. This JSON file contains the
raw data for the event. Once received, you should save this raw data to the ticket.

The following shows a sample JSON file:

//parsing fields from attachment example
if (sys_email.hasAttachments()){

var att = new GlideRecord("sys_attachment");

att.addEncodedQuery("table_name=sys_email~table_sys_id=
id"));

+ sys_email.getValue("sys_
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att.query();
while (att.next()){
if (att.file_name == "event.json" ) {

var sa = new GlideSysAttachment();

var binData

sa.getBytes(att);

var strData

Packages.java.lang.String(binData);

var parser = new JSONParser();

var parsed = parser.parse(strData);
current.comments =("EventId from JSON: " + parsed.EventId);

}

The following shows how an event appears when received in ServiceNow, after being sent from
FortiEDR:

SErVICENOW  ServiceManagement @ sremmineaer - QA B @ H

- [r eI o .
= System Mailbores - Inbax. Location Q Contacttype
‘System Maibaxes - Received Category Request v State New
‘System Policy - Intound Action: ‘Subcategory N Assignment group
e . —
[
v [
N
Related Search Results
[ e e b
R B

Addiional comments (Customervisbe) | Post

) ’ S —
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SErviICeNOW sevice Management

SelfSenice-Incidents
= Systom Maihones-Inbox
Syptem Mattzones - ecaived

System Piicy - Inbound Actions

<

incdent
= INCoo10685 Rpt-tempeaT!

= # T e o

callcor o sl collcor con)

Froces oamiccodel e
Gt S
esinaions Lt caPort gt
m\.ed v:m s

aopomamiccodetstentests oe
g
et wa s o
216113 sy Ak oup<aH a2 g SN CWOB S Y5, 35 GO DI D36 MO E MV GSGISES JONS A0 TG I0GNBEGEISE i) 2K AL

B e e e e P s e A e T e e e ST —

e U S S USSR O VSR ——
B W e
Ert e T

7 Fortne rortnet Pedchanges - 2020343 105521

[——

ncdene st

Openedty  Fortet Fortret
Procty 5. Planing

H

mage plosded

mage plosded

7 Fortoe rortnet e—

= ematrced
subfet:
Fom:  sipongenstocon
To: venaATEsence now com

Stowemai detats

mage plosded

s sysem

Aeacmertuploaded

eventjson
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Appendix B - Lucene syntax

The FortiEDR Threat Hunting free-text query is based on Lucene syntax. This syntax consists of terms and
operators, as described below. For more details about the use of this query, see Threat Hunting on page
125.

Ay
‘?' You can convert JSON and XML syntax queries into Lucene syntax using the built-in
Convert Query button in the Free-text Query filter.

Terms

A free-text term is a single word (for example NetworkService or CryptSvc) or a phrase surrounded by
double quotes (for example, "NetworkService -p -s CryptSvc”) that searches for all the words in a phrase (in
the same order) regardless of the field in which the words appear.

A Field: Value term is a combination of a field and a value.

A list of available fields is provided in the query box, which is an automatically-complete dropdown list.

Examples

Where the Source command line contains the value NetworkService:
Source.CommandLine: NetworkService

Where the value of the remote IP is 10.151.121.130:

RemoteIP: 10.151.121.130

Operators

Operators enable you to customize the search and/or to create more complex queries.

Operators are case insensitive.

Operators Definition

OR, || The query should match either one of the terms/values.
AND, && The query should match both of the terms/values.
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NOT, ! The query should not match the term/value.

_exists_ The query should match when the field value is not null.

+ - The term following this operator must be present.

. The term following this operator must not be present.
Example

Where the Event includes either the RemotelP field that contains 10.151.121.130 or the Remote Port field
that contains 443

RemoteIP: 10.151.121.130 OR RemotePort: 443

Where the ProductName field contains both Microsoft and Windows
Source.Process.File.ProductName: (microsoft AND windows){}

Where the ProductName field contains Microsoft and does not include Windows
Source.File.ProductName: (microsoft -windows)

Where the Product Name field contains the exact phrase “Microsoft Windows”
Source.Process.File.ProductName: microsoft\ windows

Where the field Behavior has any non-null value

_exists_: Behavior

Where the field PID does not include the value 5292

Source.PID: (NOT 5292)

Where the Event does not include the value 5292 in any of the Event fields

NOT 5292

Wildcards

Wildcard searches can be run on individual terms using a ? (question mark) to replace a single character,
and an * (asterisk) to replace zero or more characters. For example: Progr?m Fil*.

If the value contains a space, escape it with a backslash. For example:

e Source.Process.File.Path: Program\ Files*

e Source.Process.CompanyName: Microsoft\ Corporation

Do not enclose wildcard search values with double quotes.

\
S L4
9 Wildcard queries may consume huge amounts of memory and perform poorly.
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Ranges

Ranges can be specified for date, numeric or string fields. The inclusive ranges are specified with square
brackets

[min TO max] and exclusive ranges with curly brackets {min TO maxj}.
Numbers 1..5

count:[1 TO 5]

Numbers from 10 upwards

count:[10 TO *]

Dates before 2012

date:{* TO 2012-01-01}

Ranges of IPs

RemoteIP: "140.100.100.0/24"

Reserved characters

Should you need to use any of the characters that function as operators in the query itself (and not as
operators), then you should escape them with a leading backslash (\). For instance, to search for
c:\Windows\, write the query as cl:\|\Windowsl\.

Reserved characters are +,-, =, &&, ||, >, <, !, (), {}, [1,~ " ~, *, 2, \and /.
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Appendix C - ON PREMISE

DEPLOYMENTS

This chapter describes how to set up the FortiEDR backend components for on-premise deployments.
Before you start, make sure that on-premise deployment is the most suitable option for you.

System requirements

The following tables lists the system requirements of each backend component. Make sure that all devices,
workstations, virtual machines and servers on which a FortiEDR backend component will be installed

comply with those requirements.

Central
Manager

Aggregator’

Component

Threat Hunting Core?

Repository

Reputation
Server

Processor Intel or AMD x86 (64-bit)
Number of
CPUs 4 4
Physical 16 GB 16 GB
Memory

. 150 GB,
Disk Space ssD 80 GB
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Varies by
number of seats
and period of
required Threat
Hunting data
retention. Refer
to the Threat
Hunting
Repository CPU,
Physical
Memory, and
Disk Space
Requirements
on page 463
section for
requirements
for one month of
data retention
for the
extensive
profile.

e 4 for Core
o 2 for Core

running as a
Jumpbox

The following
CPUs are
unsupported:

S e o E5-2440
9 . E5-2650

e E5-2660
e E5-2690
e E5-2699

16 GB for Core

8 GB for Core
running as a
Jumpbox

16 GB

250 GB SSD for
Core

50 GB (non-SSD)
for Core running
as a Jumpbox

120 GB
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Central Aggregator’ Threat Hunting Core?2 Reputation

Component Manager Repository Server

For a Threat
Hunting
license, each
\ 1, 1000 additional
‘Q'Collectors
W above the first
= 1000 require
an additional

45 GB of disk
space.

ISO Image OS Ubuntu 22.04 ESXi 7.0 Ubuntu 22.04

Ui organizations will be defined and the number of Collectors exceeds 10000, set up an additional
FortiEDR Aggregator VM on the top of the initial one.
2Refer to the following guidelines to determine the number of Cores you heed to set up:
e Set up a separate Core for each Aggregator.
» For every additional 5000 Collectors, set up at least one additional Core. The number of additional
Cores required depends on the amount of Threat Hunting events data, which relates to the Data
Collection profile, number of servers, etc.

* You can set up a maximum of 50 Cores.

Network ports

Refer to the following image or table for the port information for communication between different
components. Ensure that these ports or destination servers are not blocked by your firewall product (if one
is deployed) and can be accessed by the corresponding component. You must also ensure that network
ranges 10.42.x.x and 10.43.x.x are not used by any device.

port443 -
| )
Cores = .
pOrt555/559 [ > ] On-premise
— > :Q: reputation services
On-Prem
¢por18081
Pamt== portana2/32100/
Collectors Aggregators 32000/32001/3200
— 1= -
port8081/443 | Q]: rigos0 fF==—1-
I — Yorzzi0032000 ===
o ? 132001/32002/22 =
n-Frem ponsooo;aoesres?aHrh?at
unting
port443/8090/8091Y _ _ 50r15005/8091/443/22/8443/3019

Q portad3lI < ortaoe1rz2

Admin PC Central Manager portad3] PO port
Q:'pondda port443 ;\-/{@\)

- Cloud
For’uEDR Cloud reputation services
Services (FCS) portd43
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Source

Collector

Core

Aggregator

Destination

Aggregator

Core

(Windows Collector
5.2.5.0052 or later)
Reputation services (on-
premise and/or cloud)

Aggregator

Threat Hunting Repository

Reputation services (on-
premise and/or cloud)

Central Manager and Threat
Hunting Repository

Central Manager

FortiEDR 7.2.0 Administration Guide
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Port

8081

443

555

(Core 5.2.2 or
later) 559

443

8081
9092

32100, 32000,
32001, 32002

443

8090

8091
443

Purpose
Sending events, status, etc

Sending events, status, etc, only
when a custom port is used

Collector to Core communication
without SSL

Collector to Core communication
with SSL enabled

Sending requests for reputation
data.

When both on-premise and cloud
reputation services are configured,
FortiEDR Collectors prioritize the
on-premise reputation server over
the cloud. The cloud reputation
services will be contacted only
when the on-premise reputation
server is unreachable.

Core registration

Kafka topic
Kafka broker

Sending requests for reputation
data.

AV Signature updates

Aggregator communication

Aggregator registration
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Source Destination

Threat Hunting Repository

Syslog
SMTP
rbqg.cldsrv.ensilo.com

Central

Manager cldsrv.ensilo.com
storage.googleapis.com
oauth.googleapis.com
oauth2.googleapis.com
fortiav.cloud.ensilo.com
Reputation service (cloud)
Central Manager

Threat

Hunting

Repository
Aggregator

Admin PC Central Manager

FortiEDR 7.2.0 Administration Guide
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Port
8000
8095
6379

(Optional) 6514

(Optional) 587
5672

443

443

8091
5005

443

22

8443
9019

22
32100, 32000,

32001, 32002
443

Purpose
“FortiEDR Connect” related
Threat Hunting queries
Redis MS

Syslog messages from Central
Manager IP to syslog server via
UDP/TCP/TCP SSL

SSLv3/TLS protocol to email server
To RabbitMQ

Data sent to FCS (rest over
RabbitMQ)

Localization, scheduled queries, etc

AV signatures updates

If proxy is not enabled, on-premise
reputation service requests missing
hashes from the cloud reputation
service via the manager nginx.

Aggregator communication

“FortiEDR Connect” dedicated
tunnel

GUl access

Communication with Central
Manager during Threat Hunting
Repository installation

Authentication service
Sink service

Communication with Aggregator
during Threat Hunting Repository
installation

Secure browser connections to
Kafka broker from Aggregator

FortiEDR console access
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Source Destination Port Purpose
If proxy is not enabled, on-premise
reputation service requests missing
8091 .
Central Manager hashes from the cloud reputation
. service via the manager nginx.
Reputation
service (on- 22 SSH application access
premise) . )
If proxy is enabled, on-premise
. . reputation service requests missing
Reputation service (cloud) Proxy port FesliEs TaT ANE @ e R
service via proxy.
Machinis 3000 Grafana - monitoring
connecting . .
to Grafana or Threat Hunting Repository . .
CisEme 5601 Kibana - logging
Machin‘es Central Manager
accessing
the Threat
e Aggregator 22 SSH access
server via
SSH Threat Hunting Repository
As a security best practice, it is recommended to update the firewall rules so that
K ' ’, they only have a narrow opening. For example:
9 « Only open the TCP outbound port 555 to the Core IP address.
|| ¢ Only open the TCP outbound port 8091 to the Central Manager IP address to

be accessed by the Aggregator when the Aggregator is installed on premise

while the Central Manager is in the cloud.

Threat Hunting Repository CPU, Physical Memory, and Disk Space Requirements

Number Number of
of VMs CPUs per
(Nodes) | VM (Node)

Number of

Seats

2000 or
fewer

FortiEDR 7.2.0 Administration Guide
Fortinet Inc.

40 GB

100 GB, non-SSD

Data Disk

OS Disk per VM (Node) per VM

(Node)

1500 GB
SSD
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Number of Number | Number of Data Disk
Seats of VMs CPUs per OS Disk per VM (Node) per VM
(Nodes) VM (Node) (Node)
2310 GB
4000 27 40 GB ssD
3410 GB
6000 37 41 GB ssD
4510 GB
8000 47 48 GB ssD
For Hyper-V VMs, the
! 5610 GB
10000 57 55 GB disk should be IDE with )
at least 30% of the
\ ¥, bhysical disk space 6710 GB
122900 &7 e ‘9' remaining free at all SSD
|| times. Do notuse a 2810 GB
14000 77 69 GB = Hyper-V checkpoint SSD
which consumes the
entire disk size every few 3249 GB
15000 30 27 GB hours. ssD
4318 GB
20000 40 35GCB ssD
3
5387 GB
25000 49 42 GB ssD
6456 GB
30000 58 47 GB ssD

For the Threat Hunting Repository specifications required for supporting more than 30000 Collectors,
please contact Fortinet Support.

Setting up FortiEDR components on-premise

Set up the system components top-down in the following order:

Setting up a VM to be the FortiEDR Central Manager on page 465
Setting up a VM to be the FortiEDR Aggregator on page 481
Setting up the FortiEDR Threat Hunting Repository on page 490
Setting up the FortiEDR reputation server on page 508

Setting up the FortiEDR Core on page 511

Installing FortiEDR Collectors on page 23

o0 hWOWN -

FortiEDR 7.2.0 Administration Guide
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Setting up a VM to be the FortiEDR Central
Manager

To set up a VM to be the FortiEDR Central Manager:

1. Create a new virtual server by selecting File > New Virtual Machine.
2. Select Typical option and select Next.

Mew Virtual Machine Wizard X

vmware: Welcome to the New Virtual

WORKSTATION  machine Wizard
PRO™

1 ; What type of configuration do you want?

O Typical {recommended)

Create a Workstation 17.5 or later virtual
machine in a few easy steps.

() Custom {advanced)

Create a virtual machine with advanced
options, such as a SCSI controller type,
wirtual disk type and compatibility with
older WMware products,

Help < Back Cancel

FortiEDR 7.2.0 Administration Guide
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3. Select the I will install the operating system later option and click Next.

Guest Operating System Installation

A virtual machine is like a physical computer; it needs an operating
gystem. How will you install the guest operating system?

Install from:
Installer disc:

Mo drives available

() Installer discimage file {iso):

m
=]
wi

m

O I will install the operating system later,
The wirtual machine will be created with a blank hard disk.

Help < Back Mext = Cancel

4. Select the Linux radio button. In the Version field, select Ubuntu and click Next.

select a generic Linux type, such as General Linux or Other Linux (for

s‘é’, In some VMware environments where the Linux radio button is unavailable,
- vSphere/ESXi). Do not select a specific Linux distribution.

FortiEDR 7.2.0 Administration Guide
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Select a Guest Operating System
Which operating system will be installed on this virtual machine?

Guest operating system

() Microsoft Windows
O Linux

() WMware ESX

() other

Version

buntu e

Help < Back Mext = Cancel

5. Specify a name for the virtual machine and the location in which to store the provided ISO file and click
Next.
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Mew Virtual Machine Wizard X

Hame the Virtual Machine
What name would you like to use for this virtual machine?

Virtual machine name:

Location:

C:Wirtual Machines\Ubuntul| Erowse...

The default location can be changed at Edit > Preferences.

< Back Cancel

6. Change the Maximum disk size according to system requirements listed in Appendix C — ON PREMISE
DEPLOYMENTS on page 459, leave the default option as Split virtual disk into multiple files and click
Next.

FortiEDR 7.2.0 Administration Guide
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ew Virtual Machine Wizard

specify Disk Capacity
How large do you want this disk to be?

The wirtual machine's hard disk is stored as one or more files on the host computer's
physical disk, These file(s) start small and become larger as you add applications,
files, and data to your virtual machine.

Maximum disk size (GB): BO.O -2

Recommended size for Ubuntu: 20 GB

() Store virtual disk as a single file
0 split virtual disk into multiple files

Splitting the disk makes it easier to move the virtual machine to another computer
but may reduce performance with very large disks.

Help < Back Mext = Cancel

FortiEDR 7.2.0 Administration Guide 469
Fortinet Inc.



Appendix C - ON PREMISE DEPLOYMENTS

7. Click Finish.
Mew Virtual Machine Wizard X

Ready to Create Virtual Machine
Click Finish to create the virtual machine. Then you can install Ubuntu.

The wirtual machine will be created with the follawing settings:

Mame:
Location: C:Wirtual Machines\Ubuntu
Version: Warkstation 17,5 or later

Operating System: Ubuntu

Hard Disk: a0 GB, Split

Memory: 4096 MB

Metwork Adapter:  MAT

Other Devices: 2 CPU cores, CD/DVD, USE Controller, Sound Card

Customize Hardware. ..

< Back Cancel
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8. Right-click the new machine and select the Settings option
|@ - VMware Workstation

File Edit View VM Tabs Help b- -

i X
le.rar-'" {rr Home r|:| Forl
52 Type here to search -
= 1 My Computer I'_|D Fort|EDRC
FDW 'E
Close Tab il
r
Mark as Favorite
Rename...
Open VM directory
Remowve
&) Power 3
[z Snapshot 3
d
2 Manage 5
[ Settings...
I

9. Select the Memory option and change the RAM according to the system requirements listed in
Appendix C - ON PREMISE DEPLOYMENTS on page 459.
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Wirtuzl Machine Settings x

Hardware Qptions

. Device status
Device Summary
== Memory & CR Connected
...:EPrncessgrs 2 n Connect at power on
{-\Hard Disk (5C51) 80 GB .
(=) CD/DVD (SATA) Auto detect Connection
5 Network Adapter NAT () Use physical drive:
|Z| USE Controller Present Auto detect
c]i Sound Card Auto detect )
[_Ipisplay Auto detect © Use 150 image file:
| C:Wirtual Machines) _Ubuntu_6.0.1.0¢ ~ | [ Browse... |
Advanced...
Add... Remaove
0K Cancel Help

10. Select the Processors option and change the value according to the system requirements.
11. Select the CD/DVD option and then select the Use ISO image file option on the right.

12. Click the Browse button and select the ISO file provided by Fortinet for the FortiEDR Central Manager.
Click OK.
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13.

14.
15.
16.

17.
18.
19.
20.

21.

22.

23.

24.

25.

26.

27.
28.

Start the virtual machine.

| g - VMware Workstation
File Edit View VM Tabs Help [ ~ (D o [ B
i =
le.rar'_n,r {1t Home l_'|:|
52 Type here to search -
- 1 My Computer I'_|D
I

P Power on this virtual machine
[ Edit virtual machine settings

* Devices
E Memory 8 GB
I:: :::F'FDCESEEIFE 2
{4 Hard Dizsk (5C5l) 20 GB
(%) CD/DVD (SATA) Auto detect

The virtual machine automatically starts the installation process, which may take a few minutes.
Wait until a success message is displayed requesting that you reboot.
Reboot the virtual machine.

Log into the virtual machine in order to continue the installation process.
Login: root

Change the root password, by entering any password you want. Then re-type it. The password must be

strong enough according to Linux standards.

In the VM CLI, enter fortiedr config.

At the prompt, enter your hostname and click Next. (Note: This can be any hostname)

At the prompt, select manager to configure the VM as the Central Manager, and click Next.

A list of network interfaces on this virtual machine displays. At the Pick your primary interface prompt,
select the interface to be used as the primary network interface through which all FortiEDR Cores and
FortiEDR Collectors will reach this server, and click Next.

At the Do you want to use DHCP prompt, select No to configure the IP of this virtual machine manually,
and then click Next.

At the prompt, enter the IP address of the machine that you are installing. Use the following format:
XXX . XXX . XXX . XxX/yy, Where yy is the routing prefix of the subnet.

At the prompt, enter the default gateway and click Next.

At the Please set your DNS server prompt, enter a valid IP address and click Next. Use the following
format:
XXX . XXX . XXX . XxX/yy, where yy is the routing prefix of the subnet.

At the prompt, select No for debug mode.

At the Please set the date prompt, verify the date and click Next. The installer automatically presents
the current date. You can change this date, if necessary.

At the Please set your Time prompt, set the time and click Next.
At the prompt, select the timezone and country in which the server is being installed.

FortiEDR 7.2.0 Administration Guide
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29. At the Do you want to enable web-proxy for the Manager? prompt, if the Central Manager will
communicate via a proxy when accessing the web (such as the FortiEDR Cloud Service (FCS)), select
Yes and then enter the IP and port of the proxy. Otherwise, select No.

30. Atthe Do you want to enable FCS? prompt, select Yes.

31. Wait a few moments while the installation processes, until you see the Installation completed
successfully message.

32. Configuring the FortiEDR Central Manager server and console on page 474.

Configuring the FortiEDR Central Manager server and
console

After you install the FortiEDR Central Manager, you must configure the FortiEDR Central Manager Server
and console before setting up other components, such as Aggregators, Cores, and Collectors. The
configuration includes creating an Admin user, setting up device registration password, loading your
license, and optional MITM configuration.

To configure the FortiEDR Central Manager Server and console:

1. Use any standard Internet browser to connect securely (via https://) to the IP address and port of the
machine on which the FortiEDR Central Manager is installed, as follows:

a. https://<machine_IP_addess>/
b. Default portis 443

2. Define the first administrator user to be allowed to log into the FortiEDR Manager by filling in the First
Name, Last Name, Email Address, and Define administrator user name fields.

F::RTINET

Getting Started

3. Enter and confirm the password to be used by this administrator user.

4. In the Device Registration Password fields, enter and confirm the password to be used to install all
FortiEDR Collectors, FortiEDR Aggregators and FortiEDR Cores. This same password must be used by
all. The following special characters are supported in the password: |, #, %, & +,-,.,/,:, <, =,>,7,@, [,
VIS L G) ~ and,

time a FortiEDR component is installed. If you forgot your user interface

s";’, Write this password down in a good place. This password will be needed each
- password, contact Fortinet Support to retrieve it.
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5. Click the Login button. The regular FortiEDR Central Manager Login page is then displayed, as shown
below. The page that displays varies, depending on whether the FortiEDR system is set up as a single-
organization or multi-organization system.

=RATINET

Login Page in a Single-organization System Login Page in a Multi-organization System

The FortiEDR system can be set up as a single-organization or multi-organization
system. In a multi-organization system, all users except an Administrator user
) ! /. must specify the organization in the Organization Name dropdown list. If a user is
q defined for an organization, then he/she can log in to that organization.
- Otherwise, he/she cannot.

For more details about logging in to a multi-organization system, see Step 1 -
Logging in to a multi-organization system on page 418.

6. Enter the administrator user name and password you have just defined and click Login. All fields are
case sensitive. The following window displays automatically the first time you log into the FortiEDR
Central Manager:

DASHBOARD EVENT VIEWER COMMUNICATION CONTROL v SECURITY SETTINGS ' INVENTORY v ADMINISTRATION ¢ C® simulation v

LICENSING installation 1D: /N

ORGANIZATIONS
USERS

DISTRIBUTION
LISTS

EXPORT
SETTINGS

TOOLS

SYSTEM
EVENTS

IP SETS

License expired - Please contact system administrator

7. Send the displayed Installation ID to FortiEDRAdmin@fortinet.com by email in order to receive a license
string from Fortinet.

FortiEDR 7.2.0 Administration Guide 475
Fortinet Inc.


mailto:FortiEDRAdmin@fortinet.com

Appendix C - ON PREMISE DEPLOYMENTS

8. Click Load New License. The LOAD NEW LICENSE window opens.

LOAD NEW LICENSE

nsert license text string;

nsert license string here

o
Load License I.\ Cancel ,z"

9. Copy/paste the license string that you received by email into the LOAD NEW LICENSE window and click
Load License. The following displays showing the relevant licensed entitlements:

OAsBOARD EveNTviEWeR (@) communicaTion conTRoL v @) SECURTYSETTINGS ~  INVENTORY v ADMINISTRATION @) ®  Protecion v

LICENSING Installation ID: 4% Name: Expiration Date: 28-Jun-2021 Central Manager Certificate

‘ORGANIZATIONS

License Status Workstations Servers
USERS
License Type: Predict, Protect and Response
DISTRIBUTION Communication Control:  Available Licenses Licenses
LisTS Tinuse Omuse
Forensics: Available
EXPORT Threat Hunting: Available
SETTINGS
Content Updates: Available
TOOLS Vulnerability Management:  Available
JRp— License Capaciy 100 workstations, 100 servers, 100000 loT devices
EVENTS In Use: 1 workstations, 0 servers, 0 loT devices
TS Remaining; 99workstations, 100 servers, 100000 loTdevices .
Remaining Remaining
©  There are 11 collectors thatwere notin use for more than 30 days and are not 99Licenses 100Licenses
d ssinuse
INTEGRATIONS
Content

Content Version: 5040 Update Collectors Request Collector Installer

Field Description

Installation ID Specifies the unique identifier that is automatically generated upon
installation of the ForitEDR Management server. You may be asked to
provide this ID and the Name field when contacting Fortinet for
support.
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Field Description

Name Specifies the name of the organization in a multi-organization
FortiEDR system. For more details, see Multi-tenancy (organizations)
on page 415.

Expiration Date Specifies when this license expires. Notifications will be sent to you
beforehand.

License Type Specifies whether the Discover, Protect and Response license,

Discover and Protect license, or Protect and Response license was
purchased. The license type defines the availability of the relevant

add-ons.

Communication Control Specifies the word Available if the Communication Control add-on is
included in the license.

eXtended Detection Specifies the word Available, when the eXtended Detection add-on is
included in the license.

Forensics Specifies the word Available if the Forensics add-on is included in the
license.

Threat Hunting Specifies the word Available if the Threat hunting add-on (described in

Threat Hunting on page 125) is included in the license. It also specifies
whether Repository add-ons have been purchased and how many
have been.

Content Updates Specifies the word Available if the Content Updates add-on is included
in the license. This add-on enables you to automatically receive the
latest FortiEDR policy rule and built-in exception updates.

installed. There is no need to install content during the

s";’, The system arrives with the latest content pre-
- initial installation.

The Load Content button enables you to update content, as well as to
update the Collector version on any existing Collector.

Content

Content Version: 5040

Load Content Update Collectors Request Collector Installer

To load content updates on your FortiEDR system, click the Load
Content button and then select the content file to load. In a multi-
tenant environment, the Load Content button is available in Hoster

View .
If the content file contains a Collector update, you can update all
Collectors with the new version at that time, or choose to do so later.
Click the Update Collectors button to update the version for all
Collectors.
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Field Description

Vulnerability Management

License Capacity

In Use

Remaining

UPDATE COLLECTOR VERSION

COLLECTOR GROUP = WINDOWS VERSION MACQOS VERSION LINUX VERSION

Default Collector Group 410Rev. 8 3.1.5Rev. 14 3.1.5Rev. 61

groupl 410Rev. 8 315Rev. 14 3.1.5Rev. 61 |
group2 410Rev. 8 3.1.5Rev. 14 3.1.5Rev. 61

High Security Collector Group ~ 4.1.0Rev. 8 3.1.5Rev. 14 3.1.5Rev. 61

Insiders 410Rev. 8 315Rev. 14 3.15Rev. 61

Linux 410Rev. 8 3.15Rev. 14 3.15Rev 61

Jior1 410Rev.8 315Rev. 14 3.1.5Rev. 61

Update 0 selected groups to

Windows version 4.1.0 Re macOS version  3.1.5Rev. 14 Linux version

Note: Version update involves sending 10Mb of data from the Central Manager to each Collector.

( cancel )

Specifies the word Available if the Vulnerability Management add-on
(described in Administration on page 277) is included in the license.

Specifies the number of available licenses for protection by FortiEDR
Collectors (for workstations and servers). Only the number of
FortiEDR Collectors allowed by the license can register with the
FortiEDR Central Manager. Additional FortiEDR Collectors are not
registered with the FortiEDR Central Manager. In addition, the number
of loT devices specified under the License Capacity determines
whether or not loT Discovery is available (zero number).

Specifies the number of FortiEDR licenses for workstations and
servers that are currently in use. In addition, it specifies the number of
loT devices detected in the system thus far.

Specifies the number of FortiEDR licenses for workstations and
servers that are still available for use.

Regarding questions about the number of licenses purchased, please contact Fortinet Support.
10. (Optional) Configure the FortiEDR Central Manager to communicate with the Internet via a controlled
MITM application (for example, FortiGate with SSL deep inspection enabled):
a. Add the MITM CA certificate to the list of trusted certificates in the Central Manager Java
application using the following API:

Method: POST

URL: /maintenance/upload-certificate

Body:
{

"alias": [custom_ca_name],

"certificateBlob": [CA certificate in pem format, encoded in base64]

}

A\,

S L4
q Certificates signed by your custom MITM CA will not be trusted.
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Example:
For the following certificate:

---BEGIN CERTIFICATE---

MIIDYzCCAkugAwIBAgIUXTs@s16LZ3MNoiuy1+2QUOEGNgIwDQYJIKoZIhvcNAQEL

BQAwUzE LMAKGA1UEBhMCVVMxDjAMBgNVBAgMBVNOYXR1IMQOWCWYDVQQHDARDaXR5

MRUWEwWYDVQQKDAxPcmdhbm16YXRpb24xDjAMBgNVBAMMBU15IENBMBAXDTIOMTAY

NzA4NDgxN1oXDTMOMTAyNTA4ANDgxN1lowUzELMAKGALIUEBhMCVVMXxDjAMBgNVBAgEM

BVNOYXR1MQOwCwYDVQQHDARDaXR5MRUWEWYDVQQKDAXPcmdhbml6YXRpb24xDjAM

BgNVBAMMBU15IENBMIIBIjANBgkghkiGOwOBAQEFAAOCAQ8AMIIBCgKCAQEAuUa6l

NjX39F4T@MDozaENXHFnI7qli/oK/M3SH6ZMFkOyAita31ri/J02L2k7HS4qwHp3

GGPnwsSWEMsnwYJ8xuSi2Iz90KfRniDD5sgt/DFAjb+CRO4zbfER1z00qvQqCgqnU

24T12gC131K7Frsky11B6db2s2I0LLpPV17LMyaZ84yx4g1VFISUlaYYXh8AU8oJa

ghW9LDEWFYMXjQIPORQbUhqTOUK1CuEC10ly/yVWmQ7edSyAV/YsIO7DpicPBuG9

fsLoY60tPhqgjopmfHcdMLDIoa@3offAAhigRDAQN5k5KNA6YCcPxvDCoT88jTx823

8QQNd9gsVHreuvLmpwIDAQABoy8wL TAMBgNVHRMEBTADAQH/MBOGA1UdDgQWBBQO

X70wWCDVpK1627HvgxMHNTACcp9TANBgkqhkiGOwOBAQs FAAOCAQEALS5uU6LZQFLWVd

mQhkLWNn9RUOR1vTnNHaARzURCH8k4VCfI1iz93ruYXjib/LWbI1IMxR1nPjRbieI8

WAgUBfPV2cr4bXuP70W8Ftp/MYyw37G1lsglvziorvMl/h61I7aPn4JX9IRAaP+3j0

7vT8hWP1DGT+TQKFBehHP5xJIEhCOWCESqPrOjF24YtDd4QYIWZMOIRtVIIVBnZ9

m6Z1HuRcZ3zLDpigtkyulG3S/6BsQFOWOIQNQt99QU168026+7I1F70S1H7EI179

LaguuiA+PRXAN3ysNid+/anp7Auy5ssIwjcZX7nAuPsUNGLUKH2LAELCOFxCZo06

gC6bm+wRsg==

---END CERTIFICATE---

Encode the certificate in Base64 and use it in the API as follows:
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"alias": "my_custom_MITM_ca",

"certificateBlob":
"LSOtLS1CRUMITiBDRVIUSUZIQOFURSOtLSOtCk1ISURZekNDQWt1ZOF3SUIBZO1VWFRZMHNSNkxaM@10b211eTErM
1FVTOVXTnFJdORRWUpLb1pJaHZjTkFRRUWKQLFBA1V6RUXNQWEHQTFVRUJOTUNWVKk14RGpBTUINT1ZCQWANQLZOMF1
YUmxNUTB3Q3dZRFZRUUhEQVJEYVhSNQpNU1V3RXdZRFZRUUtEQXhQY21kaGJtbDZZWFIwYjIOeERqQQU1CZOSWQKFNT
UJVMTVIRUSCTUIGWERUSTBNVEF5Ck56QTRORGA4TjFVWERUTTBNVEF5T1RBNESEZ3hOMWI3VXpFTE1Ba@dBMVVFQmh
NQ1ZWTXhEakFNQmdOVkJIBZ0OKQ1ZOMF1YUmxNUTB3Q3dZRFZRUUhEQVIEYVhSNU1SVXdFd11EV1FRSORBeFBjbWRoY
m1sN11YUnBiMjR4RGpBTQpCZO5WQKFNTUIVMTVIRUSCTUL1IQk1qQU5CZ2txaGtpRz13MEIBUUVGQUFPQOFROEFNSUL
CQ2dLQOFRRUF1YTZsCk5gWDM5RjRUME1Eb3phRUSYSGZuUSjdxbGkvbOsvTTNTSDZaTUZrT31BaXRhMzFyaS9KTzIMM
ms3SFMOcXdIcEoKROdQbndzVOVNc253WUo4eHVTaTIJejkwS2ZSbm1ERDVZzZ3QVREZBamIrQ1JIPNHpiZkVSaXpPMHF
2UXFDZ3FuVQoyNEkyZONsMzFLNOZyc2t5MTFCNmRiMnMySTBMTHBQVmMwW3TE15YV0o4NH14ANGcxVKZKU1UXYV1ZWGE4Q
VU4b@phCmdoVz1MRDZXR11INWGpRSVAWULFiVWhxVDBVSzFDdUVjbDBseS95V1dtUTd1ZFN5QVYVWXNITzdEcG1jUEJ
1RzkKZnNMb1k2MHRQaHFqMHBtZkhjZEIMREpvYTAzb2ZmQUFoaXFSREFRTjVrNUtuQTZZY1B4dkRDb1Q40GpUeDgyM
Wo4UVF0ZD1nc1ZIcjZldkxtcHdIREFRQUIveTh3TFRBTUINT1ZIUk1FQ1RBREFRSCONQjBHQTFVZERNUVACQLlFvCng
3T3dDRFZwSzE2MjdIdmd4TUhOZKFjcD1UQU5CZ2txaGtpRz13MEIBUXNGQUFPQOFRRUFMNXU2TFpRRkxXVmQKbVFoa
0xXbj1lSdU9SMXZUbk5IYUFSelVSQog4azRWQ2ZIbG1l60TNydV1Yakpil@xXYkpsTXhSMW5QalJiaWVIOAp3QWdVQmZ
QVjJjcjRiWHVQNZBXOEZOCcCIONWX13MzdHMXNNMXZ6aT1lydk1sL2g2MUk 3YVBUNEpYOU1SQWFQK2pPCjd2VDhoV1AXR
EdmK1RRSOZCZWhIUDVASk1FaENVVONFU3FQck9qRjIOWXREZDRRWUpXWmOwWSVIOVk1IVkIuWjkKbTZabEh1UmNaM3p
MRHBpZ3RreXVMRzNTLzZCc1FGMFdPS1FOUXQ5MFFVMTY4MDI2KzdKbEY3T1NsSDAFSWw30QpMYWd1dW1BK1BSWEFOM
31zTmk@OKy9hbnA3QXV5NXNzSXdqY1pYN25BdVBzVUSHTFVLSDIMQUVMQzBGeENab@82CmdDNmItK3dSc2c9PQotLSO
tLUVORCBDRVJIUSUZJQOFURS@tLSet"

}

b. Add propery ssl.truststore.enabled=true to file application-customer.properties.

c. Restart the manager service using the following command: exec command fortiedr manager
restart.
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Setting up a VM to be the FortiEDR Aggregator

To set up a VM to be the FortiEDR Aggregator:

1. Create a new virtual server by selecting File > New Virtual Machine.
2. Select Typical option and select Next.

Mew Virtual Machine Wizard >

vmware Welcome to the New Virtual

WORKSTATION  Machine Wizard
PRO"™

1 J What type of configuration do you want?

O Typical {recommended)

Create a Workstation 17.5 or later virtual
machine in a few easy steps.

() Custom {advanced)

Create a virtual machine with advanced
options, such as a SC5I controller type,
virtual disk type and compatibility with
older YMware products.

Help = Back Cancel
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3. Select the I will install the operating system later option and click Next.

Guest Operating System Installation

A virtual machine is like a physical computer; it needs an operating
gystem. How will you install the guest operating system?

Install from:
Installer disc:

Mo drives available

() Installer discimage file {iso):

m
=]
wi

m

O I will install the operating system later,
The wirtual machine will be created with a blank hard disk.

Help < Back Mext = Cancel

4. Select the Linux radio button. In the Version field, select Ubuntu and click Next.

select a generic Linux type, such as General Linux or Other Linux (for

s‘é’, In some VMware environments where the Linux radio button is unavailable,
- vSphere/ESXi). Do not select a specific Linux distribution.

FortiEDR 7.2.0 Administration Guide
Fortinet Inc.

482



Appendix C - ON PREMISE DEPLOYMENTS

Select a Guest Operating System
Which operating system will be installed on this virtual machine?

Guest operating system

() Microsoft Windows
O Linux

() WMware ESX

() other

Version

buntu e

Help < Back Mext = Cancel

5. Specify a name for the virtual machine and the location in which to store the provided ISO file and click
Next.
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Mew Virtual Machine Wizard X

Hame the Virtual Machine
What name would you like to use for this virtual machine?

Virtual machine name:

Location:

C:Wirtual Machines\Ubuntul| Erowse...

The default location can be changed at Edit > Preferences.

< Back Cancel

6. Change the Maximum disk size according to system requirements listed in Appendix C — ON PREMISE
DEPLOYMENTS on page 459, leave the default option as Split virtual disk into multiple files and click
Next.
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ew Virtual Machine Wizard

specify Disk Capacity
How large do you want this disk to be?

The wirtual machine's hard disk is stored as one or more files on the host computer's
physical disk, These file(s) start small and become larger as you add applications,
files, and data to your virtual machine.

Maximum disk size (GB): BO.O -2

Recommended size for Ubuntu: 20 GB

() Store virtual disk as a single file
0 split virtual disk into multiple files

Splitting the disk makes it easier to move the virtual machine to another computer
but may reduce performance with very large disks.

Help < Back Mext = Cancel
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7. Click Finish.
Mew Virtual Machine Wizard X

Ready to Create Virtual Machine
Click Finish to create the virtual machine. Then you can install Ubuntu.

The wirtual machine will be created with the follawing settings:

Mame:
Location: C:Wirtual Machines\Ubuntu
Version: Warkstation 17,5 or later

Operating System: Ubuntu

Hard Disk: a0 GB, Split

Memory: 4096 MB

Metwork Adapter:  MAT

Other Devices: 2 CPU cores, CD/DVD, USE Controller, Sound Card

Customize Hardware. ..

< Back Cancel
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8. Right-click the new machine and select the Settings option
|@ - VMware Workstation

File Edit View VM Tabs Help b- -

i X
le.rar-'" {rr Home r|:| Forl
52 Type here to search -
= 1 My Computer I'_|D Fort|EDRC
FDW 'E
Close Tab il
r
Mark as Favorite
Rename...
Open VM directory
Remowve
&) Power 3
[z Snapshot 3
d
2 Manage 5
[ Settings...
I

9. Select the Memory option and change the RAM according to the system requirements listed in
Appendix C - ON PREMISE DEPLOYMENTS on page 459.
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Wirtuzl Machine Settings x

Hardware Qptions

. Device status
Device Summary
== Memory & CR Connected
...:EPrncessgrs 2 n Connect at power on
{-\Hard Disk (5C51) 80 GB .
(=) CD/DVD (SATA) Auto detect Connection
5 Network Adapter NAT () Use physical drive:
|Z| USE Controller Present Auto detect
c]i Sound Card Auto detect )
[_Ipisplay Auto detect © Use 150 image file:
| C:Wirtual Machines) _Ubuntu_6.0.1.0¢ ~ | [ Browse... |
Advanced...
Add... Remaove
0K Cancel Help

10. Select the Processors option and change the value according to the system requirements.
11. Select the CD/DVD option and then select the Use ISO image file option on the right.

12. Click the Browse button and select the ISO file provided by Fortinet for the FortiEDR Central Manager.
Click OK.
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13.

14.
15.
16.

17.

Start the virtual machine.

| g - VMware Workstation
File Edit View VM Tabs Help [ ~ (D o [ B
i =
le.rar'_n,r {1t Home l_'|:|
52 Type here to search -
- 1 My Computer I'_|D
I

P Power on this virtual machine
[ Edit virtual machine settings

* Devices
E Memory 8 GB
I:: :::F'FDCESEEIFE 2
{4 Hard Dizsk (5C5l) 20 GB
(%) CD/DVD (SATA) Auto detect

The virtual machine automatically starts the installation process, which may take a few minutes.
Wait until a success message is displayed requesting that you reboot.
Reboot the virtual machine.

Log into the virtual machine in order to continue the installation process.

Login: root

Change the root password, by entering any password you want. Then re-type it. The password must be
strong enough according to Linux standards.

In the VM CLI, enter fortiedr config.

18. At the prompt, enter your hostname and click Next. (Note: This can be any hostname)

19. At the prompt, select aggregator to configure the VM as the Aggregator, and click Next.

20. At the Please enter the management IP address prompt, enter the IP address to be used for
communicating with the FortiEDR Central Manager and click Next.

21. Atthe Please enter your registration password prompt, enter the user and password used to register the
FortiEDR Aggregator with the FortiEDR Central Manager, which you configured in step 30 in the
previous section, and click Next.

22. Atthe Do you want to use DHCP prompt, select No to configure the IP of this virtual machine manually,
and then click Next.

23. Atthe prompt, enter the IP address of the machine that you are installing. Use the following format:
XXX . XXX . XXX . XXX/yy, Where yy is the routing prefix of the subnet.

24. Atthe prompt, enter the default gateway and click Next.

25. At the Please set your DNS server prompt, enter a valid IP address and click Next. Use the following
format:

XXX . XXX . XXX . XxX/yy, where yy is the routing prefix of the subnet.

26. At the prompt, select No for debug mode.

27. Atthe Please set the date prompt, verify the date and click Next. The installer automatically presents
the current date. You can change this date, if necessary.

28. At the Please set your Time prompt, set the time and click Next.

29. Atthe prompt, select the timezone and country in which the server is being installed.
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30. Wait a few moments while the installation processes, until you see the Installation completed
successfully message.

31. If organizations are defined and the number of Collectors exceeds 10000, set up additional
Aggregators by repeating the previous steps for each additional Aggregator.

32. (Recommended) Define a DNS address for the Aggregator by following the steps below. Doing so
avoids the need to reinstall all Collectors that are registered with the Aggregator IP when the
Aggregator IP changes in some cases, such as when the Aggregator is migrated to a different data
center.

a. Define a DNS address for the Aggregator.
b. Configure FortiEDR to disable the NAT IP and use the local IP of the Aggregator:
i. Connnect to the FortiEDR Central Manager via ssh.

ii. Open the conf-customer.properties configuration file using the following command:
vi/opt/FortiEDR/aggregator/conf-customer.properties.

iii. Comment out the connection.dnsname = 10.10.80.201 line as follows: #connection.dns-name
= 10.10.80.201.

iv. Save the changes and restart the FortiEDR Aggregator service using the fortiedr aggregator
restart command.

v. Check the status of the Aggregator using the fortiedr aggregator status command.

Setting up the FortiEDR Threat Hunting
Repository

The FortiEDR Threat Hunting feature (described in Threat Hunting on page 125) requires the set up of the
Threat Hunting repository, which includes the following steps:

Creating a Virtual Machine on page 491

Installing an Operating System ISO on page 493

Installing a FortiEDR Repository software ISO on page 499

Configuring the Threat Hunting Repository Monitoring console on page 502

Backing up Threat Hunting Repository data on page 503

Activating the Threat Hunting Repository Monitoring console on page 504

O Uk WN =

Prerequisites

» Alicense with access to the Threat Hunting feature.
e The FortiEDR Central Manager is installed.
e The system requirements listed in Appendix C — ON PREMISE DEPLOYMENTS on page 459 must be met.
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Creating a Virtual Machine

To create a virtual machine:

1. Create a new virtual server. For example, by selecting File > New Virtual Machine...., then selecting
Create a new virtual machine and clicking NEXT.

New Virtual Machine

1 Select a creation type Select a creation type

2 Select a name and folder How would you like to create a virtual machine?
3 Select a compute resource
3 Select storage A This option guides you through creating a new virtual machine. You
o ) _ Deploy from t€mplate will be able to customize processors, memaory, network
L Sl Clone an existing virtual machine connections, and storage. You will need to install a guest operating
Clone virtual machine to template system after creation.

Clone template to template

Convert template to virtual machine

CANCEL NEXT

2. Enter the desired virtual machine name. For example, FortiEDR-TH-Repository and click NEXT.
3. Enter the virtual machine settings, as follows:

a. Inthe Select storage step, select the storage where the virtual machine disk should be stored on
and click NEXT.

b. Inthe Select Compatibility step, select ESXi 7.0 UT and later and click NEXT.

Select compatibility
Select compatibility for this virtual machine depending on the hosts in your environment

The host or cluster supports more than one VMware virtual machine version. Select a compatibility for the virtual machine.

Compatible with: | ESXi 7.0 U1 and later v (@D

This virtual machine uses hardware version 18, which is compatible with ESXi 7.0 U1 and later. Some virtual machine hardware features

are unavailable with this option

c. Atthe Select a guest OS step:
i. Inthe Guest OS family field, select Linux.
ii. Inthe Guest OS version field, select Other 4.x Linux (64-bit).
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iii. Click Next. The following displays:

Select a guest OS
Choose the guest OS that will be installed on the virtual machine

ldentifying the guest operating system here allows the wizard to provide the appropriate defaults for the operating system installation.

Guest OS Family: ,I_|nux7v

Guest OS Version: | Other 4.x Linux (64-bit) v

d. In the Virtual Machine Boot Options, select BIOS under Firmware, and click OK.

Edit Settings X

Virtual Hardware VM Oplions

» General Options WM Name: yillouz-on-prem-test

VMware Remote Console Options

> " 3
Lock the guest operating system when the last remote user disconnects

» Encryption Expand for encryption settings
» Power management Expand for power management settings
» VMware Tools Expand for VMware Tools settings
~ Boot Options
Firmware + BIOS
EF (recommended) [N
Boot Delay wwarmn peewem g we e o setting, delay boot order by

10000 milliseconds

Force BIOS setup a Dwuring the next boot, force entry into the BIOS setup screen
Failed Boot Recovery Jif the WM fails to find boot device, automatically retry after
10 seconds
» Advanced Expand for advanced settings
> Fibre Channel NPIV Expand for Fibre Channel NPIV settings

e. Inthe Customize hardware step, do the following:

a. Enter the values for CPU, Memory, and New Hard disk fields as specified in Prerequisites. It is
highly recommended to use SSD for hard disk.

b. Add an OS disk in the New Hard disk:
a. Enter the OS disk size in GB, as specified in Prerequisites.
b. In the Disk Provisioning field, it is recommended to select Thick Provision.
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c. Add aDATA disk in the New Hard disk:
a. Enter the DATA disk size in GB, as specified in Prerequisites.
b. In the Disk Provisioning field, it is recommended to select Thick Provision.
c. In case the previous disk hasn’t been installed as SSD, define another SSD DATA disk of a
size as specified in Prerequisites.
d. In the New Network field, choose VMXNET3.
4. Select Finish to complete the creation of the virtual machine.

Installing an Operating System ISO

To install an operating system ISO:

1. Select the newly created virtual machine and click Launch Remote Console.
2. Inthe VMRC menu, select Removable Device > CD/DVE drive 1 > Connect to Disk Image File (iso)....

71 FortiEDR-TH-Repository - Viware Remote Console

lwere~| |l -~ = O

Power »
Removable Devices * CD/DVD drive 1 Connect to Disk Image File (iso)...
Send Ctrl+Alt+ Del ~  MNetwork adapter 1 Settings.[}

Manage »

S J @ G

. Full Screen Ctri+Alt+Enter

==
(L]

Preferences...

Help »

Exit

3. Select the FortiEDR_Repository_OSinstaller ISO file and click Open. Make sure that the ISO remains
mounted.

\ﬂ Another option instead of completing the two steps described above is to upload

the ISO from the VMWare datastore (this is possible if the ISO has already been
uploaded there).

FortiEDR 7.2.0 Administration Guide 493
Fortinet Inc.



Appendix C - ON PREMISE DEPLOYMENTS

4. Restart the Virtual Machine. The virtual machine starts and the following menu is displayed:

GNU GRUB version 2.02

Boot from disk
Install node
k305 Rescue Shell

Use the & and ¥ keys to select which entry is highlighted.
Press enter to boot the selected 0S, “e’ to edit the commands
before booting or ‘¢’ for a command-line.

5. Select the Install Node option.
6. Configure the timezone of the VM using the following command:

sudo su -

export TIMEZONE=Area/Location

Replace Area/Location with the time zone value from the tz (timezone) database used by Linux and
other Unix systems.

by
‘9' The default timezone UTC will be used if you skip this step. The timezone can

only be set here once and cannot be changed after the installation.

7. Login using the rancher user (without the password) and run the following commands in order to start
the K8S node installation:

sudo su -

bash /k3os/system/install_k3os.sh
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k3os—8350 [T 1# bash ~k3Jos-,systemsinstall_k3os.sh

elcome to EDRuZ repository installation

Preparing data disk...

reating data partition on ~devrsdb
Information: You may need to update retc-fstab.

Information: You may need to update retc-fstab.

keZzfs 1.45.6 (20-Mar-2020)

reating filesystem with 26213888 4k blocks and 6553600 inodes

Filesysten UUID: 916d49e?3-4260-4913-a9d9-e0ccBcf fhioe

Superblock backups stored on blocks:
32768, 98304, 163840, 229376, 294912, 819200, 884736, 1605632, 2654208,
4096000, V962624, 11239424, 20480000, 23887872

Aillocating group tables: done

riting inode tables: done

reating journal (131072 blocks): done

riting superblocks and filesystem accounting information: done

hooze installation type
1 - New installationm
2 — Add a node to the existing cluster

8. When prompted with the following, enter the number depending on the virtual machine (node) you are
installing:
— New installation
- Add a new master-node to the existing cluster

» Enter 1if you are installing one single virtual machine (node) with fewer than 15000 seats or if you
are installing the first virtual machine (node) of the three for 15000 to 30000 seats.

» Enter 2 if you are installing the second or third virtual machine (node) of the three for 15000 to
30000 seats.
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9. Complete the k3os installation by providing the following parameters:

ster token:

etwork mask (use % format)

Called function ‘“validateVars" , function path ~k: tensinstall_k3os.sh , parent script ~<k3
. line 377

5.0%210.10.10.253

Please confirm provided parameters. Type "yes” to confirm , "no"” to start over:

a. When prompted to enter the SSH password, enter the password to be used for the rancher user. A
strong password must be entered.

b. Atthe Use DHCP (yes/no) prompt, enter no.

is in an Offline state after the installation. When prompted, enter the IP, Mask

s";’, Using DHCP causes a malfunction of the FortiEDR Repository server so that it
- and Gateway details of the virtual machine.

c. Atthe Do you want to change the default Pod network CIDR's prompt, enter yes or no depending on
your needs. The default Kubernetes internal Pod network is 10.42.0.0/16.

i. If you enter yes, provide the desired Pod network subnet in x.x.0.0/16 format when prompted.

ii. If you enter no, make sure the default Pod network CIDR does not overlap with your existing
networks.

d. Atthe Do you want to change the default Service network CIDR's prompt, enter yes or no depending
on your needs. The default Kubernetes internal Service network is 10.43.0.0/16.

i. If you enter yes, provide the desired Service network subnet in x.x.0.0/16 format when
prompted.

ii. If you enter no, make sure the default Service network CIDR does not overlap with your existing
networks.

e. When prompted to enter node IP, enter an IP depending on the virtual machine (node) you are
installing:
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10. Wait for the installation to complete which may take a while. The Virtual Machine restarts automatically

1.

- 5 Q =

F\—.

* If you are installing one single virtual machine (node) with fewer than 15000 seats or if you are
installing the first virtual machine (node) of the three for 15000 to 30000 seats, enter the
virtual IP address.

 If you are installing the second or third virtual machine (node) of the three for 15000 to 30000
seats, enter the virtual IP address you defined for the first virtual machine (node).

When prompted to enter subnet mask, provide the virtual machine subnet mask.

When prompted to enter DNS, provide the DNS details.

When asked, read the settings provided and approve or reject them.

When prompted to select an operation, approve the default (7. Install to disk) by pressing Enter.
To select the sda disk as the OS disk, select 1.

At the Config system with cloud-init file prompt, enter y.

When prompted to provide a Cloud-init file location (file path or http URL), enter edr.yaml.

When prompted to continue, enter y.

The image below provides a preview of the parameters you entered for a master virtual machine

(node).

i 's#<SSH_PASSWORD>#PaSSword#’ ./edr.yaml

i *'sE<TOKEN>#tOken35#’ .- edr.yaml

i 'sR<IPU4>1#10.10.10.1\,255.255.255.0n/10.10. 10 .253%" _/edr.yanl
i 'sE<NAME_SERVER>#10.10.10.1008° . edr.yaml

i 'sE<TIMEZOME>##’ .redr.yaml

i 'sE<MASTER_IP>##’ .sedr.yaml

i 'sE<NODE_MANE>#edr-repo—master—1#' . edr.yanl

Please follow instructioms:
= In "Choose operation” memu enter "1 ("Install to disk')

* In “Installation taryet. Device will be formatted” menu enter "1% (“sda")

= In "Config system with cloud-init file? [yM1:" enter 'y

= In "cloud-init file location (file path or http URL):" enter “edr.yaml”

fumning k305 configuration

hoose operat ion

. Install to disk

E. Configure server or agent

pe lect Number [11: 1

nstallation target. Device will be formatted
. sda

P . sdb

B. =sdc

fe lect Number [1: 1

onfig system with cloud—init file? [ysNl: y
loud—-init file location (file path or http URL): edr.yaml

onfiguration

flevice: sdeussda

our disk will be formatted and k305 will be installed with the above configuration.

after the installation.

If you have 15000 to 30000 seats, define two additional virtual machines (nodes) by repeating the
steps in Creating a virtual machine and the previous steps in Installing an Operating System ISO for each
node. Otherwise, skip to the next step.
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12. In the menu, select the default option k30S Current and press Enter.

GHU GRUB wersion 2.02

Use the & and * keys to select which entry is highlighted.

Pre enter to boot the :d 03, e’ to edit the commands
before booting or ¢’ for a command-line.
The highlighted entry will be executed automatically in 7s.

The system will start. This might take a few minutes while OS data is copied to the Virtual Machine.
13. Login with the rancher name and the password set previously.
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14. Run the sudo su - command.

15.

4.0-88—geveric on an x86_64 (sdevsttyl)

State Address
10.51.102.

Welcome to k305 (login with user: rancher)
edr-repo-master-1 login: rancher

Password :

Welcome to k3031

Refer to https:ssgithub.comsrancher-k3os for READMHE and issues.

tu AcCCEess 1l ThL nudL Luktn in suvar~-
can be used to join agents to this server.

edr-repo-master-1 [715 sudo su

edr-repo—master-1 [7 1#

Verify the installation is successful by running the kubectl get nodes command and checking that the
status of edr-repo-masteriis Ready, as shown below. If you installed three nodes, verify that the status
of the other two nodes are Ready as well.

edr-repo-naster-1 [T1# kubectl get nodes
3TaTUS  ROLES AGE UERS ION

edr-repo-master-1  Ready control-plane,etcd,master 11Zs wl.Z20.7+k3s1
edr-repo-master-1 [T1#

Installing a FortiEDR Repository software ISO

To install the FortiEDR Repository Software I1SO:

1. Launch the FortiEDR_Repositorylnstaller ISO file:
a. From the VMRC menu, select Removable Device > CD/DVD drive 1> Connect to Disk Image File
(iso)....
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7F FortiEDR-TH-Repository - VMware Remote Consale

-

VMRC - || ~ ¢ 0O,
"} Power .
(=)  Removable Devices ¥ CD/DVD drive 1 Connect to Disk Image File (iso]...
&2 Send Ctrl+Alt+Del ~  MNetwork adapter 1 SeLtings.l}
Manage »
E : Full Screen Ctrl+ Alt+Enter
Preferences...
Help ¥
Exit

b. Select the FortiEDR_Repositorylnstaller ISO file and click on Open. If the ISO has already been
uploaded to the VMware datastore, you can also upload the ISO from there.

If mounting the new ISO appears to freeze the system, check if there is a

x prompt to disconnect the existing ISO. If yes, select yes to disconnect the

existing ISO and then try mounting the new ISO again by repeating steps a
and b.

2. Run the following command:

bash /k3os/system/install edr2.sh

Select init (1) for a new installation.

mount: -mnt-siso: WARNING: device write-protected, mounted read-omly.

Please select action:
1 - init € install a fresh EDRuZ environment )
2 — update ( update existing EDRuZ enwironment )

3 — resize ( resize existing EDRvZ enwironment )

The node is being synchronized, which might take 10 to 15 minutes. If you installed three nodes, you
will be prompted for the SSH password for each node.

Existing virtual machine specifications (CPU and RAM) are being validated. If one is found to be lower
than the minimum requirements for proper functioning of the FortiEDR Repository, the following
warning appears:
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ERROE: Current node’s hardware spec doest it minimum requirenents
min CPU: 16 , £ 1y 8

min BAA: 24 , o installed 16

Wait until the required container images are imported from ISO to the local image storage (might take
few minutes).

3. Complete the FortiEDR Repository software installation by providing the following parameters:

» When prompted to enter the number of seats, enter the number of seats of your FortiEDR License
(workstations and servers).

» When prompted to specify whether the repository will be used by a Managed Security Service
Provider (MSSP), enter yes if you are going to define organizations, or no if you are not.

» If you entered yes in the previous question, provide the number of expected organizations
(meaning Tenants).

« When prompted for the FortiEDR Manager details, provide its IP and the credentials of one of the
FortiEDR Console administrators that have Rest API permissions.

Ay
‘Q' Make sure that the Threat Hunting repository does not block outbound traffic
|| to port 443 on Central Manager.

» Review the displayed configuration. Type yes to approve it or if the parameters are not correct,
press Enter to restart the configuration process. The installation may take several minutes.

FortiEDR 7.2.0 Administration Guide
Fortinet Inc.

501



Appendix C - ON PREMISE DEPLOYMENTS

Please enter required parameters...

Enter number of seats, as set in your FortiEDR environment license:
2000

Flease enter number of expected Organizations (Tenants). Otherwise, press "Enter” to approve the default [11:

Enter manager's IP or DNS address:
10.52.100 .10

Enter administrator user nane:
cdradmin

Enter administrator password:
P45%word

Enter NFS server address or press "Enter” to skip NFS configuration
INFO: Calculating TOTAL_WARM_SIZE and TOTAL_HOT_SIZE

Please review and confirm provided parameters:
NUMBER_OF_SEATS = 2000

TOTAL_WARM_SIZE = 1012

TOTAL_HOT_SIZE = 17

MANAGER_IP = 10.52.100.10

[REST_USER = edradmin

REST_PASSUORD = P455uword

NUMBER_OF_TENANTS = 1

Tupe “ues” to confirm entered parameters:

Configuring the Threat Hunting Repository Monitoring console

To configure and access the Threat Hunting Repository Monitoring console:

1. When prompted, provide the password to be used for the Threat Hunting Repository monitoring
console (Grafana) login. Note that the password should be a combination of letters and digits.

2. When asked whether to enable SMTP alerts, enter yes if you want to receive alert emails triggered by
the Threat Hunting Repository monitoring. Otherwise, enter no and skip to step 7.

3. When prompted, provide the following information of the SMTP server:
a. Details of the SMTP server (IP or FQDN, and port)
b. Email address to send the alerts
c. Email sender address
d. Username and password required for the SMTP server access
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4. When prompted, review the provided details and confirm.

Set the d to the Tr monito

Backing up Threat Hunting Repository data

Fortinet recommends that you back up the data stored in the Threat Hunting Repository database by
replicating it to a NFS server, which can be used in for disaster recovery.

e The size of the NFS storage must be at least 55% of the total size of your
Repository storage.

S ! /, » The time to back up the data depends on the amount of data being copied over
? from the Repository database to the NFS server.
- * When a piece of data is deleted from the Threat Hunting Repository storage due

to retention, the backup copy of that piece of data, if exists, is deleted from the
NFS server as well.

To enable backup of data, provide details about the backup storage in the CLI:

1. Atthe prompted question, enter yes.
2. When prompted, enter the NFS server address.
3. When prompted, enter the NFS share path to which the data will be replicated.
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Activating the Threat Hunting Repository Monitoring console

1. Visithttp://<TH IP>:3000.

« ] O & 1051.101.40:2000/l0gin

[DEnsile & Google Cloud Platform [ TechStuff [ EDRstress W Elastic @3 Elastic

S/
Welcome to Grafana

Email or usemame

ad!

2. Enter the user and password that you provided during the initial installation setup.
3. Go to Configuration > Data sources.

Configuration

B Data sources

Frometheus

{6  Configuration
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4. Click Add data source.

@ Configuration

B Data sources

Prometheus

6. Inthe URL field, enter http://alertmanager-operated:9093.
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7. Click Save & test.

Data Sources / Prometheus AlertManager

fit Settings

Prometheus AlertManager Default

htip://alertmanager-operated-9093

Access Server (default)
Allowed cookies

Timeout

Auth

Basic auth With Credentials

TLS Client Auth With CA Cert

skip TLS Verify

Forward OAuth Identity
Custom HTTP Headers

+ Add header

Datasource is working

Explore Delete

8. Under Dashboards > Manage:

Dashboards

& Manage

Dashboards

New Dashboard New Folder
@® Home

Import

& Msﬁana

Filter by starred
z

ger [ Overview

ALERTS
[ Ganerat

EDR
[ Geners!

EDR Total
[ Genersl
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» Open the EDR dashboard to view the current status of threat hunting.

hot-data0 5.8%

master0 59% s

warmdata0  5.9%
KAFKA

1374 0

Kafka

* Open the Alerts dashboard to view alerts triggered by the Threat Hunting Repository monitoring
system.

Elastic unhealthy Elastic disk low Elastic Heap high ELasic CPU high

0 0 0 0 0

Kafka Cluster failed Kafka broker restarting Kafka broker isk low Kafka offine partitions. Kafka ZK restarting Kafka ZK disk low

0 0 0 0 0

Openbistro unhealthy cluster

The following table lists all the alerts and the mitigation methods.

Alert Mitigation

No events from core Verify that all Cores are an running by
using the FortiEDR Manager.
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Consumer Lag (offset)
OpenDistro Unhealthy Cluster
OpenDistro CPU usage too high

OpenDistro heap size too large

OpenDistro too many shards per node

OpenDistro slow search query
OpenDistro slow search fetch
OpenDistro disk usage

ES pod in crashloop

Kafka Offline Partitions

Kafka broker is down

Kafka cluster failed

Kafaka broker restart rate high
Kafka broker disk low
ZooKeeper disk low

Streamer restart rate high
StreamerSink restart rate high
ZooKeeper restart too often

Streamer MAX HPA

Streamer unreached desired HPA

Middleware restart rate high

Alert Mitigation

Contact Fortinet Support.

Setting up the FortiEDR reputation server

The installation of the reputation service includes the following steps:

1.
2.
3. Configuring the reputation service on page 510

Creating a Virtual Machine on page 509
Installing the reputation service on page 510
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Creating a Virtual Machine

To create a virtual machine:

1. Create a new virtual server. For example, by selecting File > New Virtual Machine...., then selecting
Create a new virtual machine and clicking NEXT.

New Virtual Machine

1 Select a creation type Select a creation type

2 Select a name and folder How would you like to create a virtual machine?
3 Select a compute resource
2 Select storage A This option guides you through creating a new virtual machine. You
g i Deploy from t€mplate will be able to customize processors, memaory, network
Sl Sl Clone an existing virtual machine connections, and storage. You will need to install a guest operating
Clone virtual machine to template system after creation

Clone template to template

Convert template to virtual machine

CANCEL NEXT

2. Enter the desired virtual machine name. For example, fortiedr-reputation-service and click NEXT.
3. Enter the virtual machine settings, as follows:
a. Inthe Select a compute resource step, select the resources as needed and click NEXT.

b. Inthe Select storage step, select the storage where the virtual machine disk should be stored on
and click NEXT.

c. Inthe Select Compatibility step, select your ESXi version and click NEXT.

Select compatibility
Select compatibility for this virtual machine depending on the hosts in your environment

The host or cluster supports more than one VMware virtual machine version. Select a compatibility for the virtual machine.

Compatible with: | ESXi 7.0 U1 and later v (@D

This virtual machine uses hardware version 18, which is compatible with ESXi 7.0 U1 and later. Some virtual machine hardware features

are unavailable with this option

d. Atthe Select a guest OS step, select Linux in the Guest OS family field and select Ubuntu Linux (64-
bit) in the Guest OS version field.
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4.

e. Inthe Customize hardware step, select the minimum requirements as specified in system
requirements in Appendix C — ON PREMISE DEPLOYMENTS on page 459 and attach a network
interface.

Select Finish to complete the creation of the virtual machine.

Installing the reputation service

To install the FortiEDR reputation service:

B WDNA

Right-click the new VM and select Open Remote Console.
Select Manage > Virtual Machine Settings.
In the Hardware tab, select the CD/DVD option and then select the Use ISO image file option on the right.

Click the Browse button and select the ISO file provided by Fortinet for the FortiEDR Reputation Server.
Click OK.

the ISO from the VMWare datastore (this is possible if the ISO has already been
uploaded there).

\ﬂ Another option instead of completing the two steps described above is to upload

Start the virtual machine and wait until installation is complete.

Log into the virtual machine in order to continue the installation process.

Login: root

Change the root password, by entering any password you want. Then re-type it. The password must be
strong enough according to Linux standards.

Configuring the reputation service

To configure the FortiEDR reputation service:

P WOWDNA

In the VM CLI, enter fortiedr config.

At the device role prompt, click Next.

At the prompt, enter your hostname and click Next. (Note: This can be any hostname)

A list of network interfaces on this virtual machine displays. At the Pick your primary interface prompt,
select the primary interface to reach the Central Manager server, and click Next.

At the Do you want to use DHCP prompt, select No to configure the IP of this virtual machine manually,
and then click Next.

At the prompt, enter the IP address of the machine that you are installing. Use the following format:
XXX . XXX . XXX . XxX/yy, Where yy is the routing prefix of the subnet.

At the prompt, enter the default gateway and click Next.

At the Please set your DNS server prompt, enter a valid IP address and click Next. Use the following
format:

XXX . XXX . XXX . XxX/yy, where yy is the routing prefix of the subnet.

At the management prompt, enter the Central Manager IP address, which must be reachable from the
reputation server.
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10.

1.
12.

13.

14.

15.
16.
17.

18.

Enter the credentials of an admin user with REST API permissions in the FortiEDR Central Manager. If no
such user exists, you must first create one by following the steps in Users on page 277.

Enter the Central Manager SSH port (default is 22).

Enter the Central Manager SSH credentials, which are the root username and password you created
when Setting up a VM to be the FortiEDR Central Manager on page 465.

At the Do you want to enable web-proxy ? prompt, if the service will communicate via a proxy when
accessing the web (such as the FortiEDR Cloud Service (FCS)), select Yes and then enter the IP and
port of the proxy. Otherwise, select No.

At the Please set the date prompt, verify the date and click Next. The installer automatically presents
the current date. You can change this date, if necessary.

At the Please set your Time prompt, set the time and click Next.
At the prompt, select the timezone and country in which the server is being installed.

Wait a few moments while the installation processes, until you see the Installation completed
successfully message.

Run fortiedr status to validate that the reputation service is running.

Setting up the FortiEDR Core

This topic includes the following sections:

Prerequisites on page 511
Installing the FortiEDR Core on page 512

Prerequisites

The workstation, virtual machine or server on which the FortiEDR Core will be installed, must meet the
following requirements:

Complies with the requirements described in the System Requirements section in Appendix C - ON
PREMISE DEPLOYMENTS on page 459.
Has connectivity to a Local Area Network (for wired users) or a Wireless Network (for wireless users). If
there is no connectivity, consult your IT support person.
Has connectivity to the FortiEDR Aggregator. You can check this by browsing to the Aggregator’s IP
address. For problems connecting, see Troubleshooting on page 445.
Has connectivity to the FortiEDR Reputation Server at reputation.cloud.ensilo.com.
If the FortiEDR Core is deployed on your organization’s premises (on-premises) and you use a web
proxy to filter requests, then before running the installer, set the system proxy to work with an HTTPS
connection, as follows:
o Edit the file /etc/environment to have a proxy address configuration, https_proxy or PAC address.
For example: https_proxy=https://192.168.0.2:443
(for PAC): https_proxy=pac+http://192.168.200.100/sample.pac, where the sample.pac file
contains an HTTPS address of the proxy.
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o |f the definitions of the system proxy are placed somewhere other than /etc/environment, then:
= Copy the definitions to the file /etc/environment. Note that this affects all processes on the

Linux system.

® Define a specific environment variable for the FortiEDR Linux Core with the name nslo_https_

proxy at the file /etc/environment
For example: nslo_https_proxy=https://192.168.0.2:443

(for PAC): nslo_https_proxy=pac+http://192.168.200.100/sample.pac

\,

the Core Registration section in Component registration in a multi-organization

environment on page 416.

sq, For more details about installing a Core in a multi-organization environment, see

Installing the FortiEDR Core

The following describes how to install the FortiEDR Core:

1. Create a new virtual server by selecting File > New Virtual Machine.
2. Select the Typical option and click Next.

Mew Virtual Machine Wizard X

vimware Welcome to the New Virtual

WORKSTATION  machine Wizard
PRO"™

1 ; What type of configuration do you want?

O Typical {recommended)

Create a Workstation 17.5 or later virtual
machine in a few easy steps.

() Custom {advanced)

Create a virtual machine with advanced
options, such as a SCSI controller type,
virtual disk type and compatibility with
older YMware products.

Help = Back Cancel
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3. Select the I will install the operating system later option and click Next.

Guest Operating System Installation

A virtual machine is like a physical computer; it needs an operating
gystem. How will you install the guest operating system?

Install from:
Installer disc:

Mo drives available

() Installer discimage file {iso):

m
=]
wi

m

O I will install the operating system later,
The wirtual machine will be created with a blank hard disk.

Help < Back Mext = Cancel

4. Select the Linux radio button. In the Version field, select Ubuntu and click Next. Alternatively, you can
select a different generic Linux 64-bit in the Version field.
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Select a Guest Operating System
Which operating system will be installed on this virtual machine?

Guest operating system

() Microsoft Windows
O Linux

() WMware ESX

() other

Version

buntu e

Help < Back Mext = Cancel

5. Specify a name for the virtual machine such as FortiEDRCore and the location in which to store the
provided ISO file and click Next.
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Mew Virtual Machine Wizard X

Hame the Virtual Machine
What name would you like to use for this virtual machine?

Virtual machine name:

Location:

C:Wirtual Machines\Ubuntul| Erowse...

The default location can be changed at Edit > Preferences.

< Back Cancel

6. Change the Maximum disk size to 80 GB, leave the default option as Split virtual disk into multiple files and
click Next.
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ew Virtual Machine Wizard

specify Disk Capacity
How large do you want this disk to be?

The wirtual machine's hard disk is stored as one or more files on the host computer's
physical disk, These file(s) start small and become larger as you add applications,
files, and data to your virtual machine.

Maximum disk size (GB): BO.O -2

Recommended size for Ubuntu: 20 GB

() Store virtual disk as a single file
0 split virtual disk into multiple files

Splitting the disk makes it easier to move the virtual machine to another computer
but may reduce performance with very large disks.

Help < Back Mext = Cancel
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7. Click Finish.
Mew Virtual Machine Wizard X

Ready to Create Virtual Machine
Click Finish to create the virtual machine. Then you can install Ubuntu.

The wirtual machine will be created with the follawing settings:

Mame:
Location: C:Wirtual Machines\Ubuntu
Version: Warkstation 17,5 or later

Operating System: Ubuntu

Hard Disk: a0 GB, Split

Memory: 4096 MB

Metwork Adapter:  MAT

Other Devices: 2 CPU cores, CD/DVD, USE Controller, Sound Card

Customize Hardware. ..

< Back Cancel
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8. Right-click the new machine and select the Settings option.
| o - Vihware Workstation

File Edit View VM Tabs Help b- -

i X
le.rﬁr'_'f {1+ Home [_'|:| Forl
52 Type here to search -
= 1 My Computer I'_|D Fort|EDRC
FDW 'E
Close Tab il
r
Mark as Favorite
Rename...
Open VM directory
Remowve
&) Power 3
[z Snapshot 3
d
2 Manage 5
[ Settings...
I

9. Select the Memory option and change the RAM to at least 8 GB.
10. Select the Processors option and change the value to a total of at least two CPU Cores.
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11. Select the CD/DVD option and then select the Use ISO image file option on the right.

Wirtual Machine Settings

Hardware Options

Device Summary
E=IMemary 8GB
"% Processors 2
=\ Hard Disk (5CSI) 30 GB
(") CD/DOVD (SATA) Auto detect
55 Metwork Adapter NAT
B USE Controller Present
t]1 Sound Card Auto detect
[_Ipisplay Auto detect
Add... Remaove

Device status
Connected

H Connect at power on

Connection
(") Use physical drive:
Auto detect

Q) Use 150 image file:

| C:Wirtual Machinesy

_Ubuntu_6.0.1.0¢ | [ Browse...

OK

Cancel

Advanced...

Help

12. Click the Browse button and select the ISO file provided by Fortinet for the FortiEDR Core. Click OK.
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13. Start the virtual machine. For example, by using the button shown below:

| g - VMware Workstation
File Edit View VM Tabs Help [ ~ (D o [ B
i =
le.rar'_n,r {1t Home l_'|:|
52 Type here to search -
- 1 My Computer I'_|D
I

P Power on this virtual machine
[ Edit virtual machine settings

¥ Devices
E= Memory 8 GE
"} Processors Z
£\ Hard Disk (5CSI) 80 GE
(%) CD/DVD (SATA) Auto detect

The virtual machine automatically starts the installation process, which may take a few minutes.
14. Wait until a success message is displayed requesting that you reboot.
15. Reboot the virtual machine.

16. Loginto the virtual machine in order to continue the installation process.
Login: root
Change the root password, by entering any password you want and then retype it. The password must
be strong enough according to Linux standards.

17. Enter fortiedr config.

18. At the prompt, select the role of the virtual machine. For this installation, select CORE and click Next.

as Core only, Jumpbox, or Both in the INVENTORY > System Components tab of

s‘é’, After the installation of the Core, you can configure the functionality of the Core
- the Central Manager.

19. At the prompt, enter your hostname (any hostname) and click Next.

20. Atthe prompt, enter the Organization name if this Core is added to a multi-tenant environment and
should work only with one organization. For a non-multi-tenant setup, leave the organization name
empty. Click Next.

21. Atthe prompt, enter the registration password.

NP If this is a multi-tenant setup and this Core is to belong only to a specific
‘Q' organization, then the password should match the registration password that
- was provided upon creating that organization (listed under ADMINISTRATION

> ORGANIZATIONS tab of the FortiEDR Central Manager).

22. Atthe prompt, enter the Aggregator external IP address.
23. At the prompt, enter this Core machine’s external IP address without the port.
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24.

25.

26.

27.
28.

29.
30.

31.
32.
33.

34.

35.

36.
37.

A list of network interfaces on this virtual machine displays. At the Pick your primary interface prompt,
select the interface to be used as the primary network interface through which all FortiEDR Cores and
FortiEDR Collectors will reach this server, and then click Next.

At the Do you want to use DHCP prompt, do one of the following:
a. Select yes to use DHCP and click Next. Proceed to step 29 below.

b. Select no to configure the IP of this virtual machine manually, and then click Next. Perform steps 26
through 35 below.

At the prompt, enter the IP address of the machine that you are installing.
Use the following format: xxx.xxx.xxx.xxx/yy, where yy is the routing prefix of the subnet.

At the prompt, enter the default gateway and click Next.

At the Please set your DNS server prompt, enter a valid IP address and click Next.
Use the following format: xxx.xxx.xxx.xxx/yy, where yy is the routing prefix of the subnet.

At the prompt, select no for debug mode.

At the Please set the date prompt, verify the date and click Next. The installer automatically presents
the current date. You can change this date, if necessary.

At the Please set your Time prompt, set the time and click Next.
At the prompt, select the timezone and country in which the server is being installed.
At the Do you want to enable Web proxy prompt, select one of the following:

» yes—If you select yes, you must manually edit the /etc/environment file to configure the proxy
address, which can be https_proxy (such as https_proxy=https://192.168.0.2:443) or PAC
address (such as https_proxy=pac+http://192.168.200.100/sample.pac, where sample.pacis the
file that contains an HTTPS address of the proxy.

* no (default)

If you selected yes in the previous step, at the Do you want to exclude proxy configuration for Aggregator
communication? prompt, if the Aggregator is also installed on-premise, select yes to ignore the proxy
for Core and Aggregator communication. Otherwise, select no.

Wait a few moments while the installation processes, until you see the Installation completed
successfully message.

To verify that core installation succeeded, use the fortiedr status and fortiedr version commands.

In the Administration > Deployment > System Components tab of the Central Manager, verify that the
FortiEDR Core details are listed and configure the functionality of the Core as Core only, Jumpbox, or
Both.

FortiEDR CLI commands

The following describes additional commands that you can perform in the FortiEDR Core, Repository Server,
FortiEDR Central Manager, or FortiEDR Aggregator CLI.

At the prompt, type fortiedr or fortiedr help to display them.
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Command
Basic actions
help

config

start

stop

status
version
tzselect

logs-watch

General service controls
start

stop

restart

status

enable

FortiEDR 7.2.0 Administration Guide
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Description

Display this message and exit.
Run FortiEDR installer.

Start all active components.
Stop all active components.
Get active components status.
Show current version.

Select a timezone.

Display Aggregator and Central Manager

logs.

Start service.

Stop service.
Restart service.
Get service status.

Enable service.
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Command

disable

Description

Disable service.

Example: fortiedr {edr|aggregator|core|manager|activemaq} {start|stop|restart|status|enable|disable}

Specific component controls
Aggregator

start-debug

stop-debug

port-change <port>

set-dns <dns_name>
bandwidth config <bandwidth>
bandwidth enable

bandwidth disable
logs-watch

activemq

queue-stat <queue>

EDR

set-properties <user> '<password>'

start-debug

stop-debug

Central Manager
start-debug

stop-debug

load-content <password>

load-extra-config <password>

load-ssl-certificate <user> <password>

<certificate-location>

<privateKeyLocation> <privateKeyPassword>

set-smtp-server <ip>
reset-password <username>
disable-edr

enable-edr
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Run in debug mode.

Stop debug mode.

Change Aggregator port.

Change Aggregator DNS name.

Change aggregator bandwidth limit (in Kb/s).
Enable aggregator bandwidth limit.

Disable aggregator bandwidth limit.

Display Aggregator logs.

Provides detailed metrics about the activemq queues
(queue name is optional)

Set user and password.
Run in debug mode.

Stop debug mode.

Run in debug mode.
Stop debug mode.

Load dynamic content.
Load extra configuration.

Load new SSL certificate.

Set SMTP server in application-customer.properties.
Reset web password for a specific user.
Disable FortiEDR in the Central Manager.

Enable FortiEDR in the Central Manager.
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set-edr-ip <ip>:<port> Set FortiEDR server IP address and port.
set-edr-password <password> Set FortiEDR password.

set-edr-user <user> Set FortiEDR user.

logs-watch Display Central Manager logs.

Upgrading FortiEDR components

This section describes how to upgrade the components in the FortiEDR system.

Upgrading to a newer build number (major.minor.patch.build) can be done in any order. However, upgrading
to newer major/minor versions (major.minor.patch.build) should be done top-down in the following order:
Upgrading the Central Manager on page 524

Upgrading the Aggregator on page 524

Upgrading the Threat Hunting Repository on page 525

Upgrading the Core on page 526

Upgrading the Collector on page 73

a kWM =

Upgrading the Central Manager

The required upgrade file is provided to you by Fortinet. Use it to perform the procedure below.
1. Copy the FortiEDRInstaller_Ubuntu_7.2.0.xxxx.x file to the Central Manager machine. You can place
the file anywhere on the Linux machine. For example, FortiEDRInstaller_Ubuntu_7.2.0.0097.X.

2. Change the chmod 755 permission and the patch name in order to enable you to run the upgrade, as
shown below:

[root@dan ~]# chmod 755 FortiEDRInstaller_Ubuntu_7.2.0.0097.x
3. Run the patch, as shown below:
[root@dan ~]# ./FortiEDRInstaller_Ubuntu_7.2.0.0097.x

4. Wait for the upgrade to complete, as shown below:
FortiEDR installation 7.2.0.0097.x finished successfully
[root@dan ~]#

Upgrading the Aggregator

The required upgrade file is provided to you by Fortinet. Use it to perform the procedure below.

1. Copy the FortiEDRInstaller_Ubuntu_7.2.0.xxxx.x file to the Aggregator machine. You can place the
file anywhere on the Linux machine. For example, FortiEDRInstaller_Ubuntu_7.2.0.0097.x.
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2. Change the chmod 755 permission and the patch name in order to enable you to run the upgrade, as
shown below:

[root@dan ~]# chmod 755 FortiEDRInstaller_Ubuntu_7.2.0.0097.x
3. Run the patch, as shown below:
[root@dan ~]# ./FortiEDRInstaller_Ubuntu_7.2.0.0097.x

4. Wait for the upgrade to complete, as shown below:
FortiEDR installation 7.2.0.0097.x finished successfully
[root@dan ~]#

Upgrading the Threat Hunting Repository

Before you begin, ensure the CPU and memory of the repository are at least 1.5 times of the defined Threat
Hunting specifications in Appendix C — ON PREMISE DEPLOYMENTS on page 459. You can reduce the CPU
and memory back to the specifications once the upgrade is completed.

To upgrade the Threat Hunting Repository:

1. Launch the FortiEDR_Repositorylinstaller ISO file of the new Threat Hunting Repository version:
a. From the VMRC menu, select Removable Device > CD/DVD drive 1> Connect to Disk Image File

(iso)....
b i FortiEDR-TH-Repository - ViMware Remote Console
wre~ | |l ~ & O
(') Power »
()  Removable Devices » CD/DVD drive 1 Connect to Disk Image File (iso)...
D Send Ctrl+Alt+Del »  MNetwork adapter 1 Seningsb
&2 Manage »
[0 Full Screen Ctrl+Alt+Enter
Preferences...
Help 3
Exit
\‘ : 'l
q If an existing ISO is still connected, select Removable Device > CD/DVD drive 1
> Disconnect [ISO path] before connecting to the new ISO file.

b. Select the FortiEDR_Repositorylnstaller 1SO file for the new version and click on Open.

\{ Another option instead of the two steps described above is to upload the ISO

from the VMWare datastore (this is possible if the ISO has already been
uploaded there).

2. Start an SSH session to the repository machine, log in with user rancher, and run the following
command:

FortiEDR 7.2.0 Administration Guide 525
Fortinet Inc.



Appendix C - ON PREMISE DEPLOYMENTS

sudo su -

bash /k3os/system/install _edr2.sh

Select update (2) to upgrade the Threat Hunting Repository.

Ling EDRuvZ enuvironment 3
sync container images to all wodes )

UFDATED : : A 0
Tue Dct 11 07 19: eploye pronethe ack-20.0.1 [t} 1 complete

INFO: Importing ~mntrisorimages-alertmanager tar image

The node is being updated, which might take 8 to 10 minutes.
3. Complete the FortiEDR Repository software upgrade by providing the following parameters:

e When prompted for the FortiEDR Manager details, provide its IP and the credentials of one of the
FortiEDR Console administrators with Rest API permissions. See Users on page 277.

* When prompted for the primary DNS server address, provide the primary DNS server address for
the Threat Hunting Repository.

* When asked whether to set additional DNS servers, enter yes and provide an alternative DNS
address for the Threat Hunting Repository if needed. Otherwise, enter no to proceed.

vy
‘?' Fortinet recommends that you set up one additional DNS server in case the

primary DNS server fails.

» Enter the password of the FortiEDR Console administrator with Rest APl permissions. See Users on
page 277.

 When asked if you have a dedicated Aggregator VM, enter yes if you installed the Aggregator on a
separate VM than the Central Manager, and you will then be prompted to provide the Aggregator
details. Otherwise, enter no to proceed.

4. Wait for the configuration to complete.
Repeat step 1-4 on each additional Threat Hunting Repository nodes you may have.

6. Verify the upgrade is successful by opening the Central Manager and checking the version information
under the INVENTORY > System Components > REPOSITORIES tab.

b

Upgrading the Core

1. Copy the FortiEDRCoreInstaller_x.x.x.x.x file to the Core machine. You can place the file anywhere
on the Linux machine. For example, FortiEDRCoreInstaller_6.0.1.X.y.
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2. Change the chmod 755 permission and the patch name in order to enable you to run the upgrade, as
shown below:

[root@dan ~]# chmod 755 FortiEDRCoreInstaller 6.0.1.X.y
3. Run the patch, as shown below:
[root@dan ~]# ./FortiEDRCorelInstaller_6.0.1.x.y

4. Wait for the upgrade to complete, as shown below:
FortiEDR patch 6.0.1.x.y finished

[root@dan ~]#
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